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Sofern nicht anders angegeben, sind die unten angegebenen Datenaustauschformate Bestandteil von
Pro/ENGINEER Foundation.

BATCH
Den Batch-Modus aufrufen, um mehrere Plot-, IGES-, DXF-, VDA-, SET-, STEP-, STL- oder VRML-
Dateien zu erzeugen.

CADAM/CDT/CPTR (Ergänzungsmodul)
� Zeichnungen mit Pro/CDT-Dienstprogrammen direkt aus der Professional CADAM-Datenbank

importieren und ändern (CADAM-Datentransfer)

� ICADAM Mainframe-Dateien über das Neutraldatei (.bin)-Format von CPTR (CADAM in
Pro/ENGINEER-Transfer) importieren

CADDS 5
� Direkter Übersetzer zum Austausch der Teile- und Baugruppengeometrie zwischen Pro/ENGINEER

und CADDS 5. Weitere Informationen zu Associative Topology Bus-fähigem CADDS 5 finden Sie im
Online-Hilfemodul Associative Topology Bus.

CATIA
Mit der Option CATIA können Sie Geometrien zwischen Pro/ENGINEER und CATIA austauschen. Bei
Associative Topology Bus-fähigem CATIA lesen Sie bitte das Hilfemodul Associative Topology Bus.

CDRS (Ergänzungsmodul)
Verwenden Sie zum Datenaustausch zwischen Pro/DESIGNER und Pro/ENGINEER die Befehlsfolge KE

> Erzeugen > CDRS In (Feature > Create > CDRS In). Die Modellflächen werden von
Industriedesignern in Pro/DESIGNER erzeugt und zur nachgeordneten und strukturellen Konstruktion
sowie zur Erzeugung der technisch relevanten Arbeitsergebnisse nach Pro/ENGINEER exportiert. Weitere
Informationen zu Associative Topology Bus-fähigem CDRS finden Sie im Hilfemodul Associative
Topology Bus.

DXF und DWG
� Eine Data Exchange Format (DXF)-Datei importieren und die resultierende Zeichnung ändern. Eine

DXF-Datei kann 2D-Geometrie, Bemaßungen, Zeichnungskosmetik, Folien (bei mehreren die oberste)
enthalten, zu denen ein Element hinzugefügt wird.

� 2D-DXF- und 2D-DWG-Dateien in Produkte, wie beispielsweise AutoCAD importieren oder
exportieren.

ECAD
Mit der Option ECAD können Informationen zwischen Pro/ENGINEER und Systemen für Electrical
Computer-Aided Design (ECAD) ausgetauscht werden.

Initial Graphics Exchange Specification (IGES)
� Zeichnungs-, Zeichnungsformat-, Layout-, Bauteile- und Baugruppendaten in das Format Initial

Graphics Exchange Specification (IGES) exportieren.

� Teiledaten über die B-Spline-Darstellung für alle Flächen exportieren und automatisch ein
Postprozessing der IGES-Datei mit einem eigenen Programm einleiten.

� IGES-Dateien mit Zeichnungsdaten in Zeichnungen, Formate und Layouts importieren und die
Resultate ändern.
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� Modellkanten in einer Zeichnung für den Export über IGES gruppieren, damit andere Systeme, die
IGES-Gruppen unterstützen, die Modellkanten als einheitliche Elementsammlung erkennen können.

� IGES-Dateien mit Zeichnungs-, Skizzen- und Teiledaten in alle Modi in Pro/ENGINEER importieren.

Bilddateien
� Ausdrucken schattierter Bilder auf einem PostScript Drucker.

� Exportieren (Datei > Exportieren > Bild (File > Export > Image)) von Grafiken in das Format TIFF,
JPEG oder EPS.

� Importieren und Exportieren von CGM-Bilddateien.

� Importieren von TIFF-Bildern im Modus Zeichnung.

Neutral
Mit der Option Neutral erzeugen oder importieren Sie eine formatierte Textdatei (NEUTRAL-Datei) mit
Informationen, wie beispielsweise Modelltopologie, Beziehungen oder Attributen zu in Pro/ENGINEER
erzeugten Teilen und Baugruppen, die zur Erzeugung von Schnittstellen mit anderen Programmen
verwendet werden können.

PATRAN
Sie können eine aus Teiledaten erzeugte Datei exportieren, die von PATRAN Software-Systemen gelesen
werden kann. Diese Formatierung dieser Datei entspricht den Spezifikationen für PATRAN-
Datenbankdateien. Die PATRAN-Datei enthält mathematische Definitionen von Elementen wie
Flächendaten, die einen Körper begrenzen. Pro/ENGINEER akzeptiert keine Dateien aus PATRAN-
Systemen als Eingabe.

PhotoRender
Sie können photorealistische Bilder von Pro/ENGINEER, Pro/NOTEBOOK und Pro/CDRS Modellen über
das Neutral-Dateiformat erzeugen.

Abtastdaten
Sie können von einem Tablett digitalisieren, um Punkt-, Linien- und Bogendaten von vorhandenen
Zeichnungen und Layouts für den Import nach Pro/ENGINEER zu erzeugen.

SET
� Eine Zeichnung, die SET-Dateien (Standard for Exchange and Transfer) enthält, importieren und

ändern.

� SET (Standard for Exchange and Transfer) Teile- und Zeichnungsdateien (auch Formate und Layouts)
importieren.

� SET-Teiledaten (Kurven- und Flächendaten sowie Koordinatensysteme) und SET-Zeichnungsdaten
(2D-Geometrie, Text und Bemaßungen) exportieren.

SchrumpfVerpack
Benennen Sie jedes Schrumpfverpackungsmodell, und speichern Sie es als separates Pro/ENGINEER Teil.

STEP
� Vollständige Produktdefinitionen zwischen heterogenen CAD-, Konstruktions- und Fertigungssystemen

über das Format STEP (Standard for the Exchange of Product Model Data) austauschen.

� Importieren und exportieren von STEP Assoziativen Zeichnungsdaten (AP214).
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Supertab
Sie können aus Teiledaten eine I-DEAS Supertab-Datei erzeugen, die von Supertab Software-Systemen
gelesen werden kann. Diese Datei ist gemäß den Spezifikationen für Supertab Universaldateien formatiert.
Die Supertab Datei enthält mathematische Definitionen von Elementen wie Flächendaten, die einen Körper
begrenzen. Pro/ENGINEER akzeptiert keine Universaldateien von Supertab Systemen als Eingabe.

Aufgeteilte Anzeigedaten
Sie können aufgeteilte Anzeigedateien erzeugen, indem Sie diese in STL, Render, OptegraVis, Xpatch,
CatiaFacets (Catia Mock-Up), MEDUSA, 3-D Paint oder Inventor exportieren. Im Dialogfenster, das
geöffnet wird, bevor Sie Ihre Dateien exportieren, können Sie Abtreppungsparameter angeben.
� Importieren und exportieren Sie STL-Dateien, mit der Pro/ENGINEER Teile- und

Baugruppengeometrie über Stereolithografie- oder Rendering-Programme eingelesen werden können.
STL-Dateien stellen die Flächen eines Volumenmodells als eine Gruppe kleiner, planarer Polygone dar.

� Eine RENDER-Datei erzeugen, mit der Pro/ENGINEER Teile- und Baugruppengeometrie über
Rendering-Programme eingelesen werden können. RENDER-Dateien enthalten Definitionen zu
Kurvenflächenelementen und Farben zur Erstellung hochwertiger schattierter Bilder. Diese Dateien
sind nicht mit Stereolithografie-Programmen kompatibel.

� Modellinformationen für Teile und Baugruppen exportieren, die von IRIS Inventor, einem 3D Grafik-
Toolkit von Silicon Graphics, gelesen werden können.

� Die Geometrie von Modellen des Modus Teil und des Baugruppenmodus zur Verwendung mit
Pro/3DPAINT über Wavefront-Dateien vom Typ .obj exportieren.

� Exportieren Sie eine aufgeteilte Anzeigedatei für die Verwendung mit der Optegra Visualizer Software.

� Exportieren einer aufgeteilten Anzeige für den Import in MEDUSA.

� Importieren und Exportieren von Dateien im VRML-Format

� Importieren und Exportieren von Dateien im Catia Mock-Up-Format

� Exportieren eines aufgeteilten Modells für die Verwendung in einer Xpatch Radar Cross Section-
Analysesoftware

VDA
Teilgeometrien können zwischen Computersystemen ausgetauscht werden, indem Sie sie über die
Datenschnittstelle der VDA-Oberfläche importieren und exportieren.

Hinweis: Pro/ENGINEER unterstützt bei einem 2D-Import nur die Standardschriftarten und bei einem
Export die meisten Formate. Bei DWG- und DXF-Formaten unterstützt Pro/ENGINEER die
Standardschriftarten für den Export und die Standard- und IGES-1003-Schriftarten beim Import in DWG-
Dateien.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=a~íÉáÉå=áå=mêçLbkdfkbbo
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Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open), um ein Pro/ENGINEER-Modell oder eine
Zeichnung durch das Importieren einer Datei zu erzeugen. Wählen Sie die Befehlsfolge Einfuegen >
Daten aus Datei (Insert > Data From File), um ein Pro/ENGINEER-Modell oder eine Zeichnung durch
das Importieren einer Datei anzuhängen.

Klicken Sie auf den Link Siehe auch für das gewünschte Verfahren.
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Wählen Sie die Befehlsfolge Datei > Kopie speichern (File > Save a Copy), um ein Pro/ENGINEER-
Modell oder eine Zeichnung zu exportieren.
Klicken Sie auf den Link Siehe auch für das gewünschte Verfahren.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=jáí=áãéçêíáÉêíÉå
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Das Einlesen einer Geometriedatei aus einem anderen CAD-System fügt dem Pro/ENGINEER Modell ein
importiertes KE hinzu.

Nachdem das importierte KE in das Pro/ENGINEER Modell aufgenommen wurde, können Sie weitere
KEs hinzufügen oder an das importierte KE anhand von Referenzbemaßungen anbringen. Sie können auch
eine Zeichnung der importierten Geometrie erzeugen und bemaßen.

Je nach Typ der importierten Geometrie und der Einsatzweise können Sie daraus ein Pro/ENGINEER KE
in Form eines Volumenkörpers erzeugen. Importierte Daten können aus 2D- oder 3D-Drahtmodellen, 3D-
Flächen oder aus einer Kombination von Datentypen bestehen. Für das Arbeiten mit importierten Daten
gibt es vier Grundmethoden. Jede hängt von der voraussichtlichen Anzahl der Änderungen an der
Geometrie ab, dem Typ der zum Hinzufügen vorgesehenen KEs (falls vorhanden) und den Informationen
zu der benötigten Geometrie. Verwenden Sie die Methode, die sich am besten für die jeweilige Situation
eignet.

_ÉáëéáÉäÉW=sÉêÑ~ÜêÉå=ÑΩê=áãéçêíáÉêíÉ=dÉçãÉíêáÉ

Geometrie wie importiert verwenden
Die Verwendung der importierten Geometrie im "Ist-Zustand", d.h. mit unveränderlichen Teilen, kann in
den folgenden Situationen sinnvoll sein:

� Die Teile stammen aus einer Standard-Bibliothek (beispielsweise Schrauben oder Klammern aus einer
Bibliothek mit bereits vorhandenen Teilen)

ODER

� Das Teil fällt in den Zuständigkeitsbereich einer anderen Abteilung oder Firma (beispielsweise eine
Stilfläche aus der Abteilung für Industriedesign).

Sie können beispielsweise eine Geometrie als Grundlage für zusätzliche KEs verwenden, sie durch
aktualisierte Versionen ersetzen, in Baugruppen plazieren und als Referenz für Importattribute
umdefinieren auf Seite  1  -  10).die Komponentenerzeugung und/oder -plazierung verwenden, sie in einer
Zeichnung plazieren usw.

Geometrie nichtparametrisch ändern
Wenn die Geometrie nicht sehr aufwendig oder häufig geändert werden muß, können Sie die importierten
Elemente auch nichtparametrisch ändern. Bestimmte Änderungen wie z.B. das Vergrößern oder
Verkleinern des Biegewinkels einer Drahtmodell-Klammer oder das Verschieben einer Rasterhalterung an
einem Flächenmodell können ohne großen Aufwand durchgeführt werden. Wenn die Geometrie nicht sehr
häufig aktualisiert werden muß, kann unter Umständen auf parametrisches Verhalten verzichtet werden.
Die Geometrie kann dann wie in Methode 1 verwendet werden.

Nur wichtige Geometrie erzeugen/neu erzeugen
Wenn bestimmte Teile der Geometrie oft geändert werden müssen, haben Sie die Möglichkeit, nur diese
Bereiche neu zu erzeugen oder aus Volumenkörpern bestehende KEs auf der Basis nur eines Teils der
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Geometrie zu erzeugen. Beispiel: Ein als Gehäuse für ein elektronisches Gerät verwendetes Legacy-Teil
muß sich unter Umständen an vielen verschiedenen Versionen des Produkts befestigen lassen. Wenn Sie
lediglich die Geometrie der Rasterhalterungen neu erzeugen, werden Parameterfunktionen nur für die
wichtigen, häufig geänderten Geometriebereiche verfügbar, wie bei der versionsspezifischen Plazierung
oder bei der Nutzung von Familientabellen.

Gesamtes Modell parametrisch neu erzeugen
Muß die importierte Geometrie sehr aufwendig und/oder häufig zur Verwendung in einer aktuellen
Konstruktion geändert werden, ist meist die Neuerzeugung des ganzen Teils am effektivsten. Dadurch wird
das gesamte Teil parametrisiert, und Vorteile wie die Erfassung der Konstruktionsabsicht durch
Assoziativität und die KE-basierte Konstruktion kommen zum Tragen.

pç=ÉêòÉìÖÉå=páÉ=Éáå=sçäìãÉåãçÇÉää=~ìë=ÉáåÉã
aê~ÜíãçÇÉää
1. Zum Erzeugen von Bezugsebenen für das Skizzieren von Referenzen, die durch die Elemente

verlaufen, verwenden Sie im Menü  BEZUGSEBENE (DATUM PLANE) die Befehle Durch
(Through) und AchseKantKurv (AxisEdgeCurve).

2. Zum Konstruieren von Volumenkörpern durch Skizzieren verwenden Sie im Menü GEOM TOOLS

(GEOM WKZGE) den Befehl Kante verwend (Use Edge).
Hinweis: Zum Entfernen einer Eltern/Kind-Abhängigkeit zwischen Pro/ENGINEER KEs und dem
importierten KE machen Sie die Ausrichtung der mit dem Befehl Kante verwend (Use Edge) erstellten
geometrischen Elemente rückgängig, und bemaßen Sie diese in Relation zu den Standard-Bezügen und
zueinander.

3.  Anschließend plazieren Sie das Drahtmodell auf einer Folie und blenden die Folie aus.

aê~ÜíãçÇÉääÇ~íÉå
Wenn nur Drahtmodelldaten zur Verfügung stehen oder wenn die Daten ungenau sind, so daß die
Flächendaten nicht importiert werden können, können Sie ein Volumenkörper-Modell des gesamten Teils
konstruieren oder Volumenkörper nur auf der Basis der wichtigen Geometrie erzeugen, wobei Sie das
Drahtmodell als Referenz verwenden. Sie können auch das mit einem Volumenkörper-Modell verbundene
Drahtmodell in eine einzelne Datei exportieren, einschließlich der sichtbaren Sammelflächen.

Mit den folgenden Elementen können Sie eine Volumenkörper-Geometrie aus einem Drahtmodell
erzeugen:

� Bezugsebenen, die durch die Elemente verlaufen. Dabei dienen die Elemente beim Erzeugen der KEs
als Referenzen. Wie schon erläutert, muß eine Volumenkörper-Geometrie nicht unbedingt für das
gesamte importierte Teil erzeugt werden.

Hinweis: Sie können ein Drahtmodell auch auf einer Folie plazieren und diese ausblenden.
� Bezugskurven auf der Oberfläche von Drahtmodell-Elementen. Dabei werden die Bezugskurven als

Berandungen zum Erzeugen von Flächen verwendet.

Wenn die importierte Drahtmodell-Geometrie Spalten zwischen den Elementen enthält, können Sie mit den
Funktionen von Pro/LEGACY Abhilfe schaffen.

pç=ÖÉåÉêáÉêÉå=páÉ=ãáí=cä®ÅÜÉåÇ~íÉå=ÉáåÉå
sçäìãÉåâ∏êéÉê
Wenn die importierte Geometrie unverbundene Flächen enthält, wird das importierte KE als Gruppe von
Sammelflächen oder als Sammelfläche mit Spalten dargestellt. Nach Beendigung des Imports können Sie
das importierte KE auswählen und mit einer der folgenden Methoden in einen Volumenkörper
konvertieren:
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� Kann das System nicht automatisch alle Flächen innerhalb der importierten Daten verbinden, definieren
Sie das importierte KE um, indem Sie ausgehend vom Menü IMPORT UMDEF (REDEF IMPT) die
Befehlsfolge Geom heilen > Manuell > Berand beheben (Heal Geometry > Manual > Fix Bndries)
wählen. Wenn die restlichen Flächenkanten nicht zu einem geschlossenen Volumen verbunden werden
können, verwenden Sie eine der Strategien für das Arbeiten mit problematischer Geometrie.

� Nachdem ein einzelnes geschlossenes Volumen definiert wurde, erzeugen Sie den Volumenkörper mit
den Befehlen Koerper (Protrusion) und Sammelfl verwend (Use Quilts).

� Wird das importierte KE als offene Sammelfläche dargestellt, die kein einzelnes Volumen einschließen
kann, können Sie mit den Befehlen Koerper (Protrusion), Sammelfl verwend (Use Quilts) und
Duenn (Thin) einen dünnen Volumenkörper erzeugen.

cä®ÅÜÉåÇ~íÉå
Beim Importieren und Exportieren von Geometrie müssen Konfigurationsdatei-Optionen, die sich auf den
Transfer auswirken, in die Konfigurationsdatei eingegeben und diese vor dem Transfer in Pro/ENGINEER
geladen werden, damit die Konvertierung problemlos durchgeführt wird. Volumenmodelle aus CAD-
Systemen der zweiten Generation sollten möglichst als Flächen nach Pro/ENGINEER exportiert werden.

Beim Importieren von Flächendaten aus anderen Systemen können Volumenkörper auf unterschiedliche
Weise aus den eingelesenen Daten konstruiert werden. Welche Methode Sie verwenden, hängt davon ab,
welche Informationen im importierten KE verfügbar sind. Vermutlich wird eine der folgenden
Beispielsituationen für Sie zutreffen:

� Der Volumenkörper kann während des Exports automatisch aus den importierten Daten erzeugt
werden. Dies ist nur möglich, wenn Pro/ENGINEER über genügend Daten verfügt (z.  B. geschlossene
Sammelflächen), um einen Volumenkörper zu erzeugen.

� Der Volumenkörper kann nicht automatisch aus den importierten Daten erzeugt werden.

pç=áãéçêíáÉêÉå=páÉ=ÉáåÉå=sçäìãÉåâ∏êéÉê=~ìë
ÖÉëÅÜäçëëÉåÉå=p~ããÉäÑä®ÅÜÉå
Beim Importieren im Modus Teil oder Baugruppe versucht Pro/ENGINEER automatisch, einen
Volumenkörper zu erzeugen, sofern die importierten Daten geschlossene Sammelflächen enthalten.

Wenn Sie Geometriedaten, die geschlossene Sammelflächen enthalten, in eine bereits vorhandene
Volumenkörper-Geometrie importieren, wird das Dialogfenster Volumenkoerper-Optionen und

Plazierung (Choose Solid Options and Placement) geöffnet.

pç=ëíÉääÉå=páÉ=ÇáÉ=dÉå~ìáÖâÉáí=áãéçêíáÉêíÉê=a~íÉå
ëáÅÜÉê
1. Stellen Sie die Konfigurationsoptionen Ihren Anforderungen entsprechend ein.
2. Importieren Sie die Datei mit der Standardgenauigkeit, um die geeignete absolute Genauigkeit zu

bestimmen.
3. Importieren Sie die Datei erneut, und geben Sie den Wert für die absolute Genauigkeit ein, der sich für

die Geometrie am besten eignet.
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hçåÑáÖìê~íáçåëçéíáçåÉå=ÑΩê=áãéçêíáÉêíÉ=dÉçãÉíêáÉ
Stellen Sie vor dem Import von Geometrie aus anderen CAD-Systemen folgende Konfigurationsoptionen
ein:

Konfigurationsoption

 (Auf Yes oder No eingestellt)

Erklärung

intf3d_in_close_open_boundaries Schließt offene Berandungen von Einzelflächen, wenn
das Trimmen von Berandungen beim Import fehlschlägt.

try_g2_fix_on_import Bereinigt und glättet vor der Konvertierung in Pro/E
überflüssige Zeichen in B-Splineflächen.

intf_collapse_geom Legt bei der Einstellung "Yes" die parametrische Fläche
von Pro/ENGINEER in das Import-KE.

wf_keep_anlyt_srf Automatischer Säuberungsvorgang, der analytische
Flächen (flache Flächen, Zylinder, Kegel) beibehält und
ihre Kanten durch Überschneidung erzeugt.

intf3d_in_enable_layer_join Gruppiert bei der Einstellung "Yes" (Standard)
importierte Flächen nach ihren ursprünglichen
importierten Folien.  Entsprechend der importierten
Folien verbindet Pro/ENGINEER zuerst Flächen in
Gruppen. Anschließend wird die übrige Geometrie
verbunden. Durch diese Verbindungsart werden
topologische Unstimmigkeiten in importierten Daten
verringert.

Bei der Einstellung "No" werden keine
Folieninformationen in dem importierten KE
aufgenommen.

intr3d_in_show_join_layers_attr Bei der Einstellung "Yes" erscheint das Attribut Folien
vereinen (Join Layers) im Menü Interface Attribute.
Bei der Einstellung "Yes" werden keine
Folienverbindungen vorgenommen.

Wenn die Software, aus der Sie importieren, davon
ausgeht, daß sich alle Flächen einer Folie in einer
anderen Sammelfläche befinden, können Sie die
beabsichtigten Sammelflächen bearbeiten, indem Sie
einzeln durch die Folien gehen.

intf_in_surf_boundary_pref
Auf uv oder xyz setzen. Die
Standardeinstellung ist uv.

Bei Benutzeroberflächen zur Bearbeitung von 3D-
Flächen wird die Trimmung der Kanten redundant
dargestellt (sowohl mit UV-Kanten als auch mit XYZ-
Kanten). Mit dieser Option legen Sie den Datensatz für
den Importiervorgang fest.

fãéçêíáÉêíÉ=hbë=ìãÇÉÑáåáÉêÉå
Sie können ein importiertes KE durch eine neue Importdatei ersetzen, ohne eine 1:1-Übereinstimmung
zwischen den vorhandenen und ersetzten Elementen zu haben. Nachdem Sie das zur Umdefinierung
vorgesehene KE ausgewählt haben, wählen Sie im Menü IMPORT UMDEF (REDEF IMPT) den Befehl Datei
(File).
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Das Programm fordert Sie auf, Paare aus allen Elementen des importierten KE zu bilden, die durch andere
interne oder externe KEs (Teile und Baugruppen) referenziert werden. Die Kanten, Flächen und
Sammelflächen werden hervorgehoben.

Das System fordert Sie zur Eingabe aller externen Referenzen auf, die zu den gerade in der Sitzung
befindlichen Teilen und/oder Baugruppen gehören.

Externe Referenzen können beispielsweise für geometrische Eigenschaften (z.  B. Flächenkopien oder
Verbundbezugskurven) und/oder als räumliche Lokatoren (z.  B. zum Gegenrichten, Ausrichten oder
Einfügen) verwendet werden.

Zum Festlegen der Bezüge zwischen den referenzierten Elementen verwenden Sie die Menüs:  IMPORT

PAARE (IMPORT PAIRS), PAAREINSTELL (SET PAIRS) und KE NEU REFER (REROUTE

FEAT). Diese Funktionen können auf alle importierten Geometrietypen angewandt werden (d.  h., auf
Drahtmodelle, Flächen, Kanten, Sammelflächen oder Bezugspunkte).

Beachten Sie bitte folgendes beim Ersetzen von importierten KEs:

� Beim Umdefinieren eines aus einer Datei importierten KE, das in einer Baugruppe extern referenziert
wird, müssen Referenzpaare mit Hilfe des Befehls Paar einstell (Set Pairs) manuell festgelegt werden.

� Verwenden Sie möglichst oft die Befehle Auto-Abfrage (Auto Prompt) und Alle Kinder (All

Children). Diese Befehle prüfen alle referenzierten Elemente zur Einstellung der Paare für das neue
KE.

� Verwenden Sie den Befehl Paare einst (Set Pairs) erst, nachdem Sie den Befehl Auto-Abfrage (Auto
Prompt) zum Auffinden aller fehlenden Referenzen verwendet haben und die Regenerierung immer
noch mißlingt. Stellen Sie dann die entsprechenden Paare ein.

� Paaren Sie bei der anfänglichen Paarung nicht die alten Referenzen. Paaren Sie die alten mit
entsprechenden neuen Referenzen, wenn die KEs, die die alten Referenzen verwenden, Fehler
verursachen.

� Verwenden Sie den Befehl Aktuelles KE (Current Feat) erst, wenn eine Referenz im alten
importierten KE in mehrere KEs im neuen importierten KE aufgeteilt werden soll und Sie für
unterschiedliche KEs im neuen Teil unterschiedliche Referenzen verwenden möchten. Jedes KE sollte
nur eine Entsprechung besitzen.

pç=ÑΩÖÉå=páÉ=ÉáåÉ=åÉìÉ=cä®ÅÜÉ=òì=ÉáåÉã=hb=Üáåòì
1. Wählen Sie in einer geöffneten Datei mit einem importierten KE die Befehlsfolge Konstr Element >

Umdefinieren (Feature > Redefine), und markieren Sie das KE, das umdefiniert werden soll. Das
Menü IMPORT UMDEF (REDEF IMPT) wird geöffnet.

2. Wählen Sie den Befehl Datei (File). Das Dialogfenster Oeffnen (Open) wird geöffnet.
3. Wählen Sie den Typ (Type) der zu importierenden Datei. Dateien im Arbeitsverzeichnis mit dem

ausgewählten Typ werden aufgeführt.
4. Klicken Sie auf die gewünschte Datei, oder wechseln Sie zu einem anderen Verzeichnis, und wählen

Sie dort eine Datei.
5. Mit OK starten Sie den Neuimport. Möglicherweise werden das Dialogfenster Folienimport-Optionen

(Layer Import Options) und das Informationsfenster geöffnet.
6. Schließen Sie gegebenenfalls das Informationsfenster. Nehmen Sie die erforderlichen Änderungen im

Dialogfenster Folienimport-Optionen (Layer Import Options) vor, und klicken Sie auf OK.
7. Das Dialogfenster Volumenkoerper-Optionen und Plazierung (Choose Solid Options and

Placement) wird geöffnet.
8. Machen Sie im Dialogfenster die erforderlichen Eingaben, und wählen Sie OK, um die Datei mit den

neu zu importierenden Daten zu öffnen. Die Original-Datei wird in einem Pro/ENGINEER
Nebenfenster angezeigt, und die gewählte Datei erscheint in einem Pro/ENGINEER Hauptfenster. Das
Menü DATEI IMP (IMPT FILE) erscheint.

9. Wählen Sie im Menü DATEI IMP (IMPT FILE) den Befehl Hinzufuegen (Add), und klicken Sie
anschließend auf Fertig (Done). Das bereits vorhandene KE wird mitsamt der neuen, zu diesem KE
hinzugefügten Importdatei im Hauptfenster angezeigt, und das Nebenfenster wird geschlossen.
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jÉåΩ=a^qbf=fjm=Efjmq=cfibF
Das Menü DATEI IMP (IMPT FILE) enthält die folgenden Befehle:

� Alle ersetzen (Replace All) – Dieser Befehl dient zum Ersetzen des gesamten KE durch die neue
Importdatei.

� Ersetzen (Replace) – Dieser Befehl dient zum Ersetzen ausgewählter Teile des KE durch eine neue
Importdatei.

� Hinzufuegen (Add) – Dieser Befehl dient zum Hinzufügen einer neuen Importdatei zum bereits
vorhandenen KE.

pç=ÉêëÉíòÉå=páÉ=áãéçêíáÉêíÉ=hbë
1. Fügen Sie eine neue Fläche zu einem vorhandenen KE hinzu.
2. Wählen Sie im Menü DATEI IMP (IMPT FILE) den Befehl Alle ersetzen (Replace All).
3. Wählen Sie im Menü PAARIMPORT (IMPORT PAIRS) die entsprechenden Optionen, um die neuen

Referenzpaare einzustellen.
4. Wählen Sie anschließend den Befehl Fertig (Done). Das Teil wird regeneriert. Falls die Regenerierung

wegen fehlender Referenzen mißlingt, können Sie mit Hilfe der Menüs PAARIMPORT (IMPORT

PAIRS) und KE NEU REFER (REROUTE FEAT) zusätzliche Paare festlegen.
Nach erfolgter Umdefinition und erfolgreicher Regenerierung wird das alte importierte KE gelöscht
und durch das neue ersetzt. Sie können das neue IGES-KE vor Abschluß der Regenerierung jederzeit
löschen und das vorherige wiederherstellen, indem Sie im Menü PAARE EINST (SET PAIRS) den
Befehl Abbruch (Quit) wählen.

aáÉ=jÉåΩë=m^^ofjmloq=Efjmloq=m^fopF=ìåÇ=hb
kbr=obcbo=Eobolrqb=cb^qF

Das Menü PAARIMPORT (IMPORT PAIRS)
Flae Analyse (Srf Analysis) – Mit diesem Befehl öffnen Sie das Menü ERSATZ WAEHL (CHOOSE

REPL).

� Original – Mit diesem Befehl öffnen Sie das Menü FLAECHENINFO (SURF INFO) mit Befehlen zur
Durchführung einer Flächenanalyse am ursprünglichen KE. Dieser Befehl ist beim Importieren eines
Pro/DESIGNER KE verfügbar.

� Ersatz (Replacement) – Mit diesem Befehl öffnen Sie das Menü FLAECHENINFO (SURF INFO) mit
Befehlen zur Durchführung einer Flächenanalyse am neuen KE. Dieser Befehl ist beim Importieren
eines Pro/DESIGNER KE verfügbar.

Referenzinfo (Ref Info) – Mit diesem Befehl öffnen Sie das Menü KOMP REFER (COMP REFS).

� Vorhanden (Existing) – Mit diesem Befehl zeigen Sie gemeinsame Referenzen in den ursprünglichen
und neuen KEs an. Öffnet das Menü FLAECH REFER (SRF REFS) mit den Befehlen Naechste
(Next) und Vorige (Previous) zum Anzeigen der Referenzpaare.

� Neu (New) – Mit diesem Befehl zeigen Sie Referenzen im neuen KE an, die im Original-KE nicht
vorhanden sind. Öffnet das Menü FLAECH REFER (SRF REFS) mit den Befehlen Naechste (Next) und
Vorige (Previous) zum Anzeigen der Referenzen.

� Fehlen (Missing) – Mit diesem Befehl zeigen Sie Referenzen im ursprünglichen KE an, die im neuen
KE nicht vorhanden sind. Öffnet das Menü FLAECH REFER (SRF REFS) mit den Befehlen Naechste
(Next) und Vorige (Previous) zum Anzeigen der Referenzen.

Zurueckrollen (Roll Back) – Dieser Befehl führt Sie zu einem beliebigen KE vor der Paareinstellung
zurück. Sie können nicht zu KEs vor dem importierten KE zurückzugehen.
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Hinweis: Wenn Sie in einem Teil bis zum importierten KE zurückgehen, können Sie die Richtung des KE
umkehren, um die Kurvenrichtungen oder Flächennormalen im Referenzpaar einfacher in
Übereinstimmung bringen zu können.

Paare einst (Set Pairs) – Dieser Befehl ermöglicht die manuelle Einstellung von Paaren zwischen
Referenzen im vorhandenen und im neuen, importierten KE. Das System findet einige Paare automatisch.
Das Menü PAARE EINST (SET PAIRS) erscheint mit folgenden Befehlen:

� Alte Refer (Old Ref) – Mit diesem Befehl wählen Sie eine alte Referenz aus den Paaren, die das
System gefunden hat. Zum Übernehmen der entsprechenden neuen Referenz wählen Sie den Befehl
StandardRef (Default Ref).

� StandardRef (Default Ref) – Mit diesem Befehl akzeptieren Sie die vorgegebenen Referenzen, die das
System ausgewählt hat.

� Neue Ref (New Ref) – Mit diesem Befehl wählen Sie eine neue Referenz aus.

� Ueberspringen (Skip) – Mit diesem Befehl wird die Paarbildung bei alten Referenzen unterlassen.

Auto-Abfrage (Auto Prompt) – Dieser Befehl findet die Referenzen im bereits vorhandenen, importierten
KE, die durch andere KEs referenziert werden (diese müssen gepaart sein). Das System findet einige Paare
automatisch. Das System fordert Sie auf, die entsprechenden Referenzen im neuen importierten KE
anzuklicken.

KE NEU REFER (Menü)
Verwenden Sie das Menü KE NEU REFER (REROUTE FEAT), um die Zulässigkeit der Referenzpaare für
das fehlgeschlagene KE zu überprüfen.

Alle Kinder (All Children) – Dieser Befehl prüft die Zulässigkeit der Referenzpaare für alle KEs.

pç=ÉêëÉíòÉå=páÉ=Éáå=hb=íÉáäïÉáëÉ
1. Fügen Sie eine neue Fläche zu einem vorhandenen KE hinzu.
2. Wählen Sie im Menü DATEI IMP (IMPT FILE) den Befehl Ersetzen (Replace). Das Menü ERSATZ

WAEHL (CHOOSE REPL) erscheint.
3. Wählen Sie einen Befehl im Menü ERSATZ WAEHL (CHOOSE REPL). Das Menü ELEM ERSETZ

(REPLACE ENTS) erscheint.
4. Da alle Elementtypen zum Ersetzen ausgewählt sind, klicken Sie die Elementtypen an, die nicht ersetzt

werden sollen, und wählen Sie den Befehl Fertig (Done).
5. Befolgen Sie zum Importieren die Anweisungen am Bildschirm. Nach erfolgter Umdefinition und

erfolgreicher Regenerierung wird der ausgewählte Teil des KE gelöscht und durch den neuen ersetzt.

jÉåΩ=bibj=bopbqw=Eobmi^`b=bkqpF
� Punkt (Point) – Dieser Befehl ermöglicht das Auswählen von Punktelementen, die zu ersetzen sind.

� Bezugsebene (Datum Plane) – Dieser Befehl ermöglicht das Auswählen von Bezugsebenen, die zu
ersetzen sind.

� Kurve (Curve) – Dieser Befehl ermöglicht das Auswählen von Kurven, die zu ersetzen sind.

� Flaeche (Surface) – Dieser Befehl ermöglicht das Auswählen von Flächen, die zu ersetzen sind.

cçäáÉåÇ~íÉå=ÉñéçêíáÉêÉå
Sie können Folien exportieren und importieren. Zum Exportieren von Folien haben Sie die folgenden
Möglichkeiten:

� Die Folien-IDs angeben, indem Sie im Menü EINST FOLIE (SETUP LAYER) den Befehl ID Eingabe
(Specify Id) wählen (wenn der Exporttyp benannte Folien nicht unterstützt).

� Den Foliennamen eingeben.
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Informationen darüber, ob ein Objekt ein- oder ausgeblendet ist (bei Sammelflächen, Bezugskurven usw.),
werden nur exportiert, wenn die betreffenden Objekte ausgeblendet werden können, ohne daß sich die
Geometrie des Modells ändert.

Bei einigen Exporttypen wird bei Austauschdateien nur eine einzige Folie pro Element unterstützt. Daher
wird bei einem Element, das auf mehr als einer Folie vorkommt, nur die Folie mit der höchsten ID als Folie
des Elements exportiert.

Der Folienname für ein Element, das aus einer Neutraldatei eingelesen wurde, lautet INTF_nnn, wobei
<nnn> für die ID-Nummer der Folie steht.

Im Modus Zeichnung können Folieninformationen nur für Einzelelemente exportiert werden. Elemente auf
ausgeblendeten Folien werden jedoch nicht in die Neutraldatei ausgegeben.

Wenn Sie Baugruppen in den IGES-Flächenmodus ausgeben und die Baugruppenkomponenten in
Pro/ENGINEER einzelnen Folien zugewiesen wurden, geschieht folgendes:

� Die Schnittstellen-IDs von Folien werden als IGES-Ebenen ausgegeben. (In einer IGES-Datei werden
Baugruppenkomponenten nicht mit Folien, sondern mit Ebenen verknüpft).

� Wird eine Baugruppenkomponente auf eine Folie gelegt und ausgeblendet, werden in einer IGES-Datei
alle Geometrie-Elemente der ausgeblendeten Komponente als unsichtbar gekennzeichnet.

� Existiert zu einer Baugruppe eine Unterbaugruppe und sollen die Foliendaten der Unterbaugruppe bei
der Ausgabe der übergeordneten Baugruppe nach IGES ebenfalls ausgegeben werden, können Sie der
Unterbaugruppe eine Folie zuweisen. Plazieren Sie auf Unterbaugruppen-Ebene alle Komponenten der
Unterbaugruppe auf dieser Folie, und weisen Sie dieser Folie eine Schnittstellen-ID zu.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=cçäáÉåJbñéçêíëí~íìë
Verwenden Sie die Konfigurationsdatei-Option áåíÑ|áå|Ää~åâÉÇ|ÉåíáíáÉë in der Voreinstellung
für den Folien-Ausgabestatus. Besitzt diese Option den Wert no, werden in der Folienliste keine
ausgeblendeten Folien zum Filtern aufgeführt.

Sie können:

� Folien als numerische IDs oder Namen exportieren.

� einen automatischen Mechanismus zum Plazieren von Komponenten auf Folien verwenden.

� die Struktur einer Baugruppe darstellen, indem Sie Komponenten auf separaten Folien plazieren.
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Nicht alle Neutraldatei-Formate unterstützen Folien mit IDs und Namen. In der folgenden Tabelle sind die
unterstützten und im Tabellenbereich des Dialogfensters Folien waehlen (Choose Layers) verfügbaren
Funktionen aufgeführt.

IGES VDA STEP AP214_CD CATIA

Folien-IDs Unterstützt Nicht unterstützt Nicht unterstützt Unterstützt

Foliennamen Unterstützt Unterstützt
(Elementtypsatz)

Unterstützt Nicht unterstützt

Elemente auf

Mehrfach-

Folien

Unterstützt Nicht unterstützt Unterstützt Nicht unterstützt

Ausgeblendete

Folien

Unterstützt Nicht unterstützt Unterstützt Nicht unterstützt
(emuliert)

Baugrupppenkom

ponenten

Unterstützt Unterstützt Unterstützt Unterstützt

Beim Exportieren eines Teils werden Unterfolien im IGES- und VDA-Export unterstützt. Elemente auf
Unterfolien werden beim STEP-Export auf den Folien der obersten Ebene plaziert.

Wenn Sie beim Exportieren einer Baugruppe den Exportstatus einer von mehreren Varianten im
Dialogfenster Folien waehlen (Choose Layers) ändern, wirkt sich diese Änderung beim Export auf alle
Varianten aus.

fãéçêí=ìåÇ=bñéçêí=îçå=cçäáÉåÇ~íÉå=ÑΩê=PaJjçÇÉääÉ
ëíÉìÉêå
Die zu importierenden oder exportierenden Foliendaten können die Formate IGES, STEP, SET, VDA,
CATIA und Neutral aufweisen. Sie können beliebig viele Elemente aus einer Liste der in der Importdatei
verfügbaren Folien und/oder Volumenkörper auswählen. Bei Baugruppen können die gewünschten
Informationen gezielt importiert werden, beispielsweise nur das aus der Baugruppe benötigte Teil.

Verwenden Sie die Konfigurationsdatei-Option áåíÑ|áå|ä~óÉê|~ëã|Çá~äçÖë in der Voreinstellung
für den Folien-Importstatus. Hat die Konfigurationsdatei-Option den Wert yes, können Sie den Import von
Folien und Baugruppen im Dialogfenster Folienimport-Optionen (Layer Import Options) konfigurieren.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=mêçéêáÉí®êÉ=cä®ÅÜÉå=ãáí
mêçLqllihfq=áãéçêíáÉêÉå
Mit Pro/TOOLKIT können Sie proprietäre Flächen nach Pro/ENGINEER importieren. Importierte Flächen
dieser Art werden als Sonderfall eines Flächen-KE behandelt.

Eine proprietäre Fläche kann beispielsweise beim Ersetzen einer Fläche mit Hilfe des Befehls Ersetzen
(Replace) im Menü VERFORMUNG (TWEAK) verwendet werden, wenn die Flächen eines
Volumenkörpers durch eine Pro/TOOLKIT Fläche ersetzt werden. Nach dem Einbinden der proprietären
Fläche in die Teilegeometrie stehen alle anderen geometrischen Operationen wie z.  B. Versatz (Offset),
MatSchnitt (Cut) oder Rundung (Round) für die Fläche zur Verfügung.
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Hinweis: Zum Aufrufen, Ändern und Speichern von Modellen, die proprietäre Flächen enthalten, muß
außer Pro/TOOLKIT kein anderes Programm ausgeführt werden.

Damit eine Fläche importiert werden kann, muß das Teil ein Koordinatensystem als Bezugssystem für die
Fläche enthalten.

pç=áãéçêíáÉêÉå=páÉ=cêÉãÇÑä®ÅÜÉå
1. Wählen Sie in einem Teil die Befehlsfolge Konstr Elem > Erzeugen > Flaeche > Importieren

(Feature > Create > Surface > Import).
2. Wählen Sie im Menü SURF CLASS eine Flächenklasse. In diesem Menü sind alle in Pro/TOOLKIT

korrekt definierten Klassen aufgeführt.
3. Geben Sie den Namen der Fläche ein.
4. Wählen Sie in der Namensliste den Namen des Koordinatensystems, das als Bezugssystem für die

Fläche verwendet werden soll.
Verwendet die importierte Geometrie andere Bemaßungseinheiten als das aktuelle Modell, werden sie in
die Einheiten des aktuellen Modells konvertiert.

Mit einer Lizenz für Pro/SURFACE können Sie zum Erzeugen von Nicht-Volumenkörperflächen eine
Reihe von Techniken verwenden, die auch beim Erzeugen von Volumenkörper-Geometrie zum Einsatz
kommen. Darüber hinaus stehen Ihnen sehr differenzierte Methoden zur Flächenmodellierung zur
Verfügung. Mit Pro/INTERFACE können Sie Flächen aus anderen CAD-Systemen importieren.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=mêçL_^q`e
Über die Pro/BATCH Benutzerschnittstelle können Sie Ihre Batch-Sitzung definieren und die Ausführung
der Befehlsdatei planen.

Außerdem können Sie Dateien aus einer älteren Version von Pro/ENGINEER auf die aktuelle Version
umstellen.

Mit Pro/BATCH können Sie im Batch-Modus nacheinander mehrere Plotterdateien erzeugen oder in
andere Formate exportieren. Mit Hilfe der Benutzerschnittstelle (oder einer erzeugten Befehlsdatei) lädt
Pro/ENGINEER die jeweils zugehörigen Objekte und erzeugt die entsprechenden Exportdateien. Sie
können ebenso CADAM-Daten via Pro/BATCH nach Pro/ENGINEER importieren.

Mit Hilfe des Dienstprogramms éêçáÖëìíáä können Sie beliebige IGES-Dateien in Teile oder
Zeichnungen konvertieren.

Im Batch-Modus wird eine Liste von Objekten zur Erstellung von Dateien verwendet. Diese Objekte
werden aufgerufen, und die Dateien werden ohne weitere Einwirkung von Ihrer Seite erstellt.

Wenn Sie Pro/BATCH von der Betriebssystemebene oder über das Pro/ENGINEER Menü aufrufen,
beachten Sie folgende Regeln:

� Lizenzanforderungen und verfügbare Module bleiben die gleichen wie für eine gewöhnliche
Pro/ENGINEER Sitzung.

� Pro/BATCH entfernt keine Versionsnummern aus einer Eingabedatei. Wenn Sie eine Versionsnummer
angeben, wird die Datei mit dieser Versionsnummer verwendet; wenn Sie keine Versionsnummer
angeben, wird eine Datei mit der neuesten Version verwendet.

� Beim Ausführen einer Befehlsdatei verwendet das System die Konfigurationsdatei im
Arbeitsverzeichnis, Home-Verzeichnis, Installationsverzeichnis oder Startverzeichnis. Diese
Einstellungen der Konfigurationsdatei bestimmen die Umgebung von Pro/ENGINEER und geben
Befehle an, die zum Ausführen einer bestimmten Aufgabe erforderlich sind (z.  B. Plotten oder
Exportieren nach IGES, DXF oder VDA).

� Die Einstellungen der Konfigurationsdatei bleiben für alle mit dem gleichen Batch-Job erzeugten
Dateien gleich. Außerdem werden die in der Konfigurationsdatei definierten Suchpfade verwendet,
weshalb Objekte nicht im aktuellen Arbeitsverzeichnis stehen müssen.
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Wenn Sie Pro/BATCH von der Betriebssystemebene aufrufen, beachten Sie folgende Regeln:

� Während des Ausführens von Pro/BATCH genügt das Drücken der EINGABETASTE nach jeder
Systemanfrage zum Übernehmen der Voreinstellung.

� Um Pro/BATCH während des Erzeugens einer Befehlszeile zu beenden, geben Sie die Zeichenfolge
QUIT ein und drücken zweimal die EINGABETASTE.

Für jede Pro/BATCH Sitzung wird eine Protokolldatei erzeugt. Sie enthält alle ausgeführten Befehle und
den jeweils zugehörigen Exitcode (SUCCESS oder FAILURE).

_ÉáëéáÉäW=éêç|Ä~íÅÜKäçÖK@I=a~íÉá
In dieser Datei werden die Ergebnisse von drei Operationen festgehalten (Plotten, IGES-Export und VDA-
Export).

sçå=mêçL_^q`e=îÉêïÉåÇÉíÉ=hçåÑáÖìê~íáçåëÇ~íÉáJ
léíáçåÉå
Pro/BATCH erkennt die folgenden Konfigurationsdatei-Option aus der Datei config.pro:

� search_path — Name des Objekts, das sich nicht im aktuellen Verzeichnis befindet.

� pro_plot_config_dir – .pcf-Datei, die sich nicht im Arbeitsverzeichnis befindet.

� plot_file_dir  — Ausgabeverzeichnis, in das die Plotterdateien standardmäßig geschrieben werden (also
nicht in das Standardverzeichnis).

� plotter_command  — Befehl zum Plotten der Ausgabedateien.

Konfigurationsdateien für Plotter beim Plotten mit Pro/BATCH
Wenn Sie eine Konfigurationsdatei für Plotter zur Angabe von Plotteroptionen verwenden wollen, geben
Sie den Namen der Datei (d.h. <Ç~íÉáå~ãÉ>.pcf) bei der Aufforderung zur Angabe eines
Ausgabegeräts ein. Das System verwendet dann die Plotteroptionen aus der .pcf-Datei und fordert Sie in
der Folge zu keiner weiteren Eingabe mehr auf. Für Pro/BATCH gelten folgende Konfigurationsdatei-
Optionen für Plotter:

� interface_quality

� paper_size

� pen_slew

� plotter
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� plot_label

� plot_scale

� plot_segmented

� plot_sheets

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=^ìëÖ~ÄÉ=áå=~åÇÉêÉ
cçêã~íÉ=ΩÄÉê=mêçL_^q`e
Die folgende Tabelle zeigt die verschiedenen Möglichkeiten für den Export von Daten aus Pro/ENGINEER
in andere Formate mit Pro/BATCH und enthält eine Liste der Konfigurationsdatei-Optionen, die den Inhalt
der Ausgabedateien steuern.

 

Ausgabeformat Unterstützter Modus

Teil  Baugruppe  Zeichnung

Konfigurationsdatei-Optionen, die den

Export steuern

IGES • • • Baugruppen – iges_out_assembly_
default_mode

3D-Daten intf3d_out_default_option und
intf3d_out_datums_by_default

DXF •

STEP • • 3D-Daten intf3d_out_default_option und
intf3d_out_datums_by_default

VDA •

SET • • •

STL • •

CGM • • •

=

Die folgenden Konfigurationsdatei-Optionen steuern Ausgabefunktionen und Dateiinhalt:

� intf3d_out_default_option

� intf3d_out_datums_by_default

� iges_out_assembly_ default_mode

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=jáí=mêçL_^q`e=~ìë
`^a^j=áãéçêíáÉêÉå
Mit Pro/BATCH können Sie CADAM-Zeichnungen importieren. Hierzu müssen Sie beim Erzeugen eines
ausführbaren Programms die Option Å~Ç~ãáå eingeben. Dann werden Sie aufgefordert, folgendes
einzugeben:
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� Gruppenname

� Untergruppenname

� CADAM Zeichnungsname

� Pro/ENGINEER Zeichnungsname (die Voreinstellung ist der CADAM Zeichnungsname)

Der Name der Pro/ENGINEER Zeichnung darf keine Leerstellen aufweisen. Werden Leerstellen erkannt,
fordert das System Sie auf, einen neuen Namen einzugeben.

Nachdem Sie alle erforderlichen Daten eingegeben haben, wird der Batchdatei ein -cadamin
hinzugefügt. Die allgemeine Form des Befehls lautet:

-cadamin -grp_nam <gruppe> -sgrp_nam <untergruppe> -dwg_nam <name> -
pro_dwg_name

Beim Ändern des ausführbaren Programms müssen die Argumente "-grp_nam", "-sgrp_nam" und "-
dwg_nam" in Anführungszeichen eingegeben werden.

pç=åÉÜãÉå=páÉ=ÇáÉ=báåëíÉääìåÖÉå=ÑΩê=mêçL_^q`e
îçê=EÖêìåÇäÉÖÉåÇÉ=pÅÜêáííÉF
1. Geben Sie den Befehl éêç|Ä~íÅÜ ein. Das Dialogfenster Pro/BATCH wird aufgerufen.
2. Wählen Sie die Befehlsfolge Voreinstellung > Voreinstellungen einstellen (Preference > Set

Preference). Das Dialogfenster Options-Voreinstellung (Option Preference) wird aufgerufen.
3. Klicken Sie die Registerkarte Allgemein an. Darin können Sie die Standard-Aktion für alle Objekte

einstellen, die Sie zum Dialogfenster Pro/BATCH hinzufügen.
4. Wählen Sie die Aktion, die Sie als Voreinstellung angeben möchten, aus der Liste im Dialogfenster aus.

Die Einstellungen im Dialogfenster Options-Voreinstellung (Option Preference) werden in Ihrem
Home-Verzeichnis gespeichert, wenn Sie das Hauptfenster schließen.
Hinweis: Wenn Sie Objekte zum Plotten in die Batchdatei aufnehmen, müssen Sie in der Registerkarte
Plotten den Plotterbefehl eingeben.

5. Nehmen Sie ggf. Einstellungen auf weiteren Registerkarten vor, und schließen Sie dann das
Dialogfenster mit OK.

pç=ÉêëíÉääÉå=páÉ=åÉìÉ=_^q`eJa~íÉáÉå
1. Plazieren Sie im Dialogfenster Pro/BATCH den Mauszeiger im Feld Batch-Datei: (Batch File), und

geben Sie den Namen der neuen Batchdatei ein.
2. Plazieren Sie den Mauszeiger im Feld Pro/Engineer Befehl: und geben Sie den Pro/ENGINEER

Befehl zum Starten der Batchdatei ein.
3. Wählen Sie die Befehlsfolge Datei > Browsen (File > Browse). Das Dialogfenster Datei-Browser

(File Browser) wird aufgerufen.
4. Wählen Sie in der Liste Filter den Dateityp aus. Daraufhin erscheint oben links eine Liste aller Dateien

des ausgewählten Dateityps.
5. Wählen Sie den Namen der Datei aus, die Sie in die Batchdatei aufnehmen wollen, und klicken Sie

dann die Schaltfläche Objekte hinzufuegen an. Der Name der ausgewählten Datei erscheint im
Dialogfenster Pro/BATCH. Wiederholen Sie diesen Schritt für alle Dateien, die Sie zu der Batchdatei
hinzufügen möchten.

6. Wenn Sie die Namen aller Dateien zu Ihrer Pro/BATCH Sitzung hinzugefügt haben, klicken Sie die
Schaltfläche Browser schliessen an.

7. Wählen Sie den Namen der Datei, die Sie für einen bestimmten Vorgang in Ihrem Dialogfenster
Pro/BATCH einrichten wollen und wählen Sie dann entweder
� die Befehlsfolge Optionen > Aktion einstellen (Options > Set Action) einstellen

ODER
� drücken Sie die rechte Maustaste und wählen Sie den Befehl Aktion einstellen (Set Action) im

Menü, das erscheint.

Es erscheint ein weiteres Menü mit folgenden Optionen:
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� plot

� stl

� iges

� vda

� step

� dxf

� cgm

� clfile

� vrml

� upgrade

8. Fahren Sie mit dem gewünschten Vorgang fort.

pç=ÇÉÑáåáÉêÉå=páÉ=ÇáÉ=iáëíÉåÉäÉãÉåíÉ=áã
aá~äçÖÑÉåëíÉê=?léíáçå=ÉáåëíÉääÉå=J=éäçí?
1. Wählen Sie im Menü den Befehl plot.
2. Wählen Sie die Befehlsfolge Optionen > Option einstellen (Options > Set Option) oder rufen Sie mit

der rechten Maustaste das Menü OPTIONEN (OPTIONS) auf. Das Dialogfenster Option einstellen -

plot wird aufgerufen.
3. Wählen Sie in der Liste Plotter den gewünschten Plotter aus.
4. Wählen Sie in der Liste Papierformat das erforderliche Papierformat für den Plot aus.
5. Wählen Sie in der Liste Ausgabequalitaet einen Wert aus. Der Wert, den Sie für die Qualität

auswählen, hat Priorität gegenüber der Einstellung für interface_quality in Ihrer Konfigurationsdatei.
6. Geben Sie im Feld Masstab einen Wert für den gewünschten Maßstab ein.
7. Über den Befehl Stiftvorschub können Sie die Stiftgeschwindigkeit einstellen.
8. Geben Sie an, ob der Plot segmentiert werden soll.
9. Geben Sie an, ob der Plot mit einer Kennung versehen werden soll.
10. Besteht die Zeichnung aus mehreren Blättern, so wählen Sie im Feld Seitenauswahl den Bereich aus,

der geplottet werden soll.
11. Wählen Sie im Feld Ausgabedatei den Typ der Ausgabedatei, und geben Sie den Namen der

Plotterdatei ein, die erzeugt werden soll.
12. Wenn Sie die Netzwerkoption verwenden möchten, aktivieren Sie die Option (Benutzte

Netzwerkoption (Using Floating Option). Daraufhin erscheint im Kontrollkästchen ein Häkchen, und
Sie können die gewünschte Option in der Liste auswählen.

13. Wählen Sie OK, um die Einstellung für die Plotterdatei zu definieren. Darauf ändert sich im
Dialogfenster Pro/BATCH das Feld Option von Standard zu Benutzerdefiniert.

14. Wählen Sie die Befehlsfolge Datei > Speichern oder Speichern als (File > Save oder Save As).
15. Planen Sie den Start des Batch-Prozesses.

Hinweis: Stellen Sie den Drucker-Befehl im Dialogfenster Options-Voreinstellung ein, wenn Sie dies
nicht schon getan haben.

pç=ÇÉÑáåáÉêÉå=páÉ=ÇáÉ=iáëíÉåÉäÉãÉåíÉ=áã
aá~äçÖÑÉåëíÉê=?léíáçå=ÉáåëíÉääÉå=J=ëíä?
1. Wählen Sie im Menü den Befehl STL.
2. Wählen Sie die Befehlsfolge Optionen > Option einstellen (Options > Set Option). Das

Dialogfenster Option einstellen - stl wird aufgerufen.
3. Stellen Sie unter Ausgabeformat das Ausgabeformat für die STL-Datei ein.
4. Wählen Sie in der Liste Ausgabequalitaet einen Wert für die Ausgabequalität der Datei aus.
5. Wenn Sie die Netzwerkoption verwenden möchten, aktivieren Sie die Option (Benutzte

Netzwerkoption (Using Floating Option). Daraufhin erscheint im Kontrollkästchen ein Häkchen, und
Sie können die gewünschte Option in der Liste auswählen.
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6. Geben Sie im Feld Dateiname den Namen der STL-Datei ein.
7. Wählen Sie OK, um die Einstellung für den Ausgabetyp der STL-Datei zu definieren. Darauf ändert

sich im Dialogfenster Pro/BATCH das Feld Option von Standard zu Benutzerdefiniert.
8. Wählen Sie die Befehlsfolge Datei > Speichern oder Speichern als (File > Save oder Save As).
9. Planen Sie den Start des Batch-Prozesses.

pç=ÇÉÑáåáÉêÉå=páÉ=ÇáÉ=iáëíÉåÉäÉãÉåíÉ=áã
aá~äçÖÑÉåëíÉê=?léíáçå=ÉáåëíÉääÉå?=ÑΩê=fdbpI=aucI
pbqI=sa^=çÇÉê=pqbm
1. Wählen Sie im Menü einen der Befehle iges, set, vda, step oder dxf.
2. Wählen Sie die Befehlsfolge Optionen > Option einstellen (Options > Set Option). Das

Dialogfenster Option einstellen wird für den ausgewählten Dateityp aufgerufen. (Die Dialogfenster für
diese Typen sind gleich.
Hinweis: Wenn Sie eine DXF-Datei erstellen, können nur Zeichnungen exportiert werden.

3. Wenn Sie die Netzwerkoption verwenden möchten, aktivieren Sie die Option (Benutzte
Netzwerkoption (Using Floating Option). Daraufhin erscheint im Kontrollkästchen ein Häkchen, und
Sie können die gewünschte Option in der Liste auswählen.

4. Wählen Sie OK, um die Einstellung für den angegebenen Dateityp zu definieren. Darauf ändert sich im
Dialogfenster Pro/BATCH das Feld Option von Standard zu Benutzerdefiniert.

5. Wählen Sie die Befehlsfolge Datei > Speichern oder Speichern als (File > Save oder Save As).
6. Planen Sie den Start des Batch-Prozesses.

pç=ÇÉÑáåáÉêÉå=páÉ=ÇáÉ=iáëíÉåÉäÉãÉåíÉ=áã
aá~äçÖÑÉåëíÉê=?léíáçå=ÉáåëíÉääÉå=J=ÅÖã?
1. Wählen Sie im Menü den Befehl cgm.
2. Wählen Sie die Befehlsfolge Optionen > Option einstellen (Options > Set Option). Das

Dialogfenster Option einstellen - cgm (Set Option - cgm) wird aufgerufen.
3. Wählen Sie einen der Befehle CLEARTEXT oder Binaer (Binary) als Exporttyp für die CGM-Datei.
4. Wählen Sie einen der Befehle ABSTRAKT (ABSTRACT) oder METRISCH (METRIC) als Typ für

den Skalierungswert.
5. Geben Sie im Feld Ausgabe-Dateiname (Output Filename) den Namen für die auszugebende CGM-

Datei ein.
6. Wenn Sie die Netzwerkoption verwenden möchten, aktivieren Sie die Option (Benutzte

Netzwerkoption (Using Floating Option). Daraufhin erscheint im Kontrollkästchen ein Häkchen, und
Sie können die gewünschte Option in der Liste auswählen.

7. Wählen Sie OK, um die Einstellung für die CGM-Datei zu definieren. Darauf ändert sich im
Dialogfenster Pro/BATCH das Feld Option von Standard zu Benutzerdefiniert.

8. Wählen Sie die Befehlsfolge Datei > Speichern oder Speichern als (File > Save oder Save As).
9. Planen Sie den Start des Batch-Prozesses.

pç=ÇÉÑáåáÉêÉå=páÉ=ÇáÉ=iáëíÉåÉäÉãÉåíÉ=áã
aá~äçÖÑÉåëíÉê=?léíáçå=ÉáåëíÉääÉå=J=îêãä?
1. Wählen Sie im Menü den Befehl vrml.
2. Wählen Sie die Befehlsfolge Optionen > Option einstellen (Options > Set Option). Das

Dialogfenster  Option einstellen - vrml wird aufgerufen.
3. Wählen Sie als Exportmodus entweder InSitzung-Export oder Direkt-Export.
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4. Geben Sie im Feld Ausgabepfad den Pfad für die VRML-Datei ein, z.  B.:
-vrml -object <objektname> -out_path <pfad> [-direct y]

Dabei gilt:
<objektname> — Ein Teil oder eine Baugruppe, z.  B. wheel_1.prt oder engine_u.asm.2.
<pfad> — Der Pfad zum Verzeichnis, in das .wrl-Dateien ggf. umgeleitet werden.
[-direct y] — Direkter Export.

5. Wenn Sie die Netzwerkoption verwenden möchten, aktivieren Sie die Option (Benutzte
Netzwerkoption (Using Floating Option). Daraufhin erscheint im Kontrollkästchen ein Häkchen, und
Sie können die gewünschte Option in der Liste auswählen.

6. Wählen Sie OK, um die Einstellung für die VRML-Datei zu definieren. Darauf ändert sich im
Dialogfenster Pro/BATCH das Feld Option von Standard zu Benutzerdefiniert.

7. Wählen Sie die Befehlsfolge Datei > Speichern oder Speichern als (File > Save oder Save As).
8. Planen Sie den Start des Batch-Prozesses.

pç=ëíÉääÉå=páÉ=ÉáåÉ=a~íÉá=~ìÑ=ÇáÉ=~âíìÉääÉ=sÉêëáçå
ìã
1. Wählen Sie im Menü den Befehl aktualisieren (upgrade).
2. Planen Sie den Start des Batch-Prozesses.

pç=éä~åÉå=páÉ=ÇÉå=pí~êí=ÇÉë=_~íÅÜJmêçòÉëëÉë
1. Bevor Sie das Dialogfenster Pro/BATCH beenden, wählen Sie die Befehlsfolge Zeitplanung >

Vorgang starten (Schedule > Start the task). Das Dialogfenster Zeitplanung (Schedule) wird
aufgerufen.

2. Stellen Sie mit Hilfe der Pfeiltasten ein, nach welchem Zeitraum der Batch-Prozeß starten soll, und
wählen Sie anschließend OK.
Hinweis: Soll die Batchdatei sofort ausgeführt werden, übernehmen Sie im Dialogfenster Zeitplanung
(Schedule) die Voreinstellung von 0 Stunden.
Zum ausgewählten Zeitpunkt beginnt Pro/BATCH mit der Bearbeitung und erzeugt in Ihrem aktuellen
Arbeitsverzeichnis folgende Dateien:
� Objektausgabedateien (z.B. <objekt>.plt, <objekt>.iges)

� Die Datei pro_batch_list.txt mit der Liste aller Objektausgabedateien

� Die Datei pro_batch.log.#, in der die Ergebnisse der Ausführung festgehalten werden.

pç=ÑΩÜêÉå=páÉ=îçêÜ~åÇÉåÉ=_ÉÑÉÜäëÇ~íÉáÉå=~ìë
1. Geben Sie den Befehl pro_batch ein. Das Dialogfenster Pro/BATCH wird aufgerufen.
2. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen wird

aufgerufen.
3. Wählen Sie die Batchdatei aus, die ausgeführt werden soll, und wählen Sie OK. Daraufhin erscheinen

in den entsprechenden Feldern des Dialogfensters Pro/BATCH der Name der Batchdatei und die
Objekte in der Batchdatei.

4. Geben Sie im Feld Pro/Engineer Befehl: den gewünschten Befehl ein.
5. Planen Sie den Start des Batch-Prozesses.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=mêçL_^q`e
_ÉÑÉÜäëÇ~íÉáÉå
Befehlsdateien enthalten eine Liste mit Objekten, die zum Erstellen von Plotterdateien oder zum Export in
andere Formate verwendet werden. Jede Zeile in einer Befehlsdatei enthält den Namen eines Objekts, das
in einer der möglichen Arten exportiert werden soll.
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pç=ÉêëíÉääÉå=páÉ=åÉìÉ=_ÉÑÉÜäëÇ~íÉáÉå
1. Geben Sie ein: pro_batch -text <pro_command>.
2. Wenn Sie gefragt werden, ob Sie eine vorhandene Befehlsdatei ausführen möchten, geben Sie NO ein.
3. Geben Sie einen Namen für die Befehlsdatei ein. Wenn Sie den Namen einer bereits vorhandenen Datei

verwenden, werden Sie vom System gefragt, ob Sie diese überschreiben möchten. Wenn Sie NO
eingeben, werden Sie zur Angabe eines anderen Namens aufgefordert.

4. Geben Sie den Namen für den Typ von Befehlszeile ein, die erzeugt werden soll (z.  B. plot, STL, DXF
oder IGES).

5. Fahren Sie mit dem gewünschten Vorgang fort. Klicken Sie auf Siehe auch, und wählen Sie ein
Verfahren.

pç=ÉêòÉìÖÉå=páÉ=ÉáåÉ=mäçíÇ~íÉá=å~ÅÜ=ÇÉã
bêòÉìÖÉå=ÉáåÉê=åÉìÉå=mêçL_^q`eJ_ÉÑÉÜäëÇ~íÉá
1. Geben Sie den Namen des Objekts ein, das geplottet werden soll.
2. Geben Sie den Namen des Plotters (z.B. postscript) oder den Namen der Konfigurationsdatei für den

Plotter ein, der bzw. die verwendet werden soll (z.B. <dateiname>.pcf). Wurde der Name einer
Konfigurationsdatei für Plotter eingegeben, so erscheinen in dieser Datei festgelegte Optionen bei den
nachstehenden Abfragen nicht.

3. Geben Sie die erforderliche Papiergröße für den Plot ein.
4. Geben Sie einen Wert für die Ausgabequalität ein oder drücken Sie die EINGABETASTE, um den

Standardwert 3 zu übernehmen. Der eingegebene Wert für die Qualität hat Vorrang vor der Einstellung
der Konfigurationsdatei-Option interface_quality.

5. Geben Sie den gewünschten Maßstab ein.
6. Geben Sie die Stiftgeschwindigkeit ein.
7. Geben Sie an, ob der Plot segmentiert werden soll.
8. Geben Sie an, ob der Plot mit einer Kennung versehen werden soll.
9. Geben Sie an der Eingabeaufforderung YES ein, damit eine neue Plotterdatei erzeugt wird. Geben Sie
NO ein, um den Namen einer vorhandenen Plotterdatei einzugeben.

10. Sie werden gefragt, ob Sie separate Plotterdateien erzeugen möchten, falls die Zeichnung mehrere
Blätter umfaßt. Geben Sie NO ein, damit alle Blätter an eine einzige Plotterdatei angehängt werden.
Geben Sie YES ein, um für jedes Blatt der Zeichnung eine separate Plotterdatei zu erzeugen.

11. Geben Sie den Namen der Plotterdatei ein, die erzeugt werden soll.
12. Geben Sie an der Eingabeaufforderung YES ein, um eine weitere Datei zu exportieren, oder NO zum

Ausführen der Befehlsdatei. Pro/BATCH zeigt den Inhalt der jeweiligen Zeile an, die zu Ihrer
Befehlsdatei hinzugefügt wird.

pç=ÉñéçêíáÉêÉå=páÉ=å~ÅÜ=pqi
1. Geben Sie den Namen des Modells ein, das nach STL exportiert werden soll.
2. Geben Sie das Ausgabeformat der STL-Datei an (binär oder ASCII).
3. Geben Sie einen Wert für die Ausgabequalität der Datei ein.
4. Geben Sie einen Namen für die STL-Datei ein. Pro/BATCH zeigt den Inhalt der jeweiligen Zeile an,

die zu Ihrer Befehlsdatei hinzugefügt wird.
5. Geben Sie an der Eingabeaufforderung YES ein, um eine weitere Datei zu exportieren, oder NO zum

Ausführen der Befehlsdatei. Pro/BATCH zeigt den Inhalt der jeweiligen Zeile an, die zu Ihrer
Befehlsdatei hinzugefügt wird.

pç=ÉñéçêíáÉêÉå=páÉ=å~ÅÜ=fdbpI=aucI=pbqI=sa^
çÇÉê=pqbm
1. Geben Sie den Namen des Modells ein, das exportiert werden soll. Pro/BATCH zeigt den Inhalt der

jeweiligen Zeile an, die zu Ihrer Befehlsdatei hinzugefügt wird.
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2. Geben Sie an der Eingabeaufforderung YES ein, um eine weitere Datei zu exportieren, oder NO zum
Ausführen der Befehlsdatei. Pro/BATCH zeigt den Inhalt der jeweiligen Zeile an, die zu Ihrer
Befehlsdatei hinzugefügt wird.
Hinweis: Wenn Sie eine DXF-Datei erstellen, können nur Zeichnungen exportiert werden.

pç=ÉñéçêíáÉêÉå=páÉ=å~ÅÜ=`dj
1. Geben Sie den Namen des Modells ein, das nach CGM exportiert werden soll.
2. Geben Sie das Ausgabeformat der CGM-Datei an, entweder Cleartext oder Milspec.
3. Geben Sie den Maßstabstyp an (abstrakt oder metrisch).
4. Geben Sie einen Namen für die CGM-Datei ein. Pro/BATCH zeigt den Inhalt der jeweiligen Zeile an,

die zu Ihrer Befehlsdatei hinzugefügt wird.
5. Geben Sie an der Eingabeaufforderung YES ein, um eine weitere Datei zu exportieren, oder NO zum

Ausführen der Befehlsdatei. Pro/BATCH zeigt den Inhalt der jeweiligen Zeile an, die zu Ihrer
Befehlsdatei hinzugefügt wird.

pç=ÉñéçêíáÉêÉå=páÉ=å~ÅÜ=soji
1. Erzeugen Sie eine Datei für die Pro/BATCH Optionen.

Bei der Option für den VRML-Export sollte für jede einzelne VRML-Datenbank eine separate Zeile
verwendet werden.

2. Geben Sie einen der folgenden Befehle ein:
� Für einen direkten Export:

-vrml -object <objektname> -out_path <pfad> -direct <y>
� Für einen Export in Sitzung:

-vrml -object <objektname> -out_path <pfad> -direct <n>
Dabei gilt:
<objektname> – Ein Teil oder eine Baugruppe, z.B. wheel_1.prt oder engine_u.asm.2.
-out_path <pfad> – Pfad zur optionalen Umleitung von .wrl-Dateien an die angegebene
Position.
-direct <y oder n> – Die Eingabe von y bewirkt einen direkten Export, und die Eingabe von n
bewirkt für den Batch-Prozeß einen Export in Sitzung.

3. Geben Sie an der Eingabeaufforderung den folgenden Befehl ein, um die Pro/BATCH Option
auszuführen:
PROE_STARBEFEHL 0 0 3 -batchfile [datei_name]

pç=~âíì~äáëáÉêÉå=páÉ=a~íÉáÉå
1. Erzeugen Sie eine neue Befehlsdatei.
2. Geben Sie den Namen der Objektdatei ein.

pç=ÑΩÜêÉå=páÉ=_ÉÑÉÜäëÇ~íÉáÉå=ÇáêÉâí=å~ÅÜ=ÇÉê
bêòÉìÖìåÖ=~ìë
Durch Ausführen einer Befehlsdatei werden die Dateien für die in der Befehlsdatei angegebenen Objekte
erzeugt. Dabei wird außerdem eine weitere Datei mit dem Namen pro_batch_list.txt erzeugt, die eine Liste
aller Dateien enthält, die erfolgreich erzeugt werden konnten. Diese Datei kann anschließend im Rahmen
eines Befehlsscripts verwendet werden, mit dem automatisch alle Plotterdateien mit einem einzigen Befehl
geplottet werden können. Die Anzeige von verdeckten Kanten und Bezügen kann im Batch-Modus mit
Hilfe Ihrer Konfigurationsdatei eingestellt werden.

1. Nach dem Fertigstellen der Dateien geben Sie NO ein, wenn Sie gefragt werden, ob Sie eine weitere
Befehlszeile erzeugen wollen.

2. Geben Sie YES ein, um die Batch-Befehlsdatei auszuführen.
3. Sie werden gefragt, ob die Ausgabedateien geplottet werden sollen. no ist die Standardeinstellung. Bei
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Bedarf können Sie einen neuen Systembefehl eingeben (z.B. laser). Falls die Konfigurationsdatei-
Option plotter_command in der Datei config.pro angegeben wurde, können Sie den Standardbefehl
plotter_command eingeben.
Hinweis: Durch den Plotter-oder den Systembefehl werden alle erzeugten Ausgabedateien geplottet,
die in der Datei pro_batch_list.txt aufgeführt sind.
Pro/BATCH beginnt mit der Verarbeitung. In Ihrem aktuellen Arbeitsverzeichnis werden folgende
Dateien erzeugt:
� Objektausgabedateien (z.  B. <objekt>.plt, <objekt>.iges)

� Die Datei pro_batch_list.txt mit der Liste aller Objektausgabedateien

� die Datei pro_batch.log.# mit der Aufzeichnung der Ergebnisse der Ausführung

_ÉáëéáÉäW=mäçíÇ~íÉáÉå=ÑΩê=wÉáÅÜåìåÖÉå=ÉêòÉìÖÉå
ìåÇ=~ìëÑΩÜêÉå
Im folgenden Beispiel wird Pro/BATCH dazu verwendet, eine Befehlsdatei zum Plotten einer Zeichnung
zu erzeugen. Die Befehlsdatei wird sofort ausgeführt, ohne den Pro/BATCH Modus zu verlassen. Nach
Beendigung der Ausführung wird die erzeugte Plotterdatei zu einem angegebenen Drucker geschickt.

qóéÉ=W=pro_batch -text <pro_command>

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

GGGGGGGGGGGGGGGGGGGGGGGG=_~íÅÜ=cáäÉ=bñÉÅìíáçå=GGGGGGGGGGGGG

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

^=Å~êêá~ÖÉ=êÉíìêå=~ÑíÉê=~åó=éêçãéí=ïáää=êÉëìäí=áå=íÜÉ=ìëÉ=çÑ=íÜÉ=î~äìÉ

ëéÉÅáÑáÉÇ=ïáíÜáå=íÜÉ=Äê~ÅâÉíë=ExzFK=båíÉêáåÖ=íÜÉ=Åçãã~åÇ="èìáí?=~ÑíÉê
~åó=éêçãéí=ïáää=~ääçï=óçì=íç=ÉñáíK=fÑ=óçì=~êÉ=áå=Åçãã~åÇ=ÑáäÉ=ÅêÉ~íáçåI

?èìáí?=ïáää=êÉíìêå=óçì=íç=íÜÉ=_~íÅÜ=cáäÉ=bñÉÅìíáçå=äÉîÉäK=båíÉêáåÖ

?èìáí?=~í=íÜ~í=äÉîÉä=ïáää=ÖÉí=óçì=çìí=çÑ=íÜÉ=éêçÖê~ãK=^=äáëí=çÑ

áåíÉåÇÉÇ=ÑáäÉ=å~ãÉë=ïáää=ÄÉ=ÅêÉ~íÉÇ=ìåÇÉê=íÜÉ=å~ãÉ

LÉ~ëíÉêLÇçÅLä~êáë~Léêç|Ä~íÅÜ|äáëíKíñí

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

aç=óçì=ïáëÜ=íç=êìå=~å=ÉñáëíáåÖ=Åçãã~åÇ=ÑáäÉ=xkçz\=Y`o[

båíÉê=íÜÉ=å~ãÉ=Ñçê=íÜÉ=åÉï=Åçãã~åÇ=ÑáäÉ

xLÉ~ëíÉêLìëÉêëLã~åáéìä~íçêLÄÑáäÉKíñízW=Y`o[

rëáåÖ=LÉ~ëíÉêLìëÉêëLã~åáéìä~íçêLÄÑáäÉKíñíK

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

GGGGGGGGGG=_ÉÖáå=Åçãã~åÇ=ÑáäÉ=ÅêÉ~íáçå=GGGGGGGGGG

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

båíÉê=íÜÉ=íóéÉ=çÑ=Åçãã~åÇ=äáåÉ=íç=ÄÉ=ÅêÉ~íÉÇ=xNzW

NK=éäçí

OK=ëíä

PK=áÖÉë

QK=ÇñÑ

RK=Å~Ç~ãáå

SK=Åä|ÑáäÉ
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TK=ëÉí

UK=îÇ~

VK=ëíÉé

NMK=ÅÖã

NNK=îêãä

NOK=ìéÖê~ÇÉ

dÉÄÉå=páÉ=ÑçäÖÉåÇÉë=ÉáåW=N

båíÉê=íÜÉ=Ñìää=å~ãÉ=çÑ=íÜÉ=çÄàÉÅí=xzW=ëÜ~ÑíKÇêï

båíÉê=íÜÉ=éäçííÉê=å~ãÉ=xÇÉÑ~ìäízW=Y`o[

båíÉê=íÜÉ=é~éÉê=ëáòÉ=x^zW=Y`o[

båíÉê=ÇÉëáêÉÇ=çìíéìí=èì~äáíó=xÇÉÑ~ìäízW=Y`o[

båíÉê=ÇÉëáêÉÇ=ìëÉê=ëÅ~äÉ=xNKMzW=OKM

båíÉê=íÜÉ=éÉå=ëäÉïáåÖ=ÇÉëáêÉÇK

========NK=kç=éÉå=ëäÉïK

========OK=päÉï

aÉÑ~ìäí=xNzI=båíÉêW=Y`o[

båíÉê=m~ÖÉ=ê~åÖÉ=ëéÉÅáÑáÅ~íáçåW

========NK=^ää=m~ÖÉë

========OK=`ìêêÉåí=m~ÖÉ

========PK=o~åÖÉ=çÑ=m~ÖÉë

aÉÑ~ìäí=xNzI=båíÉêW=O

fÑ=çìíéìí=áë=ä~êÖÉê=íÜ~å=íÜÉ=é~éÉêI=Çç=óçì=ï~åí=ëÉÖãÉåíÉÇ=çìíéìí=xkçzW

Y`o[

aç=óçì=ï~åí=íç=ä~ÄÉä=íÜÉ=éäçí=xkçzW=Y`o[

aç=óçì=ï~åí=íç=ÅêÉ~íÉ=~=åÉï=éäçí=ÑáäÉ=xvÉëzW=Y`o[

aç=óçì=ï~åí=íç=ÅêÉ~íÉ=ëÉé~ê~íÉ=éäçí=ÑáäÉë=áÑ=íÜÉ=Çê~ïáåÖ=Ü~ë=ãìäíáéäÉ

ëÜÉÉíë=xkçzW=Y`o[

båíÉê=íÜÉ=lìíéìí=éäçí=ÑáäÉ=å~ãÉ=xéäçíKéäízW=Y`o[

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

qÜÉ=ÑçääçïáåÖ=Åçãã~åÇ=äáåÉ=Ü~ë=ÄÉÉå=~ÇÇÉÇ=íç

LÉ~ëíÉêLìëÉêëLã~åáéìä~íçêLÄÑáäÉKíñíW

=Jéäçí=JçÄàÉÅí=LÉ~ëíÉêLìëÉêëLã~åáéìä~íçêLëÜ~ÑíKÇêï=JéäçííÉê=ÇÉÑ~ìäí=J

é~éÉê=^=JìëÉêëÅ~äÉ=OKMMMMMM=JéäçíÑáäÉ=éäçíKéäí

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

tçìäÇ=óçì=äáâÉ=íç=ÅêÉ~íÉ=~åçíÜÉê=Åçãã~åÇ=äáåÉ=xkçzW=Y`o[

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

=======GGGGGGG=båÇ=çÑ=`çãã~åÇ=ÑáäÉ=`êÉ~íáçå=GGGGGGGG
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GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

aç=óçì=ï~åí=íç=ÉñÉÅìíÉ=íÜÉ=Ä~íÅÜ=Åçãã~åÇ=ÑáäÉ=xvÉëz\=Y`o[

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

qÜÉ=äáëí=çÑ=ÑáäÉë=íç=ÄÉ=ÅêÉ~íÉÇ=Å~å=ÄÉ=ÑçìåÇ=ìåÇÉê

LÉ~ëíÉêLìëÉêëLã~åáéìä~íçêLéêç|Ä~íÅÜ|äáëíKíñíK

GGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGGG

aç=óçì=ï~åí=íç=éäçí=íÜÉ=çìíéìí=ÑáäÉEëF=\=xkçzW=óÉë

båíÉê=íÜÉ=ëóëíÉã=Åçãã~åÇW=ä~ëÉê

ëë|éäçí|àçÄW=Jéäçí

GGGGGGGGG=_~íÅÜ=cáäÉ=bñÉÅìíáçå=pìÅÅÉëëÑìääó=`çãéäÉíÉÇ=GGGGGGGGGG

`^a^jJa~íÉáÉå=áãéçêíáÉêÉå
Die Schnittstelle zwischen Professional CADAM und Pro/ENGINEER wird von Pro/CDT bereitgestellt,
einem optionalen Pro/ENGINEER-Modul. Sie können CADAM-Dateien vom Mainframe auch in einem
Neutralformat, CPTR, importieren. Dieses Format wurde von Integrated Industrial Information, Inc.
erstellt. Mit Pro/CDT können Sie CADAM-Zeichnungsdateien und Dateien im CPTR-Neutralformat in
Pro/ENGINEER importieren. Nachdem Sie eine Zeichnung aus CADAM importiert haben, können Sie sie
mit den Menübefehlen in Pro/DETAIL oder Pro/LEGACY bearbeiten.

Mit der Befehlsfolge Datei > Oeffnen (File > Open) können Sie die Datenbank für Professional CADAM
direkt importieren. Entsprechend den Voreinstellungen für die Zeichnung legt Pro/ENGINEER fest, wie
Bemaßungen und Text zu behandeln sind. Falls Sie wissen, daß Ihre CADAM-Daten in einer bestimmten
Art und Weise gegliedert sind, sollten Sie eine Konfigurationsdatei für Zeichnungen erstellen, in der die
gleichen Informationen zur Voreinstellung enthalten sind. Wenn z.B. in den CADAM-Daten ISO-parallele
Bemaßungen verwendet werden, setzen Sie die Konfigurationsdatei-Option íÉñí|çêáÉåí~íáçå in der
Zeichnungs-Konfigurationsdatei auf é~ê~ääÉä.

pç=áãéçêíáÉêÉå=páÉ=`^a^jJwÉáÅÜåìåÖÉå=ÇáêÉâí
Sie können Professional CADAM-Zeichnungen, die 2D-Elemente bzw. Text enthalten, nach
Pro/ENGINEER importieren. Ein direkter Transfer von CADAM-Zeichnungen ist jedoch nur möglich,
wenn beide, sowohl CADAM als auch Pro/CDT, auf der gleichen Maschine laufen (IBM RS/6000).

1. Klicken Sie auf Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File Open) wird
aufgerufen.

2. Klicken Sie im Feld Suchen in (Look In) auf CADAM-Datenbank (CADAM Database).
Hinweis: Es erscheint keine Dateiliste für die CADAM-Datenbank. Sie müssen den vollen Namen der
Datei kennen, die Sie importieren möchten.

3. Wählen Sie aus der Liste Typ (Type) den Eintrag Cadam Direkt (*.ext) (Cadam Direct (*.ext)), und
geben Sie im Feld Name den vollständigen Pfad der zu importierenden CADAM-Zeichnung an.
Hinweis: Der vollständige Pfad muß alle Leerstellen beinhalten. Beispiel:
L`^a^jLao^tfkdpLÅ~ÇLÅ~Ç~ã=Çê~ïáåÖëLa=Å~Ç~ã=ëíÇ=áåÅÜ

4. Wählen Sie OK, um die CADAM-Datei anzuhängen.
Das System fragt Sie, ob Sie die linke Ecke einer Zeichnung auf den Bildschirmursprung verschieben
wollen. Wenn Sie mit v antworten, wählt das System automatisch die nächste für die Zeichnung
passende Standardgröße, und zeigt die Zeichnung auf dem Bildschirm an. Geben Sie k=ein, wird der
Ursprung der CADAM-Zeichnung (der sich in der Mitte befindet) an den Ursprung der
Pro/ENGINEER Zeichnung (in der linken unteren Bildschirmecke) gesetzt. Das System wählt zwar
immer noch das Format, die Zeichnung wird jedoch nur teilweise dargestellt. Um die gesamte
Zeichnung oder den entsprechenden Ausschnitt darzustellen, verwenden Sie den Befehl Verkleinern
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und verschieben Sie die Zeichnungselemente, indem Sie einen Translationsvektor angeben.

_ÉáëéáÉäW=`^a^jJwÉáÅÜåìåÖÉå=ãáí
ìåíÉêëÅÜáÉÇäáÅÜÉå=rêëéêìåÖëéìåâíÉå
Wenn Sie mit Y antworten, um die linke Ecke einer Zeichnung auf den Bildschirmursprung zu verschieben,
geschieht folgendes:

N

P

Q

2

1 Bildschirm

2 CADAM-Zeichnung

3 CADAM-Zeichnungsursprung

4 Pro/ENGINEER-Zeichnungsursprung
Wenn Sie mit N antworten, wird der Ursprung der CADAM-Zeichnung (der sich in der Mitte befindet) an
den Ursprung der Pro/ENGINEER Zeichnung gesetzt:

N

O

P

1 Bildschirm

2 CADAM-Zeichnung

3 CADAM-Zeichnungsursprung wurde auf den Pro/ENGINEER-Ursprungspunkt gesetzt

pç=áãéçêíáÉêÉå=páÉ=îÉê~êÄÉáíÉíÉ=KÅÇãJa~íÉáÉå
1. Kopieren Sie die verarbeitete .ÅÇã -Datei auf eine Pro/ENGINEER-Workstation.
2. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File

Open) wird aufgerufen.
3. Wählen Sie aus der Liste Typ den Befehl CADAM. Wählen Sie dann die CADAM-Datei, die Sie

importieren möchten aus der Liste der verfügbaren Dateien, oder geben Sie den Namen in das
Namensfeld ein.

4. Wählen Sie OK, um die CADAM-Datei zu importieren. Es erscheint das Dialogfenster Neues Modell

importieren (Import New Model).
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5. Vervollständigen Sie das Dialogfenster und klicken Sie OK an, um die neue Datei mit den CADAM-
Daten zu öffnen.

6. Das System fragt Sie, ob Sie die linke Ecke einer Zeichnung auf den Bildschirmursprung verschieben
wollen. Wenn Sie mit Y antworten, wählt das System automatisch die nächste für die Zeichnung
passende Standardgröße, und zeigt die Zeichnung auf dem Bildschirm an. Geben Sie N ein, wird der
Ursprung der CADAM-Zeichnung (der sich in der Mitte befindet) an den Ursprung der
Pro/ENGINEER Zeichnung (in der linken unteren Bildschirmecke) gesetzt. Das System wählt das
Format zwar immer noch automatisch, aber die Zeichnung wird nur teilweise dargestellt. Um die
gesamte Zeichnung oder den entsprechenden Ausschnitt darzustellen, verwenden Sie den Befehl
Verkleinern und verschieben Sie die Zeichnungselemente, indem Sie einen Translationsvektor
angeben.

fãéçêíáÉêíÉ=bäÉãÉåíÑçäáÉå
Die folgende Tabelle zeigt eine Liste der Elemente, die beim Import aus CADAM nach Pro/ENGINEER
auf besonderen Folien plaziert werden. Dabei ist <Å~Ç~ã|ΩÄÉêä~ÖÉêìåÖ> der Name der
Überlagerung, die in CADAM angegeben wurde.

=

Element Folie, auf der das Objekt liegt

cadam_xyz_point points_cdt_layer

cadam_2d_point points_cdt_layer

cadam_nc nc_style_cdt_layer

cadam_overlay <cadam_überlagerung>_olay
 

qáéW=`^a^jJaáííçë=ΩÄÉêíê~ÖÉå
Ein CADAM-Ditto ist ein separates Teil, für das überall in einer Zeichnung Varianten erzeugt werden
können. Die Variante kann beliebige Maßstäbe, Drehwinkel und Schraffuren besitzen (Schraffuren werden
nicht im Import unterstützt, außer wenn CADAM-Informationen bezüglich der Erzeugungsweise der
Schraffur freigibt). Eine Ditto-Variante in einer Zeichnung existiert in einer importierten Zeichnung als ein
Satz unabhängiger Objekte. Diese Objekte kennen ihre Ditto-Quelle (Ursprung) nicht und sind von anderen
Objekten nicht zu unterscheiden, die sich nicht in einem Ditto in der CADAM-Zeichnung befinden.

Sie können die Konfigurationsdatei-Option ÅÇí|íê~åëÑÉê|ÇÉí~áäë verwenden, um zu bestimmen,
welche Dittos sich in einer CADAM-Zeichnung befinden. Wenn die Konfigurationsdatei-Option auf yes
gestellt ist, konvertiert das System die mit einer CADAM-Zeichnung verbundenen Details in zusätzliche
separate Blätter auf der Zeichnung. Sie werden Dittos jedoch nicht immer auf separaten Blättern
importieren wollen, vor allem, wenn zahlreiche Dittos vorhanden sind.

pç=ÄÉ~êÄÉáíÉå=páÉ=`^a^j=KÅÇãJa~íÉáÉå
Sie können CADAM-Zeichnungen importieren, indem Sie eine CADAM-Datei auf einem Rechner
erstellen und sie dann auf einer Pro/ENGINEER Workstation einlesen. Zum Verarbeiten einer CADAM-
Datei muß jedoch das Pro/ENGINEER Dienstprogramm éêç|Ñêçã|ÅÇã auf der gleichen IBM RS/6000
installiert sein, auf der CADAM läuft.

Erzeugen Sie auf einer IBM RS/6000, auf der Professional CADAM läuft, eine Datei mit Hilfe des auf
dieser Maschine installierten Dienstprogramms éêç|Ñêçã|ÅÇã.

Für das Erzeugen einer Datei geben Sie folgendes ein:

éêç|Ñêçã|ÅÇã=YÖêìééÉI=ìåíÉêÖêìééÉI=òÉáÅÜåìåÖ[=Y~ìëÖ~ÄÉÇ~íÉá[
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Dabei gilt:

� <ÖêìééÉI=ìåíÉêÖêìééÉI=òÉáÅÜåìåÖ> ist der CADAM-Name.

� <~ìëÖ~ÄÉÇ~íÉá> die Datei, die mit dem Namen <~ìëÖ~ÄÉÇ~íÉá>.cdm.# erzeugt wurde.

Hinweis: Der für das Dienstprogramm éêç|Ñêçã|ÅÇã eingegebene Zeichnungsname darf keine
Leerzeichen enthalten.

pç=ÉñéçêíáÉêÉå=páÉ=pqiJI=oÉåÇÉêJI=léíÉÖê~sáëJI
ué~íÅÜJI=`~íá~c~ÅÉíëJI=jbarp^J=çÇÉê=fåîÉåíçêJ
a~íÉáÉå
1. Wählen Sie in einem aktiven Teil oder einer aktiven Baugruppe die Befehlsfolge Datei > Kopie

speichern (File > Save a Copy). Das Menü Kopie speichern (Save a Copy) wird geöffnet.
2. Klicken Sie im Feld Typ (Type) auf Render, OptegraVis, Xpatch, CatiaFacets, Medusa oder

Inventor. Das Dialogfenster für das gewählte Dateiformat wird angezeigt.
3. Wenn Sie die Abtreppung noch weiter steuern möchten, ändern Sie die Werte für die maximale

Sehnenhoehe (Chord Height) und Winkelsteuerung (Angle Control).
4. Weitere Befehle, nur für Baugruppen:

� Alle Teile (All Parts) – um die gesamte Baugruppe zu exportieren.

� Einschliessen (Include) – um jedes einzelne Teil zu wählen, das in die Datei aufgenommen
werden soll. Wenn Sie die aufzunehmenden Teile ausgewählt haben, können Sie die Auswahl
fortsetzen, indem Sie das Auswahl-Icon neben dem Mitteilungsfenster anklicken.

� Ausschliessen (Exclude) – um jedes einzelne Teil auszuwählen, das Sie aus der Datei
ausschließen möchten. Wenn Sie die auszuschließenden Teile ausgewählt haben, können Sie die
Auswahl fortsetzen, indem Sie das Auswahl-Icon neben dem Mitteilungsfenster anklicken.

Die Mitteilungszeile unterhalb dieser drei Optionen gibt Aufschluß über die Anzahl der Teile, die
exportiert werden. Sie wird bei jedem Schließen des Menüs AUSWAHL (GET SELECT)
aktualisiert. Das Wechseln zwischen Einschliessen (Include) und Ausschliessen (Exclude) hat
keine Auswirkung auf Ihre Auswahl.
Wenn Sie die Auswahl abbrechen möchten, wählen Sie Zuruecksetzen (Reset).

5. Wählen oder erzeugen Sie mit dem Menü KSYS HOLEN (GET COORD S) ein Koordinatensystem
zur Definition des xyz-Raums. Klicken Sie dazu auf das Auswahl-Icon unterhalb von
Koordinatensystem (Coordinate System). Sie können das Standard-Koordinatensystem des Modells
verwenden. Unter Umständen entstehen dabei jedoch negative Koordinaten. (Dieser Befehl ist für das
Inventor-Format nicht verfügbar).

6. Für das STL-Format können Sie den Befehl Binaer (Binary) oder ASCII (ASCII) wählen.
7. Aktivieren oder deaktivieren Sie Negative Werte zulassen (Allow Negative Values). (Dieser Befehl

steht für die Formate Inventor, CatiaFacets, Medusa und OptegraVis nicht zur Verfügung.)
8. Geben Sie den Namen der Datei ohne Erweiterung ein, oder übernehmen Sie den Standardnamen. Falls

Problemflächen festgestellt werden, beheben Sie den Fehler mit der Kantenabtreppung.
9. Wählen Sie Zuweisen (Apply), um das Teil oder die Baugruppe zu exportieren, oder wählen Sie OK,

um den Export auszuführen und das Dialogfenster zu schließen.
10. Bei einem Export in das Format CATIAFacets konvertieren Sie die .Å~í-Datei, die beim Export in das

CATIA-eigene Format erzeugt wurde. Weitere Informationen finden Sie unter páÉÜÉ=~ìÅÜ.

bñéçêíÇ~íÉá=ÉêòÉìÖÉå
Die Formate STL, RENDER und Inventor sind nur mit Teilen und Baugruppen eines Pro/ENGINEER
Volumenmodells möglich. Importierte Dateien müssen somit vor dem Export in ein Volumenmodell
umgewandelt werden.  Im Modus Baugruppe können Sie beliebig viele Teile zur Ausgabe in die Datei
auswählen.
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Wenn Sie eine STL- oder Inventor-Datei für ein Modell erstellen, wird das Modell schattiert und zeigt die
Dreiecke an, die gerade erzeugt werden. Wenn das Erzeugen einer STL-Datei fehlschlägt, werden die
Problemflächen hervorgehoben.

mçëáíáîÉ=hççêÇáå~íÉå=îÉêïÉåÇÉå
Durch Koordinatensysteme auf Teilen erhalten einige aufgeteilte Elemente keine positiven
Koordinatenwerte (Werte < = 0). Dies kann zu Problemen mit Programmen führen, die nur positive
Koordinaten verarbeiten können. Um dies zu vermeiden, wählen Sie ein Koordinatensystem, das alle
Koordinatenwerte positiv hält. Falls das gewählte Koordinatensystem zu negativen Werten führt, gibt
Pro/ENGINEER eine entsprechende Warnung aus. Sie werden gefragt, ob Sie fortfahren wollen. Wenn Sie
NO eingeben, wird der Vorgang abgebrochen, und Sie erhalten die Möglichkeit, ein anderes
Koordinatensystem zu erzeugen oder zu wählen.

§ÄÉêä~ééÉåÇÉ=cä®ÅÜÉå=ÄÉá=pqiJ=ìåÇ=fåîÉåíçêJ
a~íÉáÉå=ÑΩê=_~ìÖêìééÉå
STL- und Inventor-Dateien für Baugruppen teilen jedes Teil der Baugruppe einzeln in Dreiecke auf und
legen die Daten in der gleichen Datei ab.

Wenn Sie aus der STL-Datei ein Wachsmodell erstellen, kann es bei überlappenden Flächen zu Problemen
kommen. Diese Probleme können vermieden werden, indem zuerst durch Verschmelzen aller
Baugruppenkomponenten ein einzelnes Teil und im Modus Teil eine STL-Datei erzeugt wird.

pç=ÉñéçêíáÉêÉå=páÉ=jçÇÉääÉ=å~ÅÜ=mêçLPam^fkq
1. Wählen Sie Datei > Kopie speichern (File > Save a Copy).
2. Klicken Sie in der Liste Typ (Type) auf die Option 3DPAINT (*.obj). Der vorhandene

Pro/ENGINEER Modellname erscheint ohne die Erweiterung im Feld Neuer Name (New Name).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Es erscheint das Dialogfenster 3D Paint exportieren (Export 3D Paint).
5. Wenn Sie die Abtreppung noch weiter steuern möchten, ändern Sie die Werte für die maximale

Sehnenhoehe (Chord Height) und Winkelsteuerung (Angle Control).
6. Wählen Sie den Befehl Hinzufuegen (Add), um Teile und/oder Sammelflächen auszuwählen, die in

eine Gruppe aufgenommen werden sollen. Wählen Sie anschließend Fertig Ausw (Done Sel).
7. Definieren Sie für die ausgewählte Objektgruppe die Texturzuordnung u-v. Wählen Sie eine

Bezugsebene zum planaren u-v Zuordnen oder ein Koordinatensystem zum sphärischen u-v Zuordnen.
Hinweis:  Wählen Sie eine Bezugsebene zum planaren u-v Zuordnen oder ein Koordinatensystem zum
sphärischen u-v Zuordnen. Die Auswahl einer Bezugsebene ergibt eine ebene Projektion für das u-v
Zuordnen. Die Auswahl eine Koordinatensystems ergibt eine sphärische Projektion auf eine Kugel, die
um den Ursprung des Koordinatensystems zentriert ist. Die z-Achse der Kugel stimmt dabei mit der z-
Achse des Koordinatensystems überein.

8. Definieren Sie entsprechend weitere Objektgruppen für die Ausgabe, und geben Sie die entsprechende
u-v Zuordnung für jede Gruppe an (wie in den Schritten 6 und 7 beschrieben).

9. Wenn Sie alle Gruppen definiert haben, wählen Sie Zuweisen (Apply), um das Teil oder die
Baugruppe zu exportieren, oder wählen Sie OK, um den Export auszuführen und das Dialogfenster zu
schließen.

10. Gegen Sie den Namen der Ausgabedatei an (der Modellname ist der Standardname). Es wird eine
Wavefront-Datei mit der Erweiterung .obj generiert, die Triangulierungen aller ausgewählten
Bauteilflächen und Sammelflächen für die Ausgabe enthält. Der Dateiname lautet
<Ç~íÉáå~ãÉ>.çÄà, wobei <Ç~íÉáå~ãÉ> der von Ihnen angegebene Name ist. Ferner wird eine
zweite Datei, <Ç~íÉáå~ãÉ>.ãíä, erzeugt, die Informationen zu den Farben enthält, die den
verschiedenen Teilen und Sammelflächen zugewiesen wurden.
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bñéçêíèì~äáí®í=ëíÉìÉêå
Beim Exportieren sind die folgenden Punkte zu beachten:

� Um unerwünschte Ergebnisse zu vermeiden, sollten Sie eine Eins-zu-Eins-Zuordnung für die
Projektion wählen. Das heißt, keine zwei Punkte der ausgewählten Teile/Sammelflächen sollten
demselben Punkt der Bezugsebene oder Kugel zugeordnet sein.

� Sie können jedes Teil oder jede Sammelfläche nur einmal auswählen. Wenn Sie eine Sammelfläche
oder ein Teil auswählen, das bereits in die Gruppe aufgenommen wurde, wird das wiederholte Element
hervorgehoben. Sie werden dann aufgefordert, die Auswahl zu bestätigen oder abzubrechen.

� Die Qualität der Ausgabedatei hängt von der Feinheitssteuerung der Triangulation ab. Für die
Steuerung stehen die folgenden Optionen zur Verfügung:

� Sehnenhoehe (Chord Height) — Dient zur generellen Angabe der Kachelung der
Modelloberfläche. Hiermit wird der Maximalabstand zwischen einer Sehne und einer Oberfläche
angegeben. Je kleiner die angegebene Sehnenhöhe, desto geringer ist die Abweichung von der
tatsächlichen Bauteiloberfläche. Die in Modelleinheiten gemessene Sehnenhöhe muß im folgenden
Bereich liegen: Die Untergrenze für die Sehnenhöhe ist die Funktion der Teilegenauigkeit, die
Obergrenze entspricht der Bauteilgröße. Die Bauteilgröße wird als Diagonale eines imaginären,
das Bauteil umschließenden Quaders definiert. Der Bereich kann durch Eingabe einer Null (0) in
das Mitteilungsfenster bestimmt werden. Dadurch wird der zulässige Bereich für das fragliche
Objekt ausgegeben.

==========O

P

=====N

1 Sehnenhöhe

2 Teilfläche

3 Aufgeteilte Fläche
� Winkelsteuerung (AngleControl) – Mit diesem Befehl geben Sie die zusätzliche Verbesserung

entlang Kurven mit kleinen Radien an. Genau gesagt, werden Kurven mit einem Radius (r)
abgetreppt, der folgendermaßen definiert ist:

r < r0 = Teilegröße/10

wodurch die folgende maximale Sehnenhöhe ermöglicht wird:
(r/r0)a Sehnenhöhe

wobei � der Wert für die Winkelsteuerung ist. � = 0 führt daher bei Kurven mit kleinen Radien zu keiner
weiteren Verbesserung. Angenommen, ein Flächenelement wird durch eine Kurve mit sehr kleinen Radien
relativ zur Bauteilgröße berandet, wie z.  B. die Vertiefungen auf einem Golfball. Wenn Sie in einem
solchen Fall über Winkelsteuerung (AngleControl) keine zusätzliche Verbesserung angeben, besitzen
diese KEs in der abgetreppten Ausgabe nur eine sehr geringe Auflösung. Einstellbereich: 0,0 bis 1,0.

pç=ÉñéçêíáÉêÉå=páÉ=`^qf^=áå=ÉáåÉ
dÉçãÉíêáÉ~ìëÖ~ÄÉÇ~íÉá=áã=`^qf^JkÉìíê~äÑçêã~í
EKÅíF
Bei einem indirekten Export nach CATIA ist es nicht erforderlich, daß Pro/ENGINEER und CATIA auf
Ihrer Workstation installiert sind. Zunächst exportieren Sie das Modell, dann konvertieren Sie die
resultierende KÅí-Datei in das CATIA-eigene Format.
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1. Wählen Sie in einem offenen Teil oder einer offenen Baugruppe die Befehlsfolge Datei > Kopie

speichern (File > Save a Copy). Das Menü Kopie speichern (Save a Copy) wird geöffnet.
2. Wählen Sie in der Liste Typ (Type) die Option CATIA in/aus Datei (CATIA to/from File (*.ct)).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK.
5. Das Dialogfenster Exportieren CATIA (Export CATIA) erscheint.
6. Geben Sie im Dialogfenster die Struktur und den Inhalt der Ausgabedatei an.
7. Sollen Folien exportiert werden, klicken Sie im Dialogfenster Exportieren CATIA (Export CATIA)

auf die Option Folien anpassen (Customize Layers). Das Dialogfenster Folien waehlen erscheint.
8. Klicken Sie Autom-ID (Auto ID) an, um den Folien, die noch keine IDs haben, Folien-IDs

zuzuordnen.
9. Nehmen Sie die gewünschten Änderungen im Dialogfenster Folien waehlen (Choose Layers) vor, und

klicken Sie auf OK. Die Änderungen werden übernommen.
10. Wählen Sie OK, um die Teile- oder Baugruppen-Ausgabedatei im Zwischenformat zu erzeugen.
11. Konvertieren Sie die KÅí-Datei in das CATIA-eigene Format. Weitere Informationen finden Sie unter

páÉÜÉ=~ìÅÜ.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=mêçLtb_=mr_ifpe
Pro/WEB PUBLISH bietet folgende Möglichkeiten:

� Erstellen einer papierfreien Umgebung, die zu einem Rückgang der Kosten für das Erstellen und
Plotten von Zeichnungen führt.

� Ausweitung des Datenzugriffs auf alle Firmenbereiche.

Mit Hilfe der Publishing-Tools können Sie die folgenden Daten in die Formate HTML, VRML, CGM und
JPEG exportieren und in einem Web-Browser darstellen:

� Baugruppenmodelle und -daten

� Baugruppenspezifische Prozesse mit Grafik und Text zu den einzelnen Prozeßschritten

� NC-Prozesse mit Grafik und Text zu den einzelnen Prozeßschritten

Die im Browser dargestellten Prozeß- und Baugruppen-Informationen leiten sich aus Prozeßdaten ab, die
nach bestimmten Kriterien aus Pro/ENGINEER extrahiert werden.

Mit Pro/WEB PUBLISH erstellte Dokumente können nicht bearbeitet werden. Sie sind in keiner Weise mit
dem ursprünglichen Baugruppen- oder Prozeßplan verbunden. Wenn Sie in Pro/ENGINEER Änderungen
am Modell vornehmen, müssen Sie das Dokument noch einmal erstellen, damit es die letzten Änderungen
erkennen läßt.

Voraussetzungen für das Anzeigen von Publikationen
Zum Anzeigen von Web-Dokumenten müssen folgende Software-Komponenten vorhanden sein:

� Auf dem Web-Server muß eine procgi Server-Applikation installiert sein. Informationen zur
Installation bestimmter Server finden Sie im Handbuch Pro/ENGINEER Installation und
Administration.

� Als Browser eignen sich Netscape Navigator 3.0 (oder höher) und Microsoft Explorer 3.0 (oder höher).
Der verwendete Browser muß HTML, JavaScript und Java sowie VRML, CGM und JPEG unterstützen
(direkt oder über Plug-Ins bzw. Hilfsprogramme). Der Web-Browser muß Frames unterstützen.

Unterstützte Grafikformate
Pro/WEB PUBLISH unterstützt folgende Grafikformate:

� JPEG (Joint Photographic Experts Group) — Raster-orientiertes 2D-Bildformat (wird als
Standardformat verwendet).

� CGM (Computer Graphics Metafile) — Vektor-orientiertes 2D-Bildformat.
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� VRML (Virtual Reality Modeling Language) — Web-orientierte Sprache zur Beschreibung von 3D-
Objekten und -Umgebungen.

pç=ÉêòÉìÖÉå=páÉ=tÉÄJaçâìãÉåíÉ
Zum Erstellen eines Dokuments gehen Sie folgendermaßen vor:

1. Exportieren Sie eine Baugruppe oder einen Prozeßplan aus Pro/ENGINEER in WWW-Formate. Das
System erzeugt ein Verzeichnis, das alle mit dem Dokument zusammenhängenden Dateien enthält.

2. Richten Sie im Dokument-Root-Verzeichnis des Web-Servers Unterverzeichnisse für die Ablage von
Baugruppen oder Prozeßpläne ein.

3. Sehen Sie sich die Informationsseiten in einem Web-Browser an.

pç=ÄÉêÉáíÉå=páÉ=jçÇÉääÉ=ÑΩê=ÇÉå=bñéçêí=îçê
So bereiten Sie das Modell für den Export vor

� Wenn das Dokument mehrere Orientierungen einer Baugruppe im Format CGM oder JPEG enthalten
soll, erzeugen Sie vor dem Export der Baugruppe im Modus Baugruppe benannte Ansichten.
Andernfalls ist nur die Standardansicht der Baugruppe als CGM-Darstellung verfügbar.

� Legen Sie Konfigurationsdatei-Optionen in der Datei config.pro fest, um die Pro/WEB PUBLISH
Ausgabe anzupassen oder um VRML-Daten zu konfigurieren.

� ïïï|Éñéçêí|ÖÉçãÉíêó|~ë

� ïïï|íêÉÉ|äçÅ~íáçå

� ïïï|~ÇÇ|~ìñ|Ñê~ãÉ

� îêãä|ÉñéäçÇÉ|äáåÉë

� îêãä|Ä~ÅâÖêçìåÇ|Åçäçê

� îêãä|ÑáäÉ|ÇìéäáÅ~íÉ|ã~íÉêá~ä

� îêãä|ãìäíáéäÉ|îáÉïë

� îêãä|Éñéçêí|êÉëçäìíáçå

� Soll die Teiletabelle zusätzliche Modell- oder NC-Parameter enthalten, fügen Sie sie vor dem Export
zum Modell hinzu.

wìë®íòäáÅÜÉ=jçÇÉääé~ê~ãÉíÉê
Mit Hilfe des Modellbaum-Werkzeugs können Sie Modellparameter für den Export in Pro/ENGINEER
angeben. Fügen Sie weitere Parameter einfach zu den Modellbaum-Spalten hinzu, die die zu
exportierenden Modellparameter enthalten.

Statt dessen können Sie auch eine Datei mit dem Namen ÅçåÑ|ïïïKíÄä erzeugen und im aktuellen
Arbeitsverzeichnis ablegen. Nehmen Sie die benötigten Parameter in der gewünschten Reihenfolge in die
Datei conf_www.tbl auf.

_ÉáëéáÉäW=ÅçåÑ|ïïïKíÄäJa~íÉá
oÉÑ@

níó

k~ãÉ

`lpq

sbkalo

tbfdeq
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k~ãÉåëâçåîÉåíáçåÉå=ÑΩê=mìÄäáâ~íáçåëÇ~íÉáÉå=ìåÇ
OaJjçÇÉää~åëáÅÜíÉå
Für jedes Dokument werden die folgenden Dateien erzeugt:

Dokument Dokumentenverzeichnis und

dazugehörige Dateien

Baugruppenprozeß Verzeichnis <PROZESSNAME>_PRS_WWW mit:

.html-Dateien der obersten Ebene

Ein Verzeichnis für jeden einzelnen Prozeßschritt, das .html, .vrml, .cgm und
.jpg Dateien für den betreffenden Schritt enthält.

Baugruppe Verzeichnis <BAUGRUPPENNAME>_ASM_WWW mit Dateien vom Typ
.html, .vrml, .cgm und .jpg

NC-Prozeß Verzeichnis <PROZESSNAME>_PRS_WWW mit:

.html-Dateien der obersten Ebene

Ein Verzeichnis für jeden einzelnen Prozeßschritt, das .html, .vrml, .cgm und
.jpg Dateien für den betreffenden Schritt enthält.

Wenn eine bestimmte Baugruppenansicht als Standard-Orientierung zur Darstellung von 2D-Modellen
verwendet werden soll, erstellen Sie eine entsprechende Ansicht mit dem Namen WEB_DEFAULT. Diese
Ansicht wird als Standard-Ansichtsorientierung für alle Prozeßschritte verwendet. Wenn Sie die Ansicht
WEB_DEFAULT nicht erstellen, wird die zuletzt gespeicherte Orientierung des Modells unter dem Namen
"default" als Standardansicht verwendet.

Zum Exportieren von schrittspezifischen Ansichten erzeugen Sie benannte Ansichten, die der folgenden
Namenskonvention entsprechen: step#_<benannte_ansicht>. Im Dokument erscheint der Ansichtsname als
<benannte_ansicht> ohne das Präfix step#. Beachten Sie, daß innerhalb des Dokuments verschiedene
Schritte dieselben Ansichtsnamen haben können.

qóéÉå=Éñíê~ÜáÉêíÉê=a~íÉå
Beim Erstellen eines Dokuments werden Daten aus der Baugruppe oder aus dem Prozeß extrahiert. In der
folgenden Tabelle sind die bei den unterschiedlichen Dokumentarten extrahierten Daten aufgeführt.

Dokument Datentyp

Baugruppenprozeß Teilelisten

2D- und 3D-Modelldarstellungen

In die Baugruppe einbezogene Modellparameter

Modellbaum

Schrittparameter mit Schritt-Nr., Schritt-Typ und Schritt-Beschreibung;
voraussichtlicher Zeit- und Kostenaufwand (falls definiert)
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Baugruppe Teilelisten

2D- und 3D-Modelldarstellungen

In die Baugruppe einbezogene Modellparameter

Modellbaum

NC-Prozeß 2D- und 3D-Darstellungen für jeden Schritt, gegebenenfalls mit Abbildung der
Arbeitszelle und/oder des Werkstücks und der Materialentfernung

Schritt-/MFG-Parameter (Schaltflächen zum Öffnen eines weiteren Browser-Fensters
mit zusätzlichen Informationen)

Operationen/Schrittbaum

Modellbaum
=

pç=ÉñéçêíáÉêÉå=páÉ=mêçòÉ≈Ç~íÉå=~ìë
mêçLbkdfkbbo
1. Rufen Sie in Pro/ENGINEER den Baugruppenprozeß, die Baugruppe oder den NC-Bearbeitungsprozeß

auf, den Sie exportieren möchten.
2. Konfigurieren Sie den Modellbaum so, daß die zu exportierenden Modellparameter angezeigt werden.
3. Wählen Sie Datei > Kopie speichern (File > Save a Copy). Das Menü Kopie speichern (Save a

Copy) wird geöffnet.
4. Wählen Sie in der Liste Typ (Type) die Option WWW.

Das System erzeugt ein Dokumentenverzeichnis und speichert alle mit dem Dokument
zusammenhängenden Dateien in diesem Verzeichnis. Ist der Name des Dokuments mit dem Namen
eines im aktuellen Verzeichnis bereits vorhandenen Dokuments identisch, werden Sie gefragt, ob Sie
das bereits vorhandene Dokument überschreiben möchten. Das Programm exportiert alle
benutzerdefinierten Ansichten und die Standardansicht des Baugruppenprozesses, der Baugruppe oder
des NC-Bearbeitungsprozesses.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=_~ìÖêìééÉåéêçòÉ≈J
mìÄäáâ~íáçåÉå=~åëÉÜÉå
Sie können sich die Baugruppenprozeß-Informationen nach Schritten geordnet im Web ansehen. Der
Browser-Bildschirm ist in mehrere Frames unterteilt, in denen Informationen zu unterschiedlichen
Aspekten des aktuellen Schritts angezeigt werden:

� Beschreibung des aktuellen Schritts

� Tabelle der im aktuellen Schritt einzubauenden Teile

� 2D- oder 3D-Grafikdarstellung der Baugruppe zum Zeitpunkt des aktuellen Schritts

� Modellbaum (optional)

� Navigationsleiste

Schrittparameter
Der Frame zur Beschreibung des Schritts ist mit der Schrittnummer und dem Schrittyp betitelt. Der Frame
enthält die Schrittbeschreibung und den voraussichtlichen Zeit- und Kostenaufwand (falls definiert).

Die Schrittbeschreibung umfaßt die vom Prozeßplaner in Pro/PROCESS for ASSEMBLIES eingegebenen
Informationen. Diese können sich aus verfahrenstechnischen Angaben (z.B. eine Liste mit Anweisungen),
aus Hinweisen auf den Zweck des Schritts und aus weiteren Kommentaren zusammensetzen.
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Teileliste
Dieser Frame enthält eine tabellarische Liste der Teile, die im aktuellen Schritt eingebaut werden sollen
sowie die zur Ausführung des Schritts erforderlichen Spannelemente oder Werkzeuge. In der
Voreinstellung enthält die Tabelle folgende Elemente:

� Referenznummer

� Modellname

� Menge

Die Tabelle enthält außerdem alle zusätzlichen Parameter, die bei der Vorbereitung des Prozesses für den
Export in das Modell aufgenommen wurden. Diese zusätzlichen Informationen können den Teiletyp (z.B.
Standardkomponente, Kabel, Leitung, Spannelement usw.), die Lagerposition sowie den Parameternamen
und -wert enthalten. Zusätzliche Parameter, die Sie in den Baugruppenprozeß einbezogen haben,
erscheinen für alle Schritte in der Teiletabelle.

Durch Anklicken des Teilenamens in der Tabelle wird ein Fenster mit dem VRML-Modell des
betreffenden Teils geöffnet.

Schaltflächen zum Navigieren durch die Schritte
Zum Navigieren durch den Baugruppenprozeß sind folgende Schaltflächen verfügbar:

� Vorig.— Zeigt die Informationen zum vorherigen Baugruppenprozeßschritt an.

� Naechst. (Next) — Zeigt die Informationen zum nächsten Baugruppenprozeßschritt an.

� Schritt 1 (Step 1) — Öffnet ein Menü zur Auswahl eines beliebigen Schritts. Der Name des Schritts
erscheint neben der Schrittnummer (sofern Sie den Namen im Baugruppenprozeß über Setup/Name
definiert haben).

Grafik-Frame
Der Grafik-Frame zeigt die Baugruppe, einschließlich der im aktuellen Schritt einzubauenden Teile. Beim
Öffnen eines Dokuments enthält der betreffende Frame zunächst eine 2D-Standardansicht der Baugruppe
im Format JPG. Mit der Schaltfläche 2D JPG wird ein Fenster geöffnet, in dem Sie ein anderes
Grafikformat auswählen können: 2D JPG, 2D CGM oder 3D VRML. Die verfügbaren Optionen richten
sich nach den Grafikformaten, die für den Export gewählt wurden.

Enthält Ihr Dokument mehrere 2D-Modellansichten, können Sie die gewünschte Ansicht wählen, indem
Sie die Schaltfläche View:default anklicken und in der Liste eine Ansicht wählen.

Je nachdem, wie der Schritt in Pro/PROCESS for ASSEMBLIES definiert wurde, kann ein VRML-Modell
in explodiertem Zustand, als vereinfachte Darstellung oder als vollständige Darstellung angezeigt werden.
3D-Modelle können mit Hilfe der VRML-Ansichtsfenster-Steuerung verschoben, vergrößert/verkleinert
und gedreht werden.

Wenn Sie bei einem VRML-Modell den Mauszeiger über ein Teil bewegen, erscheint der Name des Teils
neben dem Mauszeiger. Durch Anklicken des Teilenamens in der Teileliste oder im Modellbaum wird ein
Fenster geöffnet, in dem das VRML-Modell dieses Teils angezeigt wird.

Normalerweise können nur 2D-CGM-Modelle verschoben oder vergrößert/verkleinert werden. Welche
Werkzeuge zum Verändern von 2D-Ansichten verfügbar sind, hängt vom verwendeten Plug-In bzw.

Modellbaum einsehen
Sie zeigen einen Modellbaum an, indem Sie in der Navigationsleiste die Schaltfläche Baum anklicken.
Damit öffnen Sie ein Fenster mit einem Baum, der Teile bis einschließlich zum aktuellen Schritt in
hierarchischer Reihenfolge anzeigt. Zum Schließen des Fensters klicken Sie erneut die Schaltfläche Baum
an. Wenn das Fenster offen bleibt, während Sie zu einem anderen Schritt wechseln, wird der Baum
entsprechend aktualisiert.

In der Voreinstellung wird der Baum in verkleinertem Zustand angezeigt. Durch Anklicken des Icons
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neben der Baugruppe/Unterbaugruppe können Sie den Baum erweitern.

Die Anzahl der Varianten eines Teils oder einer Unterbaugruppe innerhalb einer Baugruppe höherer Ebene
erscheint in runden Klammern neben dem Namen der Komponente.

_ÉáëéáÉäW=_~ìÖêìééÉåéêçòÉ≈JmìÄäáâ~íáçå=òì
pÅÜêáíí=P

_ÉáëéáÉäW=pÅÜêáííé~ê~ãÉíÉêJcê~ãÉ=òì=pÅÜêáíí=N
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_ÉáëéáÉäW=qÉáäÉäáëíÉåí~ÄÉääÉå=òì=pÅÜêáíí=N=ìåÇ
pÅÜêáíí=O=ÇÉë=_~ìÖêìééÉåéêçòÉëëÉë

_ÉáëéáÉäW=OaJ`djJ^åëáÅÜí=òì=pÅÜêáíí=N=ÇÉë
_~ìÖêìééÉåéêçòÉëëÉë
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^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=_~ìÖêìééÉåJ
mìÄäáâ~íáçåÉå=~åëÉÜÉå
Der Browser-Bildschirm ist in Frames unterteilt: die Tabelle mit den Teilen der betreffenden Baugruppe,
das Grafikfenster und die Navigationsschaltflächen.

Teiletabelle
Die Teiletabelle enthält folgende Spalten:

� Vom System vergebene Referenznummer für jedes Teil

� Teilname

� Gesamtzahl der Teile in dieser Baugruppe

� Zusätzliche Teileparameter, die ebenfalls exportiert wurden

Durch Anklicken eines Teilenamens wird ein separates Fenster geöffnet, in dem das betreffende Teil im
VRML-Format dargestellt wird.

Grafik-Frame
Beim Öffnen eines Dokuments erscheint im Grafik-Frame eine 2D-Ansicht der Baugruppe im Format JPG.
Mit der Schaltfläche 2D JPG wird ein Fenster geöffnet, in dem Sie ein anderes Grafikformat auswählen
können: 2D JPG, 2D CGM oder 3D VRML. Die verfügbaren Optionen richten sich nach den
Grafikformaten, die für den Export gewählt wurden.

Enthält Ihr Dokument mehrere 2D-Modellansichten, können Sie die gewünschte Ansicht wählen, indem
Sie die Schaltfläche View:default anklicken und in der Liste eine Ansicht wählen.

Je nachdem, wie das Modell in Pro/ENGINEER definiert wurde, kann ein VRML Modell im explodierten
Zustand, als vereinfachte Darstellung oder als vollständige Darstellung gezeigt werden. 3D-Modelle
können mit Hilfe der VRML-Ansichtsfenster-Steuerung verschoben, vergrößert/verkleinert und gedreht
werden. Wenn Sie den Mauszeiger über ein Teil bewegen, erscheint der Name des Teils neben dem
Mauszeiger. Durch Anklicken des Teilenamens wird ein Fenster mit dem VRML-Modell des betreffenden
Teils geöffnet.

Normalerweise können 2D-Modelle vergrößert/verkleinert, gedreht (in der Bildschirmebene) und
verschoben werden. Welche Werkzeuge zum Verändern von 2D-JPG-Ansichten verfügbar sind, hängt vom
verwendeten Plug-In bzw. Hilfsprogramm ab.

Schaltflächenleiste
Die Schaltflächenleiste enthält bis zu drei Schaltflächen. Dies hängt davon ab, welche Grafikformate für
den Export gewählt wurden. Die Schaltflächen sind:

� Eine Schaltfläche zum Öffnen des Popup-Menüs für die Auswahl eines Grafikformats (Voreinstellung:
JPG). Diese Schaltfläche ist nicht verfügbar, wenn nur ein Grafikformat exportiert wurde.

� Eine Schaltfläche zum Öffnen des Popup-Menüs für die Auswahl einer 2D-Ansicht. Diese Schaltfläche
ist nicht verfügbar, wenn nur VRML exportiert wurde.

� Die Schaltfläche Baum zum Öffnen eines Modellbaumfensters.

Modellbaum einsehen
Sie zeigen einen Modellbaum an, indem Sie in der Navigationsleiste die Schaltfläche Baum anklicken. In
der Voreinstellung wird der Baum in verkleinertem Zustand angezeigt. Durch Anklicken des Icons neben
der Baugruppe/Unterbaugruppe können Sie den Baum erweitern.

Die Anzahl der Varianten eines Teils oder einer Unterbaugruppe innerhalb einer Baugruppe höherer Ebene
erscheint in runden Klammern neben dem Namen der Komponente.
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_ÉáëéáÉäW=_~ìÖêìééÉåJmìÄäáâ~íáçå

_ÉáëéáÉäW=_~ìÖêìééÉåÄ~ìã
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^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=k`J_É~êÄÉáíìåÖëJmêçòÉ≈J
mìÄäáâ~íáçåÉå=~åëÉÜÉå
Sie können sich die NC-Bearbeitungs-Prozeß-Informationen nach Schritten geordnet im Web ansehen. Der
Browser-Bildschirm ist in mehrere Frames unterteilt, in denen Informationen zu unterschiedlichen
Aspekten des aktuellen Schritts angezeigt werden:

� Beschreibung des aktuellen Schritts

� Tabelle der Operationen/Schritte im NC-Bearbeitungsprozeß

� Navigationsleiste

� 2D- oder 3D-Grafikdarstellung der Baugruppe zum Zeitpunkt des aktuellen Schritts

Schrittparameter
Der Frame zur Beschreibung des Schritts ist mit der Schrittnummer und dem Schrittyp betitelt. Der Frame
enthält die Schrittbeschreibung und den voraussichtlichen Zeit- und Kostenaufwand (falls definiert).
Darüber hinaus enthält das Fenster Links zu Detailangaben über den Schritt.

Die Schrittbeschreibung umfaßt die vom Prozeßplaner in Pro/PROCESS for MFG eingegebenen
Informationen. Diese können sich aus verfahrenstechnischen Angaben (z.B. eine Liste mit Anweisungen),
aus Hinweisen auf den Zweck des Schritts und aus weiteren Kommentaren zusammensetzen.

� Operationsparameter

Mit dem Eintrag Operationsparameter (Operation Parameters) im Schrittparameter-Frame wird ein
neues Browser-Fenster mit relevanten Operationsparametern für diesen Schritt geöffnet.

� Schritt-MFG-Parameter

Mit dem Eintrag Step MFG Parameters im Schrittparameter-Frame wird ein neues Browser-Fenster
mit Informationen mit relevanten NC-Bearbeitungsparametern für diesen Schritt geöffnet.

� Werkzeug-Informationen

Mit dem Eintrag Tool Information im Schrittparameter-Frame wird ein neues Browser-Fenster mit
relevanten Werkzeugparametern für diesen Schritt geöffnet. Wenn mit dem betreffenden Schritt ein
Werkzeugweg verbunden ist, wird er zusammen mit den Informationen der Werkzeugtabelle angezeigt.
Hinweis: Werkzeug-Informationen sind nur dann verfügbar, wenn ein Werkzeug für den gewählten
Schritt definiert wurde.

� WorkCell Parameters

Mit dem Eintrag WorkCell Parameters im Schrittparameter-Frame wird ein neues Browser-Fenster
mit relevanten Arbeitszellen-Parametern für diesen Schritt geöffnet.

� NC Seq. Parameter

Mit dem Eintrag NC Folge Parameter (NC Seq. Parameters) im Schrittparameter-Frame wird ein
neues Browser-Fenster mit Informationen mit relevanten NC-Folgen-Parametern für diesen Schritt
geöffnet.
Hinweis: Parameter für NC-Folgen sind nur dann verfügbar, wenn NC-Folgen für den gewählten
Schritt definiert wurden.

� Stücklistenbericht

Mit dem Eintrag BOM Report im Schrittparameter-Frame wird ein neues Browser-Fenster mit der
relevanten Stückliste für diesen Schritt geöffnet.

� Operations-/Schrittliste

Der Operations-/Schritt-Frame enthält eine Liste der Operationen/Schritte mit allen Teilen und
Schritten des NC-Bearbeitungsprozesses. Zum Anzeigen eines bestimmten Schritts klicken Sie im
Operations-/Schrittbaum den gewünschten Schritt an.
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Schaltflächen zum Navigieren durch die Schritte
Zum Navigieren durch den NC-Bearbeitungsprozeß sind folgende Schaltflächen verfügbar:

� Vorig.— Zeigt Informationen zum vorherigen NC-Bearbeitungsprozeß an.

� Naechst. (Next) — Zeigt Informationen zum nächsten NC-Bearbeitungsprozeß an.

� Schritt 1 (Step 1) — Öffnet ein Menü zur Auswahl eines beliebigen Schritts. Der Name des Schritts
erscheint neben der Schrittnummer (sofern Sie den Namen im NC-Bearbeitungsprozeß über
Setup/Name definiert haben).

Grafik-Frame
Der Grafik-Frame zeigt die Baugruppe, einschließlich der im aktuellen Schritt einzubauenden Teile. Beim
Öffnen eines Dokuments enthält der betreffende Frame zunächst eine 2D-Standardansicht der Baugruppe
im Format JPG. Mit der Schaltfläche 2D JPG wird ein Fenster geöffnet, in dem Sie ein anderes
Grafikformat auswählen können: 2D JPG, 2D CGM oder 3D VRML. Die verfügbaren Optionen richten
sich nach den Grafikformaten, die für den Export gewählt wurden.

Enthält Ihr Dokument mehrere 2D-Modellansichten, können Sie die gewünschte Ansicht wählen, indem
Sie die Schaltfläche View:default anklicken und in der Liste eine Ansicht wählen.

Je nachdem, wie der Schritt in Pro/PROCESS for MFG definiert wurde, kann ein VRML-Modell in
explodiertem Zustand, als vereinfachte Darstellung oder als vollständige Darstellung angezeigt werden.
3D-Modelle können mit Hilfe der VRML-Ansichtsfenster-Steuerung verschoben, vergrößert/verkleinert
und gedreht werden.

Wenn Sie bei einem VRML-Modell den Mauszeiger über ein Teil bewegen, erscheint der Name des Teils
neben dem Mauszeiger. Durch Anklicken des Teilenamens in der Teileliste oder im Modellbaum wird ein
Fenster geöffnet, in dem das VRML-Modell dieses Teils angezeigt wird.

Normalerweise können nur 2D-CGM-Modelle verschoben oder vergrößert/verkleinert werden. Welche
Werkzeuge zum Verändern von 2D-Ansichten verfügbar sind, hängt vom verwendeten Plug-In bzw.

Modellbaum einsehen
Sie zeigen einen Modellbaum an, indem Sie in der Navigationsleiste die Schaltfläche Baum anklicken.
Damit öffnen Sie ein Fenster mit einem Baum, der Teile bis einschließlich zum aktuellen Schritt in
hierarchischer Reihenfolge anzeigt. Zum Schließen des Fensters klicken Sie erneut die Schaltfläche Baum
an. Wenn das Fenster offen bleibt, während Sie zu einem anderen Schritt wechseln, wird der Baum
entsprechend aktualisiert.

In der Voreinstellung wird der Baum in verkleinertem Zustand angezeigt. Durch Anklicken des Icons
neben der Baugruppe/Unterbaugruppe können Sie den Baum erweitern.

Die Anzahl der Varianten eines Teils oder einer Unterbaugruppe innerhalb einer Baugruppe höherer Ebene
erscheint in runden Klammern neben dem Namen der Komponente.
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_ÉáëéáÉäW=k`J_~êÄÉáíìåÖëJmêçòÉ≈JmìÄäáâ~íáçå

_ÉáëéáÉäW=pÅÜêáííé~ê~ãÉíÉêJcê~ãÉ



INTERFACE58

_ÉáëéáÉäW=léÉê~íáçåëé~ê~ãÉíÉê
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_ÉáëéáÉäW=pÅÜêáííJjcdJm~ê~ãÉíÉê
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_ÉáëéáÉäW=tÉêâòÉìÖJfåÑçêã~íáçåÉå
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_ÉáëéáÉäW=^êÄÉáíëòÉääÉåé~ê~ãÉíÉê



INTERFACE62

_ÉáëéáÉäW=m~ê~ãÉíÉê=ÑΩê=k`JcçäÖÉå
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_ÉáëéáÉäW=píΩÅâäáëíÉåÄÉêáÅÜí

_ÉáëéáÉäW=léÉê~íáçåÉåLpÅÜêáííÉ
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_ÉáëéáÉäW=OaJgmdJ^åëáÅÜí=òì=pÅÜêáíí=P

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=mìÄäáâ~íáçåëJpáíÉë
~åé~ëëÉå
Sie können die Pro/WEB PUBLISH Ausgabe nicht nur über die Konfigurationsdatei-Optionen anpassen.
Auch der Web-Administrator kann Ihre Dokumentumgebungen anpassen, indem er die Datei index.html im
Dokumentenverzeichnis bearbeitet, um Frames umzubenennen oder weitere Frames mit bestimmten
Namen hinzuzufügen. Nachdem die Datei áåÇÉñKÜíãä auf die Anforderungen Ihrer Firma zugeschnitten
wurde, kann der Web-Administrator anhand dieser angepaßten Datei andere Dokumentumgebungen
einrichten.

Folgende Aspekte des Dokuments können an den Benutzer angepaßt werden.

� Auswahl von Formaten zur Verwendung bei der Modell-Darstellung

� Hinzufügen eines weiteren Frames, um den Modellbaum in die Web-Seite einzubeziehen

� Hinzufügen weiterer (auch schrittspezifischer) Frames

Hinweis: Entfernen Sie den Frame mol|tb_|m^kbi nicht aus der Datei áåÇÉñKÜíãä, da das
Dokument sonst nicht in den Web-Browser geladen werden kann.
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pç=äÉÖÉå=páÉ=cçêã~íÉ=ÑΩê=_~ìÖêìééÉåJ
a~êëíÉääìåÖÉå=ÑÉëí
Soll eine Baugruppe oder Baugruppenprozeßdaten in allen unterstützen Formaten exportiert werden (wenn
also die Konfigurationsdatei-Option ïïï|Éñéçêí|ÖÉçãÉíêó|~ë auf all gesetzt ist), können Sie
durch Bearbeiten der Datei áåÇÉñKÜíãä die Modelldarstellungen auf die für Sie wichtigen Modelle
beschränken. Ändern Sie dazu folgende Zeile in der Datei index.html:

<"frame name="PRO_WEB_ALL"   src="dummy.html"

Ersetzen Sie den Frame-Namen PRO_WEB_ALL durch einen der folgenden Namen:

� PRO_WEB_CGM_VRML — zeigt CGM und VRML an

� PRO_WEB_VRML — zeigt ausschließlich VRML an

� PRO_WEB_CGM — zeigt ausschließlich CGM an

� PRO_WEB_JPG — zeigt ausschließlich JPEG an

� PRO_WEB_JPG_VRML — zeigt JPEG und VRML an

pç=òÉáÖÉå=páÉ=ÇÉå=jçÇÉääÄ~ìã=~ìÑ=ÇÉê=tÉÄJpÉáíÉ
~å
Setzen Sie die Konfigurationsdatei-Option ïïï|íêÉÉ|äçÅ~íáçå auf den Wert áå, um den
Modellbaum beim Exportieren von Baugruppen oder Baugruppenprozeßdaten im Hauptfenster des
Browsers anzuzeigen. Statt dessen können Sie auch die Datei index.html folgendermaßen bearbeiten, um
einen zusätzlichen Frame mit dem Namen JAVABOM hinzufügen:

<"frame name="PRO_PUBLISH_JAVABOM"src="dummy.html"



INTERFACE66

_ÉáëéáÉäW=^åÖÉé~≈íÉ=mìÄäáâ~íáçå=ãáí=jçÇÉääÄ~ìã
~ìÑ=ÇÉê=tÉÄJpÉáíÉ
Die folgende Abbildung zeigt ein benutzerspezifisches Dokument, bei dem das Modellbaumfenster auf der
Web-Seite angezeigt wird.

pç=ÑΩÖÉå=páÉ=ëÅÜêáííëéÉòáÑáëÅÜÉ=cê~ãÉë=Üáåòì
Sie können zu einem oder mehreren Prozeßschritten einen zusätzlichen Frame für modellspezifische
Informationen hinzufügen.

1. Bevor Sie Daten in Web-Formaten exportieren, setzen Sie die Konfigurationsdatei-Option
ïïï|~ÇÇ|~ìñ|Ñê~ãÉ auf óÉë.

2. Fügen Sie zu jedem Schrittverzeichnis die Datei <dateiname>.html an der Stelle hinzu, an der ein
zusätzlicher Frame eingefügt werden soll. Der Inhalt der Datei <dateiname>.html kann von Schritt zu
Schritt variieren.

3. Benennen Sie den Frame mol|tb_|^ru_step in mol|tb_|^ru_<Ç~íÉáå~ãÉ> um, damit die
Datei áåÇÉñKÜíãä auf oberster Ebene auf die Datei <Ç~íÉáå~ãÉ>.Üíãä verweist.

wìë®íòäáÅÜÉ=cê~ãÉë=ÜáåòìÑΩÖÉå
Der Web-Administrator kann mehrere benutzerspezifische Frames (z.  B. ein Mail-Icon, einen Titel oder
ein Firmen-Logo) zu einem Baugruppenprozeß- oder Baugruppen-Dokument hinzufügen.

Hinweis: Wenn Sie einen zusätzlichen Frame zu einem Baugruppen-Dokument hinzufügen, legen Sie die
Datei <dateiname>.html im selben Verzeichnis ab wie die Datei index.html.
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_ÉáëéáÉäW=råíÉêëÅÜáÉÇäáÅÜÉ=sáÇÉçë=ÑΩê=ÇáÉ
ÉáåòÉäåÉå=mêçòÉ≈ëÅÜêáííÉ=ÜáåòìÑΩÖÉå
Wenn Sie den Prozeßschritten je ein Video hinzufügen möchten, verwenden Sie den Namen
mol|mr_ifpe|^ru|sfabl|co^jb für den Frame, und fügen Sie die Datei sfabl|co^jbKÜíãä zu
den einzelnen Schrittverzeichnissen hinzu. Der Inhalt der Datei sfabl|co^jbKÜíãä kann von Schritt
zu Schritt unterschiedlich sein.

^ìÑÖÉíÉáäíÉ=a~íÉáÉå
Teile- und Baugruppendaten von Volumenmodellen können in den folgenden Formaten exportiert werden:
STL (Stereolithography Apparatus), RENDER, Inventor, VRML, OptegraVis, Xpatch, MEDUSA,
CatiaFacets (auch als Catia Mock-Up bezeichnet), 3-D Paint.

Das Format STL dient verschiedenen Zwecken, im wesentlichen jedoch dem Rapid Prototyping.

Das Format RENDER enthält Daten, mit denen qualitativ hochwertige schattierte Bilder aus den
Pro/ENGINEER Volumenkörpermodellen erzeugt werden können.

Das Format Inventor enthält Daten, die von IRIS Inventor, einem 3D-Grafik-Toolkit von Silicon Graphics,
gelesen werden können. MEDUSA wird zur Visualisierung in ASCII-basierte .~ëÅ-Dateien exportiert.

Ein Import von aufgeteilten Dateien ist nur bei den Formaten STL und VRML möglich. Dabei verwenden
Sie die Befehlsfolge Datei > Oeffnen (File > Open) (ohne ein geöffnetes Teil oder eine Baugruppe) oder
Einfuegen > Daten aus Datei (Insert > Data From File) (mit einem geöffneten Teil oder einer
Baugruppe).

3-D Paint
Die Geometrie von Modellen wird für die Verwendung mit Pro/3DPAINT über Wavefront-Dateien vom
Typ .obj ausgegeben. Wavefront-Dateien des Typs .obj stellen geometrische Informationen in der Form
einer Triangulierung von Modellen und Sammelflächen dar. Die Ausgabe nach Pro/3DPAINT kann in den
Modi Teil und Baugruppe erfolgen.

Dateiformat
STL- und RENDER-Dateien stellen die Flächen eines Volumenmodells als Gruppen kleiner Polygone dar.

Das Format RENDER unterscheidet sich von STL in zweierlei Hinsicht. RENDER-Dateien enthalten:

� Elementfarbe

� Flächennormale an den Eckpunkten eines Polygonelements
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_ÉáëéáÉäW=_ÉáëéáÉäÉ=ÑΩê=Ç~ë=cçêã~í=~ìÑÖÉíÉáäíÉê
a~íÉáÉå
Die folgende Abbildung zeigt das Dateiformat einer STL-Datei (ASCII).

Format einer STL-Datei

Die folgende Abbildung zeigt das Format einer RENDER-Datei.

Format einer RENDER-Datei

pç=ÉñéçêíáÉêÉå=páÉ=~ìë=mêçLmêçLabq^fi=å~ÅÜ
jbarp^
 Pro/DETAIL-Zeichnungen in Pro/ENGINEER können nach MEDUSA exportiert werden. Pro/DETAIL-
Zeichnungen werden als MEDUSA-Blätter exportiert.

1. Wählen Sie mit einer aktivierten Zeichnung die Befehlsfolge Datei > Kopie speichern (File > Save a

Copy). Es erscheint das Dialogfenster Kopie speichern (Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option Medusa.
3. Übernehmen Sie den vorgegebenen Dateinamen, oder geben Sie einen neuen Namen für den Export

ein.

4. Klicken Sie auf , um die MEDUSA-Datei zu erzeugen.
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mêçLabq^fiJfåÑçêã~íáçåÉå=òì=jbarp^=òìçêÇåÉå
Beim Exportieren eines Pro/DETAIL-Blattes nach MEDUSA geschieht folgendes:

� Exportierte Pro/ENGINEER-gruppierte Elemente erzeugen MEDUSA-Klumpen. Zu gruppierten
Einheiten zählen Schraffuren, Tabellen, benutzerdefinierte Symbole, Gruppen sowie Teil- und
Baugruppenkomponenten.

� Die Foliendaten der Elemente werden zugeordnet.

� Parametric-Notizen werden mit deren Attributen zu MEDUSA-Text zugeordnet.

� Der Modellname wird einem Blattattribut zugeordnet.

pç=ÉñéçêíáÉêÉå=páÉ=qÉáäÉ=çÇÉê=wÉáÅÜåìåÖÉå=áå=ÉáåÉ
pbqJa~íÉá
1. Wählen Sie mit einem aktiven Teil oder einer aktiven Zeichnung die Befehlsfolge Datei > Kopie

speichern (File > Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option SET (*.set).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Das Dialogfenster Exportieren SET (Export SET) wird aufgerufen.
5. Erzeugen oder wählen Sie ein Koordinatensystem, wenn Sie ein Teil exportieren.
6. Klicken Sie auf OK, um die SET-Datei zu exportieren.

pbqJa~íÉáÉå=ÉñéçêíáÉêÉå
Alle in Pro/ENGINEER erzeugten SET-Dateien folgen der Benennungskonvention <çÄàÉâíå~ãÉ>.ëÉí,
wobei <çÄàÉâíå~ãÉ> der Name des derzeit aktiven Teils bzw. der aktiven Zeichnung ist. Wenn eine
Zeichnung mit mehreren Blättern geöffnet ist, lautet der Name standardmäßig
<òÉáÅÜåìåÖëå~ãÉ>|@.ëÉí, wobei @ die aktuelle Blattnummer ist. Sie müssen für jedes
Zeichnungsblatt eine SET-Datei erzeugen.

pç=ÉñéçêíáÉêÉå=páÉ=_~ìÖêìééÉå=áå=ÉáåÉ=pbqJa~íÉá
1. Wählen Sie mit einer aktivierten Baugruppe die Befehlsfolge Datei > Kopie speichern (File > Save a

Copy).
2. Wählen Sie in der Liste Typ (Type) die Option SET (*.set).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Das Dialogfenster Exportieren SET (Export SET) wird geöffnet.
5. Erzeugen oder wählen Sie ein Koordinatensystem als Referenz.
6. Legen Sie mit Intern (Internal ref) oder Extern (External ref) fest, ob die Baugruppe als eine

Baugruppendatei mit internen Referenzen oder als Baugruppendatei mit externen Referenzen zu
Komponentendateien ausgegeben werden soll. Klicken Sie anschließend auf Fertig (Done).  

7. Klicken Sie auf OK. Die Baugruppe wird in eine SET-Datei exportiert.  .
Hinweis: SET unterstützt nicht alle Sonderzeichen von Pro/ENGINEER. Einige Zeichen können
deshalb beim Export in eine SET-Datei verlorengehen.

pç=áãéçêíáÉêÉå=páÉ=pbqJa~íÉáÉå=áå=îçêÜ~åÇÉåÉ
qÉáäÉ=çÇÉê=_~ìÖêìééÉå
Es empfiehlt sich, vor dem Importieren von SET-Daten Standard-Bezugsebenen zu erzeugen.
1. Erzeugen Sie ein Modell, oder rufen Sie ein Modell auf (mindestens ein KE muß vorhanden sein).
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2. Wählen Sie die Befehlsfolge Einfuegen > Daten aus Datei (Insert > Data from File). Das
Dialogfenster Oeffnen erscheint.

3. Wählen Sie die Option SET in der Liste Typ (Type). Die SET-Dateien im Arbeitsverzeichnis werden
aufgeführt.

4. Klicken Sie auf den Namen der gewünschten SET-Datei, oder durchsuchen Sie die Verzeichnisse nach
der SET-Datei, und wählen Sie sie aus.

5. Klicken Sie auf OK.
6. Im Informationsfenster wird die Protokolldatei für den SET-Import angezeigt. Das Dialogfenster

Volumenkoerper-Optionen und Plazierung (Choose Solid Options and Placement) wird geöffnet.
7. Übernehmen Sie das vorgegebene Koordinatensystem, oder wählen Sie das gewünschte

Koordinatensystem aus.
8. Klicken Sie auf Koerper (Protrusion), Schnitt (Cut) oder Flaechen (Surfaces).
9. Mit OK lassen Sie die Datei importieren.

pbqJa~íÉáÉå=áãéçêíáÉêÉå
Eine Protokolldatei mit dem Namen <model_name>.log wird bei jedem Importieren eines SET-Modells
nach Pro/ENGINEER erzeugt. Diese Datei enthält eine Übersicht der SET Import-Verarbeitung. Sie
können ein importiertes KE durch eine neue Importdatei ersetzen, ohne eine 1:1-Übereinstimmung
zwischen den vorhandenen und ersetzten Elementen zu haben. Weitere Informationen finden Sie unter
Importierte KEs umdefinieren.

Enthält die SET-Datei alle notwendigen Topologie-Informationen für die Flächenverbindung, können Sie
im Menü KOERPER OPT (SOLID OPT) mit dem Befehl Sammelfl verwend (Use Quilt) einen
Volumenkörper erzeugen. Besitzen die importierten Dateien keine Informationen über Flächenverbindung,
können Flächen auf verschiedene Weisen zusammengefügt werden.

SET-Teile- und -Baugruppendateien
Wenn eine SET-Datei 3D-Geometrie, Flächendaten und Topologieinformationen enthält, können Sie sie
zum Erzeugen eines nichtparametrischen KE in ein Teil oder eine Baugruppe importieren. (Dieses KE
können Sie zwar nicht ändern, doch können Sie dem Modell KEs hinzufügen.) Falls trotz vorhandener
Flächendaten keine Topologieinformationen für Flächen vorhanden sind, wird lediglich eine Drahtmodell-
Darstellung konstruiert.

pç=ÉêòÉìÖÉå=páÉ=qÉáäÉ=çÇÉê=_~ìÖêìééÉå=ÇìêÅÜ=Ç~ë
fãéçêíáÉêÉå=îçå=pbqJa~íÉå
1. Wählen Sie Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File Open) wird

aufgerufen.
2. Wählen Sie in der Liste Typ (Type) die Option SET (*.set). Die SET-Dateien im Arbeitsverzeichnis

werden aufgeführt.
3. Klicken Sie auf den Namen der gewünschten SET-Datei, oder durchsuchen Sie die Verzeichnisse nach

der SET-Datei, und wählen Sie sie aus.
4. Klicken Sie auf OK. Das Dialogfenster Neues Modell importieren (Import New Model) wird

geöffnet.
5. Wählen Sie den Typ des zu importierenden Modells (Teil (Part) oder Baugruppe (Assembly)).
6. Übernehmen Sie den vorgegebenen Namen, oder geben Sie einen neuen Namen ein.
7. Klicken Sie auf OK. Die Datei mit dem SET-Importprotokoll wird im Informationsfenster angezeigt.

Die SET-Daten werden importiert, und das neue Teil bzw. die Baugruppe wird erzeugt.

pç=áãéçêíáÉêÉå=páÉ=pbqJa~íÉáÉå=áå=wÉáÅÜåìåÖÉå
1. Erzeugen oder öffnen Sie eine Zeichnung, ein Format oder ein Layout.
2. Wählen Sie die Befehlsfolge Einfuegen > Daten aus Datei (Insert > Data from File). Das

Dialogfenster Oeffnen erscheint.
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3. Wählen Sie in der Liste Typ (Type) die Option SET (*.set). Die SET-Dateien im Arbeitsverzeichnis
werden aufgeführt.

4. Klicken Sie auf den Namen der gewünschten SET-Datei, oder durchsuchen Sie die Verzeichnisse nach
der SET-Datei.

5. Je nach der Größe der importierten Zeichnung kann folgendes passieren:
� Wenn die Größe der importierten Zeichnung nicht mit der Größe der Pro/ENGINEER-Zeichnung

übereinstimmt, werden Sie gefragt, ob die importierte Geometrie so skaliert werden soll, daß sie in
das Format eingepaßt werden kann. Wenn Sie [N] eingeben, werden Sie gefragt, ob Sie wollen,
daß der Ursprung der importierten Zeichnung in die linke untere Ecke des Formats gelegt wird.

Hinweis: Wenn die importierte Geometrie nicht skaliert wurde, um in die ausgewählte
Zeichnungsgröße zu passen, können Sie später das Zeichnungsformat durch eine geeignetere
Größe ersetzen.

� Wenn die importierte Zeichnung die gleiche Größe hat wie die Pro/ENGINEER Zeichnung, wird
der Ursprung der importierten Zeichnung automatisch in der linken unteren Ecke (Formatursprung)
plaziert. In diesem Fall erscheint keine Eingabeaufforderung.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=pqbmJa~íÉáÉå
Mit STEP können Sie eine vollständige Produktdefinition zwischen heterogenen rechnerunterstützten
CAD-, CAE- und CAM-Systemen austauschen. Es ist möglich, kombinierte Flächen- und
Volumenkörperdaten zu exportieren, die STEP AP203 und AP214 entsprechen (Darstellung mehrerer
Formen und Hybridmodelle). Dieses Modul bietet die folgenden Export- und Importmöglichkeiten:

� Zeichnungen, die dem STEP-Format AP202DIS der ISO 10303 entsprechen.

� Teile und Baugruppen gemäß AP203IS und AP214CD.

STEP-Format
STEP (Standard for the Exchange of Product Model Data) ist ein internationaler Standard für den
Austausch von Produktmodelldaten, der in Publikationen der U.S. Product Data Association (US PRO)
IGES/PDES Organization festgelegt wurde. Der vollständige Satz der Spezifikationen für STEP wird als
ISO 10303 bezeichnet.

Das STEP-Format besteht aus einer Reihe von Dokumenten ("Parts" in der STEP-Terminologie), die alle
einzeln veröffentlicht werden. Applikationsprotokolle (APs), die sich auf generische Dokumente der ISO
10303 beziehen, werden für Besonderheiten im Datenaustausch einer bestimmten Applikation erstellt.
AP202 hat den Status einer internationalen Standard-Version (IS) erzielt. Andere APs, einschließlich
AP202DIS (Draft International Standard) und AP214CD (Committee Draft) befinden sich noch in
verschiedenen Stadien der Entwicklung.

Produkte, die STEP unterstützen, können diese Schnittstelle auf unterschiedlichen Ebenen des
Datentransfers implementieren. Jede Ebene stellt verschiedene Mechanismen zur konsistenten und
standardisierten Speicherung, Aufnahme und Weitergabe von Produktdefinitionen zwischen heterogenen
Systemen zur Verfügung.

Weitere Informationen zum STEP-Standard finden Sie unter den folgenden Internet-Adressen:

� http://www.scra.org/pdesinc.html

� http://www.iso.ch

� http://www.scra.org
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PaJpqbmJ_Éëí®íáÖìåÖëÉáÖÉåëÅÜ~ÑíÉå
Beim Exportieren und Importieren von STEP-Dateien werden auch die Bestätigungseigenschaften gemäß
STEP AP203 berücksichtigt.

Eigenschaften exportieren
Beim Export von Volumenmodellen in STEP werden die Bestätigungseigenschaften für Flächeninhalt,
Volumen und Schwerpunkt umgesetzt. Mehrere Instanzen einer Komponente in einer Baugruppe für den
Schwerpunkt werden unterstützt. Der Wert für den Schwerpunkt ist der Position einer Instanz im Verhältnis
zu seiner übergeordneten Baugruppe. Beim Export von Flächenmodellen in STEP werden die
Bestätigungseigenschaften für den Flächeninhalt berücksichtigt. Auch sämtliche Baugruppen und
Unterbaugruppen werden mit Bestätigungseigenschaften exportiert.

Um standardmäßig die AP203-Erweiterung mit in die Datei aufzunehmen, die Sie nach STEP exportieren,
setzen Sie die Konfigurationsoption step_export_format auf 203_is_ext. Durch das Setzen von
ëíÉé|Éñéçêí|Ñçêã~í auf OMP|áë|Éñí erfolgt der Export in eine STEP-Datei, die dem
internationalen Standard von STEP mit den folgenden Erweiterungen entspricht:

� cla – Farben und Folien

� gvp – Geometrische Überprüfung

� ast – Assoziativer Text

Darüber hinaus werden die Bestätigungseigenschaften berücksichtigt, wenn Sie pqbm|bumloq|cloj^q
auf ^mONQ|afp setzen.

Eigenschaften importieren
Die Bestätigungseigenschaften in STEP-Dateien werden beim Importieren automatisch umgesetzt. Die
Daten zu den Bestätigungseigenschaften werden automatisch in die .log-Datei aufgenommen. Zur
Anzeige der Daten aus der STEP-Datei verwenden Sie ein Shell-Fenster; öffnen Sie die Datei
jçÇÉääå~ãÉKäçÖ in einem Standard-Texteditor.

_ÉáëéáÉäW=mêçíçâçääÇ~íÉá=ÑΩê=áãéçêíáÉêíÉ=pqbmJ
hçãéçåÉåíÉåÇ~íÉá
Im folgenden finden Sie einen Bereich aus der .log-Datei einer importierten STEP-Datei. Sie zeigt den
Vergleich zwischen empfangenen und berechneten Daten. (Das Format der tatsächlich angezeigten Datei
kann geringfügig von dieser Darstellung abweichen.)

jçÇÉääáåÑçêã~íáçåÉå=ÑΩê=_dO|hbfi|T=ïÉêÇÉå=îÉê~êÄÉáíÉíW

sÉê~êÄÉáíÉí=ÄáëW=aç=gìå==P=MUWRRWPM=NVVV

dÉë~ãíJsÉê~êÄÉáíìåÖëòÉáíW=MMWMMWMN.

sçäìãÉåEw

çää{PF

cä~ÉÅÜÉåáåÜ

~äíEfåÅÜ{O

`dñ `dó `dò=ÑìÉê

pqbmJ

jçÇÉää

_dO|hbfi

|T

bãéÑ~åÖÉå OKMSMNVQÉH

MR

PKMNMNVQÉH

MQ

UKMQUSQSÉH

MN

MKMMMMMMÉH

MM

NKMMMMMMÉH

MN

_ÉêÉÅÜåÉí OKMSMNVQÉH

MR

PKMNMNVQÉH

MQ

UKMQUSQSÉH

MN

VKQRTVNTÉJ

NP

NKMMMMMMÉH

MN
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aáÑÑÉêÉåò OKQVNOUUÉJ

MU

PKUQNTMSÉJ

MV

NKRTQRSPÉJ

NN

VKQRTVNTÉJ

NP

MKMMMMMMÉH

MM

aáÑÑÉêÉåò

áå=B

MKMMMB MKMMMB ^Äëí~åÇ=òïáëÅÜÉå=òïÉá

jáííÉäéìåâíÉå

NKRTTQMNÉJ

NN

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=pqbm=^ëëçòá~íáîÉ
wÉáÅÜåìåÖëÇ~íÉå=áãéçêíáÉêÉå=ìåÇ=ÉñéçêíáÉêÉå
In Pro/ENGINEER können Sie STEP AP214 und STEP AP202 Assoziative Zeichnungsdaten importieren
und exportieren.

Beim Import ermittelt Pro/ENGINEER automatisch, ob die Datei AP214 CD2 oder AP203 IS entspricht,
und führt die entsprechende Umsetzung durch. Sie brauchen für den Import keine Konfigurationsoption zu
setzen.

Wenn Sie eine STEP Datei exportieren, beachten Sie die folgenden Konfigurationsoptionen:

� Setzen Sie pqbm|bumloq|cloj^q auf ^mOMO|fp, um die Zeichnung unter Verwendung des
AP202 IS STEP Applikationsprotokolls und der Konformitätsklasse zu exportieren.

� Zum Export der Zeichnung mit dem Applikationsprotokoll und der Konformitätsklasse gemäß AP214
CD2 STEP setzen Sie pqbm|bumloq|cloj^q auf ^mONQ|`a.

� Setzen Sie pqbm|bumloq|cloj^q auf ^mONQ|afp (Voreinstellung im Zeichnungsmodus), um die
Zeichnung mit dem Applikationsprotokoll und der Konformitätsklasse gemäß AP214 DIS STEP zu
exportieren.

� Setzen Sie pqbm|bumloq|cloj^q auf ^mOMP|fp (Voreinstellung im Zeichnungsmodus), um 3D-
Modelle mit dem Applikationsprotokoll und der Konformitätsklasse gemäß ^mOMP|fp=pqbm zu
exportieren. Dies ist die Voreinstellung im 3D-Modus.

� Setzen Sie pqbm|bumloq|atd|sfbtp auf kl, um nur 2D-Darstellungen der 3D-Modelle zu
exportieren. Dies ist die Voreinstellung.

� Setzen Sie pqbm|bumloq|atd|sfbtp auf ^p|Pa|sfbtp, um 3D-Modellgeometrie mit ihren
assoziativen Ansichten zu exportieren.

� Zum Export der Geometrie von 3D-Modellen mit den zugehörigen Ansichten und den Anmerkungen zu
den Ansichten setzen Sie pqbm|bumloq|atd|sfbtp auf ^p|Pa|sfbtp|^ppl`|ao^cq.

Hinweis: Die aktuelle Pro/ENGINEER-Funktionalität zum Einlesen und Schreiben von STEP AP214
Assoziativen Zeichnungsdaten wurde in Zusammenarbeit mit debis Systemhaus Germany entwickelt.
Diese Import- und Exportfunktionalität für STEP APP214 wurde mit dem DEBIS' COMSTEP
(V3.1.1.4) Prozessor für CATIA harmonisiert. Weitere Informationen zum COMSTEP-Prozessor
erhalten Sie bei der debis Systemhaus Engineering GmbH, Competence Center CAD/CAM,
Fasanenweg 9, D-70771 Leinfelden-Echterdingen, Deutschland (Tel.: +49-711-972-3001).
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råíÉêëíΩíòíÉ=pqbm=^m=OMO=hä~ëëÉå
Die Pro/ENGINEER-Schnittstelle für STEP bietet Level-1-Unterstützung (Datenübertragung) für AP202
(Associative Drafting) mit 10 Klassen. In der folgenden Tabelle werden die Konformitätsklassen
beschrieben, die durch die Pro/ENGINEER-Schnittstelle für STEP unterstützt werden.

Hinweis: Die Pro/ENGINEER-Schnittstelle für STEP unterstützt alle Klassen, die während des Imports
aufgelistet werden. Beim Export werden jedoch nur die Klassen 1 und 8 unterstützt.

Klasse Beschreibung

1 Zeichnungsstruktur und Verwaltung einschließlich der
Darstellung von Anmerkungen auf den Zeichnungsblättern ohne
Ansichten

2 Zeichnungsstruktur und Verwaltung einschließlich der
Darstellung von Formansichten eines oder mehrerer Produkte auf
den Zeichnungsblättern durch geometrisch berandete 2D-
Drahtmodelle

3 Zeichnungsstruktur und Verwaltung einschließlich der
Darstellung von Formansichten eines oder mehrerer Produkte auf
den Zeichnungsblättern durch geometrisch berandete 2D-
Drahtmodelle und deren Lagebeziehung

4 Zeichnungsstruktur und Verwaltung einschließlich der
Darstellung von Formansichten eines oder mehrerer Produkte auf
den Zeichnungsblättern durch geometrisch berandete 3D-
Drahtmodelle und/oder Flächenmodelle

5 Zeichnungsstruktur und Verwaltung einschließlich der
Darstellung von Formansichten eines oder mehrerer Produkte auf
den Zeichnungsblättern durch geometrisch berandete 3D-
Drahtmodelle und deren Lagebeziehung

8 Zeichnungsstruktur und Verwaltung einschließlich der
Darstellung von Formansichten eines oder mehrerer Produkte auf
den Zeichnungsblättern durch spezielle BREP-Modelle

9 Zeichnungsstruktur und Verwaltung einschließlich der
Darstellung von Formansichten eines oder mehrerer Produkte auf
den Zeichnungsblättern durch komplexe Flächenmodelle und
deren Lagebeziehung

10 Klasse 2 und die Verbindung zwischen den Dimensionen,
Zeichnungsbeschriftungen und Füllbereichsgrenzen mit deren
respektiven Zielproduktformgeometrie oder –Anmerkung

=



INTERFACE 75

råíÉêëíΩíòíÉ=pqbm=^mONQJ=ìåÇ=^mONQJhä~ëëÉå
Die Pro/ENGINEER-Schnittstelle für STEP bietet Level-1-Unterstützung (Dateiaustausch) für AP203
(Configuration Controlled Three-dimensional Designs of Mechanical Parts and Assemblies; 3D-
Geometriebeschreibung mit Produktstrukturanteilen für die Produktkonfiguration). In der folgenden
Tabelle werden die Konformitätsklassen beschrieben, die durch die Pro/ENGINEER-Schnittstelle für STEP
beim Importieren und Exportieren unterstützt werden.

Klasse Beschreibung

2 Nicht topologische Fläche und Drahtmodell als Drahtmodell und
Flächen

4 Komplexe Flächentopologie als Schalen

6 Körper mit erweiterter Randdarstellung (BREP) als Körper

Die Pro/ENGINEER-Schnittstelle für STEP unterstützt einen Teil der CD-Version von AP214 (Automotive
Design), Konformitätsklasse 1 und 2. Bei diesem Applikationsprotokoll wird derzeit lediglich der
Geometrieaustausch beim Importieren und Exportieren unterstützt (sowohl für Teile als auch für
Baugruppen).

pqbmJc~êÄJ=ìåÇ=JcçäáÉåìåíÉêëíΩíòìåÖ=ÑΩê=pqbm
^mOMP=ìåÇ=^mONQ
Setzen Sie die Konfigurationsdatei-Option ëíÉé|Éñéçêí|Ñçêã~í auf ^mONQ|`a, um in das STEP
AP214-Format zu exportieren. Die Voreinstellung im 3D-Modus ist ^mOMP|fp. Sollen bei einem STEP
AP203-Export dieselben Farben und Folien wie bei AP214 verwendet werden, setzen Sie die
Konfigurationsdatei-Option ëíÉé|~ééÉ~ê~åÅÉ|ä~óÉê|Öêçìéë auf vÉë. Die Voreinstellung ist kç.

Wenn dem STEP-Teil oder der STEP-Baugruppe Folien zugeordnet wurden und der Importstatus der
Folien geändert werden soll, setzen Sie die Konfigurationsdatei-Option
áåíÑ|áå|ä~óÉê|~ëã|Çá~äçÖë in der Datei config.pro auf óÉë. So können Sie das Dialogfenster
Folienimport-Optionen (Layer Import Options) während des Imports anzeigen.

STEP-Dateiimport und -Export für AP214 und AP203

Pro/ENGINEER

Objekt

Import- und Exporttyp Folienunterstütz

ung

(Ja/Nein)

Farbunterstützung

(Ja/Nein)

Volumenkörper Drahtmodell Ja Ja

Flaechen Ja Ja

Volumenkoerper Ja Ja

Schalen Ja Ja

Bezugskurven und Punkte Ja Nein

Sammelflächen/Flächen Drahtmodell Ja Ja

Flaechen Ja Ja

Volumenkoerper Nicht zutreffend Nicht zutreffend

Schalen Ja Ja
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Folgende Exporttypkombinationen werden unterstützt:

� Drahtmodellkanten plus Bezugskurven und -punkte. Bezugskurven- und punkte im Teil oder in der
Baugruppe werden in der STEP-Exportdatei exportiert.

� Volumenkörper plus Schalen plus Bezugskurven und -Punkte

� Flächen plus Bezugskurven und -Punkte

Alle STEP-Exporttypen werden für den Import unterstützt. STEP-Importtypen können nicht konfiguriert
werden.

Farben
Die Farbunterstützung für den STEP-Import und -Export umfaßt:

� Standardfarben (Farben die Pro/ENGINEER Objekten bei deren Erzeugung zuweist)

� Systemfarben (Farben, die der Benutzer Objekten zuweist)

� Benutzerdefinierte Farben (Farben, die der Benutzer Objekten zuweist)

Sie können einem Pro/ENGINEER Teil, einer Fläche, allen Flächen, Sammelflächen und Bezugskurven
Farben zuweisen. Sie können einer Pro/ENGINEER Baugruppe, Komponenten, Baugruppenflächen,
Baugruppensammelflächen und Baugruppen-Bezugskurven Farben zuweisen. Für jede Variante eines
bestimmten Teils kann eine unterschiedliche Farbzuweisung bestehen.

Folien
Bei der Folienunterstützung für STEP werden die Namen und der Inhalt der Folien als ausgewählter STEP-
Import- und -Exporttyp übernommen.

pç=ÉñéçêíáÉêÉå=páÉ=wÉáÅÜåìåÖÉåI
wÉáÅÜåìåÖëÑçêã~íÉ=çÇÉê=i~óçìíë=áå=pqbm
Wurde die Konfigurationsdatei-Option ëíÉé|Éñéçêí|ÇïÖ|îáÉïë in der Datei config.pro auf
~ë|PÇ|îáÉïë gesetzt, ermöglicht der STEP AP202 Export von 2D-Zeichnungen den Transfer von 3D-
Modellgeometrie und den zugehörigen Ansichten (Voreinstellung ist åç). Dies beinhaltet 2D-Elemente wie
z.  B. Bemaßungen und andere Anmerkungen. Sie können eine 2D-Zeichnung exportieren und
anschließend im importierenden System die Ansichten bewegen oder neu hinzufügen.

1. Wählen Sie mit einer geöffneten Zeichnung die Befehlsfolge Datei > Kopie speichern (File > Save a

Copy). Das Menü Kopie speichern (Save a Copy) wird geöffnet.
2. Wählen Sie in der Liste Typ (Type) die Option SET (*.set).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Die Datei wird exportiert, und das System erstellt Ya~íÉáå~ãÉ[Këíé.

pç=ÉñéçêíáÉêÉå=páÉ=qÉáäÉ=çÇÉê=_~ìÖêìééÉå=áå
pqbm
Beim Exportieren einer Baugruppe erzeugt das System eine Datei mit dem Namen <å~ãÉ[|~ëãKëíé.
Außerdem wird eine Protokolldatei namens <å~ãÉ>|çìíKäçÖK@ erstellt und im aktuellen Verzeichnis
gespeichert. Diese Datei enthält eine Liste der beim Erzeugen der Exportdatei verwendeten STEP-
Elementtypen.

1. Wählen Sie in einem Teil oder einer Baugruppe die Befehlsfolge Datei > Kopie speichern (File >

Save a Copy). Das Menü Kopie speichern (Save a Copy) wird geöffnet.
2. Wählen Sie in der Liste Typ (Type) die Option SET (*.set).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
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4. Klicken Sie auf OK. Es erscheint das Dialogfenster Exportieren STEP (Export STEP).
5. Geben Sie im Dialogfenster die Struktur und den Inhalt der Ausgabedatei an.
6. Sollen Folien exportiert werden, klicken Sie im Dialogfenster Exportieren STEP (Export STEP) auf

die Schaltfläche Folien anpassen (Customize Layers). Das Dialogfenster Folien waehlen erscheint.
(Beim Exportieren nach STEP können Sie gleichzeitig Schalen (Shells) und  Volumenkoerper

(Solids) aktivieren.)
7. Klicken Sie auf OK, um die Änderungen im Dialogfenster Folien waehlen (Choose Layers) zu

bestätigen.
8. Wählen Sie OK, um die STEP-Datei für das Teil oder die Baugruppe zu erzeugen.

hçåÑáÖìê~íáçåëçéíáçåÉå
Die folgenden Konfigurationsdatei-Optionen in der Datei config.pro unterstützen den Export von
Pro/ENGINEER Dateien nach STEP:

Option in Config.pro Standard Optionen Erklärung

intf3d_out_extend_surface Ja Ja/Nein Verlängert Flächen, bis sie sich
schneiden.

intf3d_out_force_surf_normals Ja Ja/Nein

intf3d_out_surface_deviation Ja Ja/Nein

intf_out_as_bezier Ja Ja/Nein

intf_out_assign_names Sie können einem Element in
einer STEP-Datei vor dem
Export einen Namen zuweisen.

intf_out_max_bspl_degree Ja Ja/Nein

step_export_format AP203 AP214_CD
AP203_IS

Legt das zu verwendende STEP-
Format fest.

step_appearance_layer_groups Nein Ja/Nein Setzen Sie
STEP_Appearance_Layers_Gro
up auf "Ja", um die
Übereinstimmung von Folien
beim Export und Import
zwischen AP203 und AP214
sicherzustellen.

step_in_style_bndry_as_fill_area Nein Ja/Nein Ermöglicht die
Farbunterstützung beim Import
von Unigraphics STEP-Dateien.
Trifft nur beim Import von
STEP zu.

export_3d_force_default_naming Nein Ja/Nein Mit der Einstellung "Ja"
akzeptieren Sie den Standard-
Dateinamen und werden nicht
zur Eingabe eines Dateinamens
vor dem Fortsetzen des Exports
aufgefordert.

step_export_ap214_asm_def_mode single_file single_file

separate_parts_only

separate_all_objects

Die Option, die Sie wählen,
bestimmt das Dateiformat der
nach STEP exportierten
Pro/ENGINEER Baugruppen.
Alle Optionen generieren eine
STEP-Datei auf
Baugruppenebene.
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step_export_format Geben Sie das Anwendungsprotokoll
(AP203_IS oder AP214_CD) mit der
Konfigurationsdatei-Option
step_export_format   in der Datei
config.pro an, bevor Sie 3D-
Geometrie in ein STEP-Format
exportieren.

intf_out_assign_names Sie können einem Element in einer
STEP-Datei vor dem Export mit der
config.pro-Option
intf_out_assign_names einen Namen
geben. Das empfangende System
kann diese Information nutzen, um
Elemente problemlos zu
identifizieren oder diese Namen in
anderen Programmen, die STEP-
Daten einlesen, als Referenz zu
verwenden. Der Name eines
Elements wird auf alle Elemente
übertragen, die dazu herangezogen
werden, den Namen eines Elements
der obersten Ebene in
Pro/ENGINEER zu definieren. So
hätte eine Fläche mit dem Namen
"topsurf" auch Berandungskurven
mit dem Namen "topsurf".

iáëíÉ=a~íÉáÑçêã~í=EcáäÉ=píêìÅíìêÉF=áã=bñéçêíãÉåΩ
îçå=pqbm
Wenn Sie eine Baugruppe exportieren und die Option step_export_format to AP214_CD in der Datei
config.pro eingestellt haben, wird das Feld Dateiformat (File Structure) im Exportmenü von STEP
angezeigt. Die Option, die Sie wählen, bestimmt das Dateiformat der nach STEP exportierten
Pro/ENGINEER Baugruppen.

Dateiformat-Option Zweck Resultierender Standard-Dateiname

single_file (default) Alle Baugruppen-
Geometriedaten in eine
Datei ausgeben.

partname.stp

separate_parts_only Gesamte
Baugruppenstruktur in eine
Datei ausgegeben; Teile in
einzelne Dateien
ausgegeben.

assemblyname_asm.stp

partname1.stp, partname2.stp, etc.

separate_all_objects Baugruppen,
Unterbaugruppen und Teile
in einzelne Dateien
ausgegeben.

subassemblyname_asm.stp

toplevelassemblyname_top.stp

partname1.stp, partname2.stp, etc.

Sie sollten die Standard-Dateinamen nicht ändern, da die erzeugten Dateien mit Hilfe dieser
Namenskonventionen unterschieden werden. Falls Sie die Standardnamen nicht verwenden möchten,
stellen Sie die Konfigurationsoption Éñéçêí|Pa|ÑçêÅÉ|ÇÉÑ~ìäí|å~ãáåÖ auf kÉáå (Standard) ein.
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Wenn Sie das Standard-Dateiformat für Pro/ENGINEER Baugruppen für den Export nach STEP
verwenden möchten, stellen Sie die Konfigurationsoption ëíÉé|Éñéçêí|~éONQ|~ëã|ÇÉÑ|ãçÇÉ auf
eine der obigen Dateiformat-Optionen ein.

pç=áãéçêíáÉêÉå=páÉ=pqbmJa~íÉáÉå=áã
wÉáÅÜåìåÖëãçÇìë
1. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) (ohne eine geöffnete Zeichnung) oder

Einfuegen > Daten aus Datei (Insert > Data From File) (mit einer geöffneten Zeichnung). Das
Dialogfenster Datei oeffnen (File Open) oder Oeffnen (Open) wird aufgerufen.

2. Wählen Sie in der Liste Typ (Type) die Option SET (*.set). Klicken Sie in der Liste der verfügbaren
Dateien auf die zu importierende STEP-Datei, oder suchen Sie nach der STEP-Datei.

3. Klicken Sie auf OK, um ein neues Modell zu erzeugen, oder um die STEP-Datei an das aktive Modell
anzuhängen.

4. Wenn Sie STEP-Daten verwenden, um eine neue Zeichnung zu öffnen, erscheint das Dialogfenster
Neues Modell importieren. Klicken Sie auf OK. Die Protokolldatei für den STEP-Import wird im
Informationsfenster angezeigt, und die STEP-Datei wird importiert.

5. Falls Sie die STEP-Daten dem geöffneten Modell anhängen, wird die Protokolldatei für den STEP-
Import im Informationsfenster angezeigt, und die STEP-Datei wird importiert.

6. Sofern erforderlich, skalieren Sie die angehängte Zeichnung, oder bewegen Sie die Zeichnung in die
linke Ecke.

få=Oa=áãéçêíáÉêÉå
Beim Import von STEP-Daten im Modus Zeichnung kann Pro/ENGINEER nur dann ein Teil oder eine
Baugruppe erzeugen, wenn die importierte Datei die entsprechenden Daten enthält. Diese Baugruppe ist
das Modell der betreffenden Zeichnung. Wenn die importierte Datei kein Teil und keine Baugruppe enthält,
erscheint lediglich eine 2D-Zeichnung.

Hinweis: Eine AP202 Datei kann mehr als ein Modell enthalten.
Sie können STEP-Formatdateien im Modus Zeichnung importieren. (Diese Dateien sind AP202-Dateien
und nicht AP203- oder AP214-Dateien für Teile oder Baugruppen.) Die folgenden Elemente werden
aktuell unterstützt:

� Blaetter

� Anmerkungen zum Zeichnungsblatt (Kurven, Text)

� Ansichten mit 3D-Modellprojektion

� Anmerkungen zu Ansichten (Kurven, Bemaßungen, Text)

� Anmerkungen zu Seiten und Ansichten

� 2D-Schraffur

� Pro/ENGINEER Standardsysmbole als Notizen

� 2D-Ansichten

pç=áãéçêíáÉêÉå=páÉ=pqbmJa~íÉáÉå=ÑΩê=qÉáäÉ=ìåÇ
_~ìÖêìééÉå
Wenn das Modell auf dem Ausgangssystem als Volumenkörper exportiert wurde, wandelt es
Pro/ENGINEER beim Import automatisch aus Sammelflächen in einen Volumenkörper um. Wenn beim
Import von STEP-Geometrie bereits Volumenkörpergeometrie vorliegt, können Sie einen Materialschnitt
oder einen Volumenkörper erzeugen bzw. als Sammelflächen mit Hilfe des Dialogfensters
Volumenkoerper-Optionen und Plazierung (Choose Solid Options and Placement) importieren.

Beim Import einer STEP-Datei, die nur Flächen enthält, erstellt das System Sammelflächen aus den
Flächendaten. Enthält die STEP-Datei Flächen (im Gegensatz zu einem Volumenkörper) mit allen
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notwendigen Topologie-Informationen für die Flächenverbindung, können Sie im Menü KOERPER OPT
(SOLID POTS) mit dem Befehl Sammelfl verwend (Use Quilt) oder durch Aktivieren des Befehls
Volumenkoerper (Make Solid) beim Neudefinieren des importierten Elements ein Volumen erzeugen.
Besitzen die importierten Dateien keine Informationen über Flächenverbindung, können Flächen auf
verschiedene Weisen zusammengefügt werden.

1. Wenn dem STEP-Teil oder der STEP-Baugruppe Folien zugeordnet wurden und der Importstatus der
Folien geändert werden soll, setzen Sie die Konfigurationsdatei-Option
áåíÑ|áå|ä~óÉê|~ëã|Çá~äçÖë in der Datei config.pro auf óÉë. So können Sie das Dialogfenster
Folienimport-Optionen (Layer Import Options) während des Imports anzeigen.

2. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) (ohne ein geöffnetes Teil oder eine
Baugruppe) oder Einfuegen > Daten aus Datei (Insert > Data From File) (mit einen geöffneten Teil
oder einer Baugruppe). Das Dialogfenster Datei oeffnen (File Open) oder Oeffnen (Open) wird
aufgerufen.

3. Wählen Sie in der Liste Typ (Type) die Option SET (*.set). Klicken Sie in der Liste der verfügbaren
Dateien auf die zu importierende STEP-Datei, oder suchen Sie nach der STEP-Datei.

4. Wählen Sie OK, um die STEP-Datei zu erzeugen oder anzuhängen.
5. Wählen Sie eine der folgenden Vorgehensweisen:

� Wenn Sie CATIA-Daten zum Erzeugen eines Teils oder einer Baugruppe verwenden, wird das
Dialogfenster Neues Modell importieren aufgerufen.  Schließen Sie die Auswahlen im
Dialogfenster ab, und klicken Sie auf OK, um die neue Datei mit den STEP-Daten zu öffnen. Im
Informationsfenster erscheint die Protokolldatei für den STEP-Import.

� Wenn die STEP-Datei an ein geöffnetes Teil angehängt werden soll und bereits importierte KEs
vorliegen, wird das Dialogfenster Volumenkoerper-Optionen und Plazierung (Choose Solid

Options and Placement) geöffnet. Schließen Sie die Auswahlen im Dialogfenster ab, und klicken
Sie auf OK (OK), um das importierte KE zu akzeptieren. Im Informationsfenster erscheint die
Protokolldatei für den STEP-Import.

6. Falls dem STEP-Teil oder der STEP-Baugruppe Folien zugeordnet sind, wird das Dialogfenster
Folienimport-Optionen (Layer Import Options) aufgerufen.

7. Wählen Sie OK, um die im Dialogfenster getroffene Auswahl zu bestätigen.
8. Klicken Sie die Schaltfläche Schliessen an, um das Informationsfenster zu schließen.

få=Pa=áãéçêíáÉêÉå
AP203 oder AP214 STEP-Formatdateien können nach Pro/ENGINEER im Modus Teil oder Baugruppe
importiert werden. Sie können zwar eine STEP-Datei importieren, die Elemente der Konformitätsklasse 5
enthält, Pro/ENGINEER überspringt diese Elemente jedoch während des Imports. Alle anderen Daten
werden jedoch importiert.

Sie können eine STEP-Datei, die mehrere Volumenkörperelemente in einer einzelnen Teil-Datei als eine
Baugruppe enthält, aus einem anderen CAD-System importieren. Mit der Pro/ENGINEER-Schnittstelle für
STEP wird diese Datei als eine Baugruppe importiert (sofern die Teile-Datei keine explizite
Baugruppenstruktur aufweist). Das Programm importiert jeden Volumenkörper als ein separates Teil und
erzeugt ein Baugruppenmodell, in das diese Teile eingefügt werden.

Sie können ein importiertes KE durch eine neue Importdatei ersetzen, ohne eine 1:1-Übereinstimmung
zwischen den vorhandenen und ersetzten Elementen zu haben.

pç=ÉñéçêíáÉêÉå=páÉ=qÉáäÉ=çÇÉê=_~ìÖêìééÉå=áå=ÉáåÉ
fdbpJa~íÉá
1. Wählen Sie in einer Baugruppe oder einem Teil die Befehlsfolge Datei > Kopie speichern (File >

Save a Copy). Es erscheint das Dialogfenster Kopie speichern (Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option IGES (*.igs).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
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4. Klicken Sie auf OK. Es erscheint das Dialogfenster Exportieren IGES (Export IGES).
5. Geben Sie im Dialogfenster die Struktur und den Inhalt der Ausgabedatei an.
6. Sollen Folien exportieren werden, klicken Sie auf Folien anpassen (Customize Layers). Das

Dialogfenster Folien waehlen erscheint.
7. Klicken Sie die Option Autom-ID an, um den Folien IDs zuzuweisen, denen noch keine ID zugewiesen

wurde.
8. Geben Sie im Dialogfenster Folien waehlen (Choose Layers) Ihre Änderungen ein, und klicken Sie

anschließend auf OK, um die Änderungen zu bestätigen.
9. Wählen Sie OK, um die IGES-Teile- oder Baugruppendatei zu erzeugen.

fdbpJqÉáäÉJ=ìåÇ=J_~ìÖêìééÉåÇ~íÉáÉå

IGES-Baugruppendateien
Beim Exportieren von Baugruppendateien nach IGES erzeugt das System eine IGES-Datei mit dem Zusatz
_asm. Dadurch wird verhindert, daß eine Teiledatei von einer Baugruppendatei des gleichen Namens
überschrieben wird. Sehen Sie sich dazu das folgende Beispiel an.

Pro/ENGINEER IGES-Format

desk.prt desk.igs

desk.asm desk_asm.igs

IGES-Teiledateien
IGES-Teiledateien können so angepaßt werden, daß sie sich an den Anforderungen des Empfangssystems
ausrichten, für das sie erzeugt werden. Kann ein System z.  B. nur Kurvengeometrie verarbeiten, so ist es
nicht sinnvoll, Flächeninformationen auszugeben.

fdbpJbäÉãÉåíÉ=ãáí=bñéçêíJråíÉêëíΩíòìåÖ=áã
jçÇìë=qÉáä=ìåÇ=_~ìÖêìééÉ
Die folgende Tabelle enthält eine Liste der IGES-Elemente, die aus den Modi Teil und Baugruppe
exportiert werden können.

 

Pro/ENGINEER Element Typ   —   IGES-Element   —   Name

Kreisförmige Kante 100 Kreisförmiger Bogen

Kurvenzüge 102 Verbundkurve

Ebene Fläche 114 Splinefläche, B-Splinefläche, wenn iges_out_spl_srfs_as_128
auf no gesetzt ist

128 B-Splinefläche, wenn iges_out_spl_srfs_as_128 auf yes
(Voreinstellung) gesetzt ist

Splinekurve oder -kante 112 Parametrische Splinekurve, wenn iges_out_spl_crvs_as_126
auf no gesetzt ist

126 B-Splinefläche, wenn iges_out_spl_crvs_as_126 auf yes
(Voreinstellung) gesetzt ist

Lineare Kante 110 Line
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Splinefläche (Bezug oder Körper) 114 Parametrische Splinekurve, wenn iges_out_spl_srfs_as_128
auf no gesetzt ist

128 B-Splinefläche, wenn iges_out_spl_srfs_as_128 auf yes
(Voreinstellung) gesetzt ist

Verbundene oder gezogene Fläche
(Bezug oder Körper)

114 Splinekurve, wenn iges_out_spl_srfs_as_128 auf no gesetzt
ist

128 B-Splinefläche, wenn iges_out_spl_srfs_as_128 auf yes
(Voreinstellung) gesetzt ist

Gedrehte Fläche (Bezug oder
Körper)

120 Drehfläche

Profilierte Splinefläche (Bezug oder
Körper)

122 Tabulierter Zylinder

124 Transformationsmatrix

Splinekurve oder -kante 126 B-Splinekurve

Splinefläche (Bezug oder Körper) 128 B-Splinefläche

Bezug oder Körperfläche 141 Berandung, wenn iges_out_trm_srfs_as_143 auf yes gesetzt
ist (Voreinstellung ist no)

Bezug oder Körperfläche 142 Kurve auf Fläche

Bezug oder Körperfläche 143 Begrenzte Fläche, wenn iges_out_trm_srfs_as_143 auf yes
gesetzt ist (Voreinstellung ist no)

Bezug oder Körperfläche 144 Getrimmte Fläche

Unterstützt den Export von
Baugruppen in den Modi Erste
Ebene und Alle Ebenen

308 Definition

Dickenattribut eines komprimierten
Schalenmodells

406 Form 11

Eine Liste der Dateien von
Baugruppenkomponenten

406 Externe Referenzdatei (Form 12)

Unterstützt den Export von
Baugruppen in den Modi Erste
Ebene und Alle Ebenen

408 Variante einzelner Unterelemente

Unterstützt den Export von
Baugruppen in den Modi Erste
Ebene und Alle Ebenen

416 Externe Referenz

a~íÉáëíêìâíìê=ÑΩê=ÇÉå=bñéçêí=îçå=_~ìÖêìééÉå
å~ÅÜ=fdbp
IGES-Teiledateien können so angepaßt werden, daß sie sich an den Anforderungen des Empfangssystems
ausrichten, für das sie erzeugt werden. Kann ein System z.  B. nur Kurvengeometrie verarbeiten, so ist es
nicht sinnvoll, Flächeninformationen auszugeben.
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Beim Exportieren von Baugruppen nach IGES können Sie Struktur und Inhalt der Ausgabedatei festlegen.
Im Dialogfenster Exportieren IGES (Export IGES) enthält die Liste Dateiformat (File Structure) die
folgenden Optionen:

� Flach (Flat) — Exportiert die gesamte Geometrie der Baugruppe in eine einzelne IGES-Datei, als
würde es sich um ein Teil handeln. Wird das Teil von einem anderen System geladen, verhält sich die
Baugruppe wie ein einzelnes Teil. Es wird empfohlen, jedes Teil auf eine eigene Folie zu plazieren,
damit das Zielsystem zwischen den Teilen unterscheiden kann.

� Erste Ebene (One Level) — Exportiert eine IGES-Baugruppendatei mit externen Referenzen, die auf
die jeweiligen IGES-Dateien der einzelnen Komponenten verweisen. Die Datei selbst enthält nur
Geometriedaten aus der obersten Ebene (z.  B. Baugruppenelemente).

� Alle Ebenen (All Levels) — Exportiert eine Baugruppendatei mit externen Referenzen zu allen
Komponenten und zu allen IGES-Dateien der Komponenten. Komponententeile und Unterbaugruppen
werden mit ihrer jeweiligen Geometrie und externen Referenzen erzeugt. Mit diesem Befehl werden
alle Ebenen der Hierarchie unterstützt.

� Alle Teile (All Parts) — Exportiert eine Baugruppe in mehrere IGES-Dateien, die Geometriedaten
ihrer Komponenten und Baugruppenelemente enthalten, falls vorhanden. Diese Teile verwenden das
gleiche Koordinatensystem, wodurch das Zusammensetzen im Zielsystem erleichtert wird. Im
besonderen werden folgende IGES-Dateien erstellt:

� Eine IGES-Baugruppendatei namens <ãçÇÉääå~ãÉ>|~ëãKáÖë, wobei <ãçÇÉääå~ãÉ> der
Name der Baugruppe ist, die die Baugruppen-KE-Geometrie enthält.

� Eine IGES-Unterbaugruppendatei für jede Unterbaugruppe (falls vorhanden) mit dem Namen
<ãçÇÉääå~ãÉ>|Åéó|@KáÖë, wobei <ãçÇÉääå~ãÉ> für den Namen der Unterbaugruppe
steht und @=für das Vorkommen der gleichen Unterbaugruppe in der Baugruppe, die Geometrie
von Baugruppen-KEs enthält.

� Teiledateien aller Komponententeile. Wenn eine Komponente öfter als einmal in der Baugruppe
vorhanden ist, gibt es für jedes Vorkommen eine entsprechende IGES-Teiledatei. Die
Namenskonvention für Teiledateien dabei ist <Ä~ìíÉáäå~ãÉ>|Åéó|@KáÖë, wobei
<Ä~ìíÉáäå~ãÉ> für den Namen des Bauteils steht und # für das Vorkommen des gleichen Teils
in der Baugruppe. Es werden mehrere Teiledateien erstellt, da jede Variation sich in einer anderen
Position relativ zum Referenzkoordinatensystem befindet.

kÉìíê~äÇ~íÉáÉå=òì=qÉáäÉå=ìåÇ=_~ìÖêìééÉå
Eine Neutraldatei ist eine formatierte Textdatei mit Informationen zu Teilen und Baugruppen, die in
Pro/ENGINEER erzeugt wurden. Um den KE-Aufbau eines Teils beizubehalten, geben Sie die Topologie,
Geometrie, symbolischen Parameter und die entsprechenden Werte an. Pro/ENGINEER formatiert die
Daten der Teilegeometrie so, daß sie von anderen Softwaresystemen problemlos gelesen und von einer
Vielzahl von Anwendungen verwendet werden können. Sie können Neutraldateien für Teile und
Baugruppen erzeugen.

Neutraldateien zu Teilen enthalten Informationen zur Teilegeometrie und den KEs des Teils.
Neutraldateien zu Baugruppen enthalten Informationen dazu, wie die Teile und Unterbaugruppen in der
Baugruppe angeordnet sind, und allgemeine Informationen zu den Komponenten. Wenn Sie eine
Neutraldatei aus einer Baugruppe erzeugen, wird automatisch für jede Komponente eine Neutraldatei
erzeugt. In der Neutraldatei der Baugruppe wird eine Liste mit den Namen der einzelnen Teiledateien
aufgenommen.

Neutraldateien enthalten Informationen zu Teilen und Baugruppen, die nicht von IGES unterstützt werden
(wie Attribute). Mit einer Neutraldatei können Sie auf diese Informationen zugreifen und sie für das
Erzeugen von Schnittstellen zu anderen Programmen verwenden.

Neutraldateien zu Baugruppen
Neutraldateien zu Baugruppen enthalten eine Liste der Komponenten der Baugruppenteile, die Massewerte
der Baugruppe und die aktuelle Versionsnummer der Baugruppe.
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Neutraldateien zu Teilen
Neutraldateien zu Teilen umfassen die KE- und Geometriedaten für ein einzelnes Teil. Jede Neutraldatei zu
Teilen enthält ein Teileelement, ein oder mehrere KE-Elemente und so viele Flächen- und Kantenelemente,
wie für die Beschreibung der Teilegeometrie benötigt werden. Sie kann noch weitere Elemente enthalten,
wie verbundene Textdateien und Massenwerte.

§ÄÉê=pbqJa~íÉáÉå
Mit dem Format Standard for Exchange and Transfer (SET) werden Grafiken und Textinformationen
zwischen Computersystemen übertragen. Pro/ENGINEER unterstützt SET Version 89-06. In SET-Dateien
unterscheidet sich der Aufbau von Teilen und Zeichnungen von dem in Pro/ENGINEER. Es gibt selten
eine völlige Übereinstimmung zwischen der Anzahl und dem Typ der Elemente, die ein Objekt in
Pro/ENGINEER gestalten und der Anzahl und dem Typ der Elemente, die das gleiche Objekt in einer SET-
Datei ergeben. Das trifft besonders auf Teile mit verbundenen und gezogenen KEs zu.

Weitere Informationen zur Verwendung von SET-Dateien finden Sie in der Data Exchange and Transfer
Standard Specification (SET), Z 68-300 Version 89-06.

Folien exportieren/importieren
SET unterstützt den Export/Import von Folien. Zum Exportieren von Folien aus Pro/ENGINEER nach SET
müssen Sie im Menü EINST FOLIE (SETUP LAYER) mit dem Befehl ID Eingabe (Specify Id) die Folien-
ID angeben.

Die Folien-ID eines Zeichnungselements (Geometrie, Bemaßung oder Notiz) wird zusammen mit dem
Element in eine SET-Datei exportiert. Pro/ENGINEER unterstützt über Schnittstellendateien nur eine
einzige Folie pro Element. Daher wird bei einem Element, das auf mehr als einer Folie vorkommt, nur die
Folien mit der höchsten ID als Folie des Elements exportiert. Mit SET eingelesenen Elemente, die Folien
enthalten, wird eine Folie im Modus Zeichnung zugewiesen. Der Folienname für ein Element, das aus SET
eingelesen wurde, lautet INTF_<nnn>, wobei <nnn> für die ID-Nummer der Folie steht.

Die Ausgabe von ausgeblendeten Folien steuern
Mit der Konfigurationsdatei-Option áåíÑ|çìí|Ää~åâÉÇ|ÉåíáíáÉë können Sie die Ausgabe von
ausgeblendeten Folien steuern. Wenn Sie diese Option auf no setzen, werden Elemente auf ausgeblendeten
Folien ignoriert. Wenn Sie die Option auf yes setzen (Vorgabe), werden ausgeblendeten Folien exportiert.

pç=ÉñéçêíáÉêÉå=páÉ=ÇáêÉâí=å~ÅÜ=`^qf^
Beim direkten Export nach CATIA werden Daten direkt aus Pro/ENGINEER nach CATIA exportiert (bei
den Plattformen IBM RS6000, HP, SUN und SGI). Für den direkten Export müssen Sie über eine gültige
Pro/ENGINEER- und CATIA-Lizenz auf der Workstation verfügen.

1. Wählen Sie in einem offenen Teil oder einer offenen Baugruppe die Befehlsfolge Datei > Kopie

speichern (File > Save a Copy). Das Menü Kopie speichern (Save a Copy) wird geöffnet.
2. Wählen Sie in der Liste Typ (Type) die Option CATIA Direkt (CATIA Direct (*.model)).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK.
5. Das Dialogfenster Exportieren CATIA (Export CATIA) erscheint.
6. Geben Sie im Dialogfenster die Struktur und den Inhalt der Ausgabedatei an.
7. Sollen Folien exportiert werden, klicken Sie im Dialogfenster Exportieren CATIA (Export CATIA)

auf die Option Folien anpassen (Customize Layers). Das Dialogfenster Folien waehlen erscheint.
8. Klicken Sie Autom-ID (Auto ID) an, um den Folien, die noch keine IDs haben, Folien-IDs

zuzuordnen.
9. Geben Sie im Dialogfenster Folien waehlen (Choose Layers) Ihre Änderungen ein, und klicken Sie

anschließend auf OK, um die Änderungen zu bestätigen.
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10. Wählen Sie OK, um die Teile- oder Baugruppendatei im CATIA-Format zu erzeugen.

a~íÉáëíêìâíìê=ÑΩê=ÇÉå=bñéçêí=îçå=_~ìÖêìééÉå
å~ÅÜ=`^qf^
Wenn Sie eine Baugruppe nach CATIA exportieren, können Sie die Struktur und den Inhalt der
Ausgabedateien angeben. Die Liste Dateiformat im Dialogfenster für den Baugruppenexport nach CATIA
enthält die folgenden Optionen:

� Flach (Flat) — Exportiert die gesamte Geometrie der Baugruppe in die CATIA-Datei, als ob diese ein
Teil wäre. Wenn die Baugruppe in CATIA aufgerufen wird, verhält sie sich wie ein einzelnes Teil. Bei
diesem Format wird jedes Teil auf eine eigene Folie plaziert, damit die Teile in CATIA
auseinandergehalten werden können.

� Dittos — Exportiert Daten von Pro/ENGINEER Baugruppen-Komponenten als CATIA-Dittos.
CATIA-Dittos ähneln den Komponenten in Pro/ENGINEER-Baugruppen.

mêçLfkqboc^`b=Ñçê=`^qf^
Mit einer Lizenz für Pro/INTERFACE for CATIA können Sie Geometrie zwischen Pro/ENGINEER und
CATIA austauschen. Der Datenaustausch kann auf zwei Arten erfolgen:

� Zwischen Pro/ENGINEER und CATIA 4.2.0, wenn beide Systeme auf der gleichen IBM RS/6000-,
SGI-, Sun- oder Hewlett Packard-Workstation laufen (Ein-Schritt-Verfahren). Zur Konvertierung der
Datei sind keine Dienstprogramme notwendig, weil sich eine KãçÇÉä-Datei ergibt.

� Zwischen CATIA 4.2.0 auf einer IBM RS/6000-, SGI-, Sun- oder Hewlett Packard-Workstation und
Pro/ENGINEER auf einer beliebigen von Pro/ENGINEER unterstützten Workstation (Zwei-Schritt-
Verfahren). Die resultierende KÅí-Datei muß mit Hilfe der entsprechenden Dienstprogramme in eine
KãçÇÉä-Datei konvertiert werden.

Pro/ENGINEER Dienstprogramme zur Dateikonvertierung
Wenn CATIA und Pro/ENGINEER auf verschiedenen Maschinen laufen, müssen die Dienstprogramme
aus Pro/INTERFACE for CATIA auf einer Workstation ausgeführt werden, auf der CATIA installiert ist
und mit der der Zugriff auf CATIA-Lizenzen möglich ist.

Nach dem Export der Ausgabedatei (YÑáäÉå~ãÉ[KÅ~í) kopieren Sie diese auf eine der unterstützten
UNIX-Plattformen, auf der CATIA ausgeführt wird. Anschließend konvertieren Sie die Datei mit dem
entsprechenden Pro/ENGINEER-Dienstprogramm in das CATIA-Format (KãçÇÉä).

CATIA Facetten
Weitere Informationen zu CatiaFacets finden Sie in der Hilfe unter Mit aufgeteilte Dateien arbeiten.

Associative Topology Bus-fähiges CATIA
Mit dem Associative Topology Bus (ATB) können Sie eine Geometrie, eine Topologie und eine
Baugruppenstruktur auf verschiedenen System assoziativ gemeinsam nutzen, ohne daß die
Ursprungsanwendung auf Ihr Desktopsystem geladen werden muß. CATIA ist eine Associative Topology
Bus-fähige Anwendung.
Wenn Sie eine aktive Schnittstelle für CATIA II mit einer Associative Topology Bus-Lizenz besitzen, die
Konfigurationsdatei-Option íçéçÄìë|Éå~ÄäÉ set aber auf åç gesetzt ist, verwenden Sie die
Konfigurationsdatei-Option Å~íá~|íê~åëä~íçê, um die Methode des direkten CATIA-Transfers
einzustellen. Besitzen Sie keine CATIA-Softwarelizenz, setzen Sie Å~íá~|íê~åëä~íçê auf Å~í|áá
(die Standardeinstellung). Dies ist die einzige Methode des direkten CATIA-Transfers, die Sie verwenden
können. Besitzen Sie eine CATIA-Softwarelizenz, und soll diese Lizenz zum Ausführen einer direkten
Übersetzung genutzt werden, setzen Sie die Konfigurationsdatei-Option Å~íá~|íê~åëä~íçê auf
éêç|Å~í.



INTERFACE86

Weitere Informationen zu Associative Topology Bus-fähigem CATIA finden Sie im Hilfemodul
Associative Topology Bus.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=k~ÅÜ=`^qf^=ÉñéçêíáÉêÉå
Pro/ENGINEER unterstützt die folgenden Typen von CATIA-Exportdateien:

� Exakte Geometrie — Sie können exakte Pro/ENGINEER Geometrie exportieren. Das System
unterstützt den Export von Bezugspunkten und -kurven, Flächen und Volumenkörpern nach CATIA als
Flächen, Volumina oder Volumenkörper. Dieses Format wird wahlweise mit dem direkten oder dem
indirekten Verfahren generiert.

� Facettenmodell — Sie können einen in Pro/ENGINEER erzeugten Volumenkörper in eine
Zwischenformatdatei mit der Erweiterung KÅ~í exportieren; diese muß dann mit dem Dienstprogramm
éêç|íç|Å~í oder pro_to_cat4 in eine CATIA-Datei konvertiert werden. Für einen Einsatz der
Pro/INTERFACE for CATIA Export-Dienstprogramme müssen die Module Catia Solids und CAT
GEO in Ihren CATIA-Lizenzen enthalten sein. Bei diesem Format wird lediglich die Körpergeometrie
exportiert, nicht jedoch die Bezüge oder Flächen.

CATIA-Dateien mit exakter Geometrie aus Pro/ENGINEER Modellen
Mit dem Befehl CATIA können Sie Teile und Baugruppen zu übertragen und somit eine CATIA-Datei mit
exakter Geometrie erzeugen.

� Direkt

Der direkte Austausch ist auf den Plattformen IBM RS/6000, SGI, Hewlett Packard und Sun mit einer
lauffähigen CATIA-Installation möglich.
Falls das gewählte CATIA-Modell bereits vorhanden ist, verwenden Sie die Konfigurationsdatei-
Option Å~íá~|çìí|íç|ÉñáëíáåÖ|ãçÇÉä, um den Konflikt zu lösen. Wenn die Option auf óÉë
gesetzt ist, werden die neuen Daten an das vorhandene CATIA-Modell angeführt; ist die Option jedoch
auf åç gesetzt, wird das vorhandene CATIA-Modell überschrieben.
Hinweis: CATIA unterstützt nur Folien mit IDs zwischen 1 und 254; Folien mit Namen werden
dagegen nicht unterstützt.

� Zwei-Schritt-Verfahren

� Datei im CATIA-Neutralformat (.Åí) exportieren

� Pro/CAT-Dienstprogramme zur Erzeugung einer KãçÇÉä-Datei im CATIA-eigenen Format
ausführen

pç=ï~åÇÉäå=páÉ=?KÅí?Ja~íÉáÉå=áå=Ç~ë=`^qf^JÉáÖÉåÉ
cçêã~í=ìã
Nach dem Export eines Teils oder einer Baugruppe in eine CATIA-Ausgabedatei muß die
resultierendeKÅí-Datei in das CATIA-eigene Format konvertiert werden. Zur Konvertierung einer
Ausgabedatei in das CATIA-eigene Format verwenden Sie das Pro/ENGINEER-Dienstprogramm
éêçÖÉç|íç|Å~íQ. Kopieren Sie die exportierte CATIA-Datei (KÅí) auf eine IBM RS/6000-, Hewlett
Packard-, Sun- oder SGI-Maschine, auf der CATIA ausgeführt wird. Auf der Empfangsseite muß Catia
Solids verfügbar sein, damit das Dienstprogramm éêçÖÉç|íç|Å~íQ ausgeführt werden kann. Sie
können dieses Dienstprogramm wahlweise im Standardmodus oder im Benutzereingabe-Modus einsetzen.

1. Wenn Sie sich im Standardmodus befinden, geben Sie éêçÖÉç|íç|Å~íQ ein. Sie gelangen in den
interaktiven Modus. Das Dienstprogramm fordert Sie auf, alle notwendigen Namen und
Verzeichnispfade einzugeben.

2. Benutzereingabe-Modus: Geben Sie den Namen der zu konvertierenden Pro/ENGINEER-CATIA-Datei
ein. Die Datei wird konvertiert, und der Inhalt wird automatisch in der CATIA-Modelldatei M0000000
abgelegt, wenn Sie keinen anderen Namen eingegeben haben.
Das Format für progeo_to_cat4 lautet wie folgt:
YéêçÖÉç|íç|Å~íQ[=xJå=çÄàÉâíå~ãÉz=xJÇ=Å~íá~|ÇÇå~ãÉz=xJã=Å~íá~|ãçÇÉää|éÑ~Çz=xJé



INTERFACE 87

éêçàÉâíz=xJá=Ç~íÉáå~ãÉz=xJî=òìë~íòáåÑçz=xJëáòÉ=áåÇÉñÖêçÉëëÉ=Ç~íÉåãÉåÖÉz

Dabei gilt:
<objektname> — der Name des CATIA-Objekts.
<catia_ddname> — die CATIA-Modellnummer (M1).
<catia_modell_pfad> — der Pfadname für die CATIA-Modellnummer.
<projekt> — der Name des CATIA-Projekts (die Voreinstellung ist ein aus sechs Leerzeichen
bestehender Nullwert). Wenn Sie dieses Argument eingeben, wird automatisch die Konfigurationsdatei-
Option catia_ddname gesetzt.
<dateiname> — der Name der Zwischenformatdatei, die konvertiert werden soll.
<size> — Spezifische Index- und Datentabellengröße für das neue CATIA-Modell. Wenn diese Option
übergangen wird, werden die Voreinstellungen in den CATIA-Deklarationsdateien verwendet.

pç=ï~åÇÉäå=páÉ=?KÅ~í?Ja~íÉáÉå=áå=Ç~ë=`^qf^J
ÉáÖÉåÉ=cçêã~í=ìã
Verwenden Sie das Pro/ENGINEER-Dienstprogramm éêç|íç|Å~í oder éêç|íç|Å~íQ, um eine
Ausgabedatei in das CATIA-Format zu konvertieren. Kopieren Sie die exportierte CATIA-Datei (KÅí) auf
eine IBM RS/6000-, Hewlett Packard-, Sun- oder SGI-Maschine, auf der CATIA ausgeführt wird. Das
Modul Catia Solids auf der Empfangsseite verfügbar sein, damit das Dienstprogramm éêç|íç|Å~í bzw.
éêç|íç|Å~íQ verwendet werden kann. Sie können dieses Dienstprogramm wahlweise im
Standardmodus oder im Benutzereingabe-Modus einsetzen.

1. Standardmodus: Geben Sie éêç|íç|Å~í oder éêç|íç|Å~íQ ein. Sie gelangen in den interaktiven
Modus. Das Dienstprogramm fordert Sie auf, alle notwendigen Namen und Verzeichnispfade
einzugeben.

2. Benutzereingabe-Modus: Geben Sie den Namen der zu konvertierenden Pro/ENGINEER-CATIA-Datei
ein. Die Datei wird konvertiert, und der Inhalt wird automatisch in der CATIA-Modelldatei M0000000
abgelegt, wenn Sie keinen anderen Namen eingegeben haben.

3. Mit dem folgenden Befehl geben Sie die gewünschten Werte ein:
YÇáÉåëíéêçÖ[=xJå=çÄàÉâíå~ãÉz=xJÇ=Å~íá~|ÇÇå~ãÉz=xJã=Å~íá~|ãçÇÉää|éÑ~Çz=xJé

éêçàÉâíz=xJá=Ç~íÉáå~ãÉz=xJî=òìë~íòáåÑçz=xJê=îÉêëáçå|åìãÄÉêz

Dabei gilt:
<ÇáÉåëíéêçÖ> — Eines der beiden Konvertierungsprogramme (éêç|íç|Å~í oder
éêç|íç|Å~íQ).
<çÄàÉâíå~ãÉ> — der Name des CATIA-Objekts.
<Å~íá~|ÇÇå~ãÉ> — die CATIA-Modellnummer (für CATIA 3.0 lautet die Voreinstellung
M0000000, für CATIA 4.0 lautet sie M1).
YÅ~íá~|ãçÇÉää|éÑ~Ç[ — der Pfadname für die CATIA-Modellnummer.
<éêçàÉâí> — der Name des CATIA-Projekts (die Voreinstellung ist ein aus sechs Leerzeichen
bestehender Nullwert). Wenn Sie dieses Argument eingeben, wird die Konfigurationsdatei-Option
Å~íá~|ÇÇå~ãÉ automatisch gesetzt.
<Ç~íÉáå~ãÉ> — der Name der Pro/ENGINEER CATIA-Facettendatei, die konvertiert werden soll.
<êÉîáëáçå|åìããÉê> — Version des Dienstprogramms éêç|íç|Å~í bzw. éêç|íç|Å~íQ.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=^ìë=`^qf^=áãéçêíáÉêÉå
Pro/ENGINEER unterstützt eine Vielzahl von CATIA-Elementen und den direkten und indirekten Import
von CATIA-Dateien.

Unterstützte CATIA-Elemente
Pro/ENGINEER unterstützt den Import der folgenden CATIA-Elemente:

� Oberseiten

� Flaechen

� 2D-Elemente (Linien, Kreise, Kurven, usw.)
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� Modellkanten

� Kurvenzüge

� Punkte

� Koordinatensysteme (KSys)

� Bezugsebenen

3-Achsen-Elemente ais CATIA werden als Koordinatensysteme in Pro/ENGINEER importiert.

Sie können ein importiertes KE durch eine neue Importdatei ersetzen, indem Sie die Entsprechungen
zwischen den vorhandenen und ersetzten Elementen angeben.

Verschiedene Methoden für den Import aus CATIA
Pro/ENGINEER unterstützt die folgenden Methoden für den Import aus CATIA:

� Direkt

Die CATIA-Dateien werden ohne Verwendung des CATIA-Neutralformats (.ct-Datei) in das
Pro/ENGINEER-Format konvertiert. In diesem Fall werden die Daten direkt der CATIA-Datenbank
entnommen.

� Indirekt

Die CATIA-Dateien werden über eine Zwischendatei im CATIA-Neutralformat (.ct) in das
Pro/ENGINEER-Format konvertiert.

Postprocessing von CATIA-Dateien
Nachdem Sie ein CATIA-Modell in Pro/ENGINEER importiert haben, können Sie es in ein
Volumenmodell konvertieren. Dazu verwenden Sie die Befehle Koerper (Protrusion) und Sammelfl

verwend (Use Quilt), oder Sie wählen, während Sie die importierte Geometrie neu definieren, den Befehl
Volumenkoerper (Make Solid).

Falls die Information für die Flächenverbindung fehlt, müssen die Flächen zuerst zusammengefügt werden,
um ein Volumen zu erzeugen. Dies geschieht auf ähnliche Weise wie das Postprocessing von IGES-
Dateien.

pç=áãéçêíáÉêÉå=páÉ=`^qf^Ja~íÉáÉå=ÇáêÉâí=ΩÄÉê=ÇÉå
wìÖêáÑÑ=~ìÑ=ÇáÉ=`^qf^Ja~íÉåÄ~åâ
Mit dem Befehl CATIA Direkt (CATIA Direct) können Sie CATIA-Modelle direkt in Pro/ENGINEER
importieren, ohne zuerst die Datei zu konvertieren. Diese Methode konvertiert die .ãçÇÉä-Datei von
CATIA vor dem Importieren zunächst in eine Åí-Datei. Für diesen Vorgang müssen CATIA und
Pro/ENGINEER auf derselben IBM RS/6000-, Hewlett Packard-, Sun- oder SGI-Maschine laufen.

Hinweis: Falls der Associative Topology Bus aktiviert ist und Sie eine aktive Schnittstelle für CATIA II
mit einer Associative Topology Bus-Lizenz besitzen, müssen Pro/ENGINEER und CATIA bei einem
direkten Import einer KãçÇÉä-Datei von CATIA nicht auf der gleichen Workstation ausgeführt werden.
Weitere Informationen finden Sie in der Hilfe zum Associative Topology Bus.

1. Sind der CATIA-Teil oder die CATIA-Baugruppe Folien zugeordnet und möchten Sie den Importstatus
der Folien ändern, setzen Sie die Konfigurationsdatei-Option áåíÑ|áå|ä~óÉê|~ëã|Çá~äçÖë in
der Datei config.pro auf óÉë. Daraufhin wird während des Imports das Dialogfenster Folienimport-

Optionen (Layer Import Options) angezeigt.
2. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) (ohne ein geöffnetes Teil oder eine

Baugruppe) oder Einfuegen > Daten aus Datei (Insert > Data From File) (mit einen geöffneten Teil
oder einer Baugruppe). Das Dialogfenster Datei oeffnen (File Open) oder Oeffnen (Open) wird
aufgerufen.

3. Klicken Sie in der Liste Suchen in (Look In) auf CATIA-Datenbank (CATIA Database).
Hinweis: Für die CATIA-Datenbank wird keine Dateiliste angezeigt. Sie müssen den vollständigen
Pfad und den Namen der Datei kennen, die Sie importieren möchten.
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4. Wählen Sie in der Liste Typ die Option CATIA Direkt und geben Sie in das Feld Name den
vollständigen Pfad der CATIA-Datei ein, die Sie importieren möchten.

5. Wählen Sie OK, um die CATIA-Datei zu erzeugen oder anzuhängen.
6. Für die Verwendung von CATIA-Daten gilt folgendes:

� Wenn Sie CATIA-Daten zum Erzeugen eines Teils oder einer Baugruppe verwenden, wird das
Dialogfenster Neues Modell importieren (Import New Model) aufgerufen. Schließen Sie die
Auswahlen im Dialogfenster ab, und klicken Sie auf OK (OK), um die neue Datei mit den
CATIA-Daten zu öffnen.

� Wenn Sie CATIA-Daten zum Anhängen an ein geöffnetes Teil verwenden und wenn importierte
KEs vorhanden sind, wird das Dialogfenster Volumenkoerper-Optionen und Plazierung

(Choose Solid Options and Placement) aufgerufen. Klicken

Koerper (Protrusion), um einen Volumenkörper aus der importierten Geometrie zu erzeugen und
zur vorhandenen Teilegeometrie hinzuzufügen.
MatSchnitt (Cut), um anhand der vorhandenen Geometrie einen Materialschnitt in der
vorhandenen Geometrie zu erzeugen.
Flaechen (Surfaces), um die importierte Geometrie in Form von mehreren Sammelflächen
darzustellen. Benachbarte Flächen wenn möglich verbinden.
Schließen Sie die Auswahlen im Dialogfenster ab, und klicken Sie auf OK (OK), um das
importierte KE zu akzeptieren.

7. Wenn dem CATIA-Teil oder der CATIA-Baugruppe Folien zugeordnet sind, wird das Dialogfenster
Folienimport-Optionen (Layer Import Options) aufgerufen.

8. Wählen Sie OK, um die Änderungen zu bestätigen und das Dialogfenster zu schließen.

pç=îÉê~êÄÉáíÉå=páÉ=a~íÉáÉå=áã=`^qf^JÉáÖÉåÉå
cçêã~í=EKãçÇÉäF=ÑΩê=ÇÉå=fãéçêí
Werden Pro/ENGINEER und CATIA nicht auf der gleichen Workstation ausgeführt, müssen Sie das
Dienstprogramm zum Konvertieren der.ãçÇÉä-Datei von CATIA in eine .Åí-Datei manuell starten. Nach
der Konvertierung kopieren Sie die verarbeitete CATIA-Datei auf eine Pro/ENGINEER-Workstation.

Erzeugen Sie eine Datei mit Hilfe des Dienstprogramms éêç|Ñêçã|Å~í bzw. éêç|Ñêçã|Å~íQ auf
einer IBM RS/6000-, Sun-, Hewlett Packard- oder SGI-Maschine, auf der CATIA installiert ist.

� Geben Sie éêç|Ñêçã|Å~í oder éêç|Ñêçã|Å~íQ ein; hiermit werden alle Voreinstellungen
übernommen.

ODER
� Geben Sie YÇáÉåëíéêçÖ[=xJå=å~ãÉz=xJÇ=ÇÇå~ãÉz=xJã=ãçÇÉää|éÑ~Çz=xJé

éêçàÉÅíz=xJç=Ç~íÉáå~ãÉz=xJî=òìë~íòáåÑçz=xJê=îÉêëáçå|åìããÉêz ein.

Die Modifikatoren ähneln denen aus dem Dienstprogramm éêç|íç|Å~í. Falls Sie bei der Ausführung
des Dienstprogramms den Modifikator Jç=YÇ~íÉáå~ãÉ[ nicht angegeben haben, erhält die neue Datei
die Erweiterung KÅí oder .cat. Standardmäßig wird das Modell in das Verzeichnis
LÜçãÉLÅ~íìëêLÇÄ plaziert, und das Skript wird aus dem Verzeichnis LÜçãÉLÅ~íìëê ausgeführt.

pç=áãéçêíáÉêÉå=páÉ=îÉê~êÄÉáíÉíÉ=KÅíJa~íÉáÉå
Führen Sie die folgenden Schritte aus, um die KÅí-Datei, die aus der Vorbereitung der KãçÇÉä-Datei
resultierte, zu importieren.

1. Kopieren Sie die verarbeitete CATIA-Datei auf eine Pro/ENGINEER Workstation.
2. Sind der CATIA-Teil oder die CATIA-Baugruppe Folien zugeordnet und möchten Sie den Importstatus

der Folien ändern, setzen Sie die Konfigurationsdatei-Option áåíÑ|áå|ä~óÉê|~ëã|Çá~äçÖë in
der Datei config.pro auf óÉë. Daraufhin wird während des Imports das Dialogfenster Folienimport-

Optionen (Layer Import Options) angezeigt.
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3. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) (ohne eine geöffnete Datei) oder
Einfuegen > Daten aus Datei (Insert > Data From File) (mit einer geöffneten Datei). Das
Dialogfenster Datei oeffnen (File Open) oder Oeffnen (Open) wird aufgerufen.

4. Wählen Sie in der Liste Typ die Option CATIA in/aus Datei und wählen Sie aus der Dateiliste die
CATIA-Datei, die Sie importieren möchten, oder geben Sie den Namen in das Feld Name ein.

5. Wählen Sie OK, um die CATIA-Datei zu erzeugen oder anzuhängen.
6. Für die Verwendung von CATIA-Daten gilt folgendes:

� Wenn Sie CATIA-Daten zum Erzeugen eines Teils oder einer Baugruppe verwenden, wird das
Dialogfenster Neues Modell importieren (Import New Model) aufgerufen. Schließen Sie die
Auswahlen im Dialogfenster ab, und klicken Sie auf OK (OK), um die neue Datei mit den
CATIA-Daten zu öffnen.

� Wenn Sie CATIA-Daten zum Anhängen an ein geöffnetes Teil verwenden und wenn importierte
KEs vorhanden sind, wird das Dialogfenster Volumenkoerper-Optionen und Plazierung

(Choose Solid Options and Placement) aufgerufen. Klicken

Koerper (Protrusion), um einen Volumenkörper aus der importierten Geometrie zu erzeugen und
zur vorhandenen Teilegeometrie hinzuzufügen.
MatSchnitt (Cut), um anhand der vorhandenen Geometrie einen Materialschnitt in der
vorhandenen Geometrie zu erzeugen.
Flaechen (Surfaces), um die importierte Geometrie in Form von mehreren Sammelflächen
darzustellen. Benachbarte Flächen wenn möglich verbinden.
Schließen Sie die Auswahlen im Dialogfenster ab, und klicken Sie auf OK (OK), um das
importierte KE zu akzeptieren.

7. Wenn dem CATIA-Teil oder der CATIA-Baugruppe Folien zugeordnet sind, wird das Dialogfenster
Folienimport-Optionen (Layer Import Options) aufgerufen.

8. Wählen Sie OK, um die Änderungen zu bestätigen und das Dialogfenster zu schließen.

pç=áãéçêíáÉêÉå=páÉ=`^qf^JjçÇÉääÉ=ãáí=aáííçë=áã
jçÇìë=_~ìÖêìééÉ
Wenn ein CATIA-Modell mit Dittos im Modus Baugruppe importiert wird, werden die Modelldaten nach
folgenden Regeln nach Pro/ENGINEER übertragen:

� Beim Import fordert Sie das System auf, den Namen der Baugruppe in Pro/ENGINEER einzugeben.
Das CATIA-Modell wird in diese Baugruppe importiert.

� Für den Master-Workspace erzeugt das System eine Unterbaugruppe mit dem Namen des CATIA-
Modells. Zusätzlich erzeugt das System noch eine Teiledatei mit der ganzen Geometrie, die ggf. im
Master-Workspace direkt enthalten ist. Das Teil wird nach dem Master-Workspace benannt.

� Das System untersucht alle Abhängigkeiten zwischen dem Master-Workspace und Detail-Workspaces.
Falls Geometrie in einem Detail-Workspace nicht im Master-Workspace oder einem anderen Detail-
Workspace referenziert wird, wird dieser Detail-Workspace ignoriert.

� Für jeden (im Master-Workspace verwendeten) Detail-Workspace, der in keinem anderen Detail-
Workspace verwendet wird, erzeugt das System eine Teiledatei mit dem Namen dieses Detail-
Workspace.

� Für jeden (im Master-Workspace verwendeten) Detail-Workspace, der Dittos enthält, erzeugt das
System eine Unterbaugruppe mit dem Namen des Detail-Workspace. Falls im Detail-Workspace
zusätzliche Geometrie enthalten ist, die nicht aus einem Ditto stammt, wird diese Geometrie in einer
Teiledatei (als eine Komponente der Unterbaugruppe) mit dem Namen des Detail-Workspace
gespeichert.

� Nachdem alle Workspaces untersucht worden sind, plaziert das System alle Komponenten unter
Verwendung von Koordinatensystemen.



INTERFACE 91

pç=áãéçêíáÉêÉå=páÉ=`^qf^JjçÇÉääÉ=ãáí=aáííçë=áã
jçÇìë=qÉáä
CATIA-Modelle mit Dittos (CATIA Version 4.1.7) können im Modus Teil und Baugruppe importiert
werden.

Beim Import eines CATIA-Modells im Modus Teil enthält die erzeugte Teiledatei die Geometrie aller
Komponenten. Falls eine Komponente im Modell öfter als einmal verwendet wird, erscheinen alle
Vorkommen der Komponente im Teil.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=mêçLfkqboc^`b=Ñçê
`^aap=R
Mit Pro/INTERFACE for CADDS können Sie dreidimensionale geometrische Daten zwischen
Pro/ENGINEER und CADDS austauschen. Für diese Schnittstelle wird keine CADDS-Lizenz benötigt. Sie
können Teile und Baugruppen von CADDS in Pro/ENGINEER importieren, und Sie können Teile und
Baugruppen von Pro/ENGINEER in das CADDS-Format exportieren. Darüber hinaus können Sie CADDS-
Folien importieren.

Die folgenden CADDS-Elemente können in Pro/ENGINEER importiert werden:

Hyperbel Parabel Nspline Ebene Rflaeche SRev

Schale Uv-Kurve Punkt. Line Bogen Ellipse

GZyl NFlaeche BDarst Kante. Flaechen Schleife
Die Übertragung von zweidimensionalen Zeichnungsdaten (CADDS oder MEDUSA) ist mit dieser
Schnittstelle nicht möglich. Die folgenden 2D-Zeichnungselemente von CADDS werden nicht unterstützt:

Knoten-
Unterabbild
ung

Knotenli
nien

Text Zeichnunge
n

Ansichten Bemassungen. Kennunge
n

Hinweis: Das Exportieren nach CADDS sowie das Importieren aus CADDS ist nur auf den Plattformen
Silicon Graphics, Sun und Hewlett-Packard möglich.

Associative Topology Bus und CADDS
Bei aktiviertem Associative Topology Bus (ATB) in Pro/ENGINEER können Sie eine Geometrie, eine
Topologie und eine Baugruppenstruktur zwischen CADDS and Pro/ENGINEER assoziativ austauschen,
ohne daß die Ursprungsanwendung auf Ihr Desktopsystem geladen werden muß. CADDS ist eine
Associative Topology Bus-fähige (ATB) Anwendung. Weitere Informationen zu ATB and CADDS finden
Sie im Hilfemodul Associative Topology Bus.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=^ìë=mêçLbkdfkbbo=å~ÅÜ
`^aap=ÉñéçêíáÉêÉå
Beim Exportieren eines Teils oder einer Baugruppe von Pro/ENGINEER nach CADDS arbeiten Sie im
Modus Explizit, einem Industriestandard für CAD/CAM-Konstruktionsumgebungen. In diesem Modus
können Sie auf vorhandene CADDS-Anwendungen zugreifen.

Folgende Geometrietypen können zwischen Pro/ENGINEER und CADDS ausgetauscht werden:
Volumenmodelle, Baugruppenstrukturen, Flächen, Drahtmodellkurven, Punkte. Die resultierende
Geometrie für den Import in Pro/ENGINEER bzw den Export nach CADDS ist statisch und nicht-
parametrisch. Alle Flächen und Kurven von Pro/ENGINEER werden jeweils in NURBS-Flächen und -
Kurven konvertiert.
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Umgebungsvariable CVPATH
Die Umgebungsvariable CVPATH definiert die Standardpfade, in denen nach CADDS Modellen gesucht
wird. Diese Variable muß vor Beginn der Pro/ENGINEER-Sitzung gesetzt werden. Verwenden Sie die
Konfigurationsoption ÉñíÉåÇ|Åîé~íÜ, um während Ihrer Pro/ENGINEER Sitzung Pfadangaben zur
Umgebungsvariablen `sm^qe hinzuzufügen. Pro/ENGINEER sucht im aktuellen Arbeitsverzeichnis nach
CADDS-Komponenten, oder es verwendet die Umgebungsvariable CVPATH mit der Konfigurationsoption
ÉñíÉåÇ|Åîé~íÜ (wenn gesetzt) als Referenzpunkt für das Auffinden von Komponenten in anderen
Verzeichnissen.

Ausführbare Datei
Beim Exportieren eines Teils oder einer Baugruppe von Pro/Engineer nach CADDS wird die ausführbare
Datei <ÉñéçêíãçÇÉääå~ãÉ>JÉñÉÅ erzeugt. Bei der Ausführung dieser Datei mit CADDS werden die
folgenden Elemente erzeugt:

� Standardzeichnungen und Ansichten für die exportierten CADDS-Modelle

� Temporäre Ansichtsdateien (tvfs), mit denen Sie die CADDS-Teile in einer Baugruppe anzeigen lassen
können

Hinweis: Wenn Associative Topology Bus aktiviert ist, werden auch die exportierten Pro/ENGINEER-
Kabel in CADDS-Kabel konvertiert.

ODB_SERVER
Der Hintergrundprozeß ODB_SERVER wird jedesmal gestartet, wenn Pro/INTERFACE for CADDS eine
Baugruppe oder ein Teil öffnet. Beim Schließen der Baugruppe oder des Teils sollte dieser Prozeß
angehalten werden. Sollte der Prozeß aufgrund eines Fehlers nicht anhalten, müssen Sie ihn manuell
stoppen, bevor Sie eine neue Sitzung starten. Wenn Sie den Prozeß nicht stoppen, könnte der
Exportversuch nach CADDS fehlschlagen.

DB_DAEMON
Damit Pro/INTERFACE for CADDS ausgeführt werden kann, muß die aktuelle Version des
Hintergrundprozesses DB_DAEMON ausgeführt werden. Falls CADDS auf Ihrem Computer nicht
verwendet werden kann, stoppen Sie alle DB_DAEMON-Prozesse und starten dann Pro/ENGINEER. Der
DAEMON-Prozeß wird gestartet, falls er benötigt wird.

Kurven, Flächen und Bögen übertragen
Kurven, Flächen und Bögen, die von Pro/ENGINEER nach CADDS 5 mit oder ohne Associative Topology
Bus-Aktivierung übertragen werden, behalten ihre exakte mathematische Form bei. Die Übertragung von
Pro/ENGINEER nach CADDS resultiert in einer authentischen Repräsentation der Originalgeometrie.

pç=áãéçêíáÉêÉå=páÉ=`^aapJqÉáäÉ=çÇÉê=J
_~ìÖêìééÉå=å~ÅÜ=mêçLbkdfkbbo
1. Setzen Sie die Umgebungsvariable `sm^qe.
2. Setzen Sie die Konfigurationsdatei-Option Å~ÇÇë|áãéçêí|ä~óÉê auf óÉë, um das Importieren

von CADDS-Folien zu ermöglichen. Die Voreinstellung ist óÉë.
3. Klicken Sie auf Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File Open) wird

aufgerufen.
4. Mit dem Pfeil bei Typ (Type) lassen Sie weitere Optionen anzeigen.
5. Klicken Sie in der Liste Typ (Type) auf CADDS5. Der Browser wechselt zu einem der Pfade aus der

Umgebungsvariablen `sm^qe. Dieser Pfad wird im Feld Suchen in (Look in) aufgeführt.
6. Mit dem Pfeil neben Suchen in (Look in) lassen Sie eine Liste der Pfade anzeigen, die in der

Umgebungsvariablen `sm^qe definiert sind. Die Pfade beginnen jeweils mit CADDS und sind in
Klammern eingeschlossen.
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7. Klicken Sie auf den Pfad, aus dem ein Teil oder eine Baugruppe importiert werden soll.
8. Doppelklicken Sie auf den Namen des zu importierenden CADDS-Teils oder der -Baugruppe.
9. Das Dialogfenster Neues Modell importieren (Import New Model) wird angezeigt. Die Option Teil

(Part) bzw. Baugruppe (Assembly) ist automatisch ausgewählt (abhängig von dem Typ des
ausgewählten Elements).

10. Geben Sie in das Feld Name einen Namen für das importierte Teil bzw. die Baugruppe ein, oder
übernehmen Sie den Standardnamen.

11. Klicken Sie auf OK. Das CADDS-Modell wird importiert.

pç=ÉñéçêíáÉêÉå=páÉ=Éáå=qÉáä=çÇÉê=ÉáåÉ=_~ìÖêìééÉ
îçå=mêçLbkdfkbbo=å~ÅÜ=`^aap=R
1. Wählen Sie Datei > Kopie speichern (File > Save a Copy). Es erscheint das Dialogfenster Kopie

speichern (Save a Copy).
2. Klicken Sie in der Liste Typ (Type) auf CADDS5. Der vorhandene Pro/ENGINEER Modellname

erscheint ohne die Erweiterung im Feld Neuer Name (New Name).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Das Teil oder die Baugruppe aus Pro/ENGINEER wird im Format "Explizit" nach

CADDS exportiert.

rãÖÉÄìåÖëî~êá~ÄäÉ=`sm^qe=ëÉíòÉå
Vergewissern Sie sich, daß `sm^qe für die richtigen Verzeichnisse eingerichtet ist, wenn Sie eine
CADDS-Baugruppe in Pro/ENGINEER importieren möchten. Bei CADDS werden Modelle nicht als
unstrukturierte Dateien, sondern physikalisch als Verzeichnisstrukturen gespeichert.

Beispiel für das Setzen der Umgebungsvariablen CVPATH:

ëÉíÉåî=`sm^qe=DYé~íÜN[Z`WYé~íÜO[WYé~íÜP[WYé~íÜQ[W=KKKKKYmÑ~Çñ[D

Beim Setzen der Variable `sm^qe können Sie mehrere Suchpfade angeben.

Pfade sind entweder vollständige oder relative Pfade zu Verzeichnissen auf Festplatten, in denen CADDS-
Modelle gespeichert sind. Am Anfang und Ende der Pfadangabe steht ein Apostroph, und die Pfade sind
durch einen Doppelpunkt (:) voneinander getrennt. Das Z` nach dem Eintrag Yé~íÜN[ im obigen
Beispiel bestimmt diesen Pfad als Erstellungsverzeichnis. Im "Erstellungsverzeichnis" werden die
exportierten CADDS-Modelle aus Pro/ENGINEER beim Export erzeugt. Sie können Z` in ein beliebiges
Verzeichnis im `sm^qe setzen.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=få=ÉáåÉ=aucJ=çÇÉê=atdJ
a~íÉá=ÉñéçêíáÉêÉå
Sie können Zeichnungsdaten zwischen Pro/ENGINEER und Produkten wie AutoCAD austauschen, die die
folgenden Formate verarbeiten:

� DXF (Drawing Interchange Format)

� DWG

Wenn Sie sich in Pro/ENGINEER befinden und in eine DXF-Datei exportieren, wird Pro/ENGINEER:
� Spline oder B-Spline als einen Spline nach DXF exportieren.

� Eine Hilfslinie als eine XLINE nach DXF exportieren.

� Schraffuren als HATCH nach DXF exportieren. Alle Pro/ENGINEER-Schraffuren erzeugen ein
AutoCAD UDF Hatch.
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DWG- und DXF-Blöcke
Mit der Konfigurationsdatei-Option áåíÑ|çìí|ä~óÉê können Sie die benutzerdefinierten Symbole und
Zeichnungsgruppen als DXF- und DWG-Blöcke exportieren. Auf diese Weise wird die Bearbeitung der
exportierten Zeichnungen vereinfacht. Zweidimensionale Darstellungen einzelner Komponenten sowie
deren 2D-Elemente für die zugehörigen Ansichten werden ebenfalls als Blöcke umgesetzt.

pç=ÉñéçêíáÉêÉå=páÉ=áå=ÉáåÉ=wÉáÅÜåìåÖëJI
wÉáÅÜåìåÖëÑçêã~íJ=çÇÉê=i~óçìíJa~íÉá
Sie können in eine Zeichnungsdatei, eine Zeichnungsformatdatei oder eine DXF- oder DWG-Layoutdatei
exportieren. Sie müssen für jedes Zeichnungsblatt eine DXF- oder DWG-Datei erzeugen.

Wenn Sie Text während des DXF- oder DWG-Exports ausstreichen möchten, setzen Sie die
Konfigurationsdatei-Option ÇñÑ|çìí|ëíêçâÉ|íÉñí in der Datei config.pro auf óÉë. Bei der
Voreinstellung no wird der Text nicht für den Export ausgestrichen.

1. Wählen Sie in einer Zeichnung die Befehlsfolge Datei > Kopie speichern (File > Save a Copy). Es
erscheint das Dialogfenster Kopie speichern (Save a Copy).

2. Wählen Sie in der Liste Typ (Type) die Option DXF oder DWG. Der vorhandene Pro/ENGINEER
Modellname erscheint ohne die Erweiterung im Feld Neuer Name (New Name).

3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen
Modellnamen für den Export ein. Klicken Sie auf OK. Der Exportdateiname wird im Pro/ENGINEER
Fenster angezeigt. Das System exportiert die Zeichnung in das Format DXF oder DWG. Das System
erstellt eine Datei mit einem der folgenden Namen:
� <òÉáÅÜåìåÖëå~ãÉ>KÇïÖ oder <òÉáÅÜåìåÖëå~ãÉ[|@KÇïÖ, wobei @ für die Blattnummer

bei einer Zeichnung mit mehreren Blättern steht.

� <òÉáÅÜåìåÖëå~ãÉ>KÇïÖ oder <òÉáÅÜåìåÖëå~ãÉ>|@KÇïÖ, wobei @ für die Blattnummer
bei einer Zeichnung mit mehreren Blättern steht.

bñéçêíáÉêÉå=îçå=aucJ=ìåÇ=atdJa~íÉáÉå=ëíÉìÉêå
Wenn Sie Text während des DXF- oder DWG-Exports ausstreichen möchten, setzen Sie die
Konfigurationsdatei-Option ÇñÑ|çìí|ëíêçâÉ|íÉñí in der Datei config.pro auf óÉë. Bei der
Voreinstellung no wird der Text nicht für den Export ausgestrichen.

Setzen Sie die Konfigurationsdatei-Option ÇïÖ|Éñéçêí|Ñçêã~í vor dem Exportieren nach DWG auf
NO, NP oder NQ, um die DWG-Version, in die Ihre Zeichnung exportiert werden soll (Version 12, 13 oder
14), zu steuern. Die Standardeinstellung ist NP.

Zum Steuern des Exports von Polylinien, Linien und Bögen oder Schraffuren und Spline-Elementen in eine
DWG- oder DXF-Datei setzen Sie die Konfigurationsdatei-Option áåíÑOÇ|çìí|ÉåÜ~åÅÉÇ|Éåíë auf:

ëéäáåÉ|Ü~íÅÜ=– (Standardeinstellung) Exportiert Spline- und Schraffurelemente.

ëéäáåÉ=– Exportiert Spline-Elemente.

Ü~íÅÜ=– Exportiert Schraffurelemente.

åçåÉ=– Exportiert keine erweiterten Elemente.
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pç=ÉñéçêíáÉêÉå=páÉ=cçäáÉå=ΩÄÉê=auc=çÇÉê=atd=ãáí
îçêÇÉÑáåáÉêíÉå=cçäáÉå=çÇÉê=_ä∏ÅâÉå
1. Setzen Sie die Konfigurationsdatei-Option áåíÑ|çìí|ä~óÉê auf:

� ÄäçÅâ|ä~óÉê, um mit Standardblöcken zu exportieren

� é~êí|ä~óÉê, um mit Standardfolien zu exportieren

� åçåÉ, um Pro/ENGINEER-Zeichnungen in das Format DXF oder DWG zu exportieren, ohne daß
Blöcke erzeugt oder Folien und Linienstile zugeordnet werden.

2. Nehmen Sie die Zuordnung der Folien und Linienstile in der Datei ÇñÑ|ÉñéçêíKéêç vor.

áåíÑ|çìí|ä~óÉê=~ìÑ=ÄäçÅâ|ä~óÉê=ëÉíòÉå
Mit áåíÑ|çìí|ä~óÉê=ÄäçÅâ|ä~óÉê exportieren Sie Komponenten (Teile), Symbole, Gruppen (für
die einzelnen Ansichten) und Tabellen für Pro/ENGINEER-Zeichnungen als AutoCAD-Blöcke. Die
Blöcke werden folgendermaßen bearbeitet:

� Benutzerdefinierte Symbole werden als benannte Blöcke umgesetzt. Varianten des Symbols werden
jeweils als separate Blöcke bearbeitet. Der Standard-Blockname lautet
<póãÄçäå~ãÉ[|Ys~êá~åíÉåå~ãÉ>.

� Benutzerdefinierte Gruppen aus dem Modus Zeichnung oder dem Modus Diagramm werden als
benannte Blöcke umgesetzt. Der Standard-Blockname lautet <póãÄçäå~ãÉ[|YdêìééÉåå~ãÉ>.

� Tabellen mit Text, die in einer Pro/ENGINEER-Zeichnung erzeugt wurden, werden als benannte
Blöcke umgesetzt. Der Standard-Blockname lautet Tabelle_<Variantenname>.

� Für einzelne Komponenten gilt der folgende Standard-Blockname:

YqÉáäå~ãÉ[|Y^åëáÅÜíå~ãÉ[|Ys~êá~åíÉåå~ãÉ>

áåíÑ|çìí|ä~óÉê=~ìÑ=é~êí|ä~óÉê=ëÉíòÉå
Mit áåíÑ|çìí|ä~óÉê=é~êí|ä~óÉê exportieren Sie Daten aus Pro/ENGINEER Zeichnungen in das
Format DXF oder DWG. So können Sie die folgenden Aufgaben ausführen:

� Vordefinierte Folien erzeugen

� Pro/ENGINEER-Linienstile zu AutoCAD-Linienstilen zuordnen

� 1:1-Maßstab für die exportierte Zeichnung festlegen, unabhängig vom ursprünglichen Maßstab

� Blöcke für die einzelnen Schraffuren und Tabellen in der Zeichnung beim Exportieren einfügen

� Den Textexport aktualisieren. Text wird nicht als externer Block, sondern als AutoCAD-Text
exportiert.

Folienschema
Erzeugen Sie je ein Folienschema für die Teile, die nach DXF oder DWG exportiert werden sollen. Bei
mehrfach auftretenden Teilen werden die zugehörigen Elemente auf dieselbe Folie plaziert.

Folienname bei DXF/DWG Elemente (auf der Folie zu plazieren)

<Teilename>_Dxf_Axis Alle Achsen

<Teilename>_Dxf_Continuous_Line Alle durchgehenden Linien

<Teilename>_Dxf_Hidden_Line Alle verdeckten Linien

<Teilename>_Dxf_Dimension Alle Bemaßungen

<Teilename>_Dxf_Text Gesamter Text

<Teilename>_Dxf_Hatching Alle Schraffuren
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<Teilename>_Dxf_Table Alle Tabellen

<Teilename>_Dxf_Balloon Alle Ballons

<Teilename>_Dxf_Format Alle Formatelemente

Folien und Linienstile zuordnen
Mit der Datei ÇñÑ|ÉñéçêíKéêç ordnen Sie die Folien zu, die aus Pro/ENGINEER nach DXF und DWG
exportiert wurden. Für die Folienzuordnung gilt die folgende Syntax:

aÉÑ|ä~óÉê=YòìòìçêÇåÉåÇÉ=bäÉãÉåíÉ[=YbêïÉáíÉêìåÖ[

Die Datei ÇñÑ|ÉñéçêíKpro enthält beispielsweise die Zeile aÉÑ|ä~óÉê=añÑ|^ñáë=R. Beim Export
von Teil1 ergibt sich die Folie Teil1_5. Diese Folie enthält alle Achsen aus Teil1, die in der exportierten
Zeichnung vorliegen.

Hinweis: Wenn ein Elementtyp im Teil nicht vorhanden ist, wird die entsprechende Folie nicht erzeugt.

Für die Zuordnung der Linienstile mit der Datei ÇñÑ|ÉñéçêíKéêç gilt die folgende Syntax:

ã~é|äáåÉ|ëíóäÉ=YmêçLbJk~ãÉ[=Y^ìíç`^aJk~ãÉ[

Beispiel: ã~é|äáåÉ|ëíóäÉ=`qoiclkq=`bkqbo

Hinweis: DXF-Dateinamen können maximal 32 Zeichen aufweisen. Foliennamen mit mehr als 32 Zeichen
werden daher gekürzt.

Maßstab von Ansichten
Beim Exportieren wird die gesamte Zeichnung auf den Hauptansichtsmaßstab 1:1 neu skaliert. Der
Hauptansichtsmaßstab lautet beispielsweise 2:1. Die Zeichnungsgröße wird mit dem Faktor 0,5 skaliert,
ebenso alle Ansichten mit Detailansichten. Der Detailansichtsmaßstab 4:1 wird somit durch den Maßstab
2:1 ersetzt.

Alle 2D-Elemente sowie das Zeichnungsformat werden mit dem Faktor 0,5 neu skaliert. Der Text in der
Bemaßung oder den Notizen wies beispielsweise die Höhe 0,125 auf. Die neue Höhe beträgt somit 0,0625.
Die Zeichnung in AutoCAD entspricht der Zeichnung in Pro/ENGINEER. Wenn Sie ein Element in einer
der Standardansichten messen, stimmt das Meßergebnis mit der Bemaßung überein.

Text, Schraffuren und Tabellen
Text wird nicht als Block exportiert, sondern als AutoCAD-Text. Mehrzeiliger Text wird unverändert als
mehrzeiliger Text nach AutoCAD exportiert.

Schraffuren werden in AutoCAD-Blöcke konvertiert. Die Schraffurgruppen werden jeweils in einen
einzelnen Block umgewandelt und gemäß dem Folienschema plaziert.

Die Tabellen werden jeweils in einen einzelnen AutoCAD-Block umgewandelt und gemäß dem
Folienschema plaziert.

wÉáÅÜåìåÖëã~≈ëí®ÄÉ=ÉñéçêíáÉêÉå
Beim Exportieren einer Pro/ENGINEER-Zeichnung in das Format DXF/DXG wird der
Zeichnungsmaßstab in die DXF/DWG-Umgebungsvariable DIMFLAC ausgegeben. Der Export der
Maßstabsinformationen wird von der Option ÇñÑ|çìí|Çê~ïáåÖ|ëÅ~äÉ in der Datei config.pro
gesteuert.

Wenn ÇñÑ|çìí|Çê~ïáåÖ|ëÅ~äÉ auf åç (Standard) gesetzt ist, wird die Zeichnung ohne
Maßstabsinformationen exportiert.

Ist ÇñÑ|çìí|Çê~ïáåÖ|ëÅ~äÉ auf óÉë gesetzt, geschieht folgendes:

� Die Maßstabsinformationen werden ordnungsgemäß für unskalierte Ansichten exportiert.
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� Detail- und andere unskalierte Ansichten exportieren das genaue Bild, übertragen jedoch keine
skalierten Bemaßungen.

� Beim Export von mehreren Modellen mit unterschiedlichen Maßstäben werden nur die unskalierten
Ansichten des aktuellen Modells mit dem richtigen Skalierfaktor exportiert.

wìçêÇåìåÖ=îçå=mêçLbkdfkbbo=pí~åÇ~êÇÑ~êÄÉå=òì
^ìíç`^a
Mit der Konfigurationsdatei ÇñÑ|ÉñéçêíKéêç ordnen Sie die Pro/ENGINEER-Systemfarben den DXF-
und DWG-Standardfarben zu. Diese Datei muß im Startverzeichnis von Pro/ENGINEER vorliegen. Um die
Standardsystemfarben von Pro/ENGINEER ähnlichen oder entsprechenden AutoCAD Systemfarben
zuzuordnen, nehmen Sie die folgenden Einstellungen in der Datei ÇñÑ|ÉñéçêíKéêç vor:
map_color BACKGROUND_COLOR 186

map_color DIMMED_COLOR 9

map_color LETTER_COLOR 2

map_color HIGHLIGHT_COLOR 1

map_color EDGE_HIGHLIGHT_COLOR 5

map_color GEOMETRY_COLOR

map_color HIDDEN_COLOR

map_color SHEETMETAL _COLOR

map_color CURVE_COLOR

map_color VOLUME_COLOR

map_color SECTION_COLOR

pí~åÇ~êÇëóëíÉãÑ~êÄÉå=îçå=mêçLbkdfkbbo
Die Standardsystemfarben von Pro/ENGINEER sind:

Name der Pro/ENGINEER Systemfarbe Pro/ENGINEER Standardfarbe

LETTER_COLOR gelb

HIGHLIGHT_COLOR Rot

GEOMETRY_COLOR Weiß

DIMMED_MENU_COLOR Hellgrau

EDGE_HIGHLIGHT_COLOR Blau

HIDDEN_COLOR Dunkelgrau

VOLUME_COLOR Magenta

SECTION_COLOR cyan

SHEETMETAL_COLOR Grün

CURVE_COLOR Braun

BACKGROUND_COLOR Dunkelblau
Die Hintergrundfarbe übermittelt nicht die tatsächliche Bildschirmfarbe an AutoCAD. Diese Farbe wird
von Pro/ENGINEER für die Farbmanipulation verwendet.
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e~ìéíJpóëíÉãÑ~êÄÉå=îçå=^ìíç`^a
In der nachstehenden Tabelle werden die Hauptfarben von AutoCAD aufgeführt, bei denen eine Zuordnung
möglich ist. Eine detaillierte Farbliste finden Sie in der AutoCAD-Dokumentation unter
http://www.autodesk.com/techpubs/autocad/index.htm.

AutoCAD Farbe Nummer(n) in

AutoCAD

Rot 1

Gelb 2

Gruen 3

Hellblau 4

Dunkelblau 5

Magenta 6

Schwarz 7

Grau 8

Hellgrau 9

Grautöne 250-255

Farbpalette 10-249

áåíÑ|çìí|ä~óÉê=~ìÑ=åçåÉ=ëÉíòÉå
Der Export/Import von Folien wird für DWG und DXF unterstützt. Wenn Sie Folien mit Pro/ENGINEER-
Elementen in DXF oder DWG exportieren und dabei fkqc|lrq|i^vbo auf åçåÉ gesetzt ist, gilt:

� Folien werden mit ihrem ursprünglichen Namen exportiert.

� Ein Element, das zu mehreren Pro/ENGINEER Folien gehört, wird mit dem niedrigsten alphabetischen
Foliennamen exportiert. Beispielsweise wird ein Element der Folie "Apfel" und der Folie "Pflaume" auf
die Folie "Apfel" exportiert.

In der folgenden Tabelle sehen Sie, wie Elemente, die von Pro/ENGINEER erzeugt und nach DXF oder
DWG exportiert wurden, den Folien in einer DXF- oder DWG-Datei zugewiesen werden.

Linienstil, der von einem geometrischen

Element auf einer Folie verwendet wird

Folie, auf der sich das Element

später befindet

Mittellinie DEFAULT_1

Verdeckte Kanten DEFAULT_2

Phantomlinie DEFAULT_3
Wenn ein Element einer Folie zugewiesen wurde, jedoch keiner der oben genannten Kategorien darauf
zutrifft, erscheint es auf derselben Folie. Gehört ein Element zu keiner Folie, erscheint es auf einer
Standardfolie Null.

_ÉáëéáÉäW=wÉáäÉ=áå=a~íÉá=ÇñÑ|ÉñéçêíKéêç
Zum Export der gesamten Pro/ENGINEER-Geometrie in grüner Farbe (AutoCAD-Farbe 3) nehmen Sie die
folgende Zeile in die Datei dxf_export.pro auf:

map_color GEOMETRY_COLOR 3
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^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=aucJ=çÇÉê=atdJa~íÉáÉå
áãéçêíáÉêÉå
Sie können Zeichnungsdaten zwischen Pro/ENGINEER und Produkten wie AutoCAD austauschen, die die
folgenden Formate verarbeiten:

� DXF (Drawing Interchange Format)

� DWG

Darüber hinaus können Sie DXF- und DWG-Dateien nicht nur importieren, sondern das Ergebnis auch
ändern.

Daten aus DXF in Pro/ENGINEER importieren
Wenn Sie sich in Pro/ENGINEER befinden und in eine DXF-Datei importieren, führt DXF folgendes aus:

� Das SPLINE-Element als einen Spline oder einen B-Spline importieren

� Das XLINE-Element als eine Hilfslinie importieren

� Das Hatch-Element als eine Schraffur importieren

Hinweis: In einigen Fällen wird eine kachelförmige Schraffur nicht importiert. Aus Pro/ENGINEER
können Sie nur Elemente importieren, die in Pro/ENGINEER erstellt wurden.

pç=ÉêòÉìÖÉå=páÉ=Éáå=åÉìÉë=jçÇÉää=ÇìêÅÜ
fãéçêíáÉêÉå=îçå=aucJ=çÇÉê=atdJa~íÉáÉå
1. Klicken Sie auf Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File Open) wird

aufgerufen.
2. Wählen Sie in der Liste Typ (Type) die Option DXF oder DWG. DXF- oder DWG-Dateien werden im

Arbeitsverzeichnis aufgeführt.
3. Klicken Sie auf den Namen der gewünschten DXF- oder DWG-Datei, oder durchsuchen Sie die

Verzeichnisse nach der Datei.
4. Klicken Sie auf OK. Es erscheint das Dialogfenster Neues Modell importieren (Import New Model).

Übernehmen Sie den vorgegebenen Dateinamen, oder geben Sie einen neuen Namen ein.
5. Wenn die gewählte Datei Modell- und Papiergrößenelemente besitzt, wählen Sie die gewünschte

Option im Menü DXF GROESSE (DXF SPACE).
6. Wählen Sie OK, um die DXF- oder DWG-Datei zu erzeugen.
7. Skalieren Sie die angehängte Zeichnungsdatei passend für das Format, verschieben Sie den Ursprung

der Zeichnungsdatei in die linke untere Ecke oder übernehmen Sie die Standardposition.

pç=Ü®åÖÉå=páÉ=aucJ=çÇÉê=atdJa~íÉáÉå=~å=ÉáåÉ
wÉáÅÜåìåÖ=~å
1. Wählen Sie in einer Zeichnung die Befehlsfolge Einfuegen > Daten aus Datei (Insert > Data from

File). Das Dialogfenster Oeffnen erscheint.
2. Wählen Sie in der Liste Typ (Type) die Option DXF oder DWG, und wählen Sie aus der Dateiliste die

zu importierende Datei.
3. Wenn die gewählte Datei Modell- und Papiergrößenelemente besitzt, wählen Sie die gewünschte

Option im Menü DXF GROESSE (DXF SPACE).
4. Wählen Sie OK, um die DXF- oder DWG-Datei anzuhängen.
5. Skalieren Sie die angehängte Zeichnungsdatei passend für das Format, verschieben Sie den Ursprung

der Zeichnungsdatei in die linke untere Ecke oder übernehmen Sie die Standardposition.
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wÉáÅÜåìåÖëÇ~íÉáÉå=áãéçêíáÉêÉå
Beachten Sie beim Import von DXF- oder DWG-Daten in eine Zeichnung folgendes:

� Die 2D-Elemente werden mit den in der Zeichnungs-Konfigurationsdatei vorgegebenen Daten erzeugt.
Wenn z.  B. die Zeichnungs-Konfigurationsdatei die Einheiten auf Inch setzt, und die DXF- oder
DWG-Daten in Millimetern vorliegen, werden die DWG-Elemente während der Übersetzung nach Inch
konvertiert. 25,4   mm in der DWG-Datei werden z.  B. zu 1 Inch in der Zeichnung.

� Werte in der DWG- oder DXF-Dateien überschreiben nicht alle Einstellungen in der Zeichnungs-
Konfigurationsdatei. Bereiche, in denen es zu Unterschieden kommen kann, sind z.  B. Pfeilgröße und -
stil, Textgröße und parallele/horizontale Bemaßungen.

Der Pfeilstil einer Bemaßung wird im Abschnitt BLOCK SECTION einer DXF-Datei gespeichert und
als Teil des Bemaßungsbildes behandelt. Standardmäßig werden bei Pro/ENGINEER keine Daten aus
dem Bemaßungsbild zum Wiederherstellen der Bemaßung verwendet. Der Pfeilstil der Bemaßung geht
daher beim Import verloren.

� AutoCAD Elemente, die sich auf einer ausgeblendeten Folie befinden, werden in Pro/ENGINEER
übertragen und auf eine leere Folie plaziert. Anschließend können Sie die Anzeige dieser Folie ändern.

Beachten Sie im Bezug auf die Größe der importierten Zeichnung folgendes:

� Wenn die importierte Zeichnung eine andere Größe hat als die Pro/ENGINEER Zeichnung, werden Sie
aufgefordert, die importierte Geometrie so zu skalieren, daß sie in das Format paßt. Wenn Sie N
eingeben, werden Sie gefragt, ob der Ursprung der importierten Zeichnung in die linke untere Ecke des
Formats gelegt werden soll.

Hinweis: Wenn die importierte Geometrie nicht skaliert wurde, um in die ausgewählte
Zeichnungsgröße zu passen, können Sie später das Zeichnungsformat durch eine geeignetere Größe
ersetzen.

� Wenn die importierte Zeichnung die gleiche Größe hat wie die Pro/ENGINEER Zeichnung, wird der
Ursprung der importierten Zeichnung automatisch in der linken unteren Ecke plaziert
(Formatursprung). In diesem Fall erscheint keine Eingabeaufforderung.

Wenn eine zu importierende DWG- oder DXF-Datei Modellraum- und Papiergrößenelemente besitzt, bietet
Ihnen das System zwei Befehle im Menü DXF GROESSE (DXF SPACE):

� Papiergroesse (Paper Space) – Modell- und Papiergrößenelemente werden in einer Zeichnung
angezeigt.  

� Modellgroesse (Model Space) – Eine Zeichnung wird nur in Modellgröße angezeigt. Es werden keine
Papiergrößenelemente angezeigt.  

cçäáÉåáãéçêí=áã=cçêã~í=auc=ìåÇ=atd
Der Export/Import von Folien wird für DWG und DXF unterstützt. Pro/ENGINEER weist über DWG oder
DXF eingelesenen Elementen mit Folien im Modus Zeichnung einer Folie zu. Die Folien-ID eines über
DWG oder DXF eingelesenen Elements ist die gleiche wie ihre Folien-ID in der DWG-oder DXF-Datei.
Folien werden so wie sie sind importiert. Es werden keine Standardwerte zugewiesen.

dÉå~ìÉ=hçéáÉ=ÉáåÉê=^ìíç`^aJwÉáÅÜåìåÖ
ÉêòÉìÖÉå
Soll beim Importieren einer AutoCAD-Zeichnung in Pro/ENGINEER eine genaue Kopie erzeugt werden,
müssen Sie die Konfigurationsdatei-Option Åçéó|ÇñÑ|Çáã|éáÅí in der Datei config.pro auf óÉë
setzen. Pro/ENGINEER importiert Geometrie, Text, Bemaßungen, geometrische Toleranzen und
Sonderzeichen aus der Originaldatei als explodierte Elemente. Ist die Option auf no (Voreinstellung)
gesetzt, wird die Zeichnung ohne geometrische Toleranzen oder Spezialsymbole importiert. Alle
Bemaßungen, Hilfslinien und Pfeile verhalten sich, als wären sie in Pro/ENGINEER erstellt worden, und
können nur dann bearbeitet werden, wenn der Bemaßungswert ausgewählt ist.
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Hinweis: Alle DXF-spezifischen Konfigurationsdatei-Optionen in der Datei config.pro wirken sich auch
auf DWG-Dateien aus.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=m^qo^kJdÉçãÉíêáÉ
Mit PATRAN- Softwaresystemen können Sie PATRAN-Geometriedateien eines Pro/ENGINEER Teils
lesen. Diese Dateien werden gemäß den Spezifikationen für PATRAN-Neutraldateien formatiert. Enthält
mathematische Funktionen von Elementen wie z.  B. Flächendaten, die einen Volumenkörper beranden.
Pro/ENGINEER akzeptiert keine Dateien aus PATRAN-Systemen als Eingabe.

PATRAM-Dateien sind ASCII-Textdateien. Sie werden im aktuellen Arbeitsverzeichnis gespeichert. Sie
können sie mit Standard-Betriebssystembefehlen umbenennen oder ändern. Wenn Sie unter UNIX zwei
PATRAM-Datendateien aus demselben Objekt erstellen, wird die zuerst erstellte überschrieben, sofern Sie
sie nicht umbenennen.

Sie können nur im Modus Teil auf den Befehl PATRAN Geom zugreifen.

pç=ÉñéçêíáÉêÉå=páÉ=m^qo^kJa~íÉáÉå
1. Wählen Sie in einem offenen Teil die Befehlsfolge Datei > Kopie speichern (File > Save a Copy). Es

erscheint das Dialogfenster Kopie speichern (Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option PATRAN (*.ntr). Der vorhandene Pro/ENGINEER

Modellname erscheint ohne die Erweiterung im Feld Neuer Name (New Name).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Die Datei wird exportiert, und das System erstellt Ya~íÉáå~ãÉ[Kåíê.

§ÄÉê=pìéÉêí~Ä=dÉçãÉíêáÉ
Mit der Option SUPRTB Geom können Sie aus Teiledaten eine I-DEAS Supertab Datei erzeugen, die von
Supertab Software-Systemen gelesen werden kann. Diese Datei ist gemäß den Spezifikationen für Supertab
Universaldateien formatiert. Enthält mathematische Funktionen von Elementen wie z.  B. Flächendaten, die
einen Volumenkörper beranden. Pro/ENGINEER akzeptiert keine Dateien aus Supertab-Systemen als
Eingabe.

Supertab Dateien sind ASCII-Textdateien. Sie werden im aktuellen Arbeitsverzeichnis gespeichert. Sie
können sie mit Standard-Betriebssystembefehlen umbenennen oder ändern. Wenn Sie unter UNIX zwei
Supertab-Datendateien aus demselben Objekt erstellen, wird die zuerst erstellte überschrieben, sofern Sie
sie nicht umbenennen.

Hinweis: Wenn Sie die Pro/ENGINEER-Supertab Datei in Geomod einlesen, gibt die Geomod-Software
eine Warnung für das Element #428 aus. Sie können diese Warnung ignorieren, da das Element von
Geomod nicht verwendet wird.

Sie können eine Pro/ENGINEER Baugruppe auf die gleiche Weise wie bei Teilen nach Supertab ausgeben.

pç=ÉñéçêíáÉêÉå=páÉ=pìéÉêí~Ä=råáîÉêë~äJa~íÉáÉå
1. Wählen Sie in einem offenen Teil die Befehlsfolge Datei > Kopie speichern (File > Save a Copy). Es

erscheint das Dialogfenster Kopie speichern (Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option SuperTab (*.unv).  Der vorhandene Pro/ENGINEER

Modellname erscheint ohne die Erweiterung im Feld Neuer Name (New Name).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Die Datei wird exportiert, und das System erstellt Ya~íÉáå~ãÉ[Kìåî.
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§ÄÉê=`lpjlpJdÉçãÉíêáÉ
Sie können mit dem Befehl COSMOS Geom eine Neutraldatei erzeugen, die von COSMOS/M gelesen
werden kann (COSMOS/M ist der Name des FEM-Solver von SRAC).

COSMOS/M-Dateien sind ASCII-Textdateien. Sie werden im aktuellen Arbeitsverzeichnis gespeichert. Sie
können sie mit Standard-Betriebssystembefehlen umbenennen oder ändern. Wenn Sie unter UNIX zwei
COSMOS/M-Dateien aus demselben Objekt erstellen, wird die zuerst erstellte überschrieben, sofern Sie sie
nicht umbenennen.

Der Befehl ist nur im Modus Teil verfügbar.

pç=ÉñéçêíáÉêÉå=páÉ=áå=`lpjlpJa~íÉáÉå
1. Wählen Sie in einem offenen Teil die Befehlsfolge Datei > Kopie speichern (File > Save a Copy). Es

erscheint das Dialogfenster Kopie speichern (Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option COSMOS (*.ntr). Der vorhandene Pro/ENGINEER

Modellname erscheint ohne die Erweiterung im Feld Neuer Name (New Name).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Die Datei wird exportiert, und das System erstellt Ya~íÉáå~ãÉ[Kåíê.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=§ÄÉê=fdbp=ÉñéçêíáÉêÉå
Bevor Sie IGES-Dateien exportieren, bestimmen Sie, welche IGES-Objekte das empfangende System
empfangen kann. Verwenden Sie dann die entsprechenden Konfigurationsdatei-Optionen für die Ausgabe
dieses Datentyps.

Wenn Sie eine IGES-Datei ausgeben, wird eine Protokolldatei in Ihrem Arbeitsverzeichnis erzeugt, die den
folgenden Namen erhält:

� áÖÉëçìíKäçÖK@ – bei Zeichnungsdateien

� Yå~ãÉ[|çìíKäçÖK@ – bei Bauteil- oder Baugruppendateien

Diese Datei enthält Informationen über den IGES-Konvertierungsprozeß, einschließlich des Typs und der
Menge jedes Objekts. Mit Hilfe von Pro/BATCH können Sie innerhalb eines Durchlaufs mehrere IGES-
Dateien aus Zeichnungen erstellen.

Hinweis: Nicht alle von Pro/ENGINEER unterstützten Sonderzeichen können in IGES dargestellt werden.
Daher kann es vorkommen, daß beim Export in die IGES-Datei einige Zeichen fehlen. So werden z.  B.
geclippte Bemaßungen mit zwei Pfeilspitzen mit nur einer Pfeilspitze exportiert.

IGES-Version in Ausgabedateien
IGES-Dateien enthalten im Dateikopf einen Code für die IGES-Version 5.2. Akzeptiert das empfangende
System diese Version nicht, kann der Dateikopf bearbeitet und der Code in die neueste Version von IGES
geändert werden, die das empfangende System akzeptiert (z.  B. 4.0). Durch diese Änderung sind
vermutlich die meisten oder alle Daten für das empfangende System lesbar.

Elementattribute aus Pro/ENGINEER, die von IGES unterstützt werden
Die folgende Tabelle enthält eine Liste der von IGES unterstützten Pro/ENGINEER Elementattribute und
die entsprechenden Modi.
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Unterstützte Elementattribute:

Attribut Modus:

Dicke Unterstützt den Export eines komprimierten Schalenmodells beim Export von
FE-Netzen.

Linienart Wird nur im Modus Zeichnung unterstützt; wird bei Modellen ignoriert.

Ausblendstatus Wird im Modus Teil und Baugruppe unterstützt. Die Konfigurationsdatei-
Optionen intf_out_blank_entities  und intf_in_blanked_entities  schalten den
Import/Export von Elementen mit dem Status Ausblenden um.

Linienstärke Wird nur im Modus Zeichnung unterstützt.

Farbe Der Import von Farben aus einer IGES-Datei wird für folgende IGES-Codes
unterstützt:

IGES-Code Farbe Pro/ENGINEER Farbe

8 Weiß Geometrie

5 Gelb Bemassung

2, 6 Rot Hervorheben

4, 7 Blau Kante hervor

`^ao^Jbñéçêí=~âíáîáÉêÉå
Im Modus Zeichnung können Sie den CADRA-Export mit der Konfigurationsdatei-Option
Éå~ÄäÉ|Å~Çê~|Éñéçêí aktivieren. Dem Menü AUSGABE wird damit der Befehl CADRA
hinzugefügt, so daß Sie eine IGES-Datei in der CADRA-Spezifikation erstellen können.  

Hinweis: Sie können im Modus Zeichnung Folien mit 2D-Elementen exportieren.

råíÉêëíΩíòíÉ=fdbpJbäÉãÉåíÉ=ÄÉáã=bñéçêí=~ìë=ÇÉã
jçÇìë=wÉáÅÜåìåÖ
Die folgende Tabelle zeigt eine Liste der 2D-IGES-Elemente, die Sie im Modus Zeichnung exportieren
können.

IGES-Element Konfigurationsdatei-Option, die den

Export steuert

Type Name Form

100 Kreisförmiger Bogen

106 Copious Data 11 — Polylinien
31 — Schnitt
40 — Hilfslinie
63 — Einfache
geschlossene ebene
Kurve

108 Klipp-Ebenen

110 Line

116 Punkt. iges_out_dwg_pnt_ent

124 Transformationsmatrix
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202 Winkelbemaßung

206 Durchmesserbemaßung

210 Allgemeine Kennung

212 Allgemeine Notiz

214 Hilfslinie (mit Pfeil)

216 Lineare Bemaßung

218 Ordinatenbemaßung

222 Radius Bemaßung

228 Allgemeines Symbol iges_out_symbol_entity

230 Geschnittener Bereich

304 Linienartdefinition iges_in_dwg_line_font

314 Farbdefinition iges_out_dwg_color

404 Zeichnung

406 Eigenschaftselement 15 — Name
16 — Zeichnungsgröße
17 —
Zeichnungseinheiten

410 Ansichtselemente

fdbpJdêìééÉå
Eine IGES-Gruppe ist eine Zusammenstellung von Zeichnungsnotizen und Modellkanten, die einer
bestimmten Zeichnungsansicht und Komponente angehören und im Zielsystem einander zugeordnet
werden.

Verwenden Sie die Konfigurationsdatei-Option áÖÉë|Éñéçêí|Çïè|îáÉïë zum Ersetzen der IGES-
Gruppe. Setzen Sie diese Option auf yes, erhalten alle Elemente, die mit einer bestimmten Ansicht in
Beziehung stehen, dieselbe Ansichts-ID in der IGES-Datei.

IGES-Gruppen werden als IGES-Assoziativitätselementtyp 402, Form 7 exportiert. Obgleich IGES diesen
Gruppen keine besondere Assoziativität zuordnet, werden sie von einigen empfangenden Systemen
unterstützt und erhalten eine besondere Bedeutung (d.  h. als Elemente oder Komponenten usw.). Mit einer
Pro/DETAIL Lizenz können Sie IGES-Gruppen erzeugen.

Pro/ENGINEER exportiert IGES-gruppierte Ansichtselemente (nur 2D-Ansichten) für folgende
Elementtypen: 108, 404, 406:15, 406:16, 406:17 und 410. Wenn Sie über eine Pro/LEGACY Lizenz
verfügen und die Konfigurationsdatei-Option iges_in_dwg_view auf yes gesetzt ist, können Sie die
Ansicht unter Verwendung von 2D-Ansichten verändern, indem Sie sie bewegen oder den Maßstab ändern.
Bemaßungen, die in diesen Ansichten erzeugt wurden, entsprechen automatisch dem Ansichtsmaßstab.
Anmerkungen auf Zeichnungsblättern werden zur IGES-Überlagerungsansicht referenziert.

Beachten Sie bei der Auswahl von Elementen für eine IGES-Gruppe die folgenden Regeln:

� In einem Teil müssen Modellkanten, kosmetische KEs und Umrißkanten aus der gleichen Ansicht des
gleichen Bauteils stammen. Die Anwahl eines Bauteils eines kosmetischen KE wählt alle Teile dieses
KE aus.

� In einer Baugruppe müssen alle Elemente zum gleichen Baugruppen-Bauteil gehören, das in der
gleichen Ansicht dargestellt wird.

� Standard-Notizen oder Ballonnotizen können aus einer beliebigen Ansicht stammen oder unverknüpft
sein.

� Folien können zu einer Gruppe hinzugefügt werden.
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pç=ÉêòÉìÖÉå=páÉ=fdbpJdêìééÉå
1. Wählen Sie in einer Zeichnung die Befehlsfolge Spezialelemente > IGES-Gruppen > Erzeugen

(Advanced > IGES Groups > Create).
2. Geben Sie einen Namen für die IGES-Gruppe ein und wählen Sie eine Zeichnungsansicht in einer

Teilezeichnung oder ein Baugruppenelement in einer Baugruppenzeichnung, aus der Sie Elemente
auswählen möchten.

3. Wählen Sie einen der Befehle im Menü AUSWAHL OPTION (SEL OPTION):
� Element (Sel Items) – Dient zur Auswahl von Elementen durch Klicken auf dem Bildschirm.

Diese Elemente werden beim Anklicken hervorgehoben.

� Folien ausw (Sel Layers) – Dient zur Auswahl von Elementen durch Klicken einer Folie, zu der
sie gehören. Wählen Sie den Foliennamen im Menü FOLIE AUSW (LAYER SEL). Eine IGES-
Gruppe kann mehr als eine Folie enthalten.

� Kette (Sel Chain) – Erzeugt eine Gruppe, die aus einer Kantenkette besteht, indem das erste und
das letzte Element in der Kette angegeben werden. Um zwischen den Kanten der Kette
umzuschalten, verwenden Sie im Menü AUSWAHL (CHOOSE) die Befehle Naechst. (Next) und
Vorig. (Previous). Wählen Sie zum Abschluß den Befehl Akzeptieren (Accept).

4. Nachdem Sie Ihre Auswahl getroffen haben, bestätigen Sie mit Fertig Ausw (Done Sel).

pç=ÄÉ~êÄÉáíÉå=páÉ=fdbpJdêìééÉå
1. Wählen Sie in einer Zeichnung die Befehlsfolge Spezialelemente > IGES-Gruppen > Editieren

(Advanced > IGES Groups > Edit).
2. Geben Sie den Namen einer Gruppe ein, und klicken Sie auf das Häkchen, oder drücken Sie die

EINGABETASTE, um abzubrechen.
3. Wählen Sie einen der Befehle im Menü AUSWAHL OPTION (SEL OPTION):

� Element (Sel Items) – Fügt Elemente einer Gruppe hinzu oder entfernt sie aus der Gruppe.
Wählen Sie einen der folgenden Befehle im Menü IGES-GRUPPE (EDIT IGES GP):

Elem hinzuf (Add Items) – Fügt ausgewählte Elemente der aktuellen Gruppe hinzu.
Entf Element (Remove Items) – Entfernt ausgewählte Elemente aus der aktuellen Gruppe.

� Folien ausw (Sel Layers) – Dient zum Ändern von Folien in der Gruppe. Deaktiviert die Folien,
die Sie entfernen wollen, bzw. aktiviert die Folien, die Sie zur aktuellen IGES-Gruppen hinzufügen
wollen.

� Kette (Sel Chain) – Dient zum Hinzufügen einer Kantenkette durch Angabe des ersten und letzten
Elements in der Kette.

4. Bestätigen Sie Ihre Auswahl mit Fertig Ausw (Done Sel).

pç=ä∏ëÅÜÉå=páÉ=fdbpJdêìééÉå
1. Wählen Sie in einer Zeichnung die Befehlsfolge Spezialelemente > IGES-Gruppen > Loeschen

(Advanced > IGES Groups > Delete).
2. Geben Sie den Namen einer vorhandenen Gruppe an, die gelöscht werden soll, oder drücken Sie die

EINGABETASTE, um abzubrechen.
3. Geben Sie v ein, um die Gruppe zu löschen, oder k, um das Löschen der Gruppe abzubrechen.

pç=äáëíÉå=páÉ=fdbpJdêìééÉå=~ìÑ
Wählen Sie zum Auflisten der in der aktuellen Zeichnung vorhandenen IGES-Gruppen im Menü IGES
GRUPPEN (IGES GROUPS) den Befehl Auflisten (List). Das System gibt die vorhandenen Gruppen in
einem Informationsfenster aus.
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pç=ÉñéçêíáÉêÉå=páÉ=wÉáÅÜåìåÖÉå=áå=ÉáåÉ=fdbpJ
wÉáÅÜåìåÖëÇ~íÉá
Durch Angabe der Schnittstellenqualität können Sie bestimmen, ob eine IGES-Zeichnung überlappende
Elemente enthalten wird.

1. Wählen Sie in einer Zeichnung die Befehlsfolge Datei > Kopie speichern (File > Save a Copy). Es
erscheint das Dialogfenster Kopie speichern (Save a Copy).

2. Wählen Sie in der Liste Typ (Type) die Option IGES (*.igs).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Die Voreinstellung ist <òÉáÅÜåìåÖëå~ãÉ>KáÖë oder

<òÉáÅÜåìåÖëå~ãÉ>|@KáÖë, wobei @ für die Blattnummer in einer Zeichnung mit mehreren
Blättern steht. Sie müssen jeweils für jedes einzelne Blatt der Zeichnung eine eigene IGES-Datei
erzeugen.
Hinweis: Beim Export von Sonderzeichen, die nicht von IGES unterstützt werden, werden diese
Zeichen auf dem empfangenden System als Striche gezeichnet.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=fdbpJa~íÉå=áå=ÉáåÉ
wÉáÅÜåìåÖ=áãéçêíáÉêÉå
Die Initial Graphics Exchange Specification (IGES) überträgt Grafik- und Textdaten zwischen CAD-
Systemen. Pro/ENGINEER unterstützt IGES 5.2 und alle früheren Versionen von IGES für den Import.

Beachten Sie beim Einlesen von IGES-Daten in eine Zeichnung folgendes:

� Die untere linke Ecke der Zeichnung ist der Ursprung für 2D-Elemente in der Zeichnung. Wenn eine
IGES-Datei in die Zeichnung eingelesen wird, wird diese auch relativ zum Zeichnungsursprung
plaziert.

� 2D-Elemente werden mit den in der Zeichnungs-Konfigurationsdatei vorgegebenen Daten erzeugt.
Wenn z.  B. in der Zeichnungs-Konfigurationsdatei die Einheiten auf Inch eingestellt sind und die
IGES-Daten in Millimetern vorliegen, werden die IGES-Elemente bei der Übersetzung zu Inch
konvertiert. Z.  B. würden aus 25.4 mm in der IGES-Datei 1 Inch in der Zeichnung.

� Normalerweise werden Einträge in der Zeichnungs-Konfigurationsdatei nicht mit den Werten der
IGES-Datei überschrieben. Pfeilgröße und -stil, Textgröße und parallel/horizontale Bemaßungen sind
Bespiele für Bereiche, wo es zu Unterschieden kommen kann.

� Beim Import von Zeichnungen können manche Linienstile unterschiedlich erscheinen. Beispielsweise
können beim Import aus CATIA Punkte wie Striche aussehen und Leerstellen größer erscheinen.

� Wenn die Befehle Aendern (Modify) und Wert (Value) für eine importierte Bemaßung gewählt
werden, dann werden Sie in den Änderungsmodus (Aendern > Text > Zeile (Modify > Text > Line)
gebracht, um die gewählte Textzeile der Bemaßung zu bearbeiten. IGES stellt nicht den Wert einer
Bemaßung als einen Parameter dar, sondern unterstützt nur die grafische Darstellung des Zahlenwerts.
Daher enthält der angezeigte Text eine eingefügte Markierung "@O" (oh) am Ursprung der Textzeile.

Diagramme, Zeichnungen, Formate, Entwürfe und Berichte
IGES-Dateien mit Geometrie und Anmerkungen können in ein Diagramm, eine 2D-Zeichnung, ein Format,
ein Layout oder in einen Bericht importiert werden. IGES-Dateien mit 3D-Modellelementen verwenden
zum Plazieren der Geometrie in der Zeichnung die Ansichtsdefinitionen. Die resultierenden Elemente sind
2D-Zeichnungselemente.

Beachten Sie folgendes beim Importieren von IGES-Dateien, die Geometrie und Anmerkungen enthalten:

� IGES-Gruppen können beim Import auf verschiedenen Folien plaziert werden. Dazu müssen Sie die
Konfigurationsdatei-Option áÖÉë|áå|Öêçìé|íç|ÇïÖ|ä~óÉê auf óÉë setzen.
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� Sie können auch mit Hilfe des Dienstprogrammes proigsutil eine Reihe von IGES-Dateien nach
Pro/ENGINEER importieren.

� Wenn das Format der importierten IGES-Zeichnungen einer Standard-Zeichnungsgröße entspricht
(Hoch- oder Querformat), wird das richtige Zeichnungsformat automatisch ausgewählt.

råíÉêëíΩíòíÉ=OaJfdbpJbäÉãÉåíÉ=ÄÉáã=fãéçêí=áã
jçÇìë=wÉáÅÜåìåÖ
Die folgende Tabelle enthält die 2D-IGES-Elemente, die Sie im Modus Zeichnung importieren können.

IGES-Element Konfigurationsdatei-

Option, die den Import

steuert

Type Name Form

100 Kreisförmiger Bogen

102 Verbundkurve

104 Konischer Bogen

106 Copious Data 11, 12 Polylinien

20 – Mittellinie durch Punkte

21 – Mittellinie durch

Kreismittelpunkte

–31-38 – Schnitt

40 – Hilfslinie

63 – Einfache geschlossene

ebene Kurve

108 Ebene

110 Line

112 Parametrische Splinekurve

116 Punkt. iges_in_dwg_pnt_ent

124 Transformationsmatrix

126 Rationale B-Splinekurve

202 Winkelbemaßung

206 Durchmesserbemaßung

210 Allgemeine Kennung

212 Allgemeine Notiz

214 Hilfslinie (mit Pfeil)

216 Lineare Bemaßung

218 Ordinatenbemaßung

222 Radius Bemaßung

228 Allgemeines Symbol iges_out_symbol_entity

230 Geschnittener Bereich

302 Assoziativitätsdefinition

308 Unterabbildungsdefinition

304 Linienartdefinition iges_in_dwg_line_font

314 Farbdefinition iges_in_dwg_color

320 Netzwerk-

Unterabbildungsdefinition

402 Assoziativitäts-Variante 3 – Ansichten sichtbar
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4 – Ansichten sichtbar, Farbe,

Linienstärke

13 – Bemaßte Geometrie

21 – Bemaßte Geometrie (ersetzt

Form 13)

404 Zeichnung

406 Eigenschaftselement 15 — Name

16 — Zeichnungsgröße

17 — Zeichnungseinheiten

408 Variante einzelner

Unterelemente

410 Ansicht

pç=áãéçêíáÉêÉå=páÉ=OaJfdbpJa~íÉáÉå=áã
wÉáÅÜåìåÖëãçÇìë
1. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) (keine Datei geöffnet) oder Einfuegen >

Daten aus Datei (Insert > Data from File) (Diagramm, Zeichnung, Format, Layout oder Berichtdatei
geöffnet). Das Dialogfenster Datei oeffnen (File Open) oder Oeffnen (Open) wird aufgerufen.

2. Wählen Sie in der Liste Typ (Type) die Option IGES (*.igs). Die IGES-Dateien im Arbeitsverzeichnis
werden aufgeführt.

3. Klicken Sie auf den Namen der gewünschten 2D IGES-Datei, oder durchsuchen Sie die Verzeichnisse
nach der IGES-Datei, und wählen Sie sie aus.

4. Mit OK können Sie eine neue IGES-Datei erzeugen bzw. das geöffnete Diagramm, die Zeichnung, das
Format, das Layout oder die Berichtdatei anhängen.
a. Soll die importierte IGES-Datei an eine vorhandene Datei angehängt werden, wird die neue

angehängte Datei erstellt.

b. Wenn Sie ein neues Modell erzeugen, wird das Dialogfenster Neues Modell importieren (Import

New Model) aufgerufen. Klicken Sie auf Zeichnung (Drawing). Aktivieren oder deaktivieren Sie
das Kontrollkästchen Ansichten importieren (Import Views).

Hinweis: Wenn Sie das Kontrollkästchen Ansichten importieren (Import Views) deaktivieren,
wird die Zeichnung ohne Ansichten und ohne 3D-Modell importiert.

Abhängig von der Größe der importierten Zeichnung tritt einer der folgenden Fälle ein:
� Wenn die Größe der importierten Zeichnung nicht mit der Größe einer Standard-Zeichnung in

Pro/ENGINEER übereinstimmt, werden automatisch die abweichenden Zeichnungsblätter anhand
der Größenangaben aus der importierten IGES-Datei erzeugt. Falls die Größe der importierten
IGES-Zeichnungsdatei nicht ermittelt werden kann, erfolgt der Import in die Standard-
Zeichungsgröße von Pro/ENGINEER.

� Wenn die importierte Zeichnung die gleiche Größe hat wie die Pro/ENGINEER Zeichnung, wird
der Ursprung der importierten Zeichnung automatisch in der linken unteren Ecke (Formatursprung)
plaziert. In diesem Fall erscheint keine Eingabeaufforderung.

Hinweise:

Wenn die importierte Geometrie nicht entsprechend der gewählten Zeichnungsgröße skaliert
wurde, können Sie später das Zeichnungsformat durch eine geeignetere Größe ersetzen.
Beim Import von IGES-Dateien im Modus Zeichnung werden die IGES-Gruppen in
Pro/ENGINEER Folien mit dem Namen fdbp|dom|YòÉáäÉååìããÉê=ÇÉê=fdbpJ
dêìééÉ[ umgewandelt.
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fdbpJ^åëáÅÜíÉåä~óçìíë=áãéçêíáÉêÉå
Erzeugen Sie eine neue Pro/ENGINEER Zeichnung durch das Importieren einer 2D-IGES-Datei mit 3D-
Ansichten und 3D-Modellinformationen, so erzeugt Pro/ENGINEER ein Modell und eine Zeichnung, die
das Modell verwendet, um die jeweiligen Ansichten darzustellen. Dies ist der Fall, wenn Sie nur ein neues
Modell erzeugen (Datei > Oeffnen (File > Open)), nicht wenn Sie an ein vorhandenes Modell anhängen
(Einfuegen > Daten aus Datei (Insert > Data From File)). Beim Importieren einer 2D IGES-Datei
geschieht folgendes:

� Sind IGES-Ansichten im importierten 2D IGES-Modell vorhanden, wird eine Zeichnung ohne 2D- oder
3D-Ansichten erzeugt.

� Falls IGES-Ansichten, jedoch keine IGES 3D-Modelldefinition vorhanden sind, wird eine Zeichnung
mit 2D-Ansichten erstellt.

� Sind IGES-Ansichten und eine IGES 3D-Modelldefinition vorhanden, werden ein Modell und eine
Zeichnung mit den entsprechenden 3D-Ansichten erzeugt.

Hinweis: Wenn Sie das Kontrollkästchen Ansichten importieren (Import Views) deaktivieren, wird die
Zeichnung ohne Ansichten und ohne 3D-Modell importiert.

pç=áãéçêíáÉêÉå=páÉ=PaJfdbpJa~íÉáÉå
Sie können 3D-IGES-Daten in ein Teil oder eine Baugruppe importieren. Sie können auch eine Reihe von
IGES-Dateien mit Hilfe des Dienstprogramms proigsutil nach Pro/ENGINEER importieren (nur unter
UNIX).

1. Wenn das IGES-Teil bzw. die IGES-Baugruppe mit Folien verknüpft ist und Sie Änderungen am
Importstatus der Folien vornehmen wollen, setzen Sie die Konfigurationsdatei-Option
áåíÑ|áå|ä~óÉê|~ëã|Çá~äçÖë in der Datei config.pro auf óÉë, damit das Dialogfenster
Folienimport-Optionen (Layer Import Options) beim Import angezeigt wird.

2. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) (ohne eine geöffnete Datei) oder
Einfuegen > Daten aus Datei (Insert > Data From File) (mit einer geöffneten Datei). Das
Dialogfenster Datei oeffnen (File Open) oder Oeffnen (Open) wird aufgerufen.

3. Wählen Sie in der Liste Typ (Type) die Option IGES (*.igs). Eine Liste der IGES-Dateien im
Arbeitsverzeichnis wird angezeigt.

4. Klicken Sie auf den Namen der gewünschten 3D IGES-Datei, oder durchsuchen Sie die Verzeichnisse
nach der IGES-Datei, und wählen Sie sie aus.

5. Klicken Sie auf Oeffnen (Open). Gehen Sie zu Schritt 6, wenn Sie die IGES-Daten zum Erzeugen
eines neuen Teils oder einer Baugruppe verwenden. Gehen Sie zu Schritt 7, wenn Sie die IGES-Datei
an ein offenes Teil oder eine offene Baugruppe anhängen.

6. Es erscheint das Dialogfenster Neues Modell importieren (Import New Model). Vervollständigen Sie
das Dialogfenster, und klicken Sie auf OK. Im Informationsfenster wird der fdbp
YÇ~íÉáå~ãÉ[KäçÖ-Dateiname angezeigt. Wenn das IGES-Bauteil bzw. die IGES-Baugruppe mit
Folien verknüpft ist, wird das Dialogfenster Folienimport-Optionen (Layer Import Options)

aufgerufen.
a. Schließen oder mininieren Sie das Informationsfenster.

b. Klicken Sie im Dialogfenster Layoutoptionen (Layer Options) auf OK, oder nehmen Sie die
notwendigen Änderungen vor, und klicken Sie auf OK, um die IGES-Datei zu importieren.

7. Im Informationsfenster wird der fdbp=YÇ~íÉáå~ãÉ[KäçÖ-Dateiname angezeigt. Wenn das IGES-
Bauteil bzw. die IGES-Baugruppe mit Folien verknüpft ist, wird das Dialogfenster Folienimport-

Optionen (Layer Import Options) aufgerufen.
a. Schließen oder mininieren Sie das Informationsfenster.

b. Klicken Sie im Dialogfenster Layoutoptionen (Layer Options) auf OK, oder nehmen Sie die
notwendigen Änderungen vor, und klicken Sie auf OK. Das Dialogfenster Volumenkoerper-

Optionen und Plazierung (Choose Solid Options and Placement) wird geöffnet. Befehl:
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Koerper (Protrusion), um einen Volumenkörper aus der importierten Geometrie zu erzeugen und
zur vorhandenen Teilegeometrie hinzuzufügen.
MatSchnitt (Cut), um anhand der vorhandenen Geometrie einen Materialschnitt in der
vorhandenen Geometrie zu erzeugen.
Flaechen (Surfaces), um die importierte Geometrie in Form von mehreren Sammelflächen
darzustellen. Benachbarte Flächen wenn möglich verbinden.

c. Schließen Sie die Auswahl im Dialogfenster Volumenkoerper-Optionen und Plazierung

(Choose Solid Options and Placement) ab, und klicken Sie auf OK, um das importierte KE zu
akzeptieren.

Enthält die IGES-Datei eine vollständig berandete Gruppe von Sammelflächen (Flächen), kann das System
ein Volumen aus dem importierten KE erzeugen oder es als eine Gruppe von Sammelflächen belassen.

mêçÑáäÉ=áãéçêíáÉêÉå
Importieren Sie eine IGES-, STEP- oder CATIA-Datei mit ebenen Verbundkurven in ein Pro/ENGINEER
Teil oder eine Pro/ENGINEER Baugruppe, können Sie die ebenen Verbundkurven zur Verwendung für die
Funktionserstellung in Bezugskurven konvertieren. Zur Steuerung dieser Funktion setzen Sie die
Konfigurationsdatei-Option áåíÑ|áå|Éñíê~Åí|éêçÑáäÉë=auf:

None – (die Standardeinstellung) Profilkurven werden bei einem Import nicht extrahiert.

Comp – Nur ebene Verbundkurven importieren.

All – Alle ebenen Kurven importieren.

fãéçêíáÉêÄ~êÉ=bäÉãÉåíÉ=áå=ÇÉå=jçÇá=qÉáäI
_~ìÖêìééÉ=ìåÇ=wÉáÅÜåìåÖ
Die folgende Tabelle enthält die Elemente, die in den Modi Teil, Baugruppe oder Zeichnung importiert
werden können.

==IGES-Typ IGES-Name IGES-

Form

Referenz Resultat in

Pro/ENGINEER

100 Kreisförmiger
Bogen

Unabhaengig Bogenelement

Ref. durch 142 Flächenkante

Ref. durch 102 Bogen einer Verbundkurve

102 Verbundkurve Unabhaengig Verbundkurve

Ref. durch 142 Kanten einer Fläche

104 Konischer Bogen Unabhaengig Splinekurve

Ref. durch 142 Flächenkante

Ref. durch 102 Spline in einer Verbundkurve

106 Copious Data 2 Unabhaengig Bei Einstellung von
iges_in_106_f2_as_spline auf

no – Punktelemente

yes – Spline

11 Ref. durch 142 Kanten einer Fläche

12 Unabhaengig Verbundkurve aus linearen
Segmenten

63 Ref. durch 142 Kanten einer Fläche
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108 Ebene 1 Ebene Fläche mit
Außenberandung

-1 Innenberandung einer ebenen
Fläche (ein Loch in einer
Ebene)

0 Unabhaengig Bezugsebene.

110 Line Unabhaengig Linienelement

Ref. durch 142 Flächenkante

Ref. durch 102 Komponente einer
Verbundkurve

112 Parametrischer
Spline

Unabhaengig Splinekurve

Unabhaengig Splinekurve

Ref. durch 142 Kante(n) einer Fläche

Ref. durch 102 Spline in einer Verbundkurve

114 Splineflächen Unabhaengig Kubische Splinefläche(n)

Ref. durch 144 Getrimmte Splinefläche(n)

116 Punkt. Unabhaengig Punktelement

118 Regelflächen Unabhaengig Regelflächenelement

Ref. durch 144 Getrimmte Regelfläche(n)

120 Gedrehte Fläche Unabhaengig Gedrehtes Flächenelement

Ref. durch 144 Getrimmte gedrehte Fläche(n)

122 Tabulierter Zylinder Unabhaengig Fläche eines tabulierten
Zylinders

Ref. durch 144 Getrimmte Fläche eines
tabulierten Zylinders

124 Transformation 0, 1 Ref. durch * Element * wird transformiert

126 B-Splinekurve Unabhaengig Splinekurve(n)

Ref. durch 142 Flächenkante

Ref. durch 102 Spline(s) in einer C-Kurve

128 Rationale B-

Splineflächen

Unabhaengig Splinefläche(n)

Ref. durch 144 Getrimmte Splineflächen

141 Berandung Ref. durch 143 Kanten getrimmter Fläche(n)

142 Kurve auf Fläche Ref. durch 144 Kanten getrimmter Fläche(n)

143 Begrenzte Fläche Unabhaengig Getrimmte Fläche(n)

144 Getrimmte Fläche Unabhaengig Getrimmte Fläche(n)

208 Kennzeichen-
Notizelement

Unabhaengig Notiz mit einem Kennzeichen

314 Farbdefinition Unabhaengig Kurven und Flächen, die
dieses Element referenzieren,
können (nach dieser
Definition) eingefärbt
werden.

402 Assoziativitäts-
Variante

1, 7, 14,
15

Unabhaengig IGES-Gruppenelemente
können beim Import in eine
Pro/ENGINEER Zeichnung
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auf einer separaten Folie
plaziert werden.

7 Erzeugt eine Folie in Teilen
oder Baugruppen.

21 Unabhaengig Wenn die
Konfigurationsdatei-Optionen
iges_in_assoc_dim_ge

om_21 und
associative_dimensio

ning in der
Konfigurationsdatei für
Zeichnungen auf yes gesetzt
sind, wird der Import
bemaßter Geometrie für
radiale, Durchmesser- und
Ordinatenbemaßungen
unterstützt. Sind diese
Optionen auf no gesetzt,
erfolgen importierte
Bemaßungen nicht assoziativ.

410 Ansicht Unabhaengig Benannte Ansicht des
Modells

pç=áãéçêíáÉêÉå=páÉ=fdbpJa~íÉáÉå=áã=jçÇìë=pâáòòÉ
IGES-Dateien, die 2D-Kurvengeometrie enthalten, können im Modus Skizze importiert werden.

Die meisten IGES-Dateien enthalten keine Bemaßungen; ist dies aber der Fall, so besteht keine
Assoziativität zwischen den Bemaßungen und der Geometrie. Deshalb müssen die meisten importierten
IGES-Dateien im Modus Skizze bemaßt werden. Wird jedoch die Assoziativität zwischen Bemaßungen
und Geometrie hergestellt, versucht Pro/ENGINEER, dieses Bemaßungsschema zu verwenden.

1. Wählen Sie die Befehlsfolge Datei > Neu (File > New). Das Dialogfenster Neu (New) wird aufgerufen.
2. Wählen Sie die Befehlsfolge Skizze > OK (Sketch > OK), um eine Datei im Modus Skizze zu öffnen.
3. Wählen Sie die Befehlsfolge Skizze > Daten aus Datei (Sketch > Data from File). Das Dialogfenster

Oeffnen erscheint.
4. Wählen Sie in der Liste der verfügbaren Dateien die IGES-Datei aus, die Sie importieren wollen.
5. Wählen Sie OK, um die IGES-Datei zu erzeugen.
6. Nachdem die 2D-Elemente in Ihrem Skizzenfenster angezeigt werden, können Sie Elemente und

Bemaßungen hinzufügen oder löschen.
Hinweis: Beim Importieren einer IGES-Datei geht Pro/ENGINEER davon aus, daß die IGES-Datei nur
2D-Elemente in der xy-Ebene enthält, und führt keine Fehlerprüfung durch. Es werden keine Unterbilder
und Unterbild-Varianten in den Modus Skizze übernommen.
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hçåÑáÖìê~íáçåëÇ~íÉáJléíáçåÉå=òìê=råíÉêëíΩíòìåÖ
ÇÉë=fãéçêíë=îçå=fdbpJa~íÉáÉå
Die folgende Tabelle enthält eine Liste der Konfigurationsdatei-Optionen in der Datei config.pro, die den
Import von IGES-Dateien in Zeichnungen, Formate, Layouts, Teile und Baugruppen unterstützen.

Import-Option Zeichnung Teil Baugruppe

edge_display_quality yes yes yes

explode_iges_dimension_note yes

auto_associate_dimensions yes

fix_autocad_iges_text_scale yes

fix_boundaries_on_import yes

fix_catia_iges_sym_note yes

fix_imported_set_view_orient yes

iges_clip_view_note yes

iges_in_dwg_color yes

iges_in_assoc_dim_geom_21 yes

iges_in_dwg_line_font yes

iges_in_dwg_pnt_ent yes

iges_in_dwg_view yes

iges_in_group_to_dwg_layer yes

iges_note_disp yes

iges_zero_view_disp yes

recompute_iges_dim_value yes

intf_in_blanked_entities  yes yes

iges_in_106_f2_as_spline  yes yes

intf3d_in_close_open_boundaries  yes yes

intf3d_in_include_items  yes yes

intf_in_extract_profiles

intf_in_treat_polyline_as yes yes

pç=ÉñéçêíáÉêÉå=páÉ=c~êÄÉå=áã=jçÇìë=wÉáÅÜåìåÖ
Sie können Farben im Modus Zeichnung exportieren.

Wenn Sie die Konfigurationsdatei-Option áÖÉë|çìí|áå|ÇïÖ|Åçäçê auf åç (Voreinstellung) setzen,
werden die benutzerdefinierten Farben in der Zeichnung beim Exportieren einer IGES-Datei ignoriert und
alle Elemente, die diese Farben referenzieren, so eingestellt, daß sie in der IGES-Datei die Farbe Weiß
verwenden. Bei Einstellung dieser Option auf yes werden die benutzerdefinierten Farben in die IGES-
Datei als Farbdefinitionselemente exportiert, und alle Elemente, die diese Farben verwenden, erhalten einen
Verweis auf das entsprechende Farbdefinitionselement in der IGES-Datei.
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káÅÜí=ìåíÉêëíΩíòíÉ=c~êÄÉå
Mit dieser Option können Sie alle benutzerdefinierten Farben außer den folgenden definieren:

� Geometrie (Weiß, IGES-Farbcode 8)

� Bemaßung (Gelb, IGES-Farbcode 5)

� Hervorhebung (Rot, IGES-Farbcode 2, 6)

� Kantenhervorhebung (Blau, IGES-Farbcode 4, 7)

c~êÄÉå=áã=jçÇìë=wÉáÅÜåìåÖ=áãéçêíáÉêÉå
Sie können Farben in den Modi Zeichnung, Teil und Baugruppe importieren.

Mit der Konfigurationsdatei-Option áÖÉë|áå|ÇïÖ|Åçäçê können Sie die Farbnummer für alle
Elemente mit benutzerdefinierten Farben in der IGES-Datei so einstellen, daß sie auf ein entsprechendes
Farbdefinitionselement verweist. Wenn Sie diese Option auf no (Voreinstellung) setzen, werden die
Farbdefinitionselemente in der IGES-Datei beim Importieren der Zeichnung ignoriert, und jedes Element,
das auf diese Farben verweist, wird so eingestellt, daß es die Farben verwendet, die dem
Farbdefinitionselement zugewiesen werden. Bei der Einstellung auf yes werden die
Farbdefinitionselemente der IGES-Datei in die Zeichnung als benutzerdefinierte Farben importiert und alle
Elemente, die diese Farben verwenden, darauf eingestellt.

c~êÄÉå=áå=ÇÉå=jçÇá=qÉáä=ìåÇ=_~ìÖêìééÉ
áãéçêíáÉêÉå
Sie können Farben in den Modi Zeichnung, Teil und Baugruppe importieren.

Sie können Farben von IGES-Kurven und -Flächen sowohl nach Standard (Rot, Grün, Blau, Gelb,
Magenta, Cyan) als auch benutzerdefiniert importieren. Beim Import werden die farbigen Flächen und
Kurven auf benannten Folien plaziert. Die Namenskonvention für Folien ist wie folgt:

� Für Standardfarben — INTF_<FARBE>, wobei <FARBE> für einen der folgenden Werte steht: RED,
GREEN, BLUE, YELLOW, MAGENTA, CYAN.

� Für benutzerdefinierte Farben (IGES-Element 314, Farbe) — Falls der Name der Farbe vorhanden ist,
ergibt sich der Folienname aus dem Farbnamen (z.  B. "BLUE"). Wenn der Name der Farbe nicht
angegeben ist, dann erhält die Folie den Namen INTFCLR_<XXX>, wobei <XXX> die IGES-ID des
Farbelements ist.

cçêã~í=îçå=kÉìíê~äÇ~íÉáÉå
Eine Neutraldatei besteht aus ASCII-Textzeilen. Das Format umfaßt folgende Elemente:

� Beginnt eine Zeile mit dem Zeichen #, handelt es sich um einen Kommentar.

� Zeilen ohne das Zeichen # weisen folgende Form auf:

� Ebene Feld Wert (level field value)

� Dabei gilt:

� Ebene eine ganze Zahl ist

� Feld ein Name ist

� Wert eine Zeichenkette ist, die vorhanden sein kann.

� Ein Feld muß eine der folgenden Angaben enthalten:

� Den Namen eines einfachen Datentyps (ganze Zahl, Zeichenkette, reelle Zahl usw.)

� Den Namen eines Array
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� Den Namen einer Struktur

� Den Namen eines Zeigers auf eine Struktur

� Alle Felder einer bestimmten Ebene gehören zu demselben Elternelement.

� Wenn ein Wert auf einer bestimmten Ebene vorhanden ist und mit der linken rechteckigen Klammer
beginnt ([) oder aus einer Reihe durch Kommas getrennten Zahlen besteht, bedeutet das, daß das Feld
ein Array der Bemaßung [n]([m] ...) ist. Die Elementwerte des Arrays befinden sich auf den Zeilen
Ebene+1 nach oben bis zur nächsten Zeile, die als Ebene beginnt.

� Bei eindimensionalen Arrays befindet sich nur eine Zeile auf der höchsten Ebene, deren Wert eine
durch Kommas getrennte Zeichenkette von Elementwerten ist.

� Die Angabe < n*m> bedeutet, daß <n> Elemente jeweils den Wert <m> aufweisen.

� Wenn auf einer bestimmten Ebene ein Wert vorhanden ist (der nicht aus der Zeichenkette -> besteht),
ist dies der Wert, der dem Feld zugeordnet wird.

� Ist auf einer bestimmten Ebene kein Wert vorhanden, heißt das, daß das Feld eine Struktur ist.
Unmittelbare Elemente des Aggregats befinden sich auf den Zeilen Ebene+1 nach oben bis zur
nächsten Zeile, die als Ebene beginnt.

� Die Zeile, deren Feld die Zeichenkette ugc_xar_len enthält, ist ein Sonderfall und gibt an, daß die
nächste Zeile mit der Beschreibung eines Arrays mit einem Längenwert beginnt.

� Wenn es sich bei dem Wert um die Zeichenkette -> handelt, ist das Feld ein Zeiger auf ein Aggregat,
dessen Elemente folgen.

� Der spezielle Wert NULL bedeutet, daß das Feld ein Zeiger mit dem Wert Null ist.

a~íÉåÑçêã~í=îçå=qÉáäÉÉäÉãÉåíÉå
Jedes Teileelement enthält eine Liste der verbundenen Flächen, Kanten, KEs und Abmessungen sowie die
Namen aller Dateien, die Informationen zu dem Teil aufweisen, wie Maßtabellen, Baugruppen, zu denen
das Teil gehört, oder Zeichnungsdateien.

Datenformat:

surfaces [ ] (Flächen)
quilts [ ] (Sammelflächen)
edges [ ] (Kanten)
datum_curves [ ] (Bezugskurven)
datum_planes [ ] (Bezugsebenen)
coord_systems [ ] (Koordinatensysteme)
attributes [ ] (Attribute)
layers [ ] (Folien)
dimensions [ ] (Bemaßungen)
features [ ] (KEs)
geometric_tolerances [ ] (geometrische Toleranzen)
colors [ ] (Farben)
views [ ] (Ansichten)
xsecs [ ] (Querschnitte)
accuracy [ ] (Genauigkeit)

a~íÉåÑçêã~í=îçå=ÖÉíêáããíÉå=cä®ÅÜÉå
Die Struktur der getrimmten Flächen enthält Daten, die die Berandung der Fläche und die Ausgangsfläche,
auf der sie sich befindet, beschreiben. Die Ausgangsfläche ist eine dreidimensionale geometrische Fläche,
die durch zwei Variablen (u und v) parametrisiert wird. Die Berandung der getrimmten Fläche besteht aus
geschlossenen Schleifen (Konturen) von Kanten. Kanten treten als gesonderte Elemente in der Neutraldatei
auf. Jede Kante ist mit zwei Flächen verbunden und enthält die Werte u und v des Teils der Berandung, den
sie in beiden Flächen bildet. Flächenberandungen sind im Uhrzeigersinn um die Außenseite der Fläche
geschnitten, so daß die Richtung der Kante in jeder Fläche vom Schnitt abhängt.
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Sie finden noch weitere Daten in den Strukturen getrimmter Flächen, einschließlich der rechteckigen
Ausdehnung der zweidimensionalen Domäne, der dreidimensionalen Fläche und einer Markierung mit der
Angabe, ob die Flächennormale zur Innen- oder Außenseite des Teiles zeigt.

Datenformat:

==ID (int) Flächen-ID

uv_min[2] (dbl) Minimale u und v Werte der Domäne

uv_max[2] (dbl) Maximale u und v Werte

xyz_min[3] (dbl) Minimale Werte eines die Fläche
umschließenden Feldes

xyz_max[3] (dbl) Maximale Werte eines rechteckigen
Feldes

orient (int) 1 wenn die Flächennormale zur
Außenseite des Teiles zeigt.

-1 wenn Sie zur Innenseite zeigt.

loops[] (loop) Erweiterbares Array von
Schleifenstrukturen

surface_type (int) Konstante, die den Typ der
Ausgangsfläche angibt.

Flaeche (surface
structure)

Datenstruktur der 3D-Ausgangsfläche

=

Strukturformat der Schleifendaten:

ÉÇÖÉ|áÇëx=zEáåíF=^êê~ó=ÇÉê=h~åíÉåJfaë=áå=ÇÉê=pÅÜäÉáÑÉ

Die 3D-Struktur der getrimmten Fläche weist für jeden Flächentyp ein anderes Format auf. Das
Strukturformat der Ausgangsfläche wird unten beschrieben.

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=bÄÉåÉå
Das Ebenenelement besteht aus zwei senkrechten Einheitsvektoren (e1 und e2) — der Senkrechten zur
Ebene (e3) und dem Ursprung der Ebene. Die folgende Abbildung zeigt ein Ebenenelement.

ÉP

ÉN

ÉO

Datenformat:

=

e1[3] (dbl) Einheitsvektor in Richtung u

e2[3] (dbl) Einheitsvektor in Richtung v

e3[3] (dbl) Senkrechte zur Ebene

origin[3] (dbl) Ursprung des lokalen
Koordinatensystems
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=

Parametrisierung:

(x, y, z) = u * e1 + v * e2 + origin

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=wóäáåÇÉêå
Die Generierungskurve eines Zylinders ist eine Linie parallel zur Achse, mit einer Entfernung R zur Achse.
Der Radialabstand eines Punktes ist konstant, und die Höhe des Punktes ist v. Die folgende Abbildung
zeigt einen Zylinder.

ÉO
ÉP

ÉN

o

Datenformat:

=

e1[3] (dbl)

e2[3] (dbl)

e3[3] (dbl)

origin[3] (dbl) Ursprung des lokalen
Koordinatensystems

R (dbl) Radius des Zylinders
=

Parametrisierung:

EñI=óI=òF=Z=o=G=xÅçëEìF=G=ÉN=H=ëáåEìF=G=ÉOz=H=î=G=ÉP=H=çêáÖáå

Für den Zylinder, den Kegel, den Torus und die allgemeine Drehfläche wird ein lokales Koordinatensystem
aus drei orthogonalen Einheitsvektoren (e1, e2 und e3) und einem Ursprung verwendet. Die Kurve liegt auf
der Ebene von e1 und e3 und dreht sich in der Richtung von e1 nach e2. Der Flächenparameter u bestimmt
den Drehwinkel, und der Parameter v bestimmt die Position des Punktes auf der Generierungskurve.

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=hÉÖÉäå
Die Generierungskurve eines Kegels besteht aus einer Linie mit einem Winkel � zur Drehachse, die die
Achse im Ursprung schneidet. Der Bereich von Winkel � ist beschränkt. Der Parameter v ist die Höhe des
Punktes entlang der Achse, und der Radialabstand des Punktes ist v * tan(�). Die folgende Abbildung zeigt
einen Kegel.
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e2

e3

e1

a

Datenformat:

==e1[3] (dbl)

e2[3] (dbl)

e3[3] (dbl)

origin[3] (dbl) Ursprung des lokalen
Koordinatensystems

a (dbl) Der Winkel zwischen der Kegelachse
und der Generierungslinie.

=

Parametrisierung:

(x, y, z) = v * tan(�) * [cos(u) * e1 + sin(u) * e2] + v * e3 + origin

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=oáåÖÉå=EqçêìëF
Die Generierungskurve eines Torus besteht aus einem Bogen mit einem Radius R2, dessen Mitte sich in
einem Abstand R1 vom Ursprung befindet. R1 kann nicht gleich Null sein. Der Startpunkt des
Generierungsbogens befindet sich in einem Abstand R1 + R2 vom Ursprung, in der Richtung des ersten
Vektors des lokalen Koordinatensystems. Der Radialabstand eines Punktes auf dem Torus ist R1 + R2 *
cos(v), und die Höhe des Punktes entlang der Drehachse ist R2 * sin(v). Die folgende Abbildung zeigt
einen Torus.

ÉOÉP

ÉN

oO

oN

Datenformat:

=

e1[3] (dbl)

e2[3] (dbl)

e3[3] (dbl)

origin[3] (dbl) Ursprung des lokalen
Koordinatensystems

R1 (dbl) Abstand von der Mitte des
Generierungsbogens zur Drehachse.
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R2 (dbl) Radius des Generierungsbogens
=

Parametrisierung:

(x, y, z) = (R1 + R2 * cos(v)) * [cos(u) * e1 + sin(u) * e2] + R2 * sin(v) * e3 + origin

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=~ääÖÉãÉáåÉå
aêÉÜÑä®ÅÜÉå
Zum Erzeugen einer allgemeinen Drehfläche drehen Sie ein Kurvenelement, in der Regel einen Spline, um
eine Achse. Die Kurve wird an einem normalisierten Parameter v berechnet und der resultierende Punkt
wird in einem Winkel u um die Achse gedreht. Die Datenstruktur der Drehfläche besteht aus einem lokalen
Koordinatensystem und einer Kurvenstruktur. Die Kurve muß eben sein: die x-Koordinate muß größer oder
gleich Null und die y-Koordinate muß Null sein. Die folgende Abbildung zeigt eine Drehfläche.

ÉO

ÉP

ÉN

ÅEîF

Datenformat:

=

e1[3] (dbl)

e2[3] (dbl)

e3[3] (dbl)

origin[3] (dbl) Ursprung des lokalen
Koordinatensystems

C (curve
structure)

Generierungskurve

=

Parametrisierung:

C (v) = (c1, c2, c3) ist ein Punkt auf der Kurve.
(x, y, z) = [c1 * cos(u) - c2 * sin(u)] * e1 + [c1 * sin(u) + c2 * cos(u)] * e2 + c3 * e3 + origin

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=oÉÖÉäÑä®ÅÜÉå
báåÉ=oÉÖÉäÑä®ÅÜÉ=ïáêÇ=îçã=póëíÉã=ÖÉåÉêáÉêíI=áåÇÉã=ÉåíëéêÉÅÜÉåÇÉ=mìåâíÉ=~ìÑ=òïÉá
hìêîÉåÉäÉãÉåíÉå=äáåÉ~ê=áåíÉêéçäáÉêí=ïÉêÇÉåK=aáÉ=hççêÇáå~íÉ=ì=áëí=ÇÉê=åçêã~äáëáÉêíÉ=m~ê~ãÉíÉêI
~å=ÇÉã=ÄÉáÇÉ=hìêîÉå=~ìëÖÉïÉêíÉí=ïÉêÇÉåK=aáÉ=hççêÇáå~íÉ=î=áëí=ÇÉê=äáåÉ~êÉ=m~ê~ãÉíÉê=òïáëÅÜÉå
ÇÉå=ÄÉáÇÉå=mìåâíÉåK=aáÉ=hìêîÉå=ïÉêÇÉå=åáÅÜí=áã=äçâ~äÉå=hççêÇáå~íÉåëóëíÉã=ÇÉë=qÉáäë=ÇÉÑáåáÉêíI
ÇÉëÜ~äÄ=ãì≈=ÇÉê=êÉëìäíáÉêÉåÇÉ=mìåâí=~åÜ~åÇ=ÇÉë=äçâ~äÉå=hççêÇáå~íÉåëóëíÉãë=ÇÉê=cä®ÅÜÉ
ìãÖÉï~åÇÉäí=ïÉêÇÉåK=aáÉ=ÑçäÖÉåÇÉ=^ÄÄáäÇìåÖ=òÉáÖí=ÉáåÉ=oÉÖÉäÑä®ÅÜÉK
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ÉO
ÉP

ÉN

ÅN

ÅO

Datenformat:

=

e1[3] (dbl)

e2[3] (dbl)

e3[3] (dbl)

origin[3] (dbl) Ursprung des lokalen
Koordinatensystems

C1 (curve
structure)

Erste Generierungskurve

C2 (curve
structure)

Zweite Generierungskurve

=

Parametrisierung:

(x', y', z') ist der Punkt in lokalen Koordinaten
(x', y', z') = (1 - v) * C1(u) + v * C2(u)
(x, y, z) = x' * e1 + y' * e2 + z' * e3 + origin

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=í~ÄìäáÉêíÉå=wóäáåÇÉêå
Ein tabulierter Zylinder wird durch lineare Projektion einer Kurve durch einen Raum berechnet. Die Kurve
wird an einem Parameter u ausgewertet, und die z-Koordinate wird um den Parameter v versetzt. Der
resultierende Punkt wird in lokalen Koordinaten ausgedrückt und muß für die Darstellung in
Teilekoordinaten mit dem lokalen Koordinatensystem umgewandelt werden. Die folgende Abbildung zeigt
einen tabulierten Zylinder.

ÉO

ÉP

ÉN

ÅEìF

Datenformat:

=

e1[3] (dbl)

e2[3] (dbl)

e3[3] (dbl)
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origin[3] (dbl) Ursprung des lokalen
Koordinatensystems

C (curve
structure)

Generierungskurve

=

Parametrisierung:

(x', y', z') ist der Punkt in lokalen Koordinaten
(x', y', z') = C(u) + (0, 0, v)
(x, y, z) = x' * e1 + y' * e2 + z' * e3 + origin

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=sÉêêìåÇìåÖëÑä®ÅÜÉå
Sie finden Verrundungsflächen dort, wo sich eine Rundung oder Verrundung auf einer gekrümmten Kante
befindet oder an Kanten mit nichtkonstanten Bogenradii. Auf geraden Kanten stellen Sie die Verrundung
eher mit einem Zylinder dar. Die folgende Abbildung zeigt eine Verrundungsfläche.

.

mEîF

`EîF

î

ìZN

ìZM

ì

qEîF

Datenformat:

=

pnt_spline Spline P(v) entlang der Berandung u = 0

ctr_spline Spline C(v) entlang der Mitte der
Verrundungsbögen

tan_spline Spline T(v) der Einheiten-Tangenten zur Achse
der Verrundungsbögen

=

Parametrisierung:

R(v) = P(v) - C(v)
(x,y,z) = C(v) + R(v) * cos(u) + T(v) X R(v) * sin(u)

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=péäáåÉÑä®ÅÜÉå
Die parametrische Splinefläche ist eine nichtgleichförmige, doppelkubische Splinefläche, die durch ein
Gitter mit Tangentialvektoren in jedem Punkt verläuft. Das Gitter ist in jedem Raum uv krummlinig. Die
folgende Abbildung zeigt eine Splinefläche.

î|é~ê|~êêxMz

ì|é~ê|~êêxMz

î|é~ê|~êêxkîJNz

ì|é~ê|~êêxkîJNz
`ìîá

áHNI

`ìá

`îá

=àHN

áHN

î

ì
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Datenformat:

=

u_par_arr[] Punktparameter, in Richtung u, von der Größe
Nu

v_par_arr[] Punktparameter, in Richtung v, von der Größe
Nv

point_arr[][3] Array von interpolaren Punkten, von der Größe
Nu � Nv

u_tan_arr[][3] Array von Tangentialvektoren u an interpolaren
Punkten, von der Größe Nu � Nv

v_tan_arr[][3] Array von Tangentialvektoren v an interpolaren
Punkten, von der Größe Nu � Nv

uvder_arr[][3] Array von gemischten Differentialen an
interpolaren Punkten, von der Größe Nu � Nv

=

Parametrisierung:

� Ermöglicht ein eindeutiges Polynom 3�3 um jede Einzelfläche.

� Die Einzelflächenberandungen weisen eine Kontinuität der zweiten Ordnung auf.

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=òóäáåÇêáëÅÜÉå
péäáåÉÑä®ÅÜÉå
Die zylindrische Splinefläche ist eine nichtgleichförmige, doppelkubische Splinefläche, die durch ein Gitter
mit Tangentialvektoren in jedem Punkt verläuft. Das Gitter ist in jedem Raum uv krummlinig. Die folgende
Abbildung zeigt eine zylindrische Splinefläche.

N

O
r2

r4

rc

rd

r3

r1

ra

rb

1 Kegelfläche S1

2 Zylinderfläche, S0 Spline
Datenformat:

=

e1[3] Vektor x' des lokalen Koordinatensystems

e2[3] Vektor y' des lokalen Koordinatensystems

e3[3] Vektor z' des lokalen Koordinatensystems, der
Drehachse der Fläche entspricht

origin[3] Ursprung des lokalen Koordinatensystems
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SplFlae Datenstruktur der Splinefläche
=

Die Datenstruktur der Splinefläche enthält die folgenden Felder:

=

u_par_arr[] Punktparameter, in Richtung u, von der Größe
Nu

v_par_arr[] Punktparameter, in Richtung v, von der Größe
Nv

point_arr[][3] Array von Punkten, in zylindrischen
Koordinaten, von der Größe Nu � Nv Die
Komponenten des Array sind:

point_arr[i][0] — Radius

point_arr[i][1] — Theta

point_arr[i][2] — Z

u_tan_arr[][3] Array von Tangentialvektoren, in zylindrischen
Koordinaten, von der Größe Nu � Nv

v_tan_arr[][3] Array von Tangentialvektoren v, in
zylindrischen Koordinaten, von der Größe Nu �
Nv

uvder_arr[][3] Array von gemischten Differentialen, in
zylindrischen Koordinaten, von der Größe Nu �
Nv

=

Konstruktionshinweise:

Wenn die Fläche in zylindrischen Koordinaten (r, Theta, z) dargestellt wird, werden die Systemwerte der
lokalen Koordinaten  (x', y', z') folgendermaßen interpretiert:

� x' = r cos (Theta)

� y' = r sin (Theta)

� z' = z

Sie erhalten eine zylindrische Splinefläche beispielsweise, indem Sie einen glatten Rotations-
Verbundkörper (wie in der Abbildung auf der vorhergehenden Seite) erzeugen. In einigen Fällen können
Sie eine zylindrische Splinefläche durch eine Fläche, wie eine Ebene, einen Zylinder oder einen Kegel,
ersetzen. Die Abbildung unter "Zylindrische Splineflächen" zeigt eine zylindrische Splinefläche S1, die
durch einen Kegel (r1=r2, r3=r4 und r1r3) ersetzt wird.Falls Sie sie nicht ersetzen können (wie bei der
Fläche S0 in der Abbildung "Zylindrische Splineflächen" (a�rb or rc�rd)), belassen Sie sie als zylindrische
Splinefläche.
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_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=kro_pJcä®ÅÜÉå
Pro/ENGINEER definiert NURBS-Flächen durch Grundfunktionen (in u und v), erweiterbare Arrays von
Knoten, Gewichtungen und Steuerpunkten. Die folgende Abbildung zeigt eine kubische NURBS-Fläche.

c00

c01

c02 c12
c13

c23

c11

c10

c31

c20

c03 c21

c30

c22

c32 c33

Datenformat:

=

deg[2] Grad der Grundfunktionen (in u und v)

u_par_arr[] Knotenarray auf der Parameterlinie u

v_par_arr[] Knotenarray auf der Parameterlinie v

wghts[] Array von Gewichtungen für rationale NURBS,
andernfalls NULL

c_point_arr[][3] Array von Steuerpunkten
=

Definition:

k = Grad in u
   l = Grad in v
   N1 = Zahl der Knoten in u, Grad in u -2
   N1 = Zahl der Knoten in v, Grad in v -2
   Bi,k = Grundfunktion in u
   Bj,l = Grundfunktion in v
   wi,j = Gewichtungen
   Ci,j = Steuerpunkte (x,y,z) * wi,j

Die Gewichtungen und Arrays c_points_arr stellen Matrizen der Größe wghts[N1+1] [N2+1] und
c_points_arr [N1+1] [N2+1] dar. Die Elemente der Matrizen sind in Arrays in der Reihenfolge der
wichtigsten Zeilen zusammengefaßt.

a~íÉåÑçêã~í=îçå=h~åíÉåÉäÉãÉåíÉå
Das Kantenelement enthält Daten zur Berandung zwischen zwei getrimmten Flächen. Diese Daten
enthalten IDs der beiden Flächen, die Richtung der Kante in bezug auf den im Uhrzeigersinn verlaufenden
Schnitt der Flächenberandungen und die uv-Punkte des Berandungssegments, dargestellt durch die Kante in
jeder Fläche. Die uv-Punkte sind in Vierergruppen zusammengefaßt. Das erste Punktepaar besteht aus den
u- und v-Koordinaten der Kante in Fläche 1, das zweite Paar besteht aus den Koordinaten der Kante in
Fläche 2. Jede Kante wird durch die gleiche Zahl von Punkten in beiden Flächen dargestellt und enthält ein
entsprechendes Kurvenelement in seinem Datenabschnitt. Die IDs der beiden Flächen sind fortlaufend.
Einzelne Kurven werden im folgenden beschrieben.
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Kantentopologiedaten
Kantentopologiedaten umfassen alle Daten, die beschreiben, wie eine Kante einen bestimmten
Berandungsteil zwischen zwei Flächen darstellt.

Datenformat:

=

surface_ids[2] (int) Identifiziert mit der Kante verbundene
Flächen

direction[2] (int) Kantenrichtung in jeder Fläche. 1,
wenn die Kante in derselben Richtung
wie die Flächenberandung verläuft; -
1, wenn sie in der entgegengesetzten
Richtung verläuft.

uv_points[ ][4] (dbl) Array von Berandungspunkten

uv_points[i][0] = u in Fläche 1

uv_points[i][0] = u in Fläche 1

uv_points[i][0] = u in Fläche 2

uv_points[i][3] = v in Fläche 2

curve_type (int) Von der Kurve dargestellter
Kurventyp

Kurve (curve
structure)

Entsprechende 3D-Kurve

uv_curves [2] (component
structure)

Kurven auf jeder Seitenfläche

 

a~íÉåÑçêã~í=îçå=hìêîÉå
Sie können jede Kante durch eine dreidimensionale Kurve darstellten, die durch den normalisierten
Parameter bestimmt wird. Die folgende Tabelle enthält die Datenformate der Kurventypen.

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=iáåáÉå
Datenformat:

=

end1[3] (dbl) Startpunkt der Linie

end2[3] (dbl) Endpunkt der Linie
=

Parametrisierung:

(x, y, z) = (1 - t) * end1 + t * end2

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=_∏ÖÉå
Ein Bogenelement wird durch die Ebene definiert, auf der sich der Bogen befindet. Der Bogen wird um den
Ursprung zentriert und mit dem Drehwinkel von dem ersten Einheitsvektor der Ebene in der Richtung des
zweiten Ebenenvektors parametrisiert. Die Start- und Endwinkelparameter des Bogens und der Radius
werden ebenfalls angegeben. Der Bogen verläuft gegen den Uhrzeigersinn, wenn der Startwinkel kleiner
als der Endwinkel ist. Andernfalls verläuft er im Uhrzeigersinn.



INTERFACE126

Datenformat:

=

vector1[3] (dbl) Definiert die Ebene des Bogens

vector2[3] (dbl) Definiert die Ebene des Bogens

origin[3] (dbl) Definiert die Ebene des Bogens

start_angle (dbl) Winkelparameter des Startpunkts

end_angle (dbl) Winkelparameter des Endpunkts

radius (dbl) Radius des Bogens
=

Parametrisierung:

t', der nicht normalisierte Parameter, ist (1 - t) * start_angle + t * end_angle
(x, y, z) = radius * [cos(t') * vector1 + sin(t') * vector2] + origin

_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=péäáåÉë
Die Splinekurve ist ein nichtgleichförmiger, kubischer Spline, der durch eine Reihe dreidimensionaler
Punkte, Tangentialvektoren an jedem Punkt und einem Array von nichtnormalisierten Splineparametern an
jedem Punkt definiert wird.

Datenformat:

=

params [] (dbl) Array von Splineparametern (t) an
jedem Punkt

points [][3] (dbl) Array von interpolaren Splinepunkten

tangents[][3] (dbl) Array von Tangentialvektoren an
jedem Punkt

=

Parametrisierung:

1. x, y und z sind Reihen eindeutiger kubischer Funktionen, jeweils einer pro Segment, die vollständig
durch die Start- und Endpunkte und Tangenten jedes Segments bestimmt werden.

2. p_max ist der Parameter des letzten Splinepunkts. Dann ist t', der nichtnormalisierte Parameter: t *
p_max.

3. Legen Sie das Splinesegment so fest, daß:
par_arr[i] < t' < par_arr[i+1]
(wenn t < 0 oder t > +1, dann verwenden Sie das erste oder das letzte Segment).
14. t0 = (t' - par_arr[i])   / (par_arr[i+1] - par_arr[i])
t1 = (par_arr[i+1] - t') / (par_arr[i+1] - par_arr[i])
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_ÉáëéáÉäW=a~íÉåÑçêã~í=îçå=kro_p
NURBS-(nichtgleichförmige rationale B-Splines-)-Kurven werden durch erweiterbare Knotenarrays,
Gewichtungen und Steuerpunkte definiert. Die folgende Abbildung zeigt eine kubische NURBS-Kurve.

c0 c1

c2

c3

Datenformat:

=

degree Grad der Grundfunktion

params[] Knotenarray

weights[] Array von Gewichtungen für rationale NURBS;
andernfalls NULL oder 1,0 für polynomen B-
Spline.

c_pnts[][3] Array von Steuerpunkten
=

Definition:

k = Grad der Grundfunktion
N = Anzahl von Knoten, Grad -2
wi = Gewichtungen
Ci = Steuerpunkte (x, y, z) * wi
Bi,k = Grundfunktionen

Nach dieser Gleichung ist die Anzahl der Steuerpunkte gleich N+1.

Referenzen:

I.D. Faux, M.J. Pratt, Computational Geometry for Design and Manufacture, Ellis Harwood Publ., 1983

M.E. Mortenson, Geometric Modeling, John Wiley & Sons, 1985

a~íÉåÑçêã~í=îçå=_Éã~≈ìåÖÉå
Teilen zugeordnete Bemaßungen haben das folgende Format:

=

dimensions {Ndim} In der Listen-Kopfzeile

Bemassungen Für jede Ndim-Bemaßung

Name

Wert

tol_plus

tol_minus
=
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a~íÉåÑçêã~í=îçå=hbJbäÉãÉåíÉå
KE-Elemente werden in aufeinanderfolgender Reihenfolge in der Neutraldatei aufgeführt. Vor den
einzelnen Datenblöcken eines KE-Elements befindet sich jeweils eine Kommentarzeile mit dem Namen des
KEs (beispielsweise Durchgangsbohrung, Rundung oder Nutmuster). Anschließend folgt der KE-Kopf mit
der Konstante des KE-Typs und die ID des KE. Die KE-Daten bestehen aus KE-Attributen, KE-
Bemaßungen und IDs verbundener Elemente. Die Liste der mit dem KE verbundenen Bemaßungen enthält
die Textkennung der symbolischen Bemaßung und den Wert der Bemaßung. Ferner ist eine Liste der
Flächen-IDs des KE enthalten.

Datenformat:

=

KEs {Nfeats} In der Listen-Kopfzeile

Name des KE Kommentarzeile

ID (int) KE-ID

user_name Breite Zeichenkette

unterdrueckt (int) 1, wenn das KE unterdrückt ist

0, wenn nicht

dim_ids[] (int) Array von Indizes verbundener
Bemaßungen

surface_ids[] (int) Array von IDs von KE-Flächen

edge_ids[] (int) Array von IDs von KE-Kanten

misc_ids[] (int) Array von IDs verschiedener
Elemente; Sammelflächen, XYZ-
Elementen

=

a~íÉåÑçêã~í=îçå=ÖÉçãÉíêáëÅÜÉå=qçäÉê~åòÉå
In der Neutraldatei werden die folgenden Informationen zu geometrischen Toleranzen, die mit einem Teil
verbunden sind, gespeichert: Toleranzklasse und -typ, mit der Toleranz verbundene KE-ID (und
gegebenenfalls Referenz-ID; falls keine Referenz-ID-Nummer verwendet wird, entspricht sie der KE-ID),
der Wert der Toleranz, Materialbedingungen und Bezugsreferenzinformationen (falls verwendet).

Datenformat:

geometric_tolerance {Ntols} In der Listen-Kopfzeile

geometric_tolerance

tol_class

tol_type

feat_id

ref_type

ref_id

Wert

matl_cond

(verwendete Bezugsreferenzen)

...

geometric_tolerance

...
=
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a~íÉåÑçêã~í=îçå=j~ëëÉåïÉêíÉå
Die Massewerte eines Objekts bestehen aus der Versionsnummer, für die sie gültig sind, dem Volumen, der
Dichte und dem Schwerpunkt des Objekts und dem Trägheitsmoment an der x-,y- und z-Achse des
Objekts.

Datenformat:

=

revnum (int) Versionsnummer des Objekts

volume (dbl) Volumen des Objekts

density (dbl) Durchschnittliche Dichte des Objekts

c_of_grav[3] (dbl) Schwerpunkt des Objekts

inertia_x[3] (dbl) Trägheitsmomente um die x-Achse

inertia_y[3] (dbl) Trägheitsmomente um die y-Achse

inertia_z[3] (dbl) Trägheitsmomente um die z-Achse
=

a~íÉåÑçêã~í=îçå=kÉìíê~äÇ~íÉáÉå=òì=_~ìÖêìééÉå
Hinweis: Wenn Sie eine Neutraldatei zu einer Baugruppe erzeugen, werden nicht automatisch gesonderte

Neutraldateien zu den Bauteilen erzeugt.
Die Massewerte einer Baugruppe haben dasselbe Datenformat wie die Massewerte eines Teils.

Datenformat:

=

revnum (int) Versionsnummer der Baugruppe

massprops Massewerte der Baugruppe

member[] Array von Strukturen der
Baugruppenteile

=

a~íÉåÑçêã~í=îçå=_~ìÖêìééÉåãáíÖäáÉÇÉêå
Jedes Baugruppenteil besteht aus dem Typ des Teils (Teil oder Baugruppe), dem Namen des
Komponententeils oder der Komponentenbaugruppe, und der Transformationsmatrix vom
Komponentenkoordinatensystem in das Baugruppenkoordinatensystem.

Datenformat:

=

Typ (int) Teil oder Baugruppe

Name (char) Name des Teils oder der Baugruppe

e1[3] Transformationsmatrix vom
Komponentenkoordinatensystem in
das Baugruppenkoordinatensystem

e2[3]

e3[3]

origin[3] (dbl)
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§ÄÉê=ÇáÖáí~äáëáÉêíÉ=báåÖ~ÄÉå
Mit der Digitalisierung über ein Tablett können Sie Punkt-, Linien- und Bogendaten von vorhandenen
Zeichnungen und Layouts für den Import nach Pro/ENGINEER erzeugen.

Pro/ENGINEER unterstützt die folgenden Tabletts für die Digitalisierung von Daten auf einer IBM
RS/6000-Workstation:

� Calcomp 33240

� Calcomp 95602

pç=áãéçêíáÉêÉå=páÉ=a~íÉå=~ìë=ÇÉã
aáÖáí~äáëáÉêí~ÄäÉíí
1. Erzeugen Sie eine Zeichnung in der entsprechenden Größe.
2. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File

Open) wird aufgerufen.
3. Wählen Sie in der Liste Typ (Type) die Option Tablett (Tablet).
4. Wenn Sie den Digitalisiermodus eingeben, werden Icons für alle Fenster von Pro/ENGINEER erzeugt

und ein Fenster wird mit den Ergebnissen der Digitalisiereingabe angezeigt.
5. Geben Sie den Maßstab und die Einheiten für die importierten Daten an.
6. Kalibrieren Sie das Tablett, damit die Software Dehnungen, Verwerfungen oder Neigungen der zu

digitalisierenden Zeichnung berücksichtigen kann.
7. Wenn ein Fadenkreuz die Position des Pucks auf dem Tablett anzeigt, können Sie mit dem

Digitalisieren der Daten beginnen.
Sie können jederzeit in einen anderen Modus wechseln, um die digitalisierten Daten neu zu kalibrieren oder
neu zu skalieren.

wìë~ããÉåÑ~ëëìåÖ=ÇÉê=q~ÄäÉííçéíáçåÉå
Die folgende Tabelle enthält eine Übersicht aller Tablettoptionen.

T  1:  Referenztabelle für Schaltflächen

 

Modus: Schaltflaeche Aktion

Masstab 1-9 Gibt Höhen- und Breitendaten ein.

A Wechselt zur vorherigen Eingabe im Menü.

B Wechselt zur nächsten Eingabe im Menü.

C Schaltet in den nächsten Modus um.

F Bringt Sie zurück in den Eingabemodus.

Kalibrieren
(Calibration)

0 Wählt den Punkt auf dem Tablett. Hebt die Position auf dem
Kalibrierungsraster hervor, die dem Punkt am nächsten liegt.

1 Verschiebt die hervorgehobene Position um einen Rasterpunkt
nach oben.

3 Bestätigt die Auswahl des Rasterpunkts.

5 Bricht die Auswahl des Rasterpunkts ab.

6 Verschiebt die hervorgehobene Position um einen Rasterpunkt
nach rechts.

9 Verschiebt die hervorgehobene Position um einen Rasterpunkt
nach unten.
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C Schaltet in den nächsten Modus um.

F Bringt Sie zurück in den Eingabemodus.

Einlesen 0 Beginnt eine Linienkette; erzeugt einen Punkt. Wählen Sie mit
der Schaltfläche 7 einen vorhandenen Punkt aus. Wird bei
Abfragen zum Bestätigen von Löschungen verwendet.

1 Verschiebt die Anzeige nach oben.

2 Setzt die Ansicht auf die Anzeige eines gesamten kalibrierten
Bereichs zurück.

3 Hält die Kettenerzeugung an. Wird bei Abfragen zum
Abbrechen eines Prozesses verwendet.

4 Verschiebt die Anzeige nach links.

5 Zentriert die Ansicht auf dem Bildschirm.

6 Verschiebt die Anzeige nach rechts.

7 Vereint zwei Ketten. Wählt mit 0 den ersten Endpunkt einer
Kette, dann mit 0 den Endpunkt, der verbunden werden soll.

8 Beginnt eine Linienkette. Erzeugt einen Punkt; verwenden Sie
Schaltfläche 7, um einen vorhandenen Punkt auszuwählen.
Wird bei Abfragen zum Bestätigen von Löschungen
verwendet.

9 Verschiebt die Anzeige nach unten.

A Verkleinert die Anzeige um den Faktor 2.

B Vergrößert die Anzeige um den Faktor 2.

C Schaltet in den nächsten Modus um.

D Löscht einen Punkt. Hebt den Punkt hervor, der dem Cursor
am nächsten liegt. Verwenden Sie nach einer Abfrage
Schaltfläche 0 zum Löschen und Schaltfläche 3 zum
Beibehalten.

E Löscht eine Kette von Liniensegmenten. Der Cursor muß an
dem Punkt auf der Kette liegen. Verwenden Sie nach einer
Abfrage Schaltfläche 0 zum Löschen und Schaltfläche 3 zum
Beibehalten.

F Beendet die Tabletteingabe. Verwenden Sie nach einer
Abfrage Schaltfläche 0 zum Bestätigen des Beendens und
Schaltfläche 3 zum Beibehalten des Digitalisiermodus.

=

pç=ÄÉíêÉíÉå=páÉ=ÇÉå=pâ~äáÉêãçÇìë
1. Wechseln Sie im Digitalisiermodus in den Skaliermodus, indem Sie die Schaltfläche C drücken.
2. Geben Sie die Höhe und Breite der Zeichnung ein, die digitalisiert werden soll. Wenn Sie die

Zeichnung skalieren, geben Sie, wie im obigen Beispiel beschrieben, die Skalierwerte ein.
� Verwenden Sie für die Eingabe der Höhen- und Breitenwerte die Schaltflächen 0–9, und geben Sie

mit D ein Dezimalzeichen ein.

� Schalten Sie mit der Schaltfläche A zur nächsten Option um.

3. Geben Sie die Einheiten für die Zeichnung ein. Schalten Sie dabei mit 0 zwischen den Einheiten um.
Sie können folgende Werte verwenden:
� Inch

� Millimeter (mm)

� Abstrakt (skaliert die digitalisierten Daten auf die Einheiten der aktuellen Zeichnung)
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4. Drücken Sie die Schaltfläche C, um das Dialogfenster zu schließen. Sie können das Dialogfenster erst
schließen, wenn alle Einträge vorgenommen wurden. Drücken Sie die Schaltfläche F, um den
Skaliermodus zu beenden.

pâ~äáÉêãçÇìë
Im Skaliermodus können Sie die Höhe und Breite des zu digitalisierenden Bereichs und die Einheiten der
digitalisierten Daten angeben. Diese Eingabe ermöglicht Ihnen, Daten zu skalieren oder Daten automatisch
in andere Einheiten zu konvertieren. Wenn die Zeichnung auf dem Tablett z.B. die Größe C hat und Sie sie
in die Größe A skalieren möchten, geben Sie für die Höhe [8.5] und für die Breite [11] ein. Die
digitalisierten Daten werden von der Größe C so herabgesetzt, daß die Bemaßungen auf ein Blatt der Größe
A passen. Dementsprechend können Sie digitalisierte Daten größer skalieren.

pç=â~äáÄêáÉêÉå=páÉ=q~ÄäÉííë
1. Legen Sie die Zeichnung auf das Tablett. Befestigen Sie sie gut, damit sie sich bei der Digitalisierung

nicht verschiebt. Falls sie sich verschiebt, gehen zwar keine Daten verloren, Sie sollten das Tablett
jedoch nochmals kalibrieren.

2. Wechseln Sie mit der Schaltfläche C in den Kalibriermodus.
3. Wählen Sie mit der Schaltfläche A den Kalibriertyp aus. Wählen Sie Einfach (Simple) für eine lineare

Dehnung in horizontaler und vertikaler Richtung. Digitalisieren Sie die untere linke, die obere linke und
die untere rechte Ecke (das erforderliche Minimum für die Positionierung der Zeichnung auf dem
Tablett). Wählen Sie Netz (Mesh) für eine Verwerfung oder nichtlineare Dehnung der Zeichnung.
Geben Sie die Anzahl der zu kalibrierenden horizontalen und vertikalen Punkte an. Die folgende
Abbildung zeigt eine Netzkalibrierung.

4. Drücken Sie die Schaltfläche C, wenn Sie den entsprechenden Kalibriertyp im Dialogfenster anzeigen.
Geben Sie bei der Auswahl von Netz (Mesh) die Anzahl der Punkte in vertikaler und horizontaler
Richtung an. Verwenden Sie 0-9 für die Angabe der Höhen- und Breitenwerte, und geben Sie mit D ein
Dezimalzeichen ein.

5. Geben Sie die Anzahl der zu kalibrierenden horizontalen und vertikalen Punkte ein. Bei der einfachsten
Form (2 Punkte in jeder Richtung) kann die lineare Dehnung in horizontaler und in vertikaler Richtung
erfolgen.

6. Digitalisieren Sie zuerst die Punkte für drei Ecken der Zeichnung. Wählen Sie den Punkt mit der
Schaltfläche 0 aus. Der Rasterpunkt, der dem Cursor am nächsten liegt, wird hervorgehoben. Wenn dies
der korrekte Rasterpunkt ist, drücken Sie 0, um zu bestätigen bzw. 3, um abzubrechen. Wenn Sie einen
anderen Rasterpunkt wählen möchten, bewegen Sie die Hervorhebung mit Hilfe der Schaltflächen zu
dem gewünschten Rasterpunkt.

7. Bei der Auswahl von Netz (Mesh) wird ein Raster auf dem Bildschirm angezeigt, das die Ecken jedes
Kalibrierbereichs skizziert. Wählen Sie mit der Schaltfläche 0 ein Kalibrierungszeichen auf der
Zeichnung aus. Der Rasterpunkt, der dem Cursor am nächsten liegt, wird hervorgehoben Wenn dies der
korrekte Rasterpunkt ist, drücken Sie 0, um zu bestätigen bzw. 3, um abzubrechen. Wenn Sie einen
anderen Rasterpunkt wählen möchten, bewegen Sie die Hervorhebung mit Hilfe der Schaltflächen zu
dem gewünschten Rasterpunkt.

8. Fahren Sie mit der Kalibrierung aller Bereiche fort. Drücken Sie zum Abschluß die Schaltfläche C, um
in den nächsten Modus zu wechseln.

h~äáÄêáÉêìåÖëãçÇìë
Im Kalibrierungsmodus stellen Sie das Tablett so ein, daß aus jeder Quellzeichnung genaue Eingabedaten
erzeugt werden. Wenn das Tablett für eine Zeichnung kalibriert wird, können Verwerfungen oder
Neigungen bei der Positionierung der Zeichnung auf dem Tablett ausgeglichen werden. Für die
Kalibrierung einer Zeichnung können Sie einen Bereich auf der Zeichnung angeben und seine Position auf
dem Bildschirm bestätigen. Bei fehlerfreien Zeichnungen können Sie einen großen Bereich (die gesamte
Zeichnung) angeben. Sie können auch für die Kalibrierung kleinerer Zeichnungsbereiche eine beliebige
Anzahl von benutzerdefinierten Gleichheitsbereichen angeben, um Verwerfungen zu verringern.
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pç=ÉêòÉìÖÉå=páÉ=ÉáåÉ=hÉííÉ=~ìë=ÖÉê~ÇÉå
iáåáÉåëÉÖãÉåíÉå
1. Drücken Sie die Schaltfläche 0, um die Kette zu starten.
2. Plazieren Sie das Fadenkreuz des Pucks an den Anfang der Linie, und drücken Sie die Schaltfläche 0.
3. Immer wenn Sie das Fadenkreuz an eine neue Stelle verschieben, dehnt sich die nächste Linie in der

Kette aus. Fahren Sie fort, mit der Schaltfläche 0 Punkte in der Kette hinzuzufügen.
4. Wenn Sie den letzten Punkt in der Kette digitalisiert haben, drücken Sie die Schaltfläche 3.
5. Es wird überprüft, ob die Kette in eine einzelne Linie oder einen Bogen konvertiert werden kann. Die

einzelnen Segmente werden hervorgehoben. Konvertieren Sie mit der Schaltfläche 0 jeweils dieses
Segment der Kette, oder brechen Sie die Konvertierung mit der Schaltfläche 3 ab.
Sie können die Kette in kleinen Teilen konvertieren, oder Sie können mit dem Abbruch der
Konvertierung für jedes Segment fortfahren, bis die gesamte Kette hervorgehoben ist. Wenn Sie die
Hervorhebung mit 0 bestätigen, wird die gesamte Kette in eine Linie oder einen Bogen konvertiert.

Sie können Ketten auch umwandeln, nachdem Sie sie geändert haben, oder über explizite Befehle. Die
Kette ist schwarz, wenn es sich um eine Polylinie gerader Segmente handelt und purpur, wenn es sich um
ein in einen Bogen umgewandeltes Kettensegment handelt.

báåÖ~ÄÉå=ÇáÖáí~äáëáÉêÉå
Während der Digitalisierung werden alle Eingaben auf dem Bildschirm angezeigt. Sie können bei allen
Funktionen des Eingabemodus Daten verschieben/zoomen, um die Daten beim Erzeugen zu überprüfen.

Auch die Skalierfunktion kann jederzeit verwendet werden. Die digitalisierten Punkte werden in den
Tablettkoordinaten beibehalten. Bei einer Änderung des Maßstabs bleiben die tatsächlichen Koordinaten
der vorhandenen digitalisierten Daten deshalb unverändert.

qáéW=hÉííÉå=ãáí=ÉñéäáòáíÉå=_ÉÑÉÜäÉå=âçåîÉêíáÉêÉå
Sie können Ketten auch umwandeln, nachdem Sie sie geändert haben, oder über explizite Befehle. Die
Kette ist schwarz, wenn es sich um eine Polylinie gerader Segmente handelt und purpur, wenn es sich um
ein in einen Bogen umgewandeltes Kettensegment handelt.

pç=ä∏ëÅÜÉå=páÉ=mìåâíÉ
Mit der Schaltfläche D können Sie im Eingabemodus einen einzelnen Punkt oder einen Punkt in einer Kette
löschen. Wenn der Punkt eine Kette definiert, werden auch die angrenzenden Kettensegmente gelöscht.
Liegt der Punkt in der Mitte einer Kette, wird die einzelne Kette in zwei Ketten aufgebrochen.

1. Setzen Sie den Cursor nahe einem Punkt auf der zu löschenden Kette, und drücken Sie die Schaltfläche
D. Der Punkt wird rot hervorgehoben.

2. Verwenden Sie Schaltfläche 0 zum Bestätigen und Schaltfläche 3 zum Abbrechen.

pç=ÇáÖáí~äáëáÉêÉå=páÉ=mìåâíÉ
Sie können einen einzelnen Punkt digitalisieren oder eine Kette aus geraden Liniensegmenten erzeugen.

Wenn Sie einen einzelnen Punkt digitalisieren möchten, drücken Sie zweimal die Schaltfläche 0 und dann
einmal die Schaltfläche 3.

pç=ä∏ëÅÜÉå=páÉ=hÉííÉå
1. Setzen Sie den Cursor nahe einem Punkt auf der zu löschenden Kette, und drücken Sie die Schaltfläche

E. Die Kette wird rot hervorgehoben.
2. Verwenden Sie Schaltfläche 0 zum Bestätigen und Schaltfläche 3 zum Abbrechen.
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pç=îÉêÉáåÉå=páÉ=òïÉá=hÉííÉå
Sie können Ketten vereinen, die zu unterschiedlichen Zeiten erzeugt wurden oder die durch Löschpunkte in
deren Mitte unterbrochen wurden.

1. Plazieren Sie den Cursor auf einem Endpunkt einer Kette, die vereint werden soll, und drücken Sie die
Schaltfläche 0. Der Punkt wird hervorgehoben, und Sie werden aufgefordert, einen weiteren
Kettenendpunkt auszuwählen. Drücken Sie zum Abbrechen der Vereinigung die Schaltfläche 3.

2. Verschieben Sie den Cursor auf einen Endpunkt der anderen Kette. Drücken Sie 0. Die beiden Ketten
werden mit einem neuen Liniensegment zwischen den beiden ausgewählten Endpunkten zu einer Kette
vereint.

pç=âçåîÉêíáÉêÉå=páÉ=hÉííÉå
Mit der Schaltfläche 8 im Eingabemodus können Sie eine Kette in einen Bogen oder eine einzelne gerade
Linie konvertieren. Dadurch können Sie eine Anzahl von Punkten als Bogen digitalisieren oder
gegebenenfalls als lange Linie, um Verwerfungen aufzunehmen. Die Kette können Sie dann in exakte
Elemente konvertieren.

Sie können eine grüne Kette in eine Linie konvertieren und eine violette Kette in einen Bogen.

1. Setzen Sie den Cursor nahe einem Punkt auf der zu konvertierenden Kette, und drücken Sie die
Schaltfläche 8.

2. Wählen Sie im Menü Bogen (Arc) oder Linie (Line).

pç=âçåÑáÖìêáÉêÉå=páÉ=ÇáÉ=f_j=opLSMMM=ÑΩê=`~äÅçãé
1. Schließen Sie das Calcomp-Tablett am seriellen Anschluß der IBM RS/6000 an.
2. Melden Sie sich für die Konfiguration des seriellen Anschlusses als root an.
3. Geben Sie [smit] an der Eingabeaufforderung ein, um das System Management Interface Tool

(SMIT) auszuführen.
4. Das SMIT-Fenster wird angezeigt. Wählen Sie Devices.
5. Wählen Sie TTY in der Geräteliste.
6. Überprüfen Sie bei der Anzeige der TTY-Liste, welche Geräte bereits definiert sind. Ändern oder

erzeugen Sie dann ein Gerät für das Calcomp-Tablett. Fügen Sie hierfür das Gerät hinzu. Wählen Sie
Add a TTY.

7. Wählen Sie tty rs232 Asynchronous Terminal.
8. Wählen Sie den seriellen Anschluß aus, an dem Sie das Calomp-Tablett angeschlossen haben.
9. Vergewissern Sie sich für die TTY-Konfiguration, daß folgende Werte verwendet werden:

� BAUD-Rate—9600

� INPUT map file—none

� OUTPUT map file—none

� CODESET map file—sbcs

� STATE to be configured at boot time—available

10. Wenn die obigen Werte vorliegen, wählen Sie Do. Beim Erzeugen eines Geräts wird die Meldung
tty0 is now available (Das TTY ist nun verfügbar) ausgegeben.

11. Wählen Sie Exit, um das Dienstprogramm SMIT zu beenden.
12. Geben Sie [cd /dev] ein.
13. Geben Sie [ln -s /dev/tty#    caltablet] ein, wobei # die TTY-Nummer des in Schritt

10 erwähnten Tabletts ist.
14. Stellen Sie sicher, daß das Dienstprogramm "getty" nicht ausgeführt wird. Beenden Sie es andernfalls,

indem Sie [pdisable tty#] eingeben. Hierbei ist # die TTY-Nummer des Tabletts.
15. Geben Sie [chmod a+rw /dev/tty#] ein, wobei # die TTY-Nummer des Tabletts ist.
16. Melden Sie sich ab.
17. Melden Sie sich als beliebiger Benutzer an.
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pç=âçåÑáÖìêáÉêÉå=páÉ=q~ÄäÉííë
tÉåå=ÇáÉ=tçêâëí~íáçå=âçåÑáÖìêáÉêí=áëíI=â∏ååÉå=páÉ=Ç~ë=q~ÄäÉíí=ΩÄÉê=ÇáÉ=pÅÜ~äíÉêI=w~ÜäÉå=ìåÇ
_ìÅÜëí~ÄÉå=~å=ëÉáåÉã=çÄÉêÉå=o~åÇ=âçåÑáÖìêáÉêÉåK

1. Schalten Sie das Tablett ein.
2. Wählen Sie mit dem Puck Config auf dem Tablett.
3. Wenn Sie das Fadenkreuz des Pucks über die Buchstaben und Zahlen auf dem Tablett bewegen, geht

der Stromschalter ein und aus. Bei 1 ist der Stromschalter eingeschaltet. Bei 0 ist der Stromschalter
ausgeschaltet.

4. Wählen Sie A unter den Reihenoptionen auf dem Tablett. Konfigurieren Sie das Tablett anhand der
folgenden Tabelle für die Reihenoptionen A.

Konfiguration von Reihe A

Schaltflaeche 1 2 3 4 5 6 7 8 9

Einstellung 1 1 0 1 0 1 0 0 1

Stromschalter on on off on off on off off on
=

Schaltflaeche 10 11 12 13 14 15 16 17 18

Einstellung 1 0 1 0 1 1 1 0 1

Stromschalter on off on off on on on off on
=

5. Wählen Sie B unter den Reihenoptionen auf dem Tablett. Konfigurieren Sie das Tablett anhand der
folgenden Tabelle für die Reihenoptionen B.

Konfiguration von Reihe B

Schaltflaeche 1 2 3 4 5 6 7 8 9

Einstellung 0 0 1 1 0 0 0

Stromschalter off off on on off off off
=

Schaltflaeche 10 11 12 13 14 15 16 17 18

Einstellung 0 0 0 0 0 0 0 0 0

Stromschalter off off off off off off off off off
=

6. Speichern Sie zum Schluß die Konfiguration. Wenn Sie sie auf Nummer 1 speichern, wird das Tablett
automatisch beim Abschalten konfiguriert. Falls Sie sie auf eine andere Nummer speichern, stellen Sie
die Konfiguration vor der Verwendung des Tabletts mit Pro/ENGINEER wieder her.

pç=ÄÉÜÉÄÉå=páÉ=cÉÜäÉê=ÄÉá=ÇÉê=aáÖáí~äáëáÉêìåÖ
In der folgenden Tabelle finden Sie die Fehler, die bei der Digitalisierung entstehen können, deren
mögliche Ursachen und Behebung.

Beschreibung Mögliche Ursache Aufloesung

Der Cursor im
Digitalisierfenster bewegt sich
in der entgegengesetzten
Richtung des Puck.

Das Tablett wurde im
Digitalisiermodus aus- und
eingeschaltet.

Prüfen Sie die
Tablettkonfiguration.
Konfigurieren Sie es
gegebenenfalls neu, und
speichern Sie die Einstellungen.
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Klicken Sie mit der IBM-Maus
in das Digitalisierfenster.

Die digitalisierten Punkte sind
falsch.

Das Tablett wurde aus- und
eingeschaltet.

Stellen Sie die Konfiguration
des Tabletts wieder her. Prüfen
Sie gegebenenfalls die
Tablettkonfiguration.

Sie sind von Pro/ENGINEER
nicht im Digitalisiermodus
eingetragen.

Es ist bereits ein anderes Gerät
mit der Bezeichnung "calcomp"
installiert.

Übermitteln Sie in diesem Fall
mit der Option
tablet_device_name der
Konfigurationsdatei den Namen
des Tabletts an
Pro/ENGINEER.

 

pç=ÉñéçêíáÉêÉå=páÉ=qÉáäÉ=çÇÉê=_~ìÖêìééÉå=áå=ÉáåÉ
sa^Ja~íÉá
Vor der Erzeugung einer VDA-Datei sollten Sie einen Standard-Dateikopf festlegen.

Die VDA-Version, der Name des Absenders und das Datum werden automatisch eingetragen. Der Name
des Absenders ist die Anmelde-ID des Benutzers. Zur Angabe der verbleibenden Daten erzeugen Sie eine
Kopfdatei, und legen Sie den Namen dieser Datei mit der Konfigurationsdatei-Option îÇ~|ÜÉ~ÇÉê
<a~íÉáå~ãÉ> fest (einschließlich der Erweiterung, falls vorhanden).

1. Wählen Sie mit einer aktivierten Baugruppe die Befehlsfolge Datei > Kopie speichern (File > Save a

Copy).
2. Wählen Sie in der Liste Typ (Type) die Option VDA (*.vda).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Das Dialogfenster Exportieren VDA (Export VDA) wird geöffnet.
5. Unter Export aktivieren Sie die zutreffenden Kontrollkästchen, die den Typ der zu exportierenden

Elemente angeben.
Drahtmodell (Wireframe) – Gibt nur Teilekanten aus.
Flaechen (Surfaces) – Gibt alle Teileflächen und -berandungen aus.
Bezugskurven und Punkte (Datum Curves and Points) – Gibt die Bezugselemente aus.

6. Geben Sie im Dialogfenster die Struktur und den Inhalt der Ausgabedatei an.
7. Sollen Folien exportiert werden, klicken Sie im Dialogfenster Exportieren VDA (Export VDA) auf

die Schaltfläche Folien anpassen (Customize Layers). Das Dialogfenster Folien waehlen erscheint.
8. Klicken Sie die Option Autom-ID an, um den Folien IDs zuzuweisen, denen noch keine ID zugewiesen

wurde.
9. Geben Sie im Dialogfenster Folien waehlen (Choose Layers) Ihre Änderungen ein, und klicken Sie

anschließend auf OK, um die Änderungen zu bestätigen.
10. Wählen Sie OK, um die VDA-Teile- oder Baugruppendatei zu erzeugen.
Pro/ENGINEER erstellt die VDA-Datendatei. Der Baugruppenursprung wird als Standard für den
Ursprung der Daten eingestellt. Wenn die Datei erstellt ist, werden Sie vom System benachrichtigt.

Für alle in Pro/ENGINEER erzeugten VDA-Dateien gilt die Namenskonvention <çÄàÉâíå~ãÉ>KîÇ~,
wobei <çÄàÉâíå~ãÉ> der Name der aktuell geöffneten Baugruppe ist. Wenn Sie unter UNIX zwei
VDA-Datendateienür aus demselben Objekt erstellen, wird die zuerst erstellte überschrieben, sofern Sie sie
nicht umbenennen.

Hinweis: Wenn Sie für alle VDA-Dateien dieselbe Kopfzeile verwenden möchten, geben Sie den
Dateinamen mit dem vollständigen Pfad an. Beispiel: LìëêLìëÉêëLîÇ~|ÜÉ~ÇKíñí.
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aáÉ=^ìëÖ~ÄÉ=îçå=~ìëÖÉÄäÉåÇÉíÉå=cçäáÉå=ëíÉìÉêå
Mit der Konfigurationsdatei-Option áåíÑ|çìí|Ää~åâÉÇ|ÉåíáíáÉë können Sie die Ausgabe von
ausgeblendeten Folien steuern. Wenn Sie diese Option auf no setzen, werden Elemente auf ausgeblendeten
Folien ignoriert. Wenn Sie die Option auf óÉë setzen (Vorgabe), werden ausgeblendeten Folien exportiert.

pç=áãéçêíáÉêÉå=páÉ=ÉáåÉ=sa^Ja~íÉá=~äë=åÉìÉë=hb=áå
Éáå=îçêÜ~åÇÉåÉë=qÉáä
Mit VDA Surface Data Interface aus Pro/ENGINEER können Sie Teilegeometrie zwischen
Computersystemen übertragen. Pro/ENGINEER unterstützt VDA Version 2.0.

1. Erzeugen Sie ein Teil, oder rufen Sie ein Teil auf (mindestens ein KE muß vorhanden sein).
2. Wählen Sie die Befehlsfolge Einfuegen > Daten aus Datei (Insert > Data from File). Das

Dialogfenster Oeffnen (Open) erscheint.
3. Wählen Sie in der Liste Typ (Type) die Option VDA (*.vda). Klicken Sie in der Liste der verfügbaren

Dateien auf die zu importierende VDA-Datei, oder suchen Sie nach der VDA-Datei.
4. Klicken Sie auf OK.
5. Das Informationsfenster und das Dialogfenster Volumenkoerper-Optionen und Plazierung (Choose

Solid Options and Placement) werden geöffnet.
6. Erzeugen oder wählen Sie im Dialogfenster Volumenkoerper-Optionen und Plazierung (Choose

Solid Options and Placement) ein Koordinatensystem, um die VDA-Daten zu lokalisieren.
7. Klicken Sie auf OK. Das KE wird erzeugt.

sa^Ja~íÉáÉå=áãéçêíáÉêÉå
Bei jedem Importieren eines VDA-Modells nach Pro/ENGINEER wird eine Protokolldatei mit dem Namen
<ãçÇÉääå~ãÉ>KäçÖ in Ihrem Arbeitsverzeichnis erzeugt. Diese Datei enthält eine Übersicht der VDA
Import-Verarbeitung.

Pro/ENGINEER kann eine VDA-Datei in ein vorhandenes Teil einlesen, oder Sie können mit den VDA-
Daten ein neues Teil erzeugen. Welcher KE-Typ von der VDA-Datei erzeugt wird, hängt von den
verfügbaren Daten ab. Volumenkörper-KEs werden nur erzeugt, wenn Sie anhand der VDA-Elemente
DRAUFSICHT (TOP), FLAECHE (FACE), RB (CONS) und KURVE (CURVE) eine vollständige
topologische Beschreibung liefern.

Mit der Konfigurationsdatei-Option êÉ~Ç|îÇ~|áå|éëÉí|~ë|ëéäáåÉ können Sie die aus einer VDA-
Datei importierten Datenpunktgruppen steuern. Wenn Sie diese Option auf yes einstellen, werden
Datenpunktgruppen als Splinekurven importiert. Wenn Sie diese Option auf no (Standard) einstellen,
werden Datenpunktgruppen nicht als Splinekurven importiert.

Sie können ein importiertes KE durch eine neue Importdatei ersetzen, ohne eine 1:1-Übereinstimmung
zwischen den vorhandenen und ersetzten Elementen zu haben.

Wenn die VDA-Datei alle erforderlichen Informationen für eine Flächenverbindung enthält, können Sie mit
dem Befehl Flaeche verwend (Use Surf) einen Volumenkörper erzeugen. Besitzen die importierten
Dateien keine Informationen über Flächenverbindung, können Flächen auf verschiedene Weisen
zusammengefügt werden.
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pç=ÉêòÉìÖÉå=páÉ=qÉáäÉ=ÇìêÅÜ=Ç~ë=fãéçêíáÉêÉå=îçå
sa^Ja~íÉå
1. Wählen Sie beim Erzeugen eines Teils die Befehlsfolge Datei > Oeffnen (File > Open). Das Menü

OEFFNEN (OPEN) wird geöffnet.
2. Wählen Sie in der Liste Typ (Type) die Option VDA (*.vda). Die VDA-Dateien im Arbeitsverzeichnis

werden aufgeführt. Klicken Sie in der Liste der verfügbaren Dateien auf die zu importierende VDA-
Datei, oder suchen Sie nach der VDA-Datei, und markieren Sie sie.

3. Klicken Sie auf OK.
4. Es erscheint das Dialogfenster Neues Modell importieren (Import New Model). Übernehmen Sie den

vorgegebenen Dateinamen, oder geben Sie einen neuen Namen ein.
5. Klicken Sie auf OK. Im Informationsfenster wird eine KäçÖ-Datei angezeigt. Die Datei wird

verarbeitet.
6. Das Teil wird automatisch erzeugt, und am VDA-Datenursprung wird ein Koordinatensystem mit dem

Namen der VDA-Datei plaziert.

sojiJa~íÉáÉå
Für jede Pro/ENGINEER Teile- und Baugruppendatei erzeugt das System eine entsprechende VRML-
Datei. Für jede Teiledatei erzeugt das System eine Reihe von LOD-Dateien (VRML Level-of-Detail).

Ein Objekt wird grafisch durch viele schattierte Dreiecke dargestellt, aus denen sich seine Form
zusammensetzt (Kachelung). Ein Level of Detail (LOD) ist eine besondere grafische Darstellung, die aus
facettierten Flächen besteht, die wiederum aus einer bestimmten Anzahl von Dreiecken bestehen. Durch die
VRML-Exportfunktion werden mehrere Dateiebenen erzeugt, die jeweils eine andere Anzahl von
Dreiecken aufweisen. Je größer die Anzahl der Dreiecke, die ein Modell beschreiben, desto mehr Details
sind sichtbar.

Das System erzeugt die VRML-Dateien im aktuellen Arbeitsverzeichnis von Pro/ENGINEER. Dabei
gelten die folgenden Namenskonventionen zwischen Pro/ENGINEER Dateien und den VRML-
Baugruppen- bzw. Teile-Dateien:

<Ä~ìÖêìééÉå|å~ãÉ>.~ëã wird exportiert zu <Ä~ìÖêìééÉå|å~ãÉ>|~Kïêä

<íÉáä|å~ãÉ>.éêí wird exportiert zu <íÉáä|å~ãÉ>|éKïêä

� Wenn vereinfachte Darstellungen exportiert werden, erhalten Baugruppen mit einer nicht auftretenden
Komponente folgende Namen:

<Ä~ìÖêìééÉå|å~ãÉ>K~ëã wird exportiert zu <Ä~ìÖêìééÉå|å~ãÉ>|ë@Kïêä
� Wenn ein Baugruppen-KE sich überschneidende Komponenten hat, werden diese folgendermaßen

benannt (Teil und Baugruppe werden geändert):
YÄ~ìÖêìééÉå|å~ãÉ[K~ëã=ïáêÇ=ÉñéçêíáÉêí=òì=YâçãéçåÉåíÉå|å~ãÉ[|~Ñ@|~Kïêä

<íÉáä|å~ãÉ>Kéêí wird exportiert zu <âçãéçåÉåíÉå|å~ãÉ>|~Ñ@|éKïêä
Verwenden Sie den direkten Export für Komponenten, die eine Unterfolie mit Status DARSTELLEN
besitzen.

Die LOD-Dateien für die einzelnen Teile verwenden folgende Namenskonventionen zwischen
Pro/ENGINEER Dateien und den LOD-Dateien:

<íÉáä|å~ãÉ>Kéêí wird exportiert zu <íÉáä|å~ãÉ>|éê@Kïêä

Dabei gilt:

@ ist die Nummer der speziellen VRML-Datei. Je niedriger die Nummer, desto höher das Level of Detail in
der Datei.

Hinweis: Sie können die Dateien vom Typ <íÉáä|å~ãÉ>|éê@Kïêä einzeln in Pro/FLY-THROUGH
laden.
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^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=få=páíòìåÖJ=ìåÇ=ÇáêÉâíÉê
bñéçêí=å~ÅÜ=soji
Durch den Export von Pro/ENGINEER Teilen und Baugruppen in das VRML-Format wird eine Datenbank
erzeugt; diese besteht aus VRML-Dateien, die Baugruppenstruktur, Namen von Teilen und Baugruppen
enthalten, sowie geometrische Daten, die die Pro/ENGINEER Teile darstellen.

Mit Pro/ENGINEER können Sie Teile- und Baugruppendateien entweder direkt in das Dateiformat VRML
1.0 (Datei > VRML-Konvertierer (File > VRML Converter)) oder in einer Sitzung (Datei > Kopie

speichern (File > Save a Copy)) exportieren.  Sie können die VRML-Dateien mit den Produkten Pro/FLY-
THROUGH und Pro/Model.View oder in anderen Viewern anzeigen, die der Spezifikation VRML 1.0
entsprechen. Setzen Sie die Konfigurationsdatei-Option ëÜ~ÇÉ|ëìêÑ~ÅÉ|ÑÉ~í auf óÉë
(Voreinstellung), um Baugruppen-Flächen, Sammelflächen und Schweiß-KEs während des Exports
anzusehen.

Überlegungen beim Exportieren von inaktiven Teilen oder Baugruppen
Wenn Sie ein inaktives Teil oder eine inaktive Baugruppe exportieren, ist dies eine direkte Übertragung.
Berücksichtigen Sie folgendes, wenn Sie diese Methode für den Export nach VRML verwenden:

� Werden an einer Unterbaugruppe Änderungen vorgenommen und die umfangreiche Baugruppe wird
vor dem Direkt-Export nicht regeneriert, werden die Änderungen nicht in Pro/FLY-THROUGH
dargestellt.

� Der Direkt-Export ist für umfangreiche Baugruppen gedacht, die zu groß zum Laden sind oder aus
anderen (hardwareabhängigen) Gründen nicht geladen werden können.

� Verwenden Sie Variantenbeschleuniger-Dateien, um beim Direkt-Export die Qualität zu verbessern.

Überlegungen beim Exportieren von aktiven Teilen oder Baugruppen
Das Exportieren eines aktiven Teils oder einer aktiven Baugruppe ist ein Exportvorgang in einer Sitzung.
Berücksichtigen Sie folgendes, wenn Sie diese Methode für den Export nach VRML verwenden:

� Reguläre Baugruppen-KEs werden nur beim Export in Sitzung unterstützt.

� Aktuell angezeigte vereinfachte Darstellungen werden nur vom Export in Sitzung unterstützt. Unter der
Konfigurationsdatei-Option îêãä|ëáãéêÉé|Éñéçêí finden Sie weitere Informationen.

� Kabelinformationen werden nur beim Export in Sitzung unterstützt. Die Software unterstützt
Kabelbaum/Verkabelungskomponenten nur dann, wenn Sie die Variable Umgebung auf den Wert
"Thick Cable" setzen.

� Verwenden Sie den Export in Sitzung für Komponenten, die eine Unterfolie mit Status DARSTELLEN
besitzen.

� Exportiert Baugruppen-KEs und Explosionszustände. Nur der aktive Explosionszustand kann exportiert
werden.

� Exportiert vereinfachte Darstellungen mit ersetzten Komponenten als Package-Datei

Hinweis: Nur vereinfachte Darstellungen mit STAND REGEL EINSCHLIESSEN (Master-
Darstellung) und REGEL AUSSCHLIESSEN für ausgewählte Komponenten werden zu Package-
Dateien exportiert.

� Exportiert eine derzeit angezeigte vereinfachte Darstellung.

Überlegungen bei In Sitzung- und direktem VRML-Export
� Sowohl der Export in Sitzungen als auch der direkte VRML-Export unterstützen Baugruppenflächen

und Familientabellen-Varianten und das Laden in Pro/ENGINEER.
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� Vereinfachte Darstellungen können exportiert werden, wenn die config.pro-Option
îêãä|ëáãéêÉé|Éñéçêí auf óÉë gesetzt wurde. Nur vereinfachte Darstellungen mit STAND
REGEL EINSCHLIESSEN (DEFAULT RULE INCLUDE) (Master-Darstellung) und REGEL
AUSSCHLIESSEN (EXCLUDE RULE) werden für ausgewählte Komponenten über Direkt-Export
oder Export in Sitzung in Package-Dateien exportiert.

� Wenn Baugruppen-KEs wie Explosionszustände exportiert werden:

� Sie können eine Pro/ENGINEER Baugruppe im explodierten oder zusammengebauten Zustand
exportieren (wobei die explodierten KEs definiert sein müssen). Der Explosionszustand kann zur
Demonstration und zum Erzeugen von Fotos für Dokumentationszwecke verwendet werden.

� Wird eine Baugruppe mindestens einmal während einer Pro/ENGINEER Sitzung explodiert, so
werden die Explosionsdaten nach VRML exportiert.

pç=ÄÉêÉáíÉå=páÉ=ÇÉå=bñéäçëáçåëòìëí~åÇ=ÑΩê=ÇÉå
bñéçêí=îçê
1. Rufen Sie die Baugruppe in Pro/ENGINEER auf.
2. Wählen Sie die Befehlsfolge Ansicht > Explodieren (View > Explode), um den Explosionszustand

anzuwenden.
Hinweis: Wenn Sie die Baugruppe im zusammengebauten Zustand exportieren wollen, nachdem Sie
ihr den Explosionszustand zugewiesen haben, verwenden Sie den Befehl Zusammenbau (Unexplode).

3. Exportieren Sie die aktive Baugruppe.

sçêÉáåëíÉääìåÖÉå=ÑΩê=ÇÉå=bñéçêí=å~ÅÜ=soji
®åÇÉêå
Wenn Sie aus Pro/ENGINEER eine Datei über den direkten Export oder in Sitzung exportieren, verwendet
das System die Standardeinstellung für den Export von Qualität (LOD), Parameter und Ansichten. Sie
können diese Einstellungen beim Export über die Schaltfläche Voreinstellung (Setup) im Dialogfenster
Exportieren VRML (Export VRML) ändern.

Im Dialogfenster VRML-Export-Einstellung befinden sich die folgenden Optionen:

� Qualitaet (Quality) – Dient zur Einstellung von LOD für den Export. Zur Auswahl stehen Niedrig,
Mittel und Hoch.

� Parameter (Parameters) – Dient zur Angabe der Parameter, die Sie bei Bedarf exportieren wollen.
Zur Auswahl stehen Alle, Zugewiesen oder Kein..

� Ansichten (Views) – Dient zur Angabe der Ansichten, die exportiert werden sollen. Zur Auswahl
stehen Alle, Oben oder Kein..

hçåÑáÖìê~íáçåëÇ~íÉáJs~êá~ÄäÉå=ÑΩê=ÇÉå=bñéçêí
å~ÅÜ=soji
Die folgenden Optionen der Datei config.pro können in Pro/ENGINEER eingestellt werden:

� ëÜ~ÇÉ|ëìêÑ|ÑÉ~í

Steuert die Schattierung von Flächen-KEs.
óÉë – Die Flächen werden beim Export in das Format VRML schattiert (Standardeinstellung).
åç=– Flächen-KEs werden beim Export in das Format VRML nicht gerendert.

� îêãä|~åÅÜçê|ìêä

Ermöglicht das Plazieren von Ankern an einer VRML Komponente beim Exportieren nach VRML. Die
Schlüsselwörter sind optional.
å~ãÉ – Verwendet den VRML Dateinamen ohne Erweiterung.
Ñìää|å~ãÉ – Verwendet den VRML Dateinamen mit Erweiterung.
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Ä~ëÉ|å~ãÉ – Verwendet den Pro/ENGINEER Objektnamen ohne Erweiterung.
éêçÉ|å~ãÉ – Verwendet den Pro/ENGINEER Objektnamen mit Erweiterung.
ÇÉÑ~ìäí – Bewirkt einen leeren WWW-Anker für den VRML Export oder eine Datenbank (wie
bisher für den VRML-Export in Pro/Process).
In der folgenden Tabelle finden Sie Beispiele für die optionalen Schlüsselwörter.

=

Komponente Ziel Eingabe: type vrml_anchor_url...

WWW-Ankerknoten:

http://paran:8000/help

http://paran:8000/help

TOP.asm WWW-Ankerknoten:

TOP_a.wrl

$full_name

TOP.asm http://paran:8000/help/T
OP_a.html

http://paran:8000/help/$name.html

TOP.asm http://paran:8000/help/T
OP_a.wrl

http://paran:8000/help/$full_name

TOP.asm http://paran:8000/top/TO
P_a.html

http://paran:8000/$base_name/$name.html

TOP.asm http://paran:8000/TOP.as
m

http://paran:8000/$proe_name

part.asm http://paran:8000/part.a
sm

=

� îêãä|Éñéçêí|êÉëçäìíáçå

Legt die Anzahl von LOD-Dateien für jedes Teil fest.
ÜáÖÜ=– Ergibt bis zu 10 LOD-Dateien für jedes Teil (langsamste Ausführung).
ãÉÇáìã – Ergibt bis zu neun LOD-Dateien für jedes Teil (Standardeinstellung).
äçï=– Ergibt bis zu fünf LOD-Dateien für jedes Teil (schnellste Ausführung).

� îêãä|é~ê~ãÉíÉêë

Legt die Parameter fest, die für das Teil exportiert werden.
ÇÉëáÖå~íÉÇ – Exportiert die ausgewiesenen Parameter und Bemaßungen (Standardeinstellung).
~ää=– Exportiert alle Benutzerparameter.
åçåÉ – Exportiert keine Benutzerparameter.

� îêãä|ãìäíáéäÉ|îáÉïë

Legt fest, welche Ansichten in die VRML-Datei exportiert werden.
~ää – Exportiert alle Ansichtsnamen in die VRML-Datenbank (Standardeinstellung).
íçé=– Exportiert nur die Ansichtsnamen der obersten Baugruppe in die VRML-Datenbank.
åçåÉ=– Exportiert keine Ansichten in die VRML-Datenbank.

� îêãä|ëáãéêÉé|Éñéçêí

Legt fest, ob in Sitzung vereinfachte Darstellungen der obersten Baugruppe in Package-Dateien
exportiert werden.
óÉë=– Leitet einen Im-Speicher-Export vereinfachter Darstellungen der obersten Baugruppe in
Package-Dateien (.éâÖ) ein.
no – Vereinfachte Darstellungen werden nicht exportiert.

pç=îÉêïÉåÇÉå=páÉ=ÇÉå=aáêÉâíJbñéçêí
Durch den Direkt-Export werden Baugruppen exportiert, ohne das ganze Modell in den Speicher zu laden.
Der Export erfolgt vielmehr in Einzelschritten, damit auch sehr große und speicherintensive Modelle
exportiert werden können. Nach Beendigung des direkten Exports sind keine Modellteile mehr im
Arbeitsspeicher vorhanden. Wenn an einer Unterbaugruppe Änderungen vorgenommen werden und die
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umfangreiche Baugruppe wird vor dem Direkt-Export nicht regeneriert, wirken sich die Änderungen nicht
auf die Darstellung des Modells in Pro/FLY-THROUGH aus. Der Direkt-Export ist für umfangreiche
Baugruppen gedacht, die zu groß zum Laden sind oder aus anderen (hardwareabhängigen) Gründen nicht
geladen werden können.

Hinweis: Wenn sehr umfangreiche Baugruppen exportiert werden, kann es sein, daß die Ausgabe in
Zeichnungsqualität erfolgt und das Modell nicht akkurat dargestellt wird.

Verwenden Sie den Direkt-Export für inaktive Teile oder Baugruppen.

1. Setzen Sie die Konfigurationsdatei-Option îêãä|Éñéçêí auf óÉë. Der VRML-Konvertierer

(VRML Converter) erscheint im Menü DATEI (FILE).
2. Wählen Sie die Befehlsfolge Datei > VRML-Konvertierer (File > VRML Converter). Das

Dialogfenster Direkter VRML-Export (Direct VRML Export) wird aufgerufen.
3. Klicken Sie auf die obere Schaltfläche Blaettern (Browse), um den Namen des Objekts zu suchen, das

Sie exportieren möchten. Das Dialogfenster Quelle fuer direkte VRML-Konvertierung (Source for

Direct VRML Conversion) wird aufgerufen.
4. Klicken Sie auf den Namen der Datei, die in das VRML-Format konvertiert werden soll, oder

durchsuchen Sie die Verzeichnisse nach der Datei, und wählen Sie sie aus. Das Dialogfenster Quelle

fuer direkte VRML-Konvertierung (Source for Direct VRML Conversion) wird geschlossen und
das Dialogfenster Direkter VRML-Export (Direct VRML Export) geöffnet. Der Name der
ausgewählten Datei und der Pfad erscheinen im Feld Objektname (Object Name).

5. Akzeptieren Sie den standardmäßigen Ausgabepfad (Output Path), oder klicken Sie auf
Durchsuchen (Browse), um einen anderen Ausgabepfad zu suchen und auszuwählen. Wenn Sie nach
einem Ausgabepfad suchen, wird das Dialogfenster Arbeitsverzeichnis waehlen (Select Working

Directory) angezeigt. Wählen Sie einen Ausgabepfad für die VRML-Datei, und klicken Sie auf OK.
Das Dialogfenster Arbeitsverzeichnis waehlen (Select Working Directory) wird geschlossen und das
Dialogfenster Direkter VRML-Export (Direct VRML Export) geöffnet. Der Pfadname wird in das
Textfeld Ausgabepfad (Output Path) eingegeben.

6. Wenn Sie die Standardeinstellungen für den Export von Qualität, Parametern oder Ansichten ändern
wollen, klicken Sie auf die Schaltfläche Voreinstellung. Das Dialogfenster VRML-Export-

Einstellung (VRML Export Setup) wird aufgerufen.
7. Nehmen Sie Änderungen am Dialogfenster VRML-Export-Einstellung (VRML Export Setup) vor,

und klicken Sie auf OK.
8. Wählen Sie OK, um das inaktive Modell zu Dateien im VRML-Format im angegebenen Verzeichnis zu

exportieren.
Sie können Pro/BATCH verwenden, um VRML-Datenbanken entweder über Direkt-Export oder über
Export in Sitzung zu erzeugen.

pç=ÉñéçêíáÉêÉå=páÉ=áå=páíòìåÖ
Es wird empfohlen, möglichst im Modus In Sitzung zu exportieren, um eine maximale Detailtreue des
Modells zu erreichen.

Verwenden Sie den Export in Sitzung für aktive Teile und Baugruppen.

1. Wählen Sie Datei > Kopie speichern (File > Save a Copy). Es erscheint das Dialogfenster Kopie

speichern (Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option VRML (*wrl). Der vorhandene Pro/ENGINEER

Modellname erscheint ohne die Erweiterung im Feld Neuer Name (New Name).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Das Dialogfenster VRML-Export-Einstellung (VRML Export Setup) wird

aufgerufen.
5. Nehmen Sie Änderungen am Dialogfenster VRML-Export-Einstellung (VRML Export Setup) vor,

und klicken Sie auf OK.
6. Wählen Sie OK, um das aktive Modell zu Dateien im VRML-Format im angegebenen Verzeichnis zu

exportieren.
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pç=ÉñéçêíáÉêÉå=páÉ=ΩÄÉê=Qa=k~îáÖ~íçê=å~ÅÜ=soji
Wurde die Konfigurationsdatei-Option ~ääçï|QÇå~î|Éñéçêí auf óÉë gesetzt, können Sie auf eine
Weise nach VRML exportieren, die konsistent mit 4D Navigator von CATIA ist.

1. Setzen Sie die Konfigurationsdatei-Option ~ääçï|QÇå~î|Éñéçêí auf óÉë.
2. Wählen Sie in einem aktiven Teil oder einer aktiven Baugruppe die Befehlsfolge Datei > Kopie

speichern (File > Save a Copy). Es erscheint das Dialogfenster Kopie speichern (Save a Copy).
3. Wählen Sie in der Liste Typ (Type) die Option 4D Navigator (*.wrl). Der vorhandene

Pro/ENGINEER Modellname erscheint ohne die Erweiterung im Feld Neuer Name (New Name).
4. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
5. Klicken Sie auf OK. Es erscheint das Dialogfenster Exportieren VRML (Export VRML). Wenn Sie

eine Baugruppe exportieren, enthält das Dialogfenster Exportieren VRML (Export VRML) die
folgenden zusätzlichen Bereiche:
� Zu exportierende Teile (Parts to Export)

� Format

6. Wenn Sie die Abtreppung noch weiter steuern möchten, ändern Sie die Werte für die maximale
Sehnenhoehe (Chord Height) und Winkelsteuerung (Angle Control).

7. Bei Baugruppen klicken Sie auf:
� Alle Teile (All Parts) – um die gesamte Baugruppe zu exportieren.

� Einschliessen (Include) – um jedes einzelne Teil zu wählen, das in die Datei aufgenommen
werden soll. Wenn Sie die aufzunehmenden Teile ausgewählt haben, können Sie die Auswahl
fortsetzen, indem Sie das Auswahl-Icon neben dem Mitteilungsfenster anklicken.

� Ausschliessen (Exclude) – um jedes einzelne Teil zu wählen, das aus der Datei ausgeschlossen
werden soll. Wenn Sie die auszuschließenden Teile ausgewählt haben, können Sie die Auswahl
fortsetzen, indem Sie das Auswahl-Icon neben dem Mitteilungsfenster anklicken.

Die Mitteilungszeile unterhalb dieser drei Optionen gibt Aufschluß über die Anzahl der Teile, die
exportiert werden. Sie wird bei jedem Schließen des Menüs AUSWAHL (GET SELECT)

aktualisiert. Das Wechseln zwischen Einschliessen (Include) und Ausschliessen (Exclude) hat
keine Auswirkung auf Ihre Auswahl.
Wenn Sie die Auswahl abbrechen möchten, wählen Sie Zuruecksetzen (Reset).

8. Bei Baugruppen klicken Sie auf:
� Flach (Flat), um eine einzelne VRML-Datei für die Baugruppe zu exportieren. Die Geometrie in

dieser Datei wird in mehrere Teile aufgeteilt. Beispielsweise wird bei Teilen jede Variante in ihrer
korrekten Position in die Datei aufgenommen.

� Alle Teile (All Parts), um jedes Teil in eine separate VRML-Datei zu exportieren.  Jedes Teil wird
an seiner entsprechenden Position und Ausrichtung in den Baugruppenraum plaziert.

9. Wählen oder erzeugen Sie mit dem Menü KSYS HOLEN (GET COORD S) ein Koordinatensystem zur
Definition des xyz-Raums. Klicken Sie dazu auf das Auswahl-Icon unterhalb von Koordinatensystem

(Coordinate System). Sie können das Standard-Koordinatensystem des Modells verwenden. Unter
Umständen entstehen dabei jedoch negative Koordinaten.

10. Geben Sie im Feld Dateiname (File name) den Namen der Datei ohne Erweiterung ein, oder
übernehmen Sie den Standardnamen.

11. Wählen Sie Zuweisen (Apply), um das Teil oder die Baugruppe zu exportieren, oder wählen Sie OK,
um den Export auszuführen und das Dialogfenster zu schließen.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=éêçáÖëìíáä
Das Dienstprogramm proigsutil ist ein IGES-Konvertierungsprogramm für Pro/ENGINEER. Sie wandeln
damit die in einer Liste enthaltenen IGES-Dateien in Pro/ENGINEER Zeichnungen oder Teile um. Dieses
Dienstprogramm konvertiert nur IGES-Dateien. SET, VDA, DXF oder andere Dateiformate können damit
nicht konvertiert werden.
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Mit dem folgenden Befehl wird proigsutil ausgeführt:

éêçáÖëìíáä=Yéêç|Åçãã~åÇ[

Folgende Befehlszeilen-Argumente sind möglich:

JÜÉäé=Jçâ=Jë=èìÉää|îÉêò=Jä=Ç~íÉáå~ãÉ=Jê=Jí=òáÉä|îÉêò=Jâ=ãáå=Jíãé

Wenn Sie proigsutil ohne Argumente aufrufen, gelangen Sie in einen interaktiven Modus. Über
Eingabeaufforderungen werden die jeweils für das Dienstprogramm erforderlichen Informationen
abgefragt.

Befehlsmodus
In der folgenden Tabelle werden die Argumentwerte beschrieben.

=

Argumentwerte Beschreibung

-help Zeigt diese Informationen an.

 -if Importformat, das angibt, ob die Daten in der IGES-Datei als Pro/ENGINEER Teil oder
Zeichnung eingelesen werden sollen.

Vorgabe: none (Sie müssen drw oder prt angeben).

 -ie Die Dateierweiterung für IGES.

Vorgabe: igs

 -ok Bestätigt, daß Sie mit dem Sichern der zu konvertierenden Dateien einverstanden sind.

Vorgabe: Wenn dieses Argument nicht in der Befehlszeile enthalten ist, werden Sie explizit
danach gefragt.

 -s Der Name des Verzeichnisses, das die zu konvertierenden Dateien enthält (das
Startverzeichnis).

Vorgabe: Das aktuelle Verzeichnis.

 -l Der Name einer Datei, die eine Liste der Namen der zu konvertierenden Dateien enthält.
Dateinamen (z.  B. box.prt) sollten jeweils in einer separaten Zeile aufgelistet werden. Geben
Sie keine Versionsnummer an. Es wird jeweils die letzte Version einer Datei konvertiert.

Vorgabe: Es werden alle Dateien im Startverzeichnis konvertiert.

 -r Dateien in Verzeichnissen unterhalb des Startverzeichnisses werden rekursiv konvertiert.

Vorgabe: Es werden nur die Dateien im Startverzeichnis konvertiert

-t Der Name eines Verzeichnisses, in dem die konvertierten Dateien abgelegt werden sollen.

Vorgabe: Das Startverzeichnis.

-k Die maximale Zeit (in Minuten), die für die Konvertierung einer Datei zulässig ist. Nach
Ablauf der angegebenen Zeit wird der Konvertierungsprozeß der aktuellen Datei
abgebrochen.

Vorgabe: 0 (d.  h. keine Begrenzung).

 -tmp Temporäres Verzeichnis für proigsutil. Die Partition des Verzeichnisses muß mindestens
ausreichend freien Platz zum Speichern der größten zu konvertierenden Datei aufweisen.

Vorgabe: /tmp.

 -ms Die Mindestgröße des für die Konvertierung erforderlichen Plattenspeicherplatzes (in Kb).
Dieser Wert wird nach jeder Konvertierung überprüft; proigsutil wird abgebrochen, wenn der
Speicherplatz nicht mehr ausreichend ist.

Vorgabe: 0 (d.  h. keine Begrenzung).

-c Eine der folgenden Vorgehensweisen:

<dateiname>.pro – Die angegebene Konfigurationsdatei wird vor jeder Konvertierung
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verwendet.

existing (Voreinstellung) – Die Konfigurationsdatei im Konvertierungsverzeichnis wird
verwendet (wenn vorhanden).

none – Es wird keine Konfigurationsdatei verwendet, selbst wenn im
Konvertierungsverzeichnis eine solche vorhanden ist.

Die folgenden Beispiele zeigen die Verwendung des Befehlsmodus:

� éêçáÖëìíáä=éêç

Konvertiert alle Dateien in diesem Verzeichnis und übernimmt alle Voreinstellungen mit Ausnahme der
Statusangabe für die Sicherungskopien.

� éêçáÖëìíáä=éêç=JáÑ=Çêï=Jçâ

Konvertiert alle .igs-Dateien in diesem Verzeichnis in Pro/ENGINEER-Zeichnungen.
� éêçáÖëìíáä=éêç=JáÑ=éêí=Jê=Jçâ

Konvertiert alle in dieser Baumstruktur vorhandenen .igs-Dateien zu Pro/ENGINEER Teilen.

_ÉáëéáÉäW=wÉáÅÜåìåÖÉå=áã=áåíÉê~âíáîÉå=jçÇìë=ãáí
éêçáÖëìíáä=âçåîÉêíáÉêÉå
Type : éêçáÖëìíáä

 proigsutil v10.0—the Pro/ENGINEER conversion utility

 ------------------------------------------------------

 Interactive mode—you will be prompted for answers, hit <RETURN>

 to get default values in []’s when available.

Use ‘proigsutil -help’ for more information, including command-line arguments.

Name of command to run Pro/ENGINEER ?: pro

Convert to parts or drawings (choice: drw prt)

[drw] ?: <CR>

Import file extension

[igs] ?: <CR>

Name of directory containing files to convert

[/home/users/user_2/drawings/iges] ?: <CR>

Name of file containing list of files to convert

hit <RETURN> to convert all files ?: draw_iges.txt

Name of directory in which to put converted files

[/home/users/user_2/drawings/iges] ?: /home/users/user_2/drawings/convert

Maximum time for any file conversion (choice: number of mins, 0 = unlimited)

[0] ?: 20

Temporary work directory

[/tmp] ?: <CR>

Minimum disk space for any conversion (choice: size in Kb, 0 = unlimited)
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[0] ?: <CR>

Name of a config. file to use (choice: none, existing OR a filename)

[existing] ?: <CR>

Satisfied with the backup of the files to be converted (choice: yes no)

[no] ?: yes

WARNUNG: Maximum file conversion time (20 mins) is less than 1 hour.

 This may be too short a time.

1st pass—estimate conversion space requirements

-------------------------------------------------

Total size of files to convert: 91 (Kb)

Total estimated size of converted files: 91 (Kb)

2nd pass—Process the files (in /tmp/10289/list.txt)

-----------------------------------------------------

 --- CHECKING THE CONFIG FILE ---

[1] 10641

[1] + Killed /tmp/10289/killer 60

CONFIG FILE OK.

PROCESSING FILE 1 OF 2 - /home/users/user_2/drawings/iges/cam_draw.igs

PROCESSING FILE 2 OF 2 - /home/users/user_2/drawings/iges/check_detail.igs

_ÉáëéáÉäW=qÉáäÉ=áã=áåíÉê~âíáîÉå=jçÇìë=ãáí
éêçáÖëìíáä=âçåîÉêíáÉêÉå
Geben Sie folgendes einW=éêçáÖëìíáä

proigsutil v10.0—the Pro/ENGINEER conversion utility

 ------------------------------------------------------

Interactive mode—you will be prompted for answers, hit <RETURN>

 to get default values in []’s when available.

Use ‘proigsutil -help’ for more information, including command-line arguments.

Name of command to run Pro/ENGINEER ?: pro

Convert to parts or drawings (choice: drw prt)
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[drw] ?: prt

Import file extension

[igs] ?: <CR>

Name of directory containing files to convert

[/home/users/user_2/models/part_iges] ?: <CR>

Name of file containing list of files to convert

hit <RETURN> to convert all files ?: <CR>

Recursively convert files in dirs encountered (choice: yes no)

[no] ?: <CR>

Name of directory in which to put converted files

[/home/users/doug/part_iges_files] ?: /home/users/user_2/convert

Store geometry when converted (choice: geom no geom)

[no geom] ?: <CR>

Maximum time for any file conversion (choice: number of mins, 0 = unlimited)

[0] ?: <CR>

Temporary work directory

[/tmp] ?: <CR>

Minimum disk space for any conversion (choice: size in Kb, 0 = unlimited)

[0] ?: <CR>

Name of a config. file to use (choice: none, existing OR a filename)

[existing] ?: <CR>

Satisfied with the backup of the files to be converted (choice: yes no)

[no] ?: yes

1st pass—estimate conversion space requirements

-------------------------------------------------

Total size of files to convert: 178 (Kb)

Total estimated size of converted files: 178 (Kb)

2nd pass—Process the files (in /tmp/11101/list.txt)

-----------------------------------------------------

PROCESSING FILE 1 OF 10 - /home/users/user_2/models/part_iges/base_2.igs

PROCESSING FILE 2 OF 10 - /home/users/user_2/models/part_iges/block.igs

PROCESSING FILE 3 OF 10 - /home/users/user_2/models/part_iges/bolt.igs

PROCESSING FILE 4 OF 10 - /home/users/user_2/models/part_iges/control_arm.igs

PROCESSING FILE 5 OF 10 - /home/users/user_2/models/part_iges/cover.igs
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PROCESSING FILE 6 OF 10 - /home/users/user_2/models/part_iges/cylinder.igs

PROCESSING FILE 7 OF 10 - /home/users/user_2/models/part_iges/slide.igs

PROCESSING FILE 8 OF 10 - /home/users/user_2/models/part_iges/clamp.igs

PROCESSING FILE 9 OF 10 - /home/users/user_2/models/part_iges/pin.igs

PROCESSING FILE 10 OF 10 - /home/users/user_2/models/part_iges/socket.igs

§ÄÉê=`djJa~íÉáÉå
Bei CGM handelt es sich um ein vektor-orientiertes 2D-Dateiformat zum Speichern und Laden von
Bilddaten. CGM wird als geräteunabhängiges Verfahren zur Datenübertragung zwischen (Hardware- und
Software-) Systemen mit unterschiedlicher Architektur verwendet.

pç=ÉñéçêíáÉêÉå=páÉ=áå=`djJa~íÉáÉå
Sie können Grafikdaten in den Modi Teil, Baugruppe und Zeichnung nach CGM exportieren. Beide
Dateiformate (reiner ASCII-Text und binäre Metadateien) verwenden beim Erzeugen von Dateien entweder
abstrakte Einheiten ("1 Einheit") oder metrische Einheiten ("1 Inch" oder "1 cm").

1. Wählen Sie in einer offenen Zeichnung, einem offenen Teil oder einer offenen Baugruppe die
Befehlsfolge Datei > Kopie speichern (File > Save a Copy). Es erscheint das Dialogfenster Kopie

speichern (Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option CGM (*.cgm). Der vorhandene Pro/ENGINEER

Modellname erscheint ohne die Erweiterung im Feld Neuer Name (New Name).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Das Menü Exportieren CGM (Export CGM) wird geöffnet.
5. Wählen Sie den Befehl Abstrakte Koordinaten (Abstract Coordinates) (speichert 1 Inch oder 1 cm

als 1 abstrakte Einheit) oder Metrische Koordinaten (Metric Coordinates) (speichert die metrischen
Einheiten).

6. Klicken Sie in der Liste Dateiformat (File Structure) auf CLEARTEXT (ASCII-Datei) oder MILSPEC

(Binärdatei).
7. Die Datei wird exportiert, und das System erstellt Ya~íÉáå~ãÉ[Kåíê.

pç=áãéçêíáÉêÉå=páÉ=`djJa~íÉáÉå
1. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) (ohne eine geöffnete Zeichnung) oder

Einfuegen > Daten aus Datei (Insert > Data From File) (mit einer geöffneten Zeichnung). Das
Dialogfenster Datei oeffnen (File Open) oder Oeffnen (Open) wird aufgerufen.

2. Wählen Sie in der Liste Typ den Eintrag CGM, und wählen Sie in der Liste der verfügbaren Dateien
die zu importierende Datei aus, oder geben Sie den Dateinamen in das Feld Name ein.

3. Klicken Sie auf OK. Der weitere Verlauf richtet sich nach dem Verwendungszweck der CGM-Datei:
� Wird die Datei zum Erzeugen einer Zeichnung verwendet, erscheint das Dialogfenster Neues

Modell importieren (Import New Model). Schließen Sie die Auswahl im Dialogfenster ab, und
wählen Sie OK, um eine Zeichnungsdatei mit den CGM-Daten zu öffnen.

� Soll die Datei an eine geöffnete Zeichnung angehängt werden, wird die CGM-Datei in die
Zeichnungsdatei importiert.

`djJa~íÉáÉå=áãéçêíáÉêÉå
Dateien im CGM-Format können nur im Modus Zeichnung nach Pro/ENGINEER importiert werden. Es
gibt zwei Möglichkeiten, um Grafikdaten im MILSPEC-Format in einer Metafile-Datei darzustellen:

� Mit metrischen Einheiten

� Mit abstrakten Koordinaten, die eine Geometrie ohne Festlegung der absoluten Objektgröße definieren
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Pro/ENGINEER unterstützt den Import beider Dateitypen.

Die meisten Applikationen erzeugen Dateien mit abstrakten Koordinaten. Bei der Übertragung von Daten
mit abstrakten Koordinaten werden diese automatisch skaliert, damit sie in die aktuelle Zeichnung
hineinpassen. Beim Importieren einer Metadatei in metrischen Einheiten wählt Pro/ENGINEER
automatisch eine entsprechende Standard-Zeichnungsgröße; die vorherige Zeichnungsgröße kann sich also
ändern.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=qfccJa~íÉáÉå
Das TIFF-Format unterstützt den Austausch von digitalen Bilddaten zwischen Systemen mit
unterschiedlicher Architektur. Pro/ENGINEER unterstützt den Export und Import von TIFF in allen
Grafikmodi.

Mit TIFF können Grafik- und Textdaten im Bitmap-Format gespeichert und später zwischen
Pro/ENGINEER und anderen Programmen unter X Windows (UNIX) oder GDI (NT) ausgetauscht werden.
Pro/ENGINEER unterstützt TIFF im Palettenfarbmodus (Level 3) und ermöglicht somit die Verwendung
von Farbgrafiken. RGB TIFF kann auf Rechnern exportiert werden, die den Grafikmodus STARBASE
oder OPEN GL unterstützen.

pç=ÉñéçêíáÉêÉå=páÉ=áå=qfccJpÅÜå~ééëÅÜì≈Ja~íÉáÉå
Wenn Pro/ENGINEER eine Grafik nach TIFF exportiert, übernimmt es praktisch die Funktion eines
Scanners, d.  h., es erfaßt den aktuellen Bildschirminhalt als Bitmap. Die Ausgabedatei ist also ein
Screenshot des gesamten Bildschirms. Das Exportieren von Grafikdaten in TIFF-Dateien (Schnappschuß)
ist aus den Modi Teil, Baugruppe und Zeichnung möglich. TIFF (Schnappschuß) ist das einzige
Bildformat, in das Sie Zeichnungsdateien exportieren können. TIFF-Dateien haben die Erweiterung .tif.

1. Wählen Sie in einer offenen Zeichnungs-, Teile- oder Baugruppendatei die Befehlsfolge Datei > Kopie

speichern (File > Save a Copy). Es erscheint das Dialogfenster Kopie speichern (Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option TIFF (Schnappschuss) TIFF (Snapshot) (*.tif).

Wenn Sie statt des aktuellen Dateinamens einen anderen Namen für die exportierte Grafik verwenden
möchten, geben Sie ihn in das Feld Neuer Name ein.

3. Klicken Sie auf OK. Die Meldung ^âíìÉääÉë=cÉåëíÉê=ëÅÜäáÉëëÉå=Emçé=`ìêêÉåí
táåÇçïF wird im Pro/ENGINEER Fenster angezeigt.

4. Wählen Sie vÉë, um die TIFF-Datei zu exportieren.

pç=ÉñéçêíáÉêÉå=páÉ=dê~ÑáâÉå=áå=Ç~ë=cçêã~í=qfcc
EpÅÜå~ééëÅÜìëëFI=qfccI=bmp=çÇÉê=gmbd

Schattierte Bilder exportieren
Sie können Drahtmodell-Grafiken und schattierte Bilder in die folgenden Formate exportieren:

� TIFF

� Schattierung

� EPS

� JPEG

TIFF- und JPEG-Dateien werden vom WWW-Browser unterstützt.

Beim Exportieren in die Formate TIFF, EPS und JPEG können Sie die Bildgröße, die Auflösung und die
Tiefe ändern. Zum Exportieren einer Grafik in das Format Shaded Image verwenden Sie die aktuellen
Pro/ENGINEER Parameter.

TIFF-Dateien werden im Bitmap-Format auf der Basis der im Bild vorhandenen Pixel (nicht der Punkte pro
Inch, dpi) gespeichert. Wenn Sie für die Bildgröße die Option Variabel verwenden, die Höhe und Breite
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festlegen und eine stärkere Auflösung wählen, entsprechen die daraus resultierenden Werte nicht unbedingt
der tatsächlichen Bildgröße.

Wenn Sie beispielsweise eine Grafik mit einer Größe von 4 x 4 Inch mit einer Auflösung von 100 dpi
exportieren, besitzt die Grafik 400 x 400 Pixel. Verwenden Sie jedoch 200 dpi als Auflösung, besitzt die
Grafik 800 x 800 Pixel. Bei höheren Auflösungen wird die Bildgröße erhöht.

Verfahren für den Export
Wählen Sie das gewünschte Exportverfahren unter páÉÜÉ=~ìÅÜ.

pç=áãéçêíáÉêÉå=páÉ=qfccJa~íÉáÉå
Dateien im TIFF-Format können nur im Modus Zeichnung nach Pro/ENGINEER importiert werden.
Stellen Sie sicher, daß die Konfigurationsoption Öê~éÜáÅë auf ñ|ïáåÇçïë gesetzt ist (UNIX-
Plattformen) bzw. auf ïáåPO|ÖÇá (Windows NT).

1. Wählen Sie in einer offenen Zeichnung die Befehlsfolge Einfuegen > Daten aus Datei (Insert > Data
from File). Das Dialogfenster Oeffnen (Open) erscheint.

2. Wählen Sie in der Liste Typ (Type) die Option TIFF (Schnappschuss) (TIFF (*.tif)).
3. Wählen Sie den Dateinamen aus der Liste der verfügbaren Dateien aus.
4. Wählen Sie OK, um die TIFF-Datei in die Zeichnung zu importieren.

eáåïÉáëÉ=òìã=fãéçêíáÉêÉå=îçå=qfccJa~íÉáÉå
Beachten Sie beim Importieren einer TIFF-Bitmap in die aktuelle Zeichnung folgendes:

� Die gesamte Grafik wird in Pro/ENGINEER zu einem einzigen Element.

� Die Zeichnungsdatei benötigt sehr viel Speicherplatz.

� Sie kann wie ein gewöhnliches Element manipuliert werden.

� Die importierten Grafiken können nicht bearbeitet werden.

� In eine Zeichnung importierte TIFF-Grafiken können nicht geplottet werden.

pç=ÉñéçêíáÉêÉå=páÉ=dê~ÑáâÉå=áå=Ç~ë=cçêã~í=qfccI
bmp=çÇÉê=gmbd
1. Wählen Sie in einem offenen Teil oder einer offenen Baugruppe die Befehlsfolge Datei > Kopie

speichern (File > Save a Copy). Es erscheint das Dialogfenster Kopie speichern (Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option TIFF (Schnappschuss) (TIFF (Snapshot) (*.tif)),

EPS (*.eps) oder JPEG (*.jpg). Wenn Sie statt des aktuellen Dateinamens einen anderen Namen für
die exportierte Grafik verwenden möchten, geben Sie ihn in das Feld Neuer Name ein.

3. Klicken Sie auf OK. Das Dialogfenster Konfiguration fuer schattierte Bilder wird aufgerufen.
4. Geben Sie im Dialogfenster die gewünschte Größe und Auflösung an.
5. Wählen Sie OK, um die Datei zu exportieren. Das System fügt die Dateinamenerweiterungen .tif, .eps.

oder .jpg automatisch hinzu.

pç=ÉñéçêíáÉêÉå=páÉ=ëÅÜ~ííáÉêíÉ=_áäÇÉê
1. Wählen Sie in einer offenen Zeichnungs-, Teile- oder Baugruppendatei die Befehlsfolge Datei >

Kopie speichern (File > Save a Copy).
2. Wählen Sie in der Liste Typ (Type) die Option Schattierung (Shaded Image) (*.shd). Wenn Sie statt

des aktuellen Dateinamens einen anderen Namen für die exportierte Grafik verwenden möchten, geben
Sie ihn in das Feld Neuer Name ein.

3. Wählen Sie OK, um das schattierte Bild zu exportieren. Die Dateinamenerweiterung für das schattierte
Bild (.shd) wird automatisch hinzugefügt.
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aá~äçÖÑÉåëíÉê=hçåÑáÖìê~íáçå=ÑìÉê=ëÅÜ~ííáÉêíÉ=_áäÇÉê
EpÜ~ÇÉ=fã~ÖÉ=`çåÑáÖìê~íáçåF
Groesse (Size) — Mit dem Pfeil neben Groesse (Size) lassen Sie eine Liste anzeigen, in der die
Standardoptionen für die Größe sowie die Option Variabel (Variable) aufgeführt werden. Klicken Sie auf
die gewünschte Größe.

Hoehe (Height) — Steht nur zur Verfügung, wenn Sie die Option Variabel (Variable) in der Liste
Groesse (Size) ausgewählt haben. Geben Sie eine benutzerdefinierte Höhenbemaßung ein.

Breite (Width) — Steht nur zur Verfügung, wenn Sie die Option Variabel (Variable) in der Liste
Groesse (Size) ausgewählt haben. Geben Sie eine benutzerdefinierte Breitenbemaßung ein.

Oberer Rand (Top Margin) — Steht nur zur Verfügung, wenn Sie die Option Variabel (Variable) in der
Liste Groesse (Size) ausgewählt haben. Geben Sie eine benutzerdefinierte Bemaßung für den oberen Rand
ein.

Linker Rand (Left Margin) — Steht nur zur Verfügung, wenn Sie die Option Variabel (Variable) in der
Liste Groesse (Size) ausgewählt haben. Geben Sie eine benutzerdefinierte Bemaßung für den linken Rand
ein.

Einheiten (Units) – Steht nur zur Verfügung, wenn Sie in der Liste Groesse (Size) die Option Variabel
(Variable) gewählt haben. Klicken Sie auf Millimeter (Millimeters) oder Inch (Inches).

DPI — Bestimmt die Auflösung des Bilds. Mit dem Pfeil neben DPI lassen Sie eine Liste der DPI-Werte
anzeigen. Klicken Sie auf den gewünschten DPI-Wert.

Bildtiefe (Image Depth) — Mit dem Pfeil neben Bildtiefe (Image Depth) lassen Sie eine Liste der Werte
für die Bildtiefe anzeigen. Klicken Sie auf die gewünschte Bildtiefe.

pç=áãéçêíáÉêÉå=páÉ=kÉìíê~äÇ~íÉáÉå
Sie können sowohl im Modus Teil als auch im Modus Baugruppen Neutraldateien importieren.

1. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) (ohne ein geöffnetes Teil oder eine
Baugruppe) oder Einfuegen > Daten aus Datei (Insert > Data From File) (mit einen geöffneten Teil
oder einer Baugruppe). Das Dialogfenster Datei oeffnen (File Open) oder Oeffnen (Open) wird
aufgerufen.

2. Wählen Sie in der Liste Typ (Type) die Option Neutral (*.neu). Die Neutraldateien im
Arbeitsverzeichnis werden aufgeführt. Klicken Sie in der Liste der verfügbaren Dateien auf die zu
importierende Neutraldatei, oder suchen Sie nach der Neutraldatei, und markieren Sie sie.

3. Klicken Sie auf OK. Das Dialogfenster Volumenkoerper-Optionen und Plazierung (Choose Solid

Options and Placement) wird geöffnet.
4. Übernehmen Sie das vorgegebene Koordinatensystem, oder wählen Sie das gewünschte

Koordinatensystem aus.
5. Klicken Sie auf Koerper (Protrusion), Schnitt (Cut) oder Flaechen (Surfaces).
6. Mit OK lassen Sie die Datei importieren.

pç=ÉñéçêíáÉêÉå=páÉ=áå=kÉìíê~äÇ~íÉáÉå
Bei Neutraldateien gilt die Namenskonvention YlÄàÉâíå~ãÉ[KåÉìK@. YlÄàÉâíå~ãÉ[ bezeichnet
den Namen des Teils oder der Baugruppe für die Generierung der Datendatei, @ entspricht der Version oder
dem Index der Neutraldatei.

Wenn Sie eine Neutraldatei erzeugen möchten, müssen Sie zuerst das Teil oder die Baugruppe aufrufen.

1. Wählen Sie die Befehlsfolge Datei > Kopie speichern (File > Save a Copy). Das Menü Kopie

speichern (Save a Copy) wird geöffnet.
2. Klicken Sie auf Neutral (*neu).
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3. Übernehmen Sie den vorgegebenen Dateinamen für den Export, oder geben Sie einen neuen
Dateinamen ein. Die Eingabe einer Erweiterung ist nicht notwendig.  Eine Datei mit dem Namen
<Objektname>.neu.# wird erzeugt und im aktuellen Arbeitsverzeichnis gespeichert.

^ääÖÉãÉáåÉ=báåÑΩÜêìåÖW=a~íÉáÉå=áã=`mqoJ
kÉìíê~äÑçêã~í=áãéçêíáÉêÉå
CADAM-Mainframe-Dateien können im CPTR-Neutralformat importiert werden. Ein Konverter von
Integrated Industrial Information, Inc., CPTR, konvertiert die CADAM-Mainframe-Daten mittels
ACCESS:IUE in ein CPTR-Neutralformat. Mit Pro/CDT können Sie dann eine Datei im CPTR-
Neutralformat (eine Datei mit der Erweiterung KÄáå) in Pro/ENGINEER importieren. CADAM-
Schriftarttabellenzeichen (ITYPE 1060) werden beim Import als Instanzen von benutzerdefinierten
Pro/ENGINEER-Symbolen unterstützt.

Hinweis: Das Dienstprogramm éêç|Ñêçã|Åéíê ist von der Hardware abhängig. Bei Fragen zur
Plattformverfügbarkeit wenden Sie sich bitte an Integrated Industrial Information, Inc.

Zwei Methoden zum Importieren von CPTR-Neutraldateien
Zum Importieren einer CPTR-Neutraldatei verwenden Sie das Pro/ENGINEER-Dienstprogramm
éêç|Ñêçã|Åéíê, um die Datei (<a~íÉáå~ãÉ>.bin) in ein Format zu konvertieren, das von Pro/CDT
gelesen werden kannEYa~íÉáå~ãÉ[KÅÇã). Anschließend importieren Sie die KÅÇã-Datei in
Pro/ENGINEER.

Eine CPTR-Neutraldatei kann auf eine der folgenden Arten in Pro/ENGINEER importiert werden:

� Direkt auf einen Computer, auf dem Pro/CDT und éêç|Ñêçã|Åéíê=installiert sind.

� Durch Verarbeitung der Datei auf einem Computer und Aufrufen von einem anderen Computer durch:

� Ausführen des Pro/ENGINEER-Dienstprogramms éêç|Ñêçã|Åéíê zum Konvertieren der Datei
in eine Datei mit der Erweiterung KÅÇã.

� Importieren der KÅÇã-Datei in Pro/ENGINEER.

Informationen über das Zeichnungsformat weitergeben
Eine CPTR-Neutraldatei kann ein CADAM-Element enthalten, das Plotachsensystem (ITYPE 960), in dem
das Format und die Positionierung einer CADAM-Zeichnung in Pro/ENGINEER definiert wird.

Mit der Konfigurationsdatei-Option ìëÉ|Å~Ç~ã|éäçí|Ç~í~ wird angegeben, ob das System die
Informationen im Plotachsensystem-Element beim Importieren einer CADAM-Zeichnung in
Pro/ENGINEER berücksichtigen soll. Ist diese Option auf åç (der Standardwert) gesetzt, wird sie vom
System ignoriert. Ist diese Option auf óÉë gesetzt und enthält die importierte Zeichnung das
Plotachsensystem-Element, werden Sie während des Importvorgangs gefragt, ob das Format basierend auf
dem Plotachsensystem definiert werden soll. Antworten Sie mit v, wählt das System das Format basierend
auf der Höhe, der Breite und dem Ursprung im Plotachsensystem-Element. Antworten Sie mit k, wird das
Format wie bei normalen CADAM-Dateien festgelegt.

pç=áãéçêíáÉêÉå=páÉ=`mqoJkÉìíê~äÇ~íÉáÉå=ÇáêÉâí
1. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File

Open) wird aufgerufen.
2. Wählen Sie aus der Liste Typ (Type) den Befehl CADAM CPTR Neutral (CADAM CPTR Neutral)

(.bin). Anschließend wählen Sie die zu importierende CADAM-Datei aus der Liste der verfügbaren
Dateien, oder geben Sie den Namen in das Feld Name ein.

3. Wählen Sie OK, um die CADAM-Datei zu importieren. Es erscheint das Dialogfenster Neues Modell

importieren (Import New Model).
4. Vervollständigen Sie das Dialogfenster und klicken Sie OK an, um die neue Datei mit den CADAM-

Daten zu öffnen.
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5. Ist die Option ìëÉ|Å~Ç~ã|éäçí|Ç~í~ auf óÉë gesetzt und enthält die importierte Zeichnung ein
Plotachsensystem-Step 7em-Element, werden Sie während des Importvorgangs gefragt, ob das Format
basierend auf dem Plotachsensystem definiert werden soll.
� Wenn Sie mit v antworten, schließen Sie den Importvorgang wie in Schritt 6 beschrieben ab.

� Wenn Sie mit k antworten oder die importierte Zeichnung das Plotachsensystem nicht verwendet,
fahren Sie mit den Schritten 6 und 7 fort.

6. Ist die importierte Zeichnung größer als das gewählte Standardformat, fragt das System, ob die
Zeichnung so skaliert werden soll, daß sie in das Format eingepaßt werden kann. Wenn Sie mit v
antworten, skaliert das System die Zeichnung neu.

7. Das System fragt Sie, ob die linke Ecke der Zeichnung an den Bildschirmursprung verschoben werden
soll. Wenn Sie mit v antworten, wählt das System automatisch die nächste für die Zeichnung passende
Standardgröße, und zeigt die Zeichnung auf dem Bildschirm an. Wenn Sie mit k antworten, wird der
Ursprung der CADAM-Zeichnung (der sich in der Mitte befindet) auf den Ursprung der
Pro/ENGINEER-Zeichnung (in der linken unteren Bildschirmecke) gesetzt. Das System wählt das
Format zwar immer noch automatisch, aber die Zeichnung wird nur teilweise dargestellt. Um die
gesamte Zeichnung oder den entsprechenden Ausschnitt darzustellen, verwenden Sie den Befehl
Verkleinern und verschieben Sie die Zeichnungselemente, indem Sie einen Translationsvektor
angeben.

pç=îÉê~êÄÉáíÉå=páÉ=`mqoJkÉìíê~äÇ~íÉáÉå
Eine CPTR-Neutraldatei kann verarbeitet werden, indem die Datei auf einem Computer verarbeitet und
dann von einer Pro/ENGINEER-Workstation aus abgerufen wird.

Mit dem Pro/ENGINEER-Dienstprogramm éêç|Ñêçã|Åéíê konvertieren Sie eine CPTR-Neutraldatei
in eine KÅÇã-Datei. Geben Sie auf einem Computer mit éêç|Ñêçã|Åéíê folgendes ein:

xéêç|Ñêçã|Åéíê=YbáåÖ~ÄÉÇ~íÉá[=Y^ìëÖ~ÄÉÇ~íÉá[z

Dabei gilt:

� YbáåÖ~ÄÉÇ~íÉá[ ist der Name der CPTR-Neutraldatei.

� Y^ìëÖ~ÄÉÇ~íÉá[ (optional) ist der Name der Ausgabedatei. Wurde kein Ausgabename angegeben,
hängt das System die Erweiterung KÅÇã an den Dateinamen an.

pç=áãéçêíáÉêÉå=páÉ=îÉê~êÄÉáíÉíÉ=`^a^jJa~íÉáÉå
1. Kopieren Sie die verarbeitete CADAM-Datei auf eine Pro/ENGINEER-Workstation.
2. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File

Open) wird geöffnet.
3. Wählen Sie aus der Liste Typ den Befehl CADAM. Anschließend wählen Sie die zu importierende

CADAM-Datei aus der Liste der verfügbaren Dateien, oder geben Sie den Namen in das Feld Name

ein.
4. Wählen Sie OK, um die CADAM-Datei zu importieren. Es erscheint das Dialogfenster Neues Modell

importieren (Import New Model).
5. Vervollständigen Sie das Dialogfenster und klicken Sie OK an, um die neue Datei mit den CADAM-

Daten zu öffnen.
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iáåáÉåëí®êâÉå=ÄÉáÄÉÜ~äíÉå
Zeichnungen können mit Linienstärken erstellt werden, die dem Standard entsprechen. Dazu legen Sie die
Linienstärken von Elementen in Pro/ENGINEER mit der Konfigurationsdatei-Option
Å~Ç~ã|äáåÉ|ïÉáÖÜíë fest. Die Pro/ENGINEER-Vorgabewerte für die Linienstärken werden in der
folgenden Tabelle aufgeführt:

Linienstärken Vorgabewerte

Leicht  .2

Mittel  .3

Grob  .5
Wenn Sie eine Zeichnung mit importierten CPTR Daten plotten möchten, stellen Sie die
Konfigurationsoption folgendermaßen ein:

Å~Ç~ã|äáåÉ|ïÉáÖÜíë=KO=KP=KR

pÅÜê~ÑÑìêãìëíÉê=áãéçêíáÉêÉå
Mit dem CADAM Areafill-Element (ITYPE=1600) können Schraffurmuster in Pro/ENGINEER importiert
werden.In der folgenden Tabelle werden die Entsprechung zwischen den CADAM- und den
standardmäßigen Pro/ENGINEER-Schraffurmustern aufgeführt.

displayCADAM-Mustername Pro/ENGINEER-Mustername

ALUM1 aluminum.xch

KUPFER copper.xch

Kacheln electric.xch

STRICHE glass.xch

LUKE iron.xch

GUMMI plastic.xch

STAHL steel.xch

TITAN titanium.xch

RASTER zinc.xch

Falls ein CADAM-Schraffurmuster kein entsprechendes Pro/ENGINEER-Muster aufweist, können Sie
folgendes versuchen:

� Erzeugen Sie in Pro/ENGINEER eine Datei mit einem benutzerdefinierten Schraffurmuster, und
speichern Sie diese Datei im Arbeitsverzeichnis oder unter Yäç~Çéçáåí[LíÉñíLÅêçëëÜ~íÅÜ
~êÉ~. Der Name der Schraffurdatei muß dem Format ÅÇã|Yk^jb[KñÅÜ entsprechen. Dabei steht
Yk^jb[ für den Namen des zu importierenden CADAM-Schraffurmusters. (Lautet der Name des
CADAM Areafill-Musters z.B. ^irjO, muß der entsprechende Name des benutzerdefinierten Musters
ÅÇã|~äìãOKñÅÜ sein.) Nach dem Importvorgang ersetzt das System das CADAM-Muster durch das
benutzerdefinierte Muster mit dem gleichen Namen.

� Lassen Sie das System ein Muster erzeugen. Falls das System kein entsprechendes benutzerdefiniertes
Muster findet, erstellt es ein Schraffurmuster unter Verwendung einer einfachen Schraffurvorlage (z.B.
Schrägstriche).
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pç=ÉñéçêíáÉêÉå=páÉ=áå=_ÉïÉÖìåÖëÜΩääÉå
1. Wählen Sie in einer offenen Baugruppe die Befehlsfolge Datei > Kopie speichern (File > Save a

Copy). Das Menü Kopie speichern (Save a Copy) wird geöffnet.
2. Wählen Sie in der Liste Typ (Type) die Option Beweg Huelle (Motion Envlp).
3. Akzeptieren Sie den Namen im Feld Neuer Name (New Name), oder geben Sie einen anderen

Modellnamen für den Export ein.
4. Klicken Sie auf OK. Die Dialogfenster Bewegungshuelle erzeugen (Create Motion Envelope) und

Oeffnen (Open) werden angezeigt.
5. Im Dialogfenster Oeffnen (Open) erscheint Frames-Datei (Frames File) (*.fra) im Feld Typ (Type).

Klicken Sie in der Liste der verfügbaren Dateien auf die zu öffnende Frames-Datei, oder suchen Sie
nach der Frames-Datei. Das Dialogfenster Oeffnen (Open) wird geschlossen.
Hinweis: Frames-Dateien werden in der Anwendung Mechanism Design erstellt.

6. Vervollständigen Sie das Dialogfenster Bewegungshuelle erzeugen (Create Motion Envelope), und
klicken Sie auf Erzeugen (Create).
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